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Chapter 1

Introduction to
PowerScribe 360 | Reporting

Objectives
In this chapter you will:

• Describe the PowerScribe 360 | Reporting system

• Review the system’s speech capabilities

• Identify the servers used in a PowerScribe 360 | 
Reporting implementation

• Describe the documentation resources available for 
the PowerScribe 360 | Reporting implementation
1
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Introduction

This system administrator guide for PowerScribe® 360 | Reporting (previously PowerScribe® 
360) provides instructions for setting up the PowerScribe 360 | Reporting system, creating 
users, configuring system, site, and user preferences, running reports, and many other 
administrative functions. 

The guide includes instructions for the configurations you must set and maintain as system 
administrator; as reference material, it also describes some configurations usually performed 
by Nuance personnel. In addition, it gives instructions for managing orders through the Order 
Entry portal. And, it includes provider training instructions (in two sections, Introduction and 
Pre-Enrollment, and Intermediate and Advanced), editor training instructions, and 
technologist training instructions.

PowerScribe 360 | Reporting
PowerScribe 360 | Reporting is a front-end speech recognition solution for academic 
centers, hospitals, and imaging centers with unique workflow, data-driven reporting, and 
communication needs. It includes: 

• Structured speech recognition technology optimized specifically for the radiology 
domain. 

• Industry-leading diagnostic imaging workflow management. Radiologists and other 
users can create reports with a variety of dictation styles, with peer review integrated 
into the process. Users can access report content with ease, and the system permits 
creation, delivery and auditing of critical messages. 

• Data extraction tools for analyzing productivity and outcomes.

PowerScribe 360 | Reporting offers industry-leading radiology workflow management. 
Designed to address the needs of healthcare networks with multiple RIS, PACS, 3D, and 
teleradiology systems, the software seamlessly integrates these elements. The system has 
the ability to launch an unlimited number of legacy and Web-based PACS viewers while 
intelligently returning orders to the appropriate RIS system from a single workstation. 
RIS/PACS workflow might be contained in a single environment, or a third-party system 
can handle order lists, routing, editing, and electronic signature workflow.

PowerScribe 360 | Reporting offers four dictation styles to accommodate provider 
preferences:

• Real-Time Speech Recognition with Self Editing: Once and done real-time speech 
recognition allows radiologists to view text as it is dictated. To navigate within and 
correct documents, they can use keyboard, mouse, and standard word processing tools, 
or they can use voice commands and microphone controls. The software immediately 
recognizes spoken changes and additions anywhere in the report. 

• Real-Time Speech Recognition with AutoText: Radiologists can use autotext, that 
is, standard text, to maximize efficiency. AutoText entries are categorized and mapped 
to procedure codes; they are triggered by factors such as the patient’s age or gender. 
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The appropriate AutoText can be loaded automatically for any exam. Users can use 
speech commands to navigate within and edit the standard text blocks.

• Real-Time Speech Recognition with Auto-Structured Reporting: Auto-structured 
reporting eliminates the need for the radiologist to follow a structured format. In 
Findings Mode, the PowerScribe 360 | Reporting software automatically converts 
free-form dictation to a structured report. This intelligent phrase recognition and 
automatic organization tool can greatly reduce the time spent using conventional 
structured macros. 

• Real-Time Speech Recognition with Editor Editing: A combination of front-end 
speech recognition with editor workflow and editing, this method can be used in 
conjunction with any of the above reporting styles. 

Audio Retention

PowerScribe 360 | Reporting maintains an audio and text backup on the workstation only 
while a report is open for editing; it deletes the backup when the user finishes work on the 
report. If the application closes down unexpectedly, the backup remains in the Temp 
folder and the user is prompted to restore the report upon logging in again. Although the 
audio file remains on the workstation until the report is reopened, it is associated with the 
original user’s profile and is not accessible to others. The Dragon speech recognition 
software stores .dra files in the local cache of the speech profile; these files are encrypted 
and are not accessible to unauthorized users. 

PowerScribe 360 | Reporting Servers and 
Workflow

Note: Before you begin, make sure that PowerScribe 360 | Reporting has been installed on 
your network, and is ready to be configured and used. Details for installing individual 
PowerScribe 360 | Reporting products are contained in the Installation Guide. 

Server Software
In a typical PowerScribe 360 | Reporting installation, the following software applications, 
services, and file structure reside on the server:

Database Server Software
• Microsoft Windows Server

• Microsoft SQL Server 
3
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IIS Web Server 

The PowerScribe 360 | Reporting Portal application is installed on the IIS Web server. 
Refer to your installation guide for instructions. 

Bridge Service 

The PowerScribe 360 | Reporting Bridge service exchanges orders and results with other 
information systems such as an RIS. The Bridge runs as a standard Windows service. 

Client Admin Application 

The Client Admin Application allows administrators to configure the PowerScribe 360 | 
Reporting Client application, which is downloaded and installed on users’ workstations. 

Shared Distribution Folders 
• Dragon speech files 

• Dragon NaturallySpeaking CD image 

• Software downloads folder 

• Software publication folder 

The diagrams in this section introduce the various servers that are part of your 
PowerScribe 360 | Reporting system, and show how dictation and data flow through the 
system.
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PowerScribe 360 | Reporting Workflow

1. Order data flows from the RIS system to the PowerScribe 360 | Reporting HIS Bridge 
and into the PowerScribe 360 | Reporting SQL database

2. The radiologist selects an order from a worklist and begins dictation at the 
workstation.

3. The dictation is converted to text directly on the workstation.

4. If the radiologist wants to edit his own work:

 a. He edits and electronically signs the completed report.

 b. The completed report is sent to the PowerScribe 360 | Reporting server.

 c. The PowerScribe 360 | Reporting server sends completed reports to the 
PowerScribe 360 | Reporting HIS Bridge for HL7 upload to the RIS system. The 
RIS systems manage document distribution beyond this point. 

OR
5
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If the provider does not want to edit his own work:

 a. He sends the speech-recognized report as well as the dictated audio to the 
PowerScribe 360 | Reporting server.

 b. The editor selects the dictation from a worklist and begins listening to the audio 
using the traditional editor tools. The editor can either edit the speech-recognized 
text or transcribe it from scratch.

 c. The edited document goes back to the PowerScribe 360 | Reporting server and is 
placed in the provider’s queue for signature.

 d. The PowerScribe 360 | Reporting server sends completed report to the 
PowerScribe 360 | Reporting HIS Bridge for HL7 upload to the RIS system as an 
ORU message. The RIS system manages document distribution. 

Note: The provider can begin editing his own work, but later send the 
partially-edited report for further editing by an editor, if desired. 

PowerScribe 360 | Reporting Administrator Portal 
and Client Applications

Administrators, dictation users, editors, technologists, front desk, and order entry 
personnel use the features described below. 

PowerScribe 360 | Reporting Administrator Portal

The PowerScribe 360 | Reporting Administrator Portal is a Web-based application you 
can use to perform system maintenance and other tasks. The portal you see when you log 
in depends on the role that has been assigned to your user ID. As system administrator, 
you have been granted administrative privileges, and you therefore see the standard 
Administrator Portal Web page upon logging in. Order entry clerks see only the order 
entry portal, and do not see any of your administrative functions. Front-desk personnel can 
log in to the Portal to enter order data into the system. Radiologists can find and edit their 
reports through yet another portal. As system administrator, you are responsible for setting 
up users and assigning the roles that determine what they can do and see in the Portal 
application. 

In the PowerScribe 360 | Reporting Portal, you can: set site and global preferences, set up 
providers and administrator users, find and view AutoText entries, develop worklists, and 
perform system maintenance. You can view system activity, find orders and reports, and 
run a variety of productivity reports. You can also view and manage patient and physician 
records.

PowerScribe 360 | Reporting Client

Radiologists and editors use the PowerScribe 360 | Reporting client application to find, 
view, dictate, and edit reports. There are two separate installation procedures: one for the 
transcriptionist and one for the radiologist. If you install the client for an editor, a modified 
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version of the speech software is installed. If installing for a radiologist, the full client is 
installed, which includes all of the Dragon files necessary for speech recognition.

As system administrator, you can use the PowerScribe 360 | Reporting Client to create and 
maintain AutoText entries, which are standard blocks of text providers or editors can 
insert in their reports. 

PowerScribe 360 | Reporting Client Portal

This Internet-based portal allows dictation providers to edit and sign reports; it does not 
provide speech-recognition capability, therefore they do not use it for dictation. 
Technologists can use this portal to enter values in custom fields. 

Optional Modules

In addition to the core product, PowerScribe 360 | Reporting offers several optional, 
purchasable modules:

• Quality Guidance: Provides quick and easy access to evidence-based clinical guidelines 
at the point of documentation. Quality Guidance is comprised of two components:

– Clinical Guidance: Allows you to insert recommended text on specific topics such as 
liver lesions, thyroid nodules, and so on. Clinical guidance collects structured 
information about findings and determines appropriate report text based upon 
established, industry-standard best practices.

– Quality Check: A consistency checker that monitors your report for inconsistencies in 
laterality and gender, and highlights potential critical results dictated in a report.

• Critical Results: Works with PowerScribe 360 | Reporting to send notifications based on 
critical report findings.

• Montage: Provides search and performance analytics.

• Peer Review: An orderly and efficient method for conducting peer reviews and 
forwarding the data to the American College of Radiology (ACR).

• Mobile Radiologist and Mobile Clinician: Allows radiologists and clinicians to perform 
reporting tasks on their mobile devices.

• Assisted Diagnosis: Provides links to radiology topics based upon your report content.

• Workflow Orchestrator: Combines the efficiencies of worklists, multiple HL7 feeds, and 
master mode to streamline your reporting tasks.

• Data integrations: Integrates your RIS/LIS/HIS (including DICOM) with PowerScribe 
360 | Reporting.

For more information on these optional modules, contact your Nuance account executive.
7
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Documentation Resources

As system administrator, you should become familiar with the following documentation: 

• Online help for the PowerScribe 360 | Reporting Administrator Portal and 
PowerScribe 360 | Reporting client applications

• Video tutorials for many procedures are on the PowerScribe 360 | Reporting 
installation DVD

• Quick reference cards for providers:

– PowerScribe 360 | Reporting AutoText QRC for Providers (L-3319)

– PowerScribe 360 | Reporting Peer Review QRC for Providers (L-3321)

– PowerScribe 360 | Reporting Provider QRC (L-3323)

– PowerScribe 360 | Reporting Using the PowerMic II QRC (L-3322)

– PowerScribe 360 | Reporting Using the Philips SpeechMike 5276 QRC (L-3324)

– PowerScribe 360 | Reporting Voice Commands QRC for Providers (L-3325)

– PowerScribe 360 | Reporting Portal Access QRC for Providers (L-3326)

– PowerMic II Button Assignment QRC (L-3332)

– Phillips SpeechMike Button Assignment QRC (L-3333)

• Quick reference card for editors:

– PowerScribe 360 | Reporting Editor QRC (L-3320)

• Quick reference cards for system administrators:

– PowerScribe 360 | Reporting Admin Portal QRC (L-3335)

– PowerScribe 360 | Reporting Creating AutoText QRC for Administrators (L-3336)

– PowerScribe 360 | Reporting Custom Fields QRC for Administrators (L-3337)

– PowerScribe 360 | Reporting Best Practices for Speech Recognition QRC (L-3550)

Advanced system administrators should also become familiar with the PowerScribe 360 | 
Reporting Software Installation Service Manual (PN 889617) before using this guide. 



Chapter 2

Navigating in the Portal
and Creating

Administrators

Objectives
In this chapter you will:

• Demonstrate logging in and navigating in the 
Administrator Portal.

• Describe the purposes of administrator users. 

• Demonstrate creating an administrator.
9
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Logging in to the Portal

To log in:

1. Open Internet Explorer and type the following URL: 
http://<PowerScribe 360 server name>/radportal/login.aspx
(Replace <PowerScribe 360 server name> with the name of the server where the 
PowerScribe 360 | Reporting Portal is installed.) 

2. Type your username. (The default administrator username is admin.)

3. Type your password. (The default administrator password is nuance.) At your first 
login, you are required to change your password. Follow the prompts to change the 
password, and then continue. 

4. Click Sign in.

Notes: 

• As a security precaution, the Sign in window reappears if the system is idle for an 
extended period of time. Re-enter your user name and password to continue.

• For PowerScribe 360 | Reporting Administrator Portal administrators, the session 
timeout period is 60 minutes; for security reasons, this setting cannot be changed in 
the Administrator Portal. For users who have been assigned roles, the default is 
‘never’ and this preference can be changed for individual users or at the system 
level. 

• For information about assigning roles to users, refer to Roles on page 112.
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Navigating in the Administrator Portal

This section assumes that you are an administrator authorized to log into the Administrator 
Portal. Other users see other portals upon logging in. 

Logging In for the First Time
The very first time you sign in to the Portal as an administrator, you see the Explorer tab 
of the Exams group. 

Note: On all subsequent logins, you return to the group and tab on which you last worked.

Choosing a Group
The Administrator Portal is divided into three main groups: Exams, Setup, and Logs. 
To select a different group, move your mouse cursor over the current group heading, 
located at the far left of the menu bar. The group list opens, allowing you to select a new 
group. The following illustration shows the Administrator Portal’s groups with the Exams 
group selected. 
11
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Overview of the Administrator Portal and 
Its Groups

Exams Group

The Exams group contains the following menu tabs:

• Explorer: Provides access to all the orders and reports in the system. From this page, you 
can search for reports based on criteria such as patient name, MRN, or accession number; 
view and print reports; and take specific actions on reports, such as resetting a report’s 
priority, editing diagnosis codes, or changing the patient MRN. In addition, you can 
associate or dissociate multiple orders with a report, and view the audit trail for a selected 
order or report. Refer to Speech Configuration Options, beginning on page 176.

• Dashboard: Provides a real-time view of activity in the system. You can see all users 
logged in to the system, the activity they are performing, and recent messages sent to and 
received from the RIS. Refer to System Logs, beginning on page 571.

• Patients: Provides access to all the patient information in the system. You can search for 
patients, and modify their demographic, visit, and insurance information. 

• Physicians: Provides access to all the referring physicians in the system. You can search 
for referring physicians and modify their demographic and insurance information. 
Creating a Physician Account, beginning on page 119 and Modifying a Physician 
Account, beginning on page 120.

Caution: Do not use the Physicians tab for creating radiologist accounts for 
dictation. Use the Accounts tab in the Setup group for creating dictation users. 
In addition, do not use the Physicians tab to create accounts for access to the 
Administrator Portal; use the Accounts tab in the Setup group for these 
accounts as well.

• Peer Reviews: Allows you to view reports and edit existing peer review ratings.

Note: Peer Review is a purchasable feature. Contact your Nuance account executive for 
more information.
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Setup Group 

The Setup group contains the following menu tabs:

• Accounts: Provides access to all user accounts in the system. Here you can search for 
specific accounts, modify the properties of existing accounts (including user preferences), 
create new accounts, and perform other account activities.

• AutoText: Provides access to all AutoText entries (also referred to as macros, templates, 
or shortcuts) used in the system. You can search for AutoText containing specific text, 
modify AutoText, import AutoText entries, and perform other tasks.

• Bridge: Defines the settings of the RIS interface, and allows you to start and stop the 
service.

Caution: Do not make changes to the Bridge tab unless Nuance technical 
support has advised you to do so.

• Procedures: Allows you to manage your organization’s procedure information. From here 
you can import and export your site’s Procedure Master Translator (formerly known as the 
ChargeMaster), categorize procedure codes by anatomy and modality, and perform other 
tasks.

• Sites: Your system might have a single site, or multiple sites. A site is typically mapped to 
an RIS or HIS; orders are unique within a site. All the accession numbers and MRNs 
within a site are unique. On the Sites tab you can manage site-level preferences.

• Speech: On this tab you can set default values for the system, assign the default acoustic 
model and language model, set up system-wide formatting options, see which 
workstations have updated their formatting options and when the updates occurred; and 
manage custom words. (Note that all of these settings can be changed for individual 
providers.) 

• System: Use this tab to configure system-wide preferences. Preferences you set at the site 
or account level will override those at the system level. You can also use the System tab to 
import providers and accounts with roles into the system, and add insurance information. 
To set system preferences and other settings, refer to Configuring the System, beginning on 
page 23.
13
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Logs Group 

The Logs group contains the following menu tabs:

• ACO/LMO: View events that occurred on the speech server during acoustic or language 
model optimization.

• Bridge: View events that occurred on the bridge service. You can export the events to an 
.xml file for further analysis.

• Communications: View communications from PowerScribe 360 | Reporting for fax, 
email, critical findings (PowerScribe 360 | Critical Results), and support requests.

• Exceptions: This is where most system errors are logged. You can search for errors on 
specific criteria, and then use the information for troubleshooting.

• Reports: View statistical reports designed to help administrators. Reports provide detailed 
information on turnaround times, provider and transcriptionist productivity, use of 
AutoText, and many other aspects of system activity. (Note that if the reporting package 
has not been installed on your system, this tab is named Statistics.)

Signing Out of the Administrator Portal

When finished working in the Portal click the Sign out link (located in the upper-right 
portion of the menu bar) to return to the sign-in window, or just close your browser.
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Creating Administrator Accounts

In the PowerScribe 360 | Reporting system, administrators are users who have been granted 
some or all of the administrator rights. An administrator might also be a user who has been 
assigned to a specific role in the PowerScribe 360 | Reporting system. 

You can configure a user as either a system administrator or a site administrator. A system 
administrator has access to all sites in the system. Create a site administrator if you want to 
limit the user’s administrative rights to specific sites. Both administrator types contain the 
same set of privileges from which you can select. 

Administrators cannot edit their own administrative rights. If there is a need for an 
administrator’s rights to be modified, another administrator must edit the account. 

Searching for an Administrator Account

To perform a filter search: 

1. Select Administrator from the Authorization drop-down list.

2. If desired, use one or both of the following criteria:

• Select a Site to find administrators at a particular site in the system.

• Select an option from the Status drop-down list to search for administrators by 
logon status, or whether the account is active or inactive.

3. Click Search. Any administrators who meet your criteria appear in the list. 

To search with the Look for field: 

1. In the Look for field, select Last Name, First Name, Email, Identifier, or 
Username.

2. Enter all or part of the text for which you want to search. 

Tip: In the Look for text field, you can use an asterisk (*) as a wild-card 
character. For example, if you do not know the exact last name of an 
administrator but you know the name ends in the letters MAN, type *man and 
click Search. 
15
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Note: In order to search using a partial name, you must include the asterisk (*) 
wild-card character. Using the previous example of MAN without the wild-card 
character, the search would have failed to return anything unless someone 
actually had the last name of MAN.

3. Click Search. Any users who meet your criteria appear in the list.

To search for an administrator using the alphabet links: 

1. Select Administrator from the Authorization drop-down list.

2. Use the A through Z links to display accounts with last names beginning with a 
particular letter.

Click Reset to return all search fields (Site, Authorization, Status, and Look for) to their 
defaults.

Creating an Administrator Account
To create an administrator account:

1. In the Setup group, click the Accounts tab. The left side of the window lists all the 
users in the system, and the right side displays a form you can use to create a new user.

Note: If a user’s information already appears on the right, click Clear. Clear 
simply removes the data from the window; it does not delete the user from the 
system. 

2. Enter a Username (not case-sensitive) and Password (case sensitive) for the user.

Tip: If your system is configured to require users to change their passwords at 
their first login (that is, if the Setup > System > Preferences > Security tab > 
Forced password change interval preference is set to anything other than 
Never), consider creating a basic password for all users to use at first, allowing 
each user change to a more secure one at first login.

3. Enter a First name and a Last name for the user.

Note: The field names labeled in bold text (Username; Password; First; and 
Last) are required fields. All other fields are optional.
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4. Select the Administrator check box. 

5. Optional: Fill in the ID, Contact, and Address information for the user.

6. Click Create New to save the user account. You can now edit the administrator’s 
rights.

7. Click the Edit Rights link, to the right of the Administrator check box. The 
Administrative Rights dialog box opens 

By default, the System Administrator user type is selected.
17
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To create a site administrator, click the Site Administrator button and open the site 
you want to configure by clicking the open icon at the far right side of the site 
name. In the illustration below, the Imaging Center site is open for editing. Lakeside 
Clinic, Riverview Hospital, and University are available for configuration as well. 
Initially, No access is selected for all sites to prevent unintended access.
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Note: For View Exams, View Peer Reviews, and View System, you must first select the 
View right before the Edit rights become available. For example, when you select View 
System, the Edit Accounts, Edit AutoTexts, Edit System, and Edit Worklists selections 
become available. In other words, you must have View rights before you can have Edit 
rights. This applies to both System and Site administrator accounts.

8. To limit an administrator’s rights, select the Limited access with the following rights 
option. Note that the rights fall into two categories: View rights and Edit rights. Refer 
to the table below to select the user’s rights.

Admin Right Function

View Rights

View Database Reports Allows access to Reporting Services.

View Exams Allows read-only access to Explorer, Dashboard, Patients, and Physician 
pages.

View Logs Allows read-only access to Communications, Exceptions, Statistics, 
Bridge, and ACO/LMO pages. 

View Peer Reviews Allows read-only access to Peer Reviews page.

View Peer Reviews 
Anonymous

Allows read-only access to Peer Reviews page, prevents display of 
radiologist names (reviewers and reviewees) and disables report preview, 
unless the user has the View Exams right. In the latter case, the report 
data are available, but not the reviewer.

View System Allows read-only access to System, Sites, Bridge, Accounts, Speech, and 
AutoText pages.
19
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Edit Rights

Edit Accounts Allows managing user accounts. (You must first select the View System 
right.)

Note: Only system administrators can edit Accounts; site 
administrators have view-only rights.

Edit AutoTexts Allows managing site and account AutoText. (You must first select the 
View System right.)

Note: Only system administrators can edit AutoText; site 
administrators have only view and export rights.

Edit Order Entry Allows managing order entry requests, including authorization. (You 
must first select the View Exams right.)

Edit Orders Allows editing order properties (for example, priority) and metadata that 
are order-related, like custom fields. It also allows assigning orders to 
radiologists, deleting unreported orders, and unlocking orders. (You must 
first select the View Exams right.)

Edit Patients Allows editing patient data. (You must first select the View Exams right.)

Edit Peer Reviews Allows managing peer reviews, including verifications and transmissions 
to the ACR. (You must first select the View Peer Reviews right.)

Edit Physicians Allows editing physician data. (You must first select the View Exams 
right.)

Edit Reports Allows editing report properties (for example, resetting the status to Draft 
or associating/dissociating orders to or from a report) and metadata that 
are report-related, like diagnosis (ICD-9) codes. It also allows changing 
or resetting the radiologist and transcriber of a report, deleting a report, 
and holding/resending a report. (You must first select the View Exams 
right.)

Edit System Allows editing global system, site and Bridge properties, preferences, and 
general configuration. Allows access to the Speech tab in the Setup 
group. (You must first select the View System right for the administrator 
to use this right.)

Note: Only system administrators can edit system-level items; site 
administrators do not see the System tab at all. However, site 
administrators can add and manage items on the Bridge tab.

Edit Worklists Allows creating and editing worklists. (You must first select the View 
System right.)

Note: Only system administrators can edit worklists; since 
worklists appear on the System tab, they are not available to site 
administrators.

Admin Right Function
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To give the administrator full rights, select the Unlimited access to all system 
functions option. This option gives the user all the rights shown in the Admin Rights 
group box below, as well as any other administrative rights. Select this option if you 
want no limits to this user’s rights. 

Caution: It is recommended that you not select this option, but assign 
administrators only the specific rights they need. 

9. When finished, click Save and Close.

Practical Exercise

Test your work: Log out of the Portal, and log back in as the new administrator user you 
just created.
21
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Chapter 3

Configuring the System

Objectives
In this chapter, you will:

• Describe the three-level configuration hierarchy

• Configure system options, including:

- Basic system settings

• Configure BI-RADS codes, if applicable
23
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Introduction to System Configuration

This chapter provides instructions for configuring your entire system. System settings are 
found on the System tab of the Setup group, or in the Configuration dialog box you can 
access from that tab. For information on optional BI-RADS code configuration, refer to 
Configuring BI-RADS Codes, beginning on page 38.

Configuring the Basic System Settings

Most of the settings described in this section are configured only by Nuance personnel. The 
information in this section is provided for your reference. 

Configuring the LDAP Settings
If an LDAP server exists, such as Microsoft Active Directory or ADAM, it can be used for 
authenticating user login. This eliminates the need to maintain passwords in PowerScribe 
360 | Reporting or to synchronize them with other systems such as PACS (Picture 
Archiving and Communication System). 

To configure the LDAP settings:

1. Select the System tab in the Setup group.

2. In the Path field, specify the parts of the LDAP path, not including the user name. 
These parts are the distinguished name attributes (for example, ‘O=County 
Hospital;C=US’). 

3. In the Domain field, specify the host name or IP address of the LDAP server. 

4. In the Authentication field, select the authentication method used by the LDAP 
server.

5. Enter the default administrator user name and password for your LDAP system.

6. Enter the user name pattern for your LDAP system.

7. Select the Active box to use the configured LDAP settings. If you do not select this 
option, the Nuance internal username/password authentication is used. 

8. Click Save Changes.
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Configuring the Application Server
Note: Most of the settings on the Application Server tab are configured only by your 
Nuance representative. You should not change them unless you are directed to do so.

To configure the application server: 

1. In the Setup group, select the System tab.

2. Click Configuration. The System Configuration dialog box opens.

3. Select the Application Server tab.

4. Enter or select the appropriate settings for the application server: 

• In most cases, the Store audio in files option is set to the appropriate value during 
system installation, and you do not need to change it. If your providers are using 
self-edit and you do not want to store the .dra files for playback, or if you do not 
have sufficient room for storage, your Nuance representative might direct you not 
to select this option. 
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• If you select the Store audio in files option, supply a drive and folder location in 
the Audio storage folder field. This folder is the one set up by your Nuance 
representative on the server where RAS (Radiology Application Service) is located; 
be sure to use the exact server name and path to this folder. 

• Modify the SMTP settings only if your email configuration has changed. For 
example, the host address might be smtphost.mycompany.com.

• In the Portal URL field, enter the address of the Administrator Portal page, for 
example, http://<server>/<folder name>.

Note: After you convert to PowerScribe 360 | Reporting, the address shown in 
the illustration on the previous page will be incorrect. Your Nuance 
representative will enter the new URL here. 

• To allow users to fax (specifically, PowerScribe 360 | Reporting uses Microsoft 
Faxing) reports or orders from the Explorer page in the Portal (see Faxing an 
Order or Report, beginning on page 476.): 

 a. Select Enable Fax.

 b. Leave the Fax server field blank if the fax server is on the same computer as 
the Portal application software, as is typical. Otherwise, enter the network 
location of the fax server, for example, http://<server>/<folder name>.

 c. The fax drop folder will have been set up either on the local computer or on a 
remote system. Enter the folder’s location, for example, C:\<folder name>. 

5. Click Save and Close.
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Configuring the Web Portal
Note: The settings on the Web Portal tab are configured by your Nuance representative. 
You should not change them unless you are directed to do so.

To configure the Web Portal:

1. In the Setup group, select the System tab.

2. Click Configuration. The System Configuration dialog box opens.

3. Select the Web Portal tab.

4. Enter or select the appropriate settings for the Web Portal: 

• In the Portal Dragon user directory field, enter the location of the folder your 
Nuance representative created to store the Dragon user information. This folder 
usually resides on the Portal server. Use this format: \\<server>\<foldername>. 

• Do not change the default value in the Bridge Service name field, Nuance 
RadBridge, unless directed to do so. 

• In the Dashboard refresh rate field, select the interval at which you want the 
Dashboard tab to reload. Refer to System Logs, beginning on page 571.

Best Practice: Set this value to 30 seconds or greater. Anything less than 30 
seconds will constantly refresh and possibly not show any results.st Practice!
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• Select the desired value in the Maximum search records field. 

Best Practice: Setting this value to 500 can improve the response time of your 
database searches. Note that this value affects both the client and administrator 
Explorer window.

• Select one of the following Printable document formats: PDF, DOC, or DOCX.

• Leave the Enable extended multi select field at its default value of False. 

Caution: With the Enable extended multi select option set to False, users can 
act only on the selected items on the current page of a multi-page list. For 
example, clicking Delete removes only the selected items visible on the current 
page, not those on other pages. Setting the option to True can result in 
unintended actions on selected items that are not visible, therefore you should 
not change this setting from the default. Refer, however, to Extended Multi 
Select, beginning on page 309 for information on activating the option 
temporarily when you need to import a large number AutoText entries or other 
items. 

• Select Enable use by radiologists if you want your radiologists to be able to 
access the client using the Web Portal. Note that providers cannot use speech 
recognition to edit their reports when using the Web Portal. They can view reports 
and manually edit them using their keyboard and mouse. Consider using this 
method for sites that would like to provide system access at home for its providers 
without having to load the full PowerScribe 360 | Reporting client on the each 
provider’s home computer. Providers must be connected to the hospital’s 
PowerScribe 360 | Reporting system, either by VPN or SSL, to use this feature. 

• Select Enable use by physicians if you want physicians to be able to use the Web 
Portal. This allows the attending, consulting, referring physicians access to the 
portal to view reports once they are in a preliminary status in the system. These 
physicians can view only their own reports. VPN or SSL access is required for this 
feature to work properly.

5. Click Save and Close to save the settings. 

st Practice!
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Configuring the Bridge Service
The PowerScribe 360 | Reporting HIS Bridge service exists to share patient information 
and orders with HIS or RIS systems. The Bridge service receives inbound order and 
patient information and stores it in the PowerScribe 360 | Reporting database. As 
radiologists create reports and sign them, the Bridge service sends them out to the HIS or 
RIS systems in the proper format for the receiving systems.

To activate and use the Bridge service, your Nuance representative will need to create a 
Bridge link and specify the type of data that is to be transferred. Various options control 
the way the data is transferred. 

Configuring Bridge Logging to the Database

You can select the Enable Bridge logging to database option to activate extensive 
logging of the Bridge service to the database, including the complete HL7 message sent 
and received. It is suggested that you enable this option only while the interface is first 
being tested, and then disable it after testing is complete, to maximize database 
performance and conserve data storage space. Whether or not you enable this option, you 
can always search for and view individual Bridge events on the Bridge tab of the Logs 
group; the Log text box might appear empty when this option is disabled. For more 
information on viewing the Bridge logs, refer to Bridge Logs, beginning on page 572.

To configure the Bridge service: 

1. In the Setup group, select the System tab.

2. Select the Bridge Service tab in the System Configuration dialog box.

3. To activate LEXIMER (Lexicon Mediated Entropy Reduction), select Enable 
LEXIMER processing. You should select this option if your system uses RadCube.

4. To select the type of user who should receive mobile notifications, select one of the 
choices from the Enable mobile notifications drop-down list: For Radiologists; For 
Physicians; For Radiologists and Physicians; or select Disabled to send no mobile 
notifications.

5. To enable Bridge logging of both inbound and outbound messages, select Enable 
Bridge logging to database. Or, to disable logging, remove the check mark from this 
option. 

Note: Since this feature is resource intensive, select the Enable Bridge logging 
to database check box only during testing. Clear this check box when you move 
to your production environment.

6. In the Bridge global log folder field, enter the location where the logs are stored, for 
example, C:\<server>\<folder name>. In most cases, you do not need to change the 
default setting. 

7. The remaining settings on this tab govern the number of days the system is to store 
various event log and audio files. In most cases you do not need to change the default 
settings. 
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• Note that if you set a large value for items such as the Days to keep final report 
audio or Days to keep content audit (for example, one month or more), you must 
ensure that you have allocated sufficient disk space for storing the .dra audio files.

• If your order and report attachments are .jpg files or other large files, you should 
consider reducing the number of days to keep the attachments.
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The following table describes the events shown in the bridge service tab.

8. Click Save and Close.

Event Description

Days to keep account audit 
events

Number of days to keep individual user’s account audit trail. 
This audit trail retains events that appear in the Account > 
Audit area for each user, including Logon, Logoff, and 
Change Password events.

Days to keep account speech 
action logs

Speech action logs are located in the Logs > ACO/LMO tab.

Days to keep bridge audit 
events

Bridge audit events are located in the Logs > Bridge tab. 
Includes Inbound, Outbound, and Failed Today logs.

Days to keep bridge events 
logs

Number of days to retain bridge event logs

Days to keep final report 
audio

Best Practice: Set to no more than 7 days. 
If you want to set this value to more than 7 days, your project 
manager needs to consult with the Nuance technical liaison 
to ensure that the database can handle the extra amount of 
data.

Days to keep content audit Number of days to retain audit information

Days to keep order audit 
events For each accession number, the event log is located in 

Exams > Explorer. Days to keep report audit 
events

Days to keep order and report 
attachments

For attachments in the client, such as an image or a 
requisition.

Days to keep patient 
attachments

For attachments on patients when using order entry

Days to keep order and report 
audio notes

Only pertains to audio notes; text notes are never purged

Days to keep patient audio 
notes

Only pertains to audio notes; text notes are never purged

Days to keep exception logs Exceptions that appear in the client or in the administrator 
module. Can be used as a tool to resolve issues when working 
with Nuance technical support. 
Located in Logs > Exceptions. 

Days to keep administrative 
audit events

Number of days to keep administrative audit events

Days to keep AutoText usage Number of days to keep AutoText usage events

Days to keep DICOM SR Number of days to retain DICOM Structured Reports

Days to keep Quality Check 
results

Number of days to retain Quality Check results
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Configuring the Speech Utility Server
Note: Your Nuance representative sets the option on the Speech Utility tab. You should not 
change it unless you are directed to do so.

The Speech Utility tab defines where the Dragon users are stored on the application 
server.

To configure the speech utility:

1. In the Setup group, select the System tab.

2. Click Configuration. The System Configuration dialog box opens.

3. Select the Speech Utility tab.

4. Enter the address of the Dragon user directory in the following format: 
\\<server>\DragonUsers. Replace <server> with the name of your application server.

5. Click Save and Close to save the setting. 
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Configuring the PowerScribe 360 | Reporting Client
Note: Your Nuance representative sets the options on the PowerScribe 360 | Reporting 
Client tab. You should not change them unless you are directed to do so.

To configure the PowerScribe 360 | Reporting client application:

1. In the Setup group, select the System tab.

2. Select the PowerScribe 360 | Reporting Client tab in the System Configuration 
dialog box.

3. Configure the client settings as directed by your Nuance representative: 

• Enter the Dragon user directory location in the following format: 
\\<server>\DragonUsers. Replace <server> with the name of the application 
server.

• If your organization uses WebDAV (Web-based Distributed Authoring and 
Versioning):

– Enter the Dragon share username.

– Enter the Dragon share password that was set up in the WebDAV configuration 
in IIS. 

• The Dragon minimum compute speed and the Dragon maximum compute 
speed fields adjust the Speed vs. Accuracy slider in the PowerScribe 360 | 
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Reporting client’s Dragon options. The following information describes the impact 
the minimum and maximum settings have on performance: 

– Maximum position for Fastest Response should be close to, or just to the left 
of, what is shown in the illustration below. Moving the slider towards Fastest 
Response tells the system to work with a smaller version of the vocabulary, 
which creates a faster response time.

– Maximum position for Most Accurate should not go beyond approximately 
70% on the slider bar. Moving the slider towards Most Accurate tells the 
system to work with a larger version of the vocabulary, which can result in a 
slight delay in response time. You should not move the slider towards Most 
Accurate unless you have speech recognition issues.

Note: You cannot set the slider beyond the maximum value defined by your 
system administrator (in the Dragon maximum compute speed parameter 
located in the Administrator Portal). If your administrator has not increased the 
maximum compute speed to 70%, and you have moved the slider all the way to 
the right (towards Most Accurate), a message box opens displaying the value to 
which the maximum compute speed value has been set on the system, and 
explaining that your Speed vs. Accuracy slider has been reset to that value. 

• The IRadWhere port setting specifies the TCP/IP port on which the PowerScribe 
360 | Reporting client application listens for incoming requests for PACS desktop 
integration. This setting must match the value your Nuance representative 
configured during setup of the RadWhere Connector Components, which were 
installed at the same time as the PowerScribe 360 | Reporting client application. In 
most cases you should not change this setting.

• The Broadcast IRadWhere events setting determines whether the PACS desktop 
integration is to send all reporting events to the client connected through the 
desktop API. By default, PowerScribe 360 | Reporting does not send events to the 
same client that initiated the request. This setting is dependent on the specific PACS 
vendor’s requirements.

• Select a value for the Days to keep application logs parameter. Default is 7 days.

4. Click Save and Close to save your settings.
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Configuring Other Services
Note: Your Nuance representative sets the options on the Other Services tab. You should 
not change them unless you are directed to do so.

To configure the other services:

1. In the Setup group, select the System tab.

2. Click Configuration.

3. Select the Other Services tab in the System Configuration dialog box. (See the 
example illustrations on this page and the next page; divided the illustration in half due 
to the number of items on this tab.)
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4. Configure the Reporting Services items: 

Best Practice: If your organization purchased the reporting option, be sure to 
configure the Reporting Services items described below. The reporting module 
includes Author Productivity, Editor Productivity, and TAT types of reports.

• Enter the Reporting Services URL. 

• Enter the Reporting Services username and password that was configured by 
your Nuance representative when your system was set up.

• Enter the Reporting Services domain in the following format: http://localhost/
reportserver/ReportService2005.asmx. If the reporting services are not on the 
Portal server, replace ‘localhost’ with the name of the server on which they reside.

5. If your organization purchased the PowerScribe 360 | Critical Results option, enter or 
verify the Critical Results Service URL and the Critical Results Dashboard URL. 
(PowerScribe 360 | Critical Results is a purchasable feature. Contact your Nuance account 
executive for more information.)

st Practice!
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6. If your organization has an eRADPEER account with the ACR (American College of 
Radiology), enter the eRADPEER Service URL.

7. If your organization purchased the Assure consistency checker option, enter or verify 
the Quality Check Service URL, Quality Check License ID, and the Quality Check 
Connection Type. (Quality Check is a purchasable feature. Contact your Nuance account 
executive for more information.)

8. If your organization purchased the PowerShare Network option, enter the PowerShare 
Network information for your system. (PowerShare Network is a purchasable feature. 
Contact your Nuance account executive for more information.)

9. Set the log collector information for your organization.

10. If your organization purchased the Montage search and analytics option, enter or 
verify the Montage Patient URL, Montage Search URL, and Montage Security 
Key. (Montage is a purchasable feature. Contact your Nuance account executive for 
information.)

11. If your organization purchased the STATdx option, enter or verify the STATdx Vendor 
ID and the STATdx Group ID.

12. Click Save and Close to save your settings.
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Configuring BI-RADS Codes

You can configure the BI-RADS codes and the text of the corresponding BI-RADS 
statements that appear on mammography reports. 

Only a single BI-RADS code can be assigned to a study. If you need to use codes that 
represent follow-up recommendations, you should use custom fields for both BI-RADS 
codes and any other codes, rather than using the feature described in this section. 

To create a BI-RADS code: 

1. Select the System tab in the Setup group.

2. Click the BI-RADS link.

The BI-RADS Codes dialog box opens.
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3. Click the plus sign. A new row is added to the table. 

4. Type the code and description.

5. Click the Save icon to save your changes.

To edit a BI-RADS code: 

1. In the Setup group, select the System tab. 

2. Click BI-RADS.... The BI-RADS Codes dialog box opens. 

3. Click the Edit icon next to the code you want to modify. The code and description are 
opened for editing. 

4. Type your changes to the code, description, or both. 

5. Click the Save icon to save your changes. 

To delete a BI-RADS code: 

1. In the Setup group, select the System tab. 

2. Click BI-RADS.... The BI-RADS Codes dialog box opens. 

3. Click the Delete icon next to the code you want to delete. A confirmation message 
appears. 

4. Click OK to delete the item. 
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 Auditing System Events

Administrators can now audit several types of events at both the system and site levels. 

• To view the audit log at the system level, click Setup > System > Audit.

Filter your audit event list by: 

• Site: Select one or all sites (the Site-level audit list shows only the current site) 

Note: To view Change preference and Change worklist events, select System/Global, 
located at the bottom of the Site drop-down list.

• Account: Select an administrator account or select all administrators

• Type: Select a specific type of event or select all events:

– Create/Delete/Update Entity: Shows create, delete, and update events for entities 
such as systems and sites



Chapter 3: Configuring the System
– Change preference: Shows changes in system- or site-level preferences performed 
by the selected administrators

– Change configuration: Shows changes made to any of the tabs in the Setup > 
System > Configuration window

– Change bridge option: Shows changes made in the Setup > Bridge tab

– Change worklist: Shows changes made to any worklists in the system (Setup > 
System > Worklists)

– Import procedures/persons/auto text/custom fields: Shows any activity 
involving the import procedures within the system.

• Time Frame: Select a time from the drop-down list, or click Custom and create your 
own filter

In addition, several new account-level items have been added to the existing account audit 
log (to view an account-level audit log, click Setup > Accounts, select the account you 
want to view, and click the Audit link): 

• Change Username

• Change Personal Info

• Change Admin Rights

• Change Sections

• Change Supervisor

• Change Specialties
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Chapter 4

Setting Preferences

Objectives
In this chapter, you will:

• Review the preference hierarchy

• Set default preferences for the system, sites, and 
accounts
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Introduction to System, Site, and 
Account Preferences

This chapter provides instructions for configuring preferences for the system, for sites, and for 
accounts. 

About System, Site, and Account Preferences
Preferences have a hierarchical relationship: 

• System preferences are defaults for the entire system.

• A site preferences can override the system default, affecting only reports for that site.

• A user account preference can override the system preference for a particular user.

• When you change a preference at the system level, any user accounts you add after the 
change have the new preference as the default. 

When viewing the System preferences (Setup > System > Preferences link), the bottom 
of each tab displays a reminder that System-, Site-, and Account-level preferences have 
color coded bullets to distinguish the category for each. There are also reminders about 
default values and how they are indicated. (See the example illustration below.)

Caution: If the user is logged in to PowerScribe 360 | Reporting, the changes you make in 
the Administrator Portal to his or her preferences do not take effect immediately. (You see 
a message indicating this.) The user must exit the application (using File > Exit) and log 
in again to have the new preferences reloaded, and must restart PowerScribe 360 | 
Reporting to have the new system and site preferences reloaded. If you change a system 
preference and you want the change to be reflected immediately in one or more user 
accounts, you must modify the preference in each user account (or the user must modify 
her own preference in the client application).
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Configuring the Preferences

Note: For any user accounts that require different settings, follow the procedures in 
Configuring Account Preferences, beginning on page 138. 

To configure the preferences: 

1. To set preferences for the system:

 a. Select the System tab in the Setup group.

 b. Click Preferences. The System Preferences dialog box opens. 

OR

To set preferences for a single site: 

 a. Select the Sites tab in the Setup group.

 b. Select the site you want to configure from the drop-down list. 

 c. Click Preferences. The Site Preferences dialog box opens. 

2. Use each of the tabs to set the preferences for the system or site. The colored bullet to 
the left of each preference indicates the lowest level at which it can be configured: 
system (blue), site (red), or account (green).

Tip: To set all the values on a tab to ‘true’, click Check All. Likewise, select 
Uncheck All to set all the values on the currently selected tab to ‘false.’ Click 
Restore Defaults to set all values to their original defaults.

• Workflow Preferences, beginning on page 47

• Permissions Preferences, beginning on page 58

• Peer Review Preferences, beginning on page 63

• Report Editing Preferences, beginning on page 65

• Dictation Preferences, beginning on page 71
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• AutoCorrect Preferences, beginning on page 76

• Devices Preferences, beginning on page 77

• Explorer Screen Preferences, beginning on page 85

• Security Preferences, beginning on page 90

• Scheduling ACO and LMO, beginning on page 93

3. When you have finished setting preferences, click Save and Close to save your 
changes. 
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Workflow Preferences
Note: Due to its size, the Workflow preferences tab image is divided into two halves. The 
second half appears on the next page of this guide.
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Chapter 4: Setting Preferences
Workflow Preferences: Click Setup > System > Preferences > Workflow tab

Type System Preference Definition Default

Site Diagnosis coding system Select ICD-10; ICD-9; or Disabled. Disabled

Site
Diagnosis coding at 
preliminary signoff

Controls whether PowerScribe 360 | Reporting 
requires diagnosis (ICD-9) coding when a 
resident approves a report. Note that this 
preference does not apply when an attending 
saves a report as preliminary. 

• Do not perform: Diagnosis coding is not 
invoked at preliminary signoff. 

• Do not require codes: Diagnosis coding is 
invoked, if not already set for all the 
accessions of the report, but the user is 
allowed to cancel without assigning codes. 

• Require codes: The report cannot be 
approved unless at least one code is entered 
for each order in the report. 

Note: This setting may override the 
behavior of the Diagnosis coding at 
final signoff preference as noted below.

Do not perform
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Site
Diagnosis coding at final 
signoff

Controls whether PowerScribe 360 | Reporting 
requires diagnosis (ICD-10 or ICD-9) coding 
when the Attending provider signs a final 
report. 

Note: Note, this setting is ignored if the 
Diagnosis coding at preliminary 
signoff preference is set to Require 
codes and at least one code is not 
entered for each order in the report. 
That is, if coding is required at 
preliminary signoff, but the report was 
not approved by a resident, coding will 
be required at final signoff regardless of 
the setting of this preference.

• Do not perform: Diagnosis coding is not 
invoked at final signoff. 

• Do not require codes: Diagnosis coding is 
invoked, if not already set for all the 
accessions of the report, but the user is 
allowed to cancel without assigning codes. 

• Require codes: The user cannot sign the 
report without entering one or more codes 
for each order in the report. 

Note: If codes were entered by the 
Resident, this setting will cause 
diagnosis coding to be invoked so that 
the Attending can review the codes 
entered by the Resident.

Do not perform

Site
Require BI-RADS for 
mammography exams

If selected, requires that a BI-RADS code be 
entered in mammography exams.

False

Account
Perform spell check at 
signoff

Automatically spell checks a report when the 
user signs or approves it. If the system finds 
errors, it prompts the user to correct them.

True

Workflow Preferences: Click Setup > System > Preferences > Workflow tab

Type System Preference Definition Default
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Account

Perform Quality Check at 
signoff

Note: Quality 
Check (formerly 
known as Assure) is 
a purchasable 
option. Please 
contact your 
Nuance account 
representative for 
more information.

Runs the Quality Check consistency check 
feature when a report is signed.

False

Account Invoke FAX at signoff

Automatically opens the Fax dialog box when 
a user signs or approves a report. Allows user 
to select the person(s) to whom the report is 
faxed.

False

Site Final electronic signature

The character string that is automatically 
appended to a final report when an attending 
physician signs it. The string might include 
merge fields, for example, “Finalized by <627: 
Signer name>.” You can make the string span 
multiple lines by using \n to indicate a new 
line.
The preliminary electronic signature, attending 
attestation statement, and final electronic 
signature all appear on final reports that were 
initiated by residents. 

Blank initially

Site
Preliminary electronic 
signature

The character string that is automatically 
appended to a preliminary report when a 
resident approves it. The string might include 
merge fields, for example,
“Approved by <640: Dictator Name> on 
<608: Report Preliminary Date>”. You can 
make the string span multiple lines by using \n 
to indicate a new line.
The preliminary electronic signature, attending 
attestation statement, and final electronic 
signature all appear on final reports that were 
initiated by residents. 

Blank initially

Workflow Preferences: Click Setup > System > Preferences > Workflow tab

Type System Preference Definition Default
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Site
Corrected electronic 
signature

The character string that is automatically 
appended to a dictated report when an editor 
corrects it. The string might include merge 
fields, for example, “Corrected by <672: Editor 
name> on <609: Report Corrected Date>. You 
can make the string span multiple lines by 
using \n to indicate a new line. 

Blank initially

Site
Attending attestation 
statement

The statement that is automatically added to a 
resident’s report when an attending physician 
signs it. It is added before the final electronic 
signature, if one is specified. The statement can 
include merge fields, for example, “I, <Signer 
Name>, have reviewed the images and report 
and concur with these findings.”
The preliminary electronic signature, attending 
attestation statement, and final electronic 
signature all appear on final reports that were 
initiated by residents. 

Blank initially

Site Wet read report header
Type the header text you want to appear on wet 
read reports in this field. 

Blank initially

Site Report header
Type the header text you want to appear on 
your reports in this field.

Blank initially

Site Addendum header
Type the header text you want to appear on 
your addendums in this field.

Blank initially

Site
Critical communication 
sent statement

The statement that is automatically added to a 
report when a critical finding is communicated 
through PowerScribe 360 | Critical Results. 
The recipient and date/time of the message are 
automatically appended to this statement. 

 A <FindingType> 
message has been 
communicated to 
<RecipientName> 
via the PowerScribe
360 | Critical 
Results system on 
<102:Current 
Date>, Message ID
<MessageID>. 

Workflow Preferences: Click Setup > System > Preferences > Workflow tab

Type System Preference Definition Default
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Site
Critical communication 
document only statement

The statement that is automatically added to a 
report when a document only message is sent.

A <FindingType> 
message has been 
documented for 
<RecipientName> 
in the PowerScribe 
360 | Critical 
Results system on 
<102:Current 
Date>, Message ID
<MessageID>.

Site
Require audio for 
document only message

If selected, this check box requires the user to 
include an audio statement even though the 
PowerScribe 360 | Critical Results message is 
marked as document only.

False

Site
Site AutoText overrides 
user default/normal

If you select this option, the system always uses 
the site AutoText as the default or normal, even 
if the user has a matching AutoText entry, that 
is, one whose procedures and properties (such 
as age and gender) match those of the exam. 
Otherwise, it uses the user’s AutoText.

False

Site
DICOM merge multiple 
values

Controls the behavior of DICOM merge fields 
when multiple DICOM SRs are available for an 
order and contain the same measurement.
When set to True (check box selected), all of 
the values from the multiple DICOM SR are 
merged into a comma separated list. The values 
are in order based on the DICOM study/series/
instance where the most recent instance is first.
When set to False (check box cleared), only the 
value from the most recent DICOM SR 
instance is merged.

False

Site
Merge field timestamp 
source

Choices are Local time or Server time. Server time

Site Merge field time format

Expands the Merge field timestamp source 
preference. 
Choose either System locale; System locale 
with time zone; 24-hour clock; or 24-hour 
clock with time zone.

System locale

Workflow Preferences: Click Setup > System > Preferences > Workflow tab

Type System Preference Definition Default
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Account Enable Wet Reads 

Select an option: 
Allowed: Radiologist can create a report either 
as a wet read or a draft. Provider can send these 
reports to an editor (if they are assigned the 
Allow correctionist workflow permission).
Always: All reports are automatically wet reads 
(as opposed to drafts). Provider cannot send 
these reports to an editor.
Disabled: Provider cannot create reports as wet 
reads. 

Disabled

Site
Enable Save Draft and 
Send as Preliminary

For Residents Only: Turn on/off the Save 
Draft and Send as Preliminary function.

False

Account Add note on reject

When the radiologist rejects a corrected/
transcribed report, the Insert Note dialog box 
automatically opens, allowing her to create a 
note for the transcriptionist. This preference 
also applies when an attending physician 
rejects a report approved by a resident.

True

Site
Automatically set rejected 
reports to STAT

When a user rejects a report, its priority is 
changed to STAT.

True

Account Prompt on GUI sign

Clearing this check box allows the normally 
displayed prompt to be bypassed when signing 
a report. 
If this check box is selected, when a radiologist 
signs a report, he is prompted to confirm his 
signature. (Selecting this check box also causes 
a prompt to appear when residents click 
Approve and when transcriptionists click 
Finish.)
Note that this preference affects signing from 
both the Explorer and Report Editor screen.

True

Site Prompt on approval
Text that appears when approving a report. You 
can change the text for each site.

Approve Report: I 
have personally 
reviewed the 
images and I agree 
with this <report>.

Site
Prompt on final signoff 
for attending reports

Text that appears when an attending provider 
signs their own report. You can change the text 
for each site.

Sign Report: I have
personally reviewed
the images and 
agree with this 
<report>.

Workflow Preferences: Click Setup > System > Preferences > Workflow tab

Type System Preference Definition Default
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Site
Prompt on final signoff 
for resident reports

Text that appears when an attending provider 
signs a report created by a resident. You can 
change the text for each site.

Sign Report: I have
personally reviewed
the images and 
agree with the 
resident's 
interpretation.

Account
Warn if fields are empty 
when signing

 The radiologist or resident is warned when 
signing or approving a report if the report 
contains empty fill-in or merge fields.

True

Account
Warn on sign if new notes 
exist

Controls whether the user is alerted during the 
signing process if new notes have been added 
since the last time he opened the report. 

• Never: New notes do not trigger a warning.
• From Transcription: Notes are shown 

only when added by the transcriptionist.
• Always: Any new notes trigger a warning, 

including those from other radiologists, or 
notes the system automatically adds on 
certain actions, such as when an order is 
assigned to a radiologist.

Never

Site
Require impression when 
signing

The system can warn radiologists if they sign or 
approve a report without including an 
Impression section. This preference works in 
conjunction with the Impression section 
indicator preference.

• Not required: No warning
• Warn if not present: Warn, but allow the 

report to be signed/approved anyway
• Require impression: Do not allow the 

report to be signed or approved without an 
impression.

Not required

Site
Require impression for 
addendum

If selected, radiologists will be warned that the 
addendum must include an Impression section.

False

Workflow Preferences: Click Setup > System > Preferences > Workflow tab

Type System Preference Definition Default
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Site
Impression section 
indicator

The regular expression that is to mark the 
impression area in the report. The system 
searches the report text for this expression and 
treats the text immediately following it as the 
impression. 
Examples: 
Impression\s*: 
Conclusion\s*:

Note: Make sure that this field is not 
blank. The best practice is to use the 
default, Impression\s*.

Impression\s*

Site
Maximum number of 
associated orders

The number of orders that can be associated 
with a report. Select Unlimited or a number 
between one and ten. If your system allows 
only one accession number per report, select 1 
here. 

Unlimited

System
Reporting via automation 
only

You can select this preference only where 
PowerScribe 360 | Reporting is driven by 
another application such as PACS. If you select 
this option, users cannot create new reports or 
perform order associations/dissociations using 
the user interface; these functions can only be 
accessed and performed by another application 
through automation. In this mode, users can 
open and addend only the reports they own. 

False

Site
Add contributor on report 
assignment

When a report already containing some text is 
acquired by or assigned to another radiologist, 
the original radiologist is automatically added 
as a contributor to the report.

False

Site
Restrict attending 
selection by section

If you enable this preference, when a resident 
to whom you have not directly associated an 
attending provider logs in, the list from which 
to choose an attending provider contains only 
those who belong to the same section(s).

True

System Enable notes
Users are allowed to create notes for orders, 
reports, and patients.

True

Site Enable Montage

Select this preference to enable the Montage 
search feature. (This is a purchasable feature. 
Contact Nuance sales for additional 
information.)

True

Workflow Preferences: Click Setup > System > Preferences > Workflow tab

Type System Preference Definition Default
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Site
Final report transmit 
grace period 

The number of minutes the Bridge software is 
to wait before sending the final report to the 
RIS. (Preliminary reports are sent 
immediately.) This delay allows the attending 
physician time to re-open and correct the 
report, if necessary. Once the final report is sent 
to the RIS, it can no longer be edited; any 
changes must be made through an addendum. 
The interface server must be restarted for this 
setting to take effect. 

2 minutes

Site
Final report edit grace 
period 

The number of minutes or hours after which a 
final report can no longer be edited; after this 
period, any changes to the report must be made 
with an addendum.The interface server must be 
restarted for this setting to take effect. 

3 minutes

Site Daily RVU quota
The number of work Relative Value Units 
(RVU) required of radiologists each day

Zero (0)

Site
Use Attest workflow in 
mobile application

Allows the Sign button to change to Attest and 
Sign in the mobile application.

False

Workflow Preferences: Click Setup > System > Preferences > Workflow tab

Type System Preference Definition Default
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Permissions Preferences

Permissions Preferences: Click Setup > System > Preferences > Permissions tab

Type System Preference Definition Default

Site
Allow attendings to 
acquire ownership

Attending physicians can transfer ownership of 
reports dictated by others to themselves.

True

Site
Allow residents to acquire 
ownership

Residents can transfer ownership of reports 
dictated by others to themselves.

True
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Site
Allow editors to acquire 
ownership

Transcriptionist/editors can transfer ownership 
of reports corrected by others to themselves.

False

Site
Allow dictation for 
scheduled orders

Reports can be created for orders in Scheduled 
status. If you do not select this preference, an 
order must be in Completed or Temporary 
status for a report to be created. 

True

Account
Allow report creation for 
non-radiologists

Determines what types of reports, if any, users 
other than radiologists can create. Choices are: 
Reports and addendums; Reports only; 
Addendums only; or Not allowed. (Replaces 
the Allow report creation check box 
preference in previous versions.)

Reports and 
addendums

Account Allow order association

Controls whether the provider has the right to 
add unreported orders to existing reports, or to 
dissociate an order from a multi-accession 
report. This function is available only if your 
RIS/HIS permits multiple accessions per order. 

True

Account
Allow correctionist 
workflow

Select this option to activate the Correct 
function for radiologists. 

True

Site
Allow order association 
on preliminary reports

User can add or remove orders to/from reports 
that have already reached preliminary status 
(Pending Signature) and have been sent to the 
RIS. (With some RIS, adding orders to a 
preliminary report results in an error.) 

True

Site
Allow signing reports 
with temporary order

Attending physicians can sign and finalize 
reports associated with one or more temporary 
orders. (With some RIS, signing a temporary 
order results in an error because the report date 
precedes the order date.) 

True

Site
Allow attending signoff 
on resident login

The attending radiologist can enter her 
password and finalize reports while the resident 
is logged in without interrupting the resident’s 
session. This is accomplished by holding down 
the Shift key and selecting Approve; the 
system displays a confirmation prompt. 

True

Site Allow order assignment

If selected, the My Reports pane in the 
Explorer screen contains a link to retrieve 
orders assigned to the logged-in user. 
Selecting this option also enables the Assign 
Order function, which allows one radiologist to 
assign an order to another radiologist. 

True

Permissions Preferences: Click Setup > System > Preferences > Permissions tab

Type System Preference Definition Default
59



60

PowerScribe® 360 | Reporting System Administrator Guide
Site
Allow to override 
assigned orders

If you select this preference, a radiologist can 
create a report for an order that has been 
assigned to another radiologist, or associate 
such an order to an existing report. In this case 
the system displays a confirmation prompt 
informing the user of the current assignment. 
The system ignores this preference unless you 
also select the Allow order assignment 
preference.

True

Site
Allow correction after 
keyboard edit

If you do not select this preference, the user 
cannot send a dictated report to correction 
when manual edits have been made to the 
dictated text. This prevents editors from 
receiving reports that might have missing 
audio, therefore, it is recommended that you 
select this preference.

False

Site Allow Quality Check

Allows users to run the Quality Check 
consistency checker. (Quality Check is a 
purchasable feature. Contact your Nuance 
account executive for more information.)

True

Site Allow image insertion

When selected, allows radiologists to insert 
images into their reports. 
When not selected, radiologists can still use the 
Capture Image tool; however, the image 
appears in the Attachments pane, and the image 
name appears as a link at the bottom of the 
report.
Clear (uncheck) this check box when a site’s 
outbound HL7 interface does not support Rich 
Text Format (RTF). 

False

Permissions Preferences: Click Setup > System > Preferences > Permissions tab

Type System Preference Definition Default
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Site Allow table authoring

Enables/disables table creation for reports on a 
site. Clear (uncheck) this check box when a 
site’s outbound HL7 interface does not support 
Rich Text Format (RTF). When cleared, the 
user will not have access to the toolbar, menu, 
context menu, or voice commands for adding 
and manipulating tables. Default is False 
(unchecked).

Note: Table authoring will be available 
in the AutoText editor screen when this 
preference is selected for any of the 
user's accessible sites.

Note: This preference cannot prevent the 
user from adding tables via copy/paste, 
or by inserting an AutoText that contains 
tables.

True

Site
Allow physicians to 
access preliminary reports

Allows physicians to access their preliminary 
reports

False

Account Enable mobile access
Allows users to sign reports and use Assisted 
Diagnosis from their mobile devices

True

Site Enable mobile reporting
Allows users to perform speech-enabled report 
editing

True

Permissions Preferences: Click Setup > System > Preferences > Permissions tab

Type System Preference Definition Default
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Order Entry Preferences

Order Entry Preferences: Click Setup > System > Preferences > Order Entry tab

Type System Preference Definition Default

Site
Order entry generate 
Accession

Select to allow the order entry system to 
automatically generate accession numbers.

False

Site
Order entry Accession 
prefix

Enter a prefix that will appear before each of 
your accession numbers.

Blank

Site
Order entry Accession 
counter

Enter the starting value for your accession 
numbers.

Blank

Site
Order entry generate 
MRN

Select to allow the order entry system to 
automatically generate MRNs. 

False

Site Order entry MRN prefix
Enter a prefix that will appear before each of 
your MRNs.

Blank

Site Order entry MRN counter Enter the starting value for your MRNs. Blank

Site
Printable order entry 
confirmation

Select if you want to allow printing order entry 
confirmation messages.

False
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Peer Review Preferences
Note: Peer review is an optional feature. If your organization has not purchased this 
feature, you do not need to configure these preferences.

Peer Review Preferences: Click Setup > System > Preferences > Peer Review tab

Type System Preference Definition Default

Account
Enable automated peer 
review

Select an option:
Disabled: The radiologist is not included in the 
peer review process.
Allow to cancel: The radiologist can cancel an 
automatic peer review if he does not want to 
complete it.
Required: The radiologist must complete the 
peer review before being allowed to create a 
new report.

Disabled

Account
Enable manual peer 
review

Select to allow manually generated peer 
reviews. If not selected, only system-prompted 
peer reviews are allowed, and the peer review 
button in the client application is hidden.

False

Account
Maximum number of 
automated peer reviews 
per day

Select a specific number from the drop-down 
list, or select Unlimited. Unlimited
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Account
Launch peer review on 
report close

Select to allow radiologists to finish dictating 
their current report before performing an 
automatically initiated peer review. If not 
selected, radiologists must perform the peer 
review when the new report is first opened.

False

Site
Exclude inactive accounts 
from auto peer review

Select to exclude reports created by radiologists 
no longer at the facility from the peer review 
process.

False

Site
Require comment for all 
peer review

Select to require providers to include a 
comment for peer review ratings 1 and 2. (Peer 
review ratings 3 and 4 still automatically 
require comments.)

False

Site
Maximum age for peer 
reviewed report

Indicate at what point an exam becomes 
ineligible for peer review. For example, you 
might not want peer review to be performed on 
exams over two years old.

Note: You can override this setting for 
individual sites. 

2 years

Site
Count reports for auto 
peer review interval

Allows you to determine whose user account 
will be incremented when a peer review is 
performed; especially useful when resident 
workflow is predominately used by an 
Attending. The default behavior is to increment 
the resident's user account (i.e., the Author of 
the report) even though the Attending signs the 
report. The Author and Signer option will 
increment both the resident's account and the 
Attending's account. Signer only will increment 
the Attending's account.
Choose either Author, Author and Signer, or 
Signer only.

Author 

Site
Priors anatomy matching 
for peer review

Choose one of the following: 
Broad matching, Exact matching, or Include 
All. 

Broad matching

Site
Priors modality matching 
for peer review

Choose either Broad matching or Exact 
matching.

Broad matching

Peer Review Preferences: Click Setup > System > Preferences > Peer Review tab

Type System Preference Definition Default
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Report Editing Preferences
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Report Editing Preferences: Click Setup > System > Preferences > Report Editing tab

Type System Preference Definition Default

Account Default font face
Specifies the typeface to use when viewing and 
editing reports. 

Arial

Account Default font size
Specifies the font size to use when viewing and 
editing reports.

12

Account
Start with default 
AutoText

If you select this option, and an AutoText entry 
has been designated as the default for a 
particular type of exam, the AutoText is 
automatically inserted when a provider creates 
a new report for an exam of that type.

True

Account
Move cursor on AutoText 
insert

This specifies where the cursor is placed after 
the user inserts AutoText.
Select an option: 

• End of AutoText: Cursor moves to the 
right of the AutoText

• First empty field: Cursor moves to the first 
empty field in the document.

• First field: Cursor moves to the first field 
in the document.

First field

Account
Automatic AutoText 
categorization

Allows automatic inclusion of procedures to an 
AutoText that is inserted into a report. The 
choices for this preference are:

• Always: Procedures for the orders 
associated with the report are automatically 
added to any/all AutoText inserted into the 
report.

• Prompt: User is prompted to accept the 
automatic categorization.

• Disabled: No automatic categorization 
occurs.

Disabled

Account Fill-in field navigation

Select the status of fields to which your Tab 
button/key navigates. This allows you to skip 
fill-in fields that already have content. Choices 
are All; Empty; None; or Unmodified 
(meaning it still contains its default value). 

All

Account Merge field navigation

Select the status of fields to which your Tab 
button/key navigates. This allows you to skip 
merge fields that already have content. Choices 
are All; Empty; None; or Unmodified 
(meaning it still contains its default value).

All
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Account
Cursor position on field 
selection

Select where to position the cursor in a field 
that you select or move to. Choices are Text is 
selected; Cursor at the end; or Cursor at the 
beginning. 

Text is selected

Account
Monitor order data 
changes during reporting

Notifies users if the order data has changed 
while they are dictating a report. Choices are:

• Notify and apply changes
• Apply changes without notification
• Disabled

Notify and apply 
changes

Account
Show image captions in 
report

When selected, captions appear under any 
images you insert into your reports.

True

Account Image size on insertion
Default width of your inserted images. Choose 
either Small (1.4 inches), Medium (2.0 
inches), or Large (3.1 inches). 

Medium

Account
Warn if open orders when 
signing 

Controls whether the system warns radiologists 
signing (or residents approving) a report when 
there are unreported orders for the patient that 
are not filtered by the Open orders property 
match and Open orders maximum age 
preferences. The radiologist or resident might 
want to add one or more of the open orders to 
the report before signing or approving it.
Note that the warning applies only to the Open 
Orders that are displayed when the report is 
first opened.

True

Account
Open orders property 
match

Show (in the Report Editor Order Data tab) 
only orders that match the selected properties 
of the order(s) in the current report. Choices 
include Modality, Location, Section, and 
others.

None

Account
Open orders maximum 
age

Do not display (in the Report Editor Order Data 
tab) orders older than this value. Select a 
number of hours or days from the drop-down 
list.
(Relative to the age of the order for the current 
report, or the oldest order if there are multiple 
orders in the current report.)

10 days

Account
Enable Quality Check 
types

Allows you to include some, all, or none of the 
three available consistency checks (Critical 
Text Results; Gender Mismatches; and 
Laterality Mismatches)

All

Report Editing Preferences: Click Setup > System > Preferences > Report Editing tab

Type System Preference Definition Default
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Account

PowerShare image viewer

Note: PowerShare is a 
purchasable option. 
Please contact your 
Nuance account 
representative for more 
information.

Select either Basic or Advanced for the type of 
viewer to use when using PowerShare (which 
is an optional feature).

Note: The PowerShare Advanced Viewer 
requires Java 6 update 32 or higher in 
order to run. If providers have 
applications running on their 
workstations that require an older 
version of Java, there is a potential for 
existing installed applications to operate 
improperly or to stop functioning 
altogether.

Basic

Account Show brackets on fields
Place square brackets around all fill-in fields. 
This feature does not cause actual bracket 
characters to be inserted in the text. 

True

Account Enable talking fields

If you select this option, the software 
announces the name of the active field through 
the PowerMic II or SpeechMike, if one of these 
is the default sound device selected in 
Windows. The name is spoken when a user 
takes any of the following actions: 

• Moves the cursor into a field
• Selects a field in the field pane
• Navigates into the field using the 

microphone buttons or Tab key
This helps the user know which field to dictate 
without having to glance at the report. For 
example, the user might be dictating in a PACS 
window with the PowerScribe 360 | Reporting 
window minimized. 

Note: Talking Fields requires that 
Dragon Text-To-Speech (TTS) be 
installed on the user’s workstation. Note 
that field names are not spoken while the 
dictation mode is active.

True

Account
Highlight text on 
playback

Each section of the report text is highlighted as 
it is played back.

True

Report Editing Preferences: Click Setup > System > Preferences > Report Editing tab

Type System Preference Definition Default
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Account
Add unmatched findings 
to report

Applies to Findings Only dictation mode in the 
PowerScribe 360 | Reporting client application. 
When the user clicks Apply Findings, the 
software creates a new item in the field pane for 
each unmatched finding. The fields are named 
*Unmatched1, *Unmatched2, and so on. If you 
do not select this option, any unmatched 
findings remain in the Findings Only window.

False

Account
Restrict diagnosis codes 
by exam type

The list of ICD-9 codes is restricted to those 
that are appropriate for the exam. 

Note: This behavior is controlled through 
a check box in the Diagnosis Coding 
dialog box.

False

Account
Automatically load PACS 
studies

If you select this option and a ‘master’ PACS 
integration is configured, as soon as a report is 
opened in PowerScribe 360 | Reporting, the 
corresponding study is automatically opened in 
the PACS selected for the site.

False

Account
Focus application on 
PACS launch

If you select this option and a ‘slave’ PACS 
integration is configured, PowerScribe 360 | 
Reporting is brought to the front of all 
applications and activated when a dictation 
request is received from the PACS. 

Note: This function does not work with 
all PACS systems.

True

Account
Discard unedited new 
report on PACS close

Allows the radiologist to delete a report that 
contains an AutoText template without being 
prompted, minimizing their interruptions. 
Permitted only if the radiologist did not create 
any content (audio or text) for the report. 

Note: Reports created manually will still 
prompt you before allowing deletion.

True

Account
Set application window 
always on top

This preference keeps the PowerScribe 360 | 
Reporting application the top application in an 
environment with multiple applications 
present, and prevents you from having to 
switch between applications during the session. 
The preference is remembered per-user, 
regardless of workstation they are using. Note 
that this preference is applied only after login. 

False

Report Editing Preferences: Click Setup > System > Preferences > Report Editing tab

Type System Preference Definition Default
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Account
Enable background report 
saving

If you select this option, the user, on closing a 
report, is taken immediately back to the 
Explorer screen (or to next report, in AutoFeed 
mode) while the report is being saved to the 
database. You can de-select this option for 
users who want to see the save operation 
completed before beginning new work. 

True

Account Enable AutoFeed polling
Determines whether the system automatically 
looks for new reports when the AutoFeed 
queue is empty.

False

Account

Enable clinical guidance 
alerts

Note: Clinical Guidance 
is a purchasable option. 
Please contact your 
Nuance account 
representative for more 
information.

Select this check box to alert the user that there 
is a clinical guideline that covers the finding(s) 
that he or she documented in their report. This 
gives the user the opportunity to review the 
guideline and use it for recommendations. The 
alert appears once the provider dictates a 
relevant phrase.

False

Report Editing Preferences: Click Setup > System > Preferences > Report Editing tab

Type System Preference Definition Default
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Dictation Preferences
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Dictation Preferences: Click Setup > System > Preferences > Dictation tab

Type System Preference Definition Default

Account Speech recognition mode

Controls how speech recognition is performed. 
• Text streaming: Automatically displays 

the dictated text as the provider dictates. 
• Press to transcribe: Requires the provider 

to press a button on the microphone. Note: 
In this mode, the Enable Microphone 
Toggle preference has no effect; commands 
to toggle the microphone are ignored. 

• Disabled, which means speech recognition 
is not loaded. The user, therefore, cannot 
record or play back audio. This setting is 
typically used for technologists.

Text streaming

Account
Cursor position on 
transcribe

Controls the position of the cursor after the 
provider presses the Transcribe button on the 
microphone.

• Cursor at the end: The cursor appears at 
the end of the transcribed text.

• Cursor at the beginning: The cursor 
appears at the beginning of the transcribed 
text.

• Text is selected: The transcribed text is 
highlighted.

Cursor at the end

Account
Select utterances shorter 
than

When the provider dictates audio shorter than 
the number of seconds you indicate here (for 
example, when she dictates short words, or the 
values in fill-in fields), the dictated content is 
automatically selected when she issues the 
“transcribe” command. She can then quickly 
edit the dictated content or move on to the next 
field.

Note: This preference is available only 
when you have selected either Cursor at 
the beginning or Cursor at the end as 
the Cursor position on transcribe 
preference.

0

Account
Beep on dictation start/
stop

An audible tone sounds when the provider 
starts and stops dictation. Select No beep, On 
start, or On start and stop. 

Note: Beep on stop is available only in 
Text Streaming mode; it is always 
suppressed in Press to Transcribe mode.

On start
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Account
Beep on command 
recognized

An audible tone sounds when the software 
recognizes a voice command.

True

Account
Use PC speaker for sound 
alerts

Uses the computer’s built-in speaker for beeps 
in the above two preferences.

True

Account
Turn off dictation when 
changing modes

If you select this option, dictation is 
automatically toggled off when the user 
switches screens, such as when moving from 
the Explorer screen to the Report screen, or 
when opening or closing dialog boxes that 
accept dictation input.

False

Account
Prompt to save speech 
files

Controls saving modified speech files when a 
user logs out of the application. 

• Prompt: The software prompts the user to 
save the speech files or not save them. 

• Always save: The software saves the 
speech files without prompting. 

• Never save: The software does not save the 
speech files. Learning does not continue 
and new words added are not saved; the 
user must actively save any new words.

A user who has worked with the system for 
awhile and is satisfied with speech recognition 
accuracy might want to change this option to 
Never save.

Always save

Account AutoText voice command

The word or phrase you specify here is used as 
the voice command for inserting AutoText into 
a report. (The word Macro might be preferable 
for users accustomed to older speech-reporting 
applications.)

AutoText

Account
Voice enable all default 
AutoText

Select to allow insertion of AutoText marked as 
Default into Report Editor using voice 
commands, regardless of relevance. 

False

Account
Enable microphone 
toggle

If you select this option and the start/stop 
button has been configured to turn the 
microphone on and off, the provider can press 
the start/stop button once to turn the 
microphone on, use voice commands to start 
and stop recording, and then press the start/stop 
button to turn the microphone off. In Press to 
Transcribe recognition mode, this preference 
has no effect.

False

Dictation Preferences: Click Setup > System > Preferences > Dictation tab

Type System Preference Definition Default
73



74

PowerScribe® 360 | Reporting System Administrator Guide
Account Microphone off idle time
The time the microphone is allowed to be idle 
before the system automatically turns it off.

3 minutes

Account Save audio with report

Set to True if a radiologist wants to save the 
report as a draft, re-open it later and be able to 
play the audio. 
In addition, set to True when a transcriptionist 
finishes a report with a note requesting 
clarification from the radiologist and the 
radiologist wants to listen to the report audio. 

False

Site
Accession number 
grammar rule

This preference allows fine-tuning of the 
speech-recognition rule used to identify 
accession numbers, for optimal accuracy. For 
example, an accession number might include 
digits only, or digits plus hyphens and slashes.

• Digit
• Digit hyphen slash
• Alphanumeric
• Alphanumeric hyphen slash
• Alphanumeric hyphen slash period

Digit

Account
Allow Dragon Formatting 
dialog

The user can access the Dragon Formatting 
tab, and modify the formatting settings for the 
application.

True

Account
Allow Dragon Options 
dialog

The user can access the Dragon Options tab, 
allowing him to modify the options settings for 
the application.

True

Account
Enable Dragon save 
correction to archive

Select this option if you want the speech 
recognition engine to collect correction data in 
the acoustic archive. 

True

Account
Enable Dragon data 
collection

The software selects data for troubleshooting 
purposes; if recognition is unsatisfactory, a 
Nuance representative can use a log file to 
analyze the problem.

True

Account
Enable Dragon collect 
data for research

Select this option if you want the speech 
recognition engine to collect correction data for 
research purposes.

False

Account
Enable Dragon insert 
rejections into documents

Select this option to insert the audio from 
rejected segments (dictation in which Dragon 
cannot understand what the user says) without 
any corresponding text. 

False

Dictation Preferences: Click Setup > System > Preferences > Dictation tab

Type System Preference Definition Default
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Account
Enable Dragon greedy 
replacement

If selected, replaces an entire word that has 
been only partially selected. For example, if a 
provider highlights only the letters im in 
superimposed infection, and then dictates 
“mild”, the resulting text would show mild 
infection.

True

Account Microphone off delay

With this option enabled, the microphone does 
not turn off immediately when the provider 
presses the off switch. This delay prevents 
dictation from being lost when a provider 
presses the switch while still speaking. 

Disabled

Account
Short utterance retry 
delay

Fine tunes the handling of dictation in Press to 
Transcribe mode to help ensure that short 
utterances are not lost. 

Note: Adjust this parameter only in 
rare scenarios when a user is 
experiencing unique speech-related 
issues, and only when directed by 
Nuance support.

250 msec 
(milliseconds)

Dictation Preferences: Click Setup > System > Preferences > Dictation tab

Type System Preference Definition Default
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AutoCorrect Preferences

AutoCorrect Preferences: Click Setup > System > Preferences > AutoCorrect tab

Type System Preference Definition Default

Account
Capitalize beginning of 
dictated sentences

Automatically capitalizes the first letter of the 
first word of a new sentence. Can be modified 
for individual user accounts.

True

Account
Replace text during 
dictation

Select to replace text during dictation for all 
users. Can be modified for individual user 
accounts.

True
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Devices Preferences 
Note: When you configure these preferences at the system level, they become the defaults 
for all users. However, an administrator can assign preferences for individual users, or 
each user can set their own preferences in the PowerScribe 360 | Reporting client 
application. 

Dictaphone PowerMic

Select the desired action for each of the buttons on the PowerMic. The default options 
appear in green at the right of the window.

Barcode Scan Check Box

Note: The “focused” application is the one in which you are currently working. For 
example, you might have your PACS application, PowerScribe 360 | Reporting, and a 
messaging application open on your workstation at the same time. If you click (or select 
77
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with keystrokes) your PACS application, it becomes the one that is in “focus” since it is 
the one that you are working in right now. 

Send barcode scan to focused application: Select this check box to allow the provider to 
scan barcodes into other applications (your PACS, for example) as long as PowerScribe 
360 | Reporting is not in focus. If the PowerScribe 360 | Reporting application is not in 
focus, the scanned barcode is sent to the application which currently is in focus. If the 
PowerScribe 360 | Reporting application is in focus, it accepts the scanned barcode. By 
default this check box is not selected.

Dictaphone PowerMic Button Actions

The following table shows the programmable buttons on the PowerMic, along with all the 
possible actions that can be assigned to each button. 

Dictaphone PowerMic Preferences: Click Setup > System > Preferences > 
Devices > Dictaphone PowerMic tab

Button Action/Setting

Transcribe, Enter/Select, 
and Scan buttons

Toggle play audio on off Save as draft
Transcribe Backspace
Sign report New line
Delete key Delete last utterance
Nothing Toggle visibility
Deadman play audio Enter key
Correct report Normal report
New paragraph Delete last word
STAT Sign as preliminary

Dictate button Toggle dictation on off Use deadman switch

Tab Backward and 
Custom Left buttons

Previous field Toggle play audio on off 
Deadman play audio Backspace
Sign report New line
Delete key Delete last utterance
Nothing Select backward
Save as draft Enter key
Correct report Normal report
New paragraph Delete last word
Previous discrepancy STAT
Sign as preliminary Previous field or table cell
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Philips SpeechMike

Select the desired action for each of the buttons on the SpeechMike. The default options 
appear in green at the right of the window.

Tab Forward and Custom 
Right buttons

Next field Toggle play audio on off
Deadman play audio Backspace
Sign report New line
Delete key Delete last utterance
Nothing Select forward
Save as draft Enter key
Correct report Normal report
New paragraph Delete last word
Next discrepancy STAT
Sign as preliminary Next field or table cell

Rewind button Toggle rewind on off Use deadman switch
Previous field Select backward
Previous field or table cell

Fast Forward button Toggle fast forward on off Use deadman switch
Next field Select forward
Next field or table cell

Stop/Play button Toggle microphone on off Toggle play audio on off
Deadman microphone Deadman play audio

Dictaphone PowerMic Preferences: Click Setup > System > Preferences > 
Devices > Dictaphone PowerMic tab

Button Action/Setting
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Philips SpeechMike Button Actions

The following table shows the programmable buttons on the Philips SpeechMike, along 
with all the possible actions that can be assigned to each button. 

Philips SpeechMike Preferences: Click Setup > System > Preferences > 
Devices > Philips SpeechMike tab

Button Action/Setting

Record button Toggle play audio on off Use deadman switch

Play/Stop button Toggle microphone on off Deadman microphone
Toggle audio play on off Deadman play audio

Rewind button Toggle rewind on off Previous field
Use deadman switch Select backward
Previous field or table cell

Forward button Toggle fast forward on off Use deadman switch
Next field Select forward
Next field or table cell

EOL button Previous field Sign report
Normal report New line
New paragraph Delete key
Delete last word Delete last utterance
Toggle play audio on off Select backward
Save as draft Deadman play audio
Enter key Backspace
Correct report Previous discrepancy
STAT Nothing
Sign as preliminary Previous field or table cell

Ins/Ovr button Next field Sign report
Normal report New line
New paragraph Delete key
Delete last word Delete last utterance
Toggle play audio on off Toggle visibility
Save as draft Deadman play audio
Transcribe Backspace
Correct report Next discrepancy
STAT Nothing
Sign as preliminary Next field or table cell
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Command button (on 
back of microphone)

Toggle play audio on off Toggle visibility
Save as draft Deadman play audio
Transcribe Enter key
Backspace Correct report
Sign report Normal report
New line New paragraph
Delete key Delete last word
Delete last utterance STAT
Nothing Sign as preliminary

F1, F2, F3, and F4 
buttons

Previous field Next field
Sign report Normal report
New line New paragraph
Delete key Delete last word
Delete last utterance Toggle play audio on off
Select backward Select Forward
Toggle visibility Save as draft
Deadman play audio Transcribe
Enter key Backspace
Previous discrepancy Next discrepancy
STAT Nothing
Sign as preliminary Previous field or table cell
Next field or table cell

Philips SpeechMike Preferences: Click Setup > System > Preferences > 
Devices > Philips SpeechMike tab

Button Action/Setting
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tab 
Foot Pedal

The foot pedal preferences govern how the software responds when the user presses each 
of the controls on the foot pedal. 

Note that there are separate preferences for Editors and Authors. For example, you can 
configure the right pedal to fast forward the audio for a transcriptionist, and configure it to 
go to the next field for a dictation user.

Foot Pedal Actions

The following table shows the programmable foot pedals, along with all the possible 
actions that can be assigned to each pedal. 

Foot Pedal Preferences: Click Setup > System > Preferences > Devices > Foot Pedal 

Pedal Action/Setting

Editor Foot Pedal Left
Editor Foot Pedal Center
Editor Foot Pedal Right
(all three Editor foot pedals have the 
same options)

Previous field Next field
Toggle play audio on off Deadman play audio
Rewind Fast forward
Previous discrepancy Next discrepancy
Previous field or table cell Next field or table cell

Author Foot Pedal Left
Author Foot Pedal Right

Previous field Next field
Toggle play audio on off Deadman play audio
Transcribe Rewind
Fast forward Previous discrepancy
Next discrepancy Previous field or table cell
Next field or table cell

Author Foot Pedal Center Toggle dictation on off Use deadman switch
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Descriptions of Action for the Devices 

The following list briefly describes each of the possible actions:

• Nothing: No action occurs when the user presses the button.

• Sign Report: Electronically sign the current report.

• Use deadman switch: Continue the action while the user holds the button down, stop 
when the button is released. 

• Toggle [action]: Begin the action when the user presses and releases the button. Stop 
the action when the user presses the button again. Toggle actions include:

– Toggle dictation on off

– Toggle play audio on off

– Toggle rewind on off

– Toggle fast forward on off

– Toggle microphone on off

• Toggle visibility: Toggles the application window (useful for single-workstation 
integrated PACS environments).

• Previous field: Highlights the previous field in the report.

• Next field: Highlights the next field in the report.

• Normal report: Creates and signs a normal report for the selected exam.

• New line: Inserts a new line into the report.

• New paragraph: Inserts a new paragraph into the report.

• Delete key: Deletes forward from current position.

• Delete last word: Deletes the last word dictated.

• Delete last utterance: Deletes the last group of words recognized (similar to the 
“scratch that” function).

• Save as draft: Saves current report to the draft folder.

• Transcribe: Convert the audio to text.

• Deadman play audio: Continue playing back audio while the user holds the button 
down, stop playing back audio when the button is released. 

• Enter key: The key acts like the Enter key on the computer keyboard.

• Backspace: The key acts like the Backspace key on the computer keyboard.

• Correct report: Sends the report to an editor for correction/transcription

• STAT: Marks the dictation as a STAT report

• Select backward: Selects the previous word based on the current cursor location.

• Select forward: Selects the next word based on the current cursor location.

• Next discrepancy: Highlights the next discrepancy when using the Quality Check 
consistency checker (which is a purchasable option)
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• Previous discrepancy: Highlights the previous discrepancy when using the Quality 
Check consistency checker (which is a purchasable option)

• Previous field or table cell: Highlights the next field or cell in a table

• Next field or table cell: Highlights the previous field or cell in a table

Explorer Screen Preferences
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Explorer Screen Preferences: Click Setup > System > Preferences > Explorer Screen tab

Type System Preference Definition Default

Account
Enable Explorer Quick 
Search

Select to display the Quick Search section in 
the left side of the Explorer window

True

Account Enable Explorer Browse

Allows you to select which of the Browse 
filters to display to the users. Choose one of the 
following:
Time Frame; Status; Site; Location; 
Radiologist; Ordering Provider; Modality; 
Anatomy; Section; Patient Age; Patient Class; 
All; None

All

System Enable barcodes

Select to allow barcode scanning. Choose one 
of the following:
Enabled; Disabled; PowerMic II Only

Note: If you select PowerMic II Only, 
and the provider is using a PowerMic II, 
the barcode filter setting will not apply 
when manually typing into the accession 
field.

Disabled

Site
Barcode filter start 
position

The position of the first valid character in 
scanned data such as the MRN or accession 
number. Use this preference in conjunction 
with the Barcode filter end position to filter 
out control characters. 
For example, if the scanned data contains one 
control character to the left of the actual MRN 
or accession number, enter 1 as the start 
position. Enter 0 if there are no leading control 
characters. 
(You must also select Enable barcodes and 
Barcode filter.)

0
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Site
Barcode filter end 
position

A zero-based (starts with zero, not one) index 
value that indicates the position of the last valid 
character in scanned data. Use this preference 
in conjunction with the Barcode filter start 
position to filter out control characters. For 
example, if the MRN is 10 characters long and 
there are no leading control characters, enter 9 
(which actually indicates the tenth character, 
since this value is a zero-based). If the MRN is 
10 characters long and there is one leading 
control character, enter 10 (which actually 
indicates the eleventh character position, to 
take into consideration the leading control 
character). 
(You must also select Enable barcodes and 
Barcode filter.)

0

Account Barcode filter

Allows the system to filter out control 
characters from barcode-scanned data. If you 
select this option, use the Barcode filter start 
position and Barcode filter end position to 
specify where the valid data begins and ends. 
This option activates the Barcode Filter item 
in the PowerScribe 360 | Reporting client 
application’s Tools menu and the 
corresponding toolbar button.

False

Site Patient identifier field

Select MRN, Dept number, or Both. The 
selection you make here configures the entire 
system to use the selected item as the identifier 
for patients. For example, if you select Both, 
the system uses the combined MRN and 
Department Number as the patient identifier.

MRN

Site Allow quick signing

Allows the normally displayed prompt to be 
bypassed when signing from Explorer. (Applies 
only to Pending Signature reports; for 
example, an attending signing a resident’s 
reports).
Changed from a check box to three choices: 
Never; Always; Attending reports only. 

Never

Account Enable batch signing

Select this check box to allow attending 
providers to sign several reports at the same 
time, or to allow residents to approve several 
reports at the same time.

False

Explorer Screen Preferences: Click Setup > System > Preferences > Explorer Screen tab

Type System Preference Definition Default
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Site Accession number length

The length of an accession number, for sites 
that use a fixed number of characters/digits. It 
enables the Detect accession length in search 
box feature described below. 

0

System
Maximum Explorer 
search records

The number of records that can be retrieved 
from the database during a search. Select
No Limit, 100, 200, 300, 400, 750, 1000, 2000, 
3000, or 5000.

500

Account
Detect accession length in 
search box

If you select this option, when the user enters 
an accession number in the Quick Search area, 
the system automatically begins the search 
when it receives the correct number of digits. 
This preference is applicable only if you have 
set the Accession Number Length preference 
to a value greater than zero. Automatic 
detection is not used when the Barcode filter 
preference (described above) is enabled. 

False

Account
Show old resident drafts 
in My Reports

Allows attending radiologists to see (and sign) 
their residents’ drafts when they click the 
Drafts link in the My Reports section. This 
option helps ensure that a report is not lost if 
the resident does not complete it in a timely 
fashion. Attending physicians can choose to 
show all resident drafts, or only those that are 
older than a certain number of hours.

Do not show

Account
Show resident corrected 
reports in My Reports

With this check box selected, when a resident 
dictates a report and sends it to an editor for 
correction, and the editor finishes the report, it 
becomes visible to the Attending provider. This 
preference applies to an Editor workflow.

False

Account
Show subscribed 
worklists only

Determines whether the View “All” worklists 
option is available to the user. 

True

Account
Display addenda above 
report

Controls whether addenda are displayed before 
the report body for previewed 
reports. (Previewed
reports include the report preview at the bottom 
of the Explorer screen, as well
as the report preview in all instances of the 
Prior Reports Control.)

True

Site TAT Deadline Standard

TAT (turnaround time) for standard reports that 
do not have a Red or Yellow status. Selectable 
values range from 5 minutes to 4 weeks, or 
None.

None

Explorer Screen Preferences: Click Setup > System > Preferences > Explorer Screen tab

Type System Preference Definition Default
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Site TAT Red Alert Standard
TAT for standard reports that have a Red alert 
status. Selectable values range from 1 minute 
to 24 hours, or None.

None

Site
TAT Yellow Alert 
Standard

TAT for standard reports that have a Yellow 
alert status. Selectable values range from 1 
minute to 24 hours, or None.

None

Site TAT Deadline STAT
TAT for STAT reports that do not have a Red or 
Yellow status. Selectable values range from 5 
minutes to 4 weeks, or None.

None

Site TAT Red Alert STAT
TAT for STAT reports that have a Red alert 
status. Selectable values range from 1 minute 
to 24 hours, or None.

None

Site TAT Yellow Alert STAT
TAT for STAT reports that have a Yellow alert 
status. Selectable values range from 1 minute 
to 24 hours, or None.

None

Explorer Screen Preferences: Click Setup > System > Preferences > Explorer Screen tab

Type System Preference Definition Default
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Security Preferences

Security Preferences: Click Setup > System > Preferences > Security tab

Type System Preference Definition Default

System
Signing password cache 
interval

This setting controls how often to request a 
password confirmation when a radiologist signs 
or approves a report. This preference is ignored 
for transcriptionist/editors; they are not 
prompted for a password. 
Select Ask every time, Never ask, a number of 
minutes (5, 10, 15, 20, 25, 30, 45, 60, or 90), or 
of hours (2, 3, 4, 5, 6, or 12).

Ask every time
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System
Automatic log off idle 
time

The amount of time the user can stay logged 
into the system when there is no activity at the 
workstation. Select Never, or a number of 
minutes (15, 30, 45, 60, or 90), or hours (2, 3, 
4, 5, 8, 12, 18, or 24).

Note: For administrators with access to 
the Administrator Portal, the idle time is 
fixed at 60 minutes.

Never

System
Lock out user after failed 
attempts

Select Never, or select the number of attempts. 
Never

System
Lock out user after days 
of inactivity

Select Never, a number of days (7, 15, 30, or 
45), a number of months (2, 3, 4, 5, or 6), or 
one year. 

Never

System
Forced password change 
interval

The period of time after which the user is 
prompted to create a new password.The user is 
not allowed to reuse an older password, and 
empty passwords are not permitted. 
This preference is disregarded when LDAP 
authentication is used.
Select Never, a number of days (7, 15, 30, or 
45), a number of months (2, 3, 4, 5, or 9), or 
one year.
Selecting a value other than Never activates the 
Force Reset item in the Password menu on the 
Accounts tab. 

30 days

System Require strong password
The system will reject any password that does 
not contain at least six characters, with at least 
one letter and one digit.

False

System
Allow null password via 
automation

A third-party system (for example, PACS) can 
log in a user to PowerScribe 360 | Reporting 
without specifying a password. This option can 
be useful for single sign-on scenarios where the 
PACS is not capable of sending the password. 

True

System
Enable simultaneous 
logins

Allows a user to log in at more than one 
workstation simultaneously. 
Caution: It is recommended that you not 
enable this preference, both for security 
purposes and to avoid corruption of the 
roaming speech profile.

False

Account
Enable automatic log 
collection

Select this check box to enable the Collect logs 
feature automatically when the user logs off of 
the client application. 

False

Security Preferences: Click Setup > System > Preferences > Security tab

Type System Preference Definition Default
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Account
Enable application 
logging

Allows you to log application activity. Choose 
either Grammar Rules; Cursor Moves; Reco 
Mode Changes; Field Navigation; Report 
Workflow; Speech Session; Stray Toolbars; 
Performance; RAS; Microphone Button; All; or 
Disabled.
With the Microphone Button item selected, 
events are written to the log file on DOWN, UP, 
and HOLD actions for each button. Events are 
logged for PowerMic, SpeechMike, and foot 
pedal devices.

Disabled

Account Warn on logoff
The software displays a warning message when 
the user exits the application or if the 
application is closed automatically.

Never

Account
Block display of 
demographics

The patient’s Name and MRN appear as n/a, 
and are not displayed when the user views the 
report. (This option is usually activated for 
users with Editor or Technologist roles—
assuming they do not need to see this patient 
information—so as to meet HIPAA 
requirements.)

False

Site Physician access mode

This preference controls the way physicians 
access the system. 

• Disabled: Physicians do not have access.
• Enabled with administered registration: 

New Portal accounts for physicians are 
created by only administrators.

• Enabled with self-registration: A link in 
the login page allows a physician who 
already has one or more record in the 
database (typically originating from a HL7 
feed) to create a Portal account and map it 
to the record(s) by providing his site 
identifier. 

• Enabled with self-registration and OE 
access: At the time of the registration, the 
Order Entry User role is automatically 
assigned to the new physician account, 
allowing access to the Order Entry pages. If 
a physician account does not have that role, 
she can only access Explorer, to browse for 
patients’ reports.

Enabled with 
administered 
registration

Security Preferences: Click Setup > System > Preferences > Security tab

Type System Preference Definition Default
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Scheduling ACO and LMO
You can schedule the ACO and LMO processes for all users, or for individual users. 
Scheduling has two aspects: setting an interval for ACO and for LMO, and, if desired, 
limiting the time frame in which the server is permitted to run the ACO process. You can 
apply the schedule at the system level to all users, or modify the schedule for individual 
user accounts. 

About the ACO and LMO Intervals

An interval is the period of time between two processes. The interval for ACO or for LMO 
might be daily, weekly, monthly, every three weeks, or some other time period. You can 
also disable either process by selecting ‘Disabled’ rather than an interval. Once you have 
set the intervals for these processes at the system level, you can tailor the intervals for 
individual user accounts. 

Factors to Consider in Setting ACO and LMO Intervals

Because an LMO process runs quickly and does not tie up resources, you can schedule an 
LMO for every user every day. At minimum, you should schedule LMO:

• At least every week for providers new to dictating (that is, those who do not already 
have a user profile or who have not yet dictated five full hours of audio).

• At least every month for providers with more experience dictating (those who already 
have a user profile and have already dictated a minimum of five hours of audio).

Some factors to consider when deciding how often to run LMO include:

• How much dictation a provider or group of providers generates

• How often you add new words to vocabularies (page 181)

In the ACO process, the speech software measures the amount of dictation collected for 
each provider. If sufficient data has been collected for a particular provider, it runs the 
process. For example, if the interval for ACO is Weekly, the software checks once a week 
for accumulated dictation. If not enough data exists to run ACO for a particular provider, 
the system does not run ACO for that provider, but might run it for others. 

The ACO process, by contrast with LMO, is time-intensive—it runs for one hour to 
process one hour of dictation. In deciding how often to run ACO, consider:

• Whether or not a particular provider has an accent. An accented provider might benefit 
from running ACO frequently.

• Whether the speech engine often fails to interpret a particular provider’s speech 
accurately. In this case, increasing the ACO frequency might be warranted.

• How much dictation a provider or group of providers generates. A provider who 
seldom dictates might need ACO to be run less often than weekly or monthly. 

For a provider to benefit most from the ACO process, you should set the schedule so that 
the process runs whenever he or she has dictated five hours of audio. A medical 
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practitioner is unlikely to dictate continuously for five hours, but might produce that much 
audio over a period of a month or two, dictating as needed.

At minimum, ACO should run for a given provider every six months. This allows the 
system to adjust the profile for natural variations that occur over time in a person’s speech 
pattern.

One suggested method for scheduling LMO and ACO is as follows: 

1. Set the interval to Every day for LMO at the system level.

2. Keep the default interval of Weekly for ACO at the system level.

3. When a new dictation provider is added to the system, or when a provider begins 
dictating with speech recognition, determine when this user’s the first ACO has been 
run. You can get this information by viewing the audit data for the user (page 165), by 
viewing ACO and LMO logs for all users (page 574), or by checking the user’s 
account, which shows the date and time of the most recent ACO and LMO.

4. When the ACO has run for that user, modify the interval in the user’s account to 
Monthly. 
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About Setting the ACO Time Window(s)

It is recommended that you not schedule specific time slots for ACO. If you define 
daily windows for the ACO process, it can run only during the specified periods. 
Furthermore, even if the process is ready to run during the specified time frame, other 
jobs with higher priority might prevent it from running during that time. 

To allow ACO to run at any time, do not set the time windows; leave all of the ACO 
Daily Windows fields blank. The system prioritizes jobs based on when the ACO was 
last run.
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Leaving the ACO time parameters blank does not disable the process, but removes any 
limitations on when it can run. If you need to disable ACO, select Disabled as the 
Dragon ACO Interval:

Type System Preference Definition Default

Account
Dragon LMO interval 
(days)

Set the amount of time between language 
model optimizations, or select Disabled if you 
do not want to run LMO.

Weekly

Account
Dragon ACO interval 
(days)

Set the amount of time between acoustic model 
optimizations, or select Disabled if you do not 
want to run ACO.

Weekly

Account ACO daily windows
Configure the time(s) during which you want 
the ACO to run.

None
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Scheduling or Disabling ACO and LMO

You can schedule ACO and LMO at the system or individual user level. 

To schedule or disable ACO and LMO at the system level:

1. In the Setup group, select the System tab. 

2. Click Preferences, and then select the ACO/LMO tab.

3. Set the Dragon LMO Interval to Every day.

4. Set the Dragon ACO Interval to Weekly.

5. Click Save and Close. 

To schedule or disable ACO and LMO for an individual user:

1. In the Setup group, select the Accounts tab. 

2. Select the provider whose optimization schedule you want to modify.

3. Click Preferences, and then select the ACO/LMO tab

4. Set the Dragon LMO Interval to Every day.

5. Set the Dragon ACO Interval to Weekly.

6. Click Save and Close.

Tip: Look for Speech Utility in the Realm column to find ACO or LMO-related 
events. You can click the Realm column heading to sort the list by this column. 

Type Description

Reset speech The administrator performs a checkpoint restore (page 172). 
For this event, the Info column indicates whether the entire 
profile is restored, or just the acoustics. 

Checkpoint speech The user creates a checkpoint (backup of the current speech 
profile), or the system creates one automatically after the user 
performs training. 

Set speech to mock profile The administrator creates a profile from the prototype 
(page 172). 

Delete speech profile The administrator removes the user’s profile (page 174). 

Set speech language The administrator assigns a language model to the account. 

Set speech acoustics The administrator assigns an acoustic model to the account. 

Delete speech acoustics The administrator selects Reset acoustics and retrain from 
the Roaming Profile menu. 

Optimize speech acoustics The ACO process runs for the account. 

Optimize speech language The LMO process runs for the account. 

Import speech vocabulary The PowerScribe 360 | Reporting client application detects 
new words and adds them to the user’s profile.
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7. When you have finished reviewing the LMO and ACO events for this account, click 
Close Window.

Tip: You can also use the ACO/LMO tab in the Logs group to view LMO and 
ACO activity. Refer to “ACO/LMO Logs” on page 574.



Chapter 5

Configuring Sites

Objectives
In this chapter, you will:

• Review the available site configuration options

• Define PACS

• Describe the purpose and use of sections 

• Describe the purpose and use of custom fields

• Explain how locations are used 
99



10

PowerScribe® 360 | Reporting System Administrator Guide
Introduction to Site Configuration

In a single-site installation, you need only configure one site. In a multiple-site installation, 
you have the option of configuring settings differently for one or more sites, depending on 
your organization’s needs.

Site Settings
Site settings include each site’s name and description, PACS (Picture Archiving and 
Communications System) setup, sections, locations (if applicable), and custom fields. 
These configurations are on the Sites tab in the Setup group. This tab contains a 
drop-down list from which you can select the site you want to configure. 

In a single-site installation, you need only configure one site on this tab. 
0
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Site Preferences
If your facility has multiple sites, you might want to configure some preferences 
differently for one or more sites; any setting you make at the site level overrides the 
corresponding system preference and affects only that site. You can use the Preferences 
link on the Sites tab to tailor the site’s configuration as needed.

For example, suppose you have created an attestation statement at the system level; this 
statement appears on all reports in the system. If you do not change this preference at the 
site level, reports at all sites contain this statement. You might require, however, that 
reports at one site display a different attestation statement. Or, you might require that the 
report transmission grace period be longer at a particular site than at the others. 

Refer to Chapter 4 for information on setting your system, site, and user account 
preferences. 
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Configuring Sites

Follow the procedure below to configure an individual site in your system. 

Creating the Site
Follow this procedure to create and configure a new site.

To create the site: 

1. In the Setup group, select Sites. 

2. From the drop-down list at the upper right, select Create New.

3. Enter a name for the site in the Name field. If desired, add a Description. 

Caution: Site names can contain only alphabetic and numeric characters; 
apostrophes and any other type of punctuation or special characters are not 
permitted. 

4. Click Save and Close to save the site, or continue with the procedures below. 

Adding a PACS to a Site

In most cases, your Nuance representative configures the site for your PACS. If you need 
to perform this configuration, consult with your Nuance representative.

To add a PACS: 

1. In the Setup group, select Sites. 

2. Click the plus sign next to PACS. 

3. From the Type drop-down list, select the type of PACS integration you want to add to 
this site. For example, you might select ProVision. 
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4. In the Name field, type the name by which this PACS will be known in your system. 
By default, the PACS has the same name as its type. 

5. If desired, type a description of the PACS. 

6. Select Master or Slave mode. (If the PACS is in both master and slave mode, you will 
need to create two separate entries.)

7. In the text field next to the selected mode, enter any information required for this 
integration type.

8. Click the Save icon  to add this PACS to the site. 

Adding Sections to a Site

Sections are automatically populated upon importing the Procedure Master Translator. 
Sections can also be added as needed. For example, to control the work a user receives, 
you can associate a particular section with a user account and also with one or more 
worklists. To use sections, you will need to define them in the site. 

Tip: Create an Editor section for those who will send to the editor. You can then use this 
section to subscribe the editors to the Editor worklist.

To add a section: 

1. In the Setup group, select the Sites tab. 

2. Click the plus sign in the Sections area. A line for a new section is added.

3. Enter a Name for the new section. 

4. If desired, enter a Description of the section. 

5. Click the Save icon to save the section. 
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6. To associate this section with one or more procedure codes, click Add (or Edit if 
modifying an existing section) in the Procedures column next to the new section. The 
Procedure Code Selection dialog box opens. 

Find the procedure(s) you want to associate with this section:

 a. Place a check mark next to any modality or anatomy whose codes you want to 
display. 
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 b. Click Search. Any procedures connected to the items you chose appear in the All 
Procedures list.

 c. In the All Procedures list, place a check mark next to each procedure you want to 
add to this section. 
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 d. Click Add. The procedure(s) appear in the Selected Procedures list at the right.

 e. Click Close window. The count is increased by the number of procedures you 
added.

Tip: For more information on procedure codes, refer to Introduction to 
Procedure Master Translators, beginning on page 188.

7. To associate one or more user accounts with this section: 
6
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 a. Click Add (or Edit if you are modifying an existing account) in the Accounts 
column next to the section. The Accounts dialog box displays the accounts in this 
site.

 b. Select the accounts you want to associate with this section. 

 c. Click Save and Close. The count in the Accounts column is increased by the 
number of user accounts you chose. In each of these accounts, the section is added 
in the Sections field (Accounts tab in the Setup group). 

8. To associate one or more worklists with this section: 

 a. Click Add (or Edit if you are modifying an existing worklist) in the Worklists 
column next to the section. The Worklists dialog box opens.

 b. Select the worklists you want to associate with this section. 

 c. Click Save and Close. 

Tip: You can also associate sections with a worklist. Refer to Chapter 15 for 
information about creating worklists. 
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Adding Accounts to a Section

You can associate one or more accounts with a section. You can use this method to control 
providers’ access to worklists; refer to Using Sections to Control Worklist Access, 
beginning on page 424.

To add accounts to a section: 

1. Click Add in the Accounts column next to the section. The Accounts dialog box 
opens. 

2. Place a check mark next to each account you want to add to this section.

OR

Click Select All. 

3. Click Save and Close.

Adding Custom Fields to a Site

Tip: For more information, see Custom Fields, beginning on page 325. 

Custom fields are data items (also called metadata) associated with a particular order. 
These might include measurements, radiation dosage information, flags, and so on. 

Adding Locations to a Site

To add a location to the site: 

1. In the Setup group, select the Sites tab. 

2. Click the plus sign in the Locations area. A new location line is added.

3. Enter a name and optional description for the site location. 

4. Click the Save icon to save the location. 

Tip: The Edit link in the Templates column allows you to create and maintain 
print, fax, and fax cover sheet templates for a site location. Refer to Creating 
Templates for the Site, beginning on page 109.
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Creating Templates for the Site 
To create print and fax templates at the site level, or for locations within a site, refer to 
Chapter 19.

Auditing Site Events
Administrators can now audit several types of events at both the system and site levels. 

• To view the audit log at the site level, click Setup > Sites > Audit.

Filter your audit event list by: 

• Site: The Site-level audit list shows only the current site

• Account: Select an administrator account or select all administrators

• Type: Select a specific type of event or select all events:
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Note: Although the Change configuration and Change worklist items are 
visible in the Type drop-down list at the Site level, audit results for these items 
are displayed only at the System level, and not at the Site level.

– Create/Delete/Update Entity: Shows create, delete, and update events for entities 
such as systems and sites

– Change preference: Shows changes in system- or site-level preferences performed 
by the selected administrators

– Change configuration: Shows changes made to any of the tabs in the Setup > 
System > Configuration window. Available at system level only; see note above.

– Change bridge option: Shows changes made in the Setup > Bridge tab

– Change worklist: Shows changes made to any worklists in the system (Setup > 
System > Worklists). Available at system level only; see note above.

– Import procedures/persons/auto text/custom fields: Shows any activity 
involving the import procedures within the system.

• Time Frame: Select a time from the drop-down list, or click Custom and create your 
own filter

Several account-level items are available in the account audit log (to view an account-
level audit log, click Setup > Accounts, select the account you want to view, and click the 
Audit link): 

Managing Procedure Codes in the Site
To import, edit, and map procedure codes at the site level, refer to Introduction to 
Procedure Master Translators, beginning on page 188.

• Change Username • Change Personal Info

• Change Admin Rights • Change Sections

• Change Supervisor • Change Specialties
0



Chapter 6

Creating Provider,
Transcriptionist/Editor,

and Other Accounts

Objectives
In this chapter you will:

• Define the roles you can assign to accounts

• Create provider and transcriptionist/editor 
accounts

• Create front desk, technologist, and order entry 
user accounts

• Import physicians, patients, and 
non-administrative users

• Define the preferences you can assign to users

• Describe multiple-site user access

• Discuss user auditing 

• Maintain a user account and manage speech 
profiles
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Creating Users

This section provides instructions for creating dictation providers, transcriptionist/editors, and 
other accounts. You create users on the Accounts tab of the Setup group. 

Roles
To understand how to create users in PowerScribe 360 | Reporting, you need to be 
familiar with the various roles you can assign to them. 

Roles determine which features users see when they log into the Portal. A user might have 
the same role in all sites to which she has access, or a different role in each site. As 
administrator, you can assign users the following roles:

• Attending: An attending radiologist is certified and is authorized to create and sign his 
own medical reports and those authored by residents.

• Resident: A provider who is not yet certified. Residents can author medical reports 
but are not authorized to sign them; they can only approve the reports, which are later 
signed by an attending provider. In most cases, the resident has a designated attending 
radiologist (or group of attending radiologists) who eventually signs the report.

• Fellow: A fellow is a visiting physician who has been invited to serve at a healthcare 
institution. A fellow’s role is similar to a resident’s, but a fellow might have the 
privileges of an attending provider if certified in a specialty. When logging in as a 
fellow, the user can select either the attending or resident role. Depending on your 
facility, a fellow might have signing privileges on some reports but resident privileges 
(non-signing) on others. 

• Editor: An editor transcribes recorded dictation. In addition, an editor can listen to 
dictated audio and correct errors in the output of automated speech recognition. An 
editor can create a draft report without dictation; the draft report is then finalized by a 
radiologist.

• Front Desk: A Front Desk user has limited rights on the Portal. For example, Front 
Desk users can scan patient insurance cards, and so on.

• Order Entry: Users assigned the Order Entry role can use the Web-based portal 
application only to enter, modify, or update orders in the system.

• Technologist: Before the radiologist dictates a report on an order, a technologist might 
supply some data that has not been sent in HL7 as part of the order. Alternately, a 
technologist can create a draft report without dictation; the report is then finalized by a 
radiologist.

Providers
A provider can create reports in the PowerScribe 360 | Reporting client application, and 
can edit reports in the Administrator Portal. 
2
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Physicians
A physician can log in only to the Portal. In the Portal, she can perform order entry and 
view reports. A physician can see only the Explorer and Profile tabs in the Portal.

Administrators
In the PowerScribe 360 | Reporting system, administrators are users who have been 
granted some or all of the administrator rights. An administrator might also be a user who 
has been assigned to a specific role in the PowerScribe 360 | Reporting system. (See 
Creating an Attending, Resident, or Fellow Account, beginning on page 113.) 

As an administrator, you are not able to edit your own administrative rights. If there is a 
need for your rights to be modified, another administrator must edit your account. 

Creating an Attending, Resident, or 
Fellow Account

Use the following steps to create a provider account with the Attending, Resident, or 
Fellow role.

Notes: 

• If you have to add more than a few provider accounts, you can use the Import 
feature located under the System tab. Refer to “Importing Persons” on page 124.

• If the Bridge service receives a report and does not find its provider in the system, it 
automatically creates a new, inactive user account with the provider’s last name 
and RIS identifier as the user ID. To prevent creation of these ‘dummy’ accounts, 
ensure you have created all the necessary accounts before the Bridge service begins 
receiving reports from the RIS. 

To create a provider account:

1. In the Setup group, click the Accounts tab. 

2. Enter a Username for the user.

3. Enter a Password.

Tip: If your system is configured to require users to change their passwords at 
their first login (that is, if the Setup > System > Preferences > Security tab > 
Forced password change interval preference is set to anything other than 
Never), consider creating a basic password for all users to use at first, allowing 
each user change to a more secure one at first login.

4. Enter a First name and a Last name for the user.
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Note: The field names labeled in bold text are required fields. All other fields, 
such as the user’s ID and email address, are optional and appear only on this 
tab. Only users with access to this tab have the ability to see these data items; 
they are not displayed in any reports.

5. Optional: Fill in the ID, Contact, and Address information for the user.

6. Click Create New. The Practice, Sections, and Specialties fields become active, and 
an area to assign a role now appears. 

7. If this user requires a language model other than the default:

• If the workstation on which this user will work was set up primarily as a 
transcription workstation (‘T’ was selected during client installation), select PS360 
Transcriptionist.

• If the workstation was set up for both transcription and dictation (“R” was selected 
during client installation), select US Radiology. 

Note: If any other language model is selected for a user, ensure that the 
language model (e.g., PS360 Cardiology) was installed on the system properly.
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8. Again in the Speech item, select an Acoustic Model from the list.

Note: Select an accent acoustic model for users who have strong accents. The 
US English model works well for most users, including those with moderate 
accents.

9. If applicable, assign the user to a practice group. Typically, radiologists do not belong 
to practice groups. 

 a. In the Practice item, click Edit. The Practice Groups dialog box opens.

 b. Select one or more practice groups to assign to the user.

 c. Click Save and Close. Your selections now appear next to the Practice item.

10. If applicable, assign one or more sections to the user. The sections you assign to users 
affect what they can do and see in the PowerScribe 360 | Reporting applications. For 
example, you can use sections to control which worklists a user can see. Or, you might 
use sections to associate a group of residents with a particular attending provider, to 
group radiologists who work only for certain facilities, or to group a number of 
radiologists who usually perform the same type of exams.

Tip: You define sections in the site. For more information about creating and 
using sections, refer to “Adding Sections to a Site” on page 103. 
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 a. In the Sections item, click Edit. The Sections dialog box opens.

 b. Select one or more sections in one or more sites (if more than one site exists).

 c. Click Save and Close. Your selections now appear next to the Sections item.

11. If applicable, select one or more specialties for this user. This information is stored in 
the user’s profile but is not used by the PowerScribe 360 | Reporting application at this 
time.

 a. In the Specialties item, click Edit. The Specialties dialog box opens.

 b. Select any specialties that apply to this provider.

 c. Click Save and Close. Your selections now appear next to the Specialties item.
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12. For each site that this user must access:

 a. Enter an Identifier. For example, enter the ID for this provider in the RIS. Ensure 
that this identifier is accurate, otherwise the RIS can reject reports. 

 b. If the provider is a fellow and sometimes logs in as a resident, enter their resident 
ID in the Secondary ID field.

 c. Choose a Role. In this example, choose Attending, Resident, or Fellow, depending 
on the type of provider you are creating. 

 d. Click Create. 

Note: You might want to assign an attending provider to a Resident or Fellow 
user. After you finish creating the resident or fellow, refer to Assigning an 
Attending Provider to a Resident or Fellow, beginning on page 117.

When you click the Create button to add the identifier to the site, the Create link 
becomes a Delete link, allowing you to remove a user from a specific site if needed. 

In addition, the Save icon appears in the right column. If you make changes to an 
identifier or a role, click the icon to save the changes.

Assigning an Attending Provider to a Resident or Fellow

To assign an attending provider to a resident or fellow: 

1. In the Setup group, select the Accounts tab. 

2. Select the resident or fellow to whom you want to assign an attending provider. 

3. Click Edit next to the word Attendings. The Account Supervisors dialog box opens. 

4. Select the attending provider, or providers, you want to assign to the resident or fellow. 
Or, click Select all to assign all the providers in the list.

5. Click Save and Close. The attending provider is assigned to the resident or fellow. 
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Creating a Transcriptionist/Editor 
Account

To create a transcriptionist/editor:

1. In the Setup group, click the Accounts tab. The left side of the page lists all the users 
in the system, and the right side displays a form you can use to create a new user.

Note: If a user’s information already appears in the right side of the window, 
click Clear. Remember that Clear simply removes the data from the window; it 
does not delete the user from the system. 

2. Enter a Username and Password for the transcriptionist.

3. Enter a First name and a Last name for the transcriptionist.

Note: The field names in bold text are required fields. All other fields, such as 
the user’s ID and email address, are optional and appear only on this tab. Only 
users with access to this tab have the ability to see these data items; they are not 
displayed in any reports.

4. Select the Administrator check box if you want to give this transcriptionist 
administrative rights.

5. Select PS360 Transcriptionist from the Language Model drop-down list.

6. Click Create New to save the user; this action allows you to edit the user’s 
administrative rights, if applicable.

7. If you are granting this user administrative rights:

 a. Click the Edit Rights link at the right of the Administrator check box. The 
Administrative Rights dialog box opens.

 b. Select the Limited access with the following rights option. Use the table that 
begins on page 19 to help make your choices. Note that the rights fall into two 
categories: Edit rights and View rights. If you grant an Edit right, you should also 
grant the corresponding View right. 

 c. When finished, click Save and close. 

8. For each site that this user must access, enter an Identifier (and an eScription ID, if 
applicable). Then select Editor as the role, and click Create. 
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Note: Once you click the Create button to add the identifier to the site, the 
Create link becomes a Delete link, allowing you to remove a user from a specific 
site if needed.

9. Add the editor to the Editor Section. (See Adding Sections to a Site, beginning on 
page 103.)

Creating a Physician Account

Physicians are accepted from the HL7 feed; you can also maintain them on the Physicians 
tab in the Administrator Portal. Physicians cannot access the PowerScribe 360 | Reporting 
system unless you create accounts for them. The Physicians grid in the Accounts tab is a 
shortcut you can use to do this. If you assign a physician Order Entry rights in a site, she 
can access the PowerScribe 360 | Reporting order entry system (RadPort) for that site. 

To create a physician account: 

1. In the Setup group, click the Accounts tab. 

2. Enter a Username and Password for the physician.

Tip: If your system is configured to require users to change their passwords at 
their first login (that is, if the Setup > System > Preferences > Security tab > 
Forced password change interval preference is set to anything other than 
Never), consider creating a basic password for all users to use at first, allowing 
each user change to a more secure one at first login.

3. Enter a First name and a Last name for the user.

4. Click Create New. The Roles grid appears by default at the bottom of the tab.
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5. Click Switch to Physicians grid. The grid changes.

6. For each site to which this physician is to have access:

 a. Enter an Identifier. For example, enter the identifier by which this user is known in 
the HL7 system. 

 b. If the physician is to have order entry capability at the site, select Order Entry. If 
the physician is only to view orders at this site, leave the check box empty.

 c. Click Create. The Save icon appears.

 d. Click the Save icon.

7. Click Save Changes to save the physician account.

Modifying a Physician Account
The Physicians tab in the Exams group provides access to all the physicians in the 
system. On this tab, you can use various criteria to find and edit physician accounts. 

Note that each physician record is associated with a single site (that is, a single RIS). The 
same physician might have multiple physician records, one per site, each with a different 
site identifier. You can link these physicians by creating an account for them for use in 
PowerScribe 360 | Reporting.

To modify a physician account:

1. In the Exams group, select the Physicians tab.

2. Find the physician you want to modify.
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Click All to see all physicians, or select a letter from the alphabet to see physicians 
whose last names begin with that letter.

To search by name or identifier: 

 a. Select a site, if applicable.

 b. Select Last Name or Identifier. 

 c. Enter all or part of the physician's last name or identifier. 

 d. Click Search. Any physicians who meet your criteria appear in the list.

Tip: In the Look for text field, you can use an asterisk (*) as a wild-card 
character. For example, if you do not know the exact last name of a physician 
but you know the name ends in the letters MAN, type *man and click Search.

3. Select the physician you want to modify. 

4. If you are creating a new physician from this window: Select a site from the Site drop-
down list,

5. Type the RIS identifier for this physician. (Required)

6. Enter the NPI (National Provider Identifier) for this physician. 

7. Type the physician’s First and Last names. (Required)

8. Enter any other information you have for this physician.

9. If desired, indicate the specialties for this physician. Click the Edit link, select one or 
more specialties, and then click Save and close.

10. When finished entering the information for this physician, click Save Changes.
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Creating a Front Desk or Technologist 
Account

Creating a Front Desk Account
A Front Desk user has limited rights on the Portal. For example, Front Desk users can scan 
patient insurance cards, enter patient name and address, and so on.

To create a Front Desk user:

1. In the Setup group, click the Accounts tab. The left side of the page lists all the users 
in the system, and the right side displays a form you can use to create a new user.

Note: If a user’s information already appears in the right side of the window, 
click Clear. Remember that Clear simply removes the data from the window; it 
does not delete the user from the system. 

2. Enter a Username and Password for the Front Desk user. 

3. Enter a First name and a Last name for the Front Desk user.

4. Click Create New to save the user. The user’s name appears in the list at the left of the 
page.

5. For each site this user must access:

 a. Enter an Identifier. 

 b. Select Front Desk as the role.

 c. Click Create.

The user’s site access information is added to the list at the left of the page.

Note: Once you click the Create button to add the identifier to the site, the 
Create link becomes a Delete link, allowing you to remove the user’s access to a 
specific site if needed.
2
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Creating a Technologist Account
Before the radiologist dictates a report on an order, a technologist might need to supply 
some data that has not been sent in HL7 with the order. Alternately, a technologist can 
create a draft report without dictation; the report is then finalized by a radiologist.

To create a technologist account: 

1. In the Setup group, click the Accounts tab. The left side of the page lists all the users 
in the system, and the right side displays a form you can use to create a new user.

Note: If a user’s information already appears in the right side of the window, 
click Clear. Remember that Clear simply removes the data from the window; it 
does not delete the user from the system. 

2. Enter a Username and Password for the technologist. 

3. Enter a First name and a Last name for the technologist.

4. Click Create New to save the user. The user’s name appears in the list at the left of the 
page.

5. Click Preferences…. The Preferences dialog box opens. 

6. On the Dictation tab, select Disabled as the Speech recognition mode preference. 
This action stops the technologist from begin prompted to train upon logging in. 

7. Click Save and Close to close the Preferences dialog box. 

8. For each site this user must access:

 a. Enter an Identifier. 

 b. Select Technologist as the role. 

 c. Click Create.

The user’s site access information is added to the list at the left of the page.

Note: Once you click the Create button to add the identifier to the site, the 
Create link becomes a Delete link, allowing you to remove the user’s access to a 
specific site if needed.
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Importing Persons

Use this feature to import referring physicians, patients, or non-administrative users into the 
PowerScribe 360 | Reporting system from an Excel (.xls, not .xlsx) file. Importing allows you 
to add or modify many users at one time. This features is especially useful for importing 
accounts when converting from RadWhere.

This section provides separate procedures for importing patients, physicians, and 
non-administrative accounts. You can, however, import both physicians and 
non-administrative accounts from the same spreadsheet in a single procedure. 

Importing Patients

Creating the Excel File

To import patients into your system, you must create an Excel spreadsheet file with, at the 
minimum, columns representing the site name, MRN, first name, and last name. The 
columns can be in any order. The spreadsheet can be with or without column heading 
labels.

Importing the Patients

To import the patients:

1. Select the System tab in the Setup section.
4
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2. Click Import Persons.... The Import Persons dialog box opens.

3. Select Patients.

4. Click Browse and then navigate to and select the Excel file containing the patients you 
want to import. Click Open. 

5. Select First line of import data includes column headings if your Excel file contains 
a row of heading labels. 

6. Click Next. A dialog box displays the columns (by name, if you specified heading 
labels in Step 5), a sample of each column’s contents, and a Field drop-down list for 
each column.
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7. For each column, select the database field in which you want to insert the data. For 
example, map the column containing site names to the Site Name field in your 
database. For any columns you don’t want to include, select Skip Column. 

You can map data to the following columns in the patient database. 

Column Column Column

Last Name* First Name* Site Name*

MRN* MPI DOB

Gender SSN (Social Security 
Number)

Dept Num (Department 
Number)

Alternate ID Deceased Date Middle Name

Prefix Suffix Degree

Street Street2 City

State Zip Country

Home Phone Work Phone Mobile Phone

Pager Phone FAX Email

IM Insurance Plan Identifier Insurance Company 
Identifier

Group Number Group Name Insured Group Employer 
ID

Insured Group Company 
ID

Tax Identifier Plan Effective Date

Plan Expiration Date Insured Relationship Insured DOB

Insured Identifier

*Required
6
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8. Click Next >>. The next dialog box in the import procedure opens.

9. Indicate what you want the import software to do when a patient in the spreadsheet 
already exists in the database.

Select Do not replace existing data on update if you do not want the data in the 
spreadsheet to replace that in the database. For example, if the software finds a patient 
with the same MRN in the database as in the import list, it will not replace the patient’s 
name or other information with that in the spreadsheet. 

OR

If you do want to replace existing data, select Replace existing data on update. 

10. Indicate how the import software should treat blank columns in the spreadsheet. 

If you do not want any existing values to be replaced with spaces, select Do not 
replace original value with blank. For example, if the address and phone number 
columns in the spreadsheet are blank, the patient’s address and phone number in the 
database will remain intact.

OR

To replace an existing value in the database with spaces when the corresponding 
spreadsheet column is blank, select Replace original value with blank on update. 
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11. Click Next >> to continue. The system displays the results found. Any patients who 
already exist appear with a check mark in the Exists column.

Your preferences for the import appear at the top of the dialog box. To change your 
preferences, click <<Previous to go back to the last step.

12. Click Import. The patients are imported, and a confirmation message appears.
8
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Importing Referring Physicians

Creating the Excel Spreadsheet

To import physicians, you must provide, at the minimum, the physician’s First name, Last 
Name, Site Name, and Identifier. Leave the Login Name column blank or omit the Login 
Name column. The columns can be in any order. For example:

Importing the Physicians

To import the physicians:

1. Select the System tab in the Setup section.

2. Click Import Persons.... The Import Persons dialog box opens.

3. Select Accounts/Physicians.

4. Click Browse..., and then navigate to and select the Excel file containing the 
physicians you want to import. Click Open. 

5. Select First line of import data includes column headings if your Excel file contains 
a row of heading labels. 
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6. Click Next. A dialog box displays the columns (by name, if you specified heading 
labels in Step 5), a sample of each column’s contents, and a Field drop-down list for 
each column.

7. For each column, select the database field in which you want to insert the data. For 
example, map the column containing site names to the Site Name field in your 
database. For any columns you don’t want to include, select Skip Column. 

Note: At minimum you must map columns to First Name, Last Name, Site Name, 
and Identifier. 

You can map data to the following columns in the physician database: 

Column Column Column

Last Name* First Name* Site Name*

Identifier* NPI Role

Is Physician Veriphy ID ACR ID

Practice Group Specialties Middle Name

Prefix Suffix Degree

Street Street2 City

State Zip Country

Home Phone Work Phone Mobile Phone

Pager Phone Fax Email

IM Insurance Plan Identifier Insurance Company 
Identifier
0
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8. Click Next >>. The next dialog box in the import procedure opens.

9. Indicate what you want the import software to do when a physician in the spreadsheet 
already exists in the database.

Select Do not replace existing data on update if you do not want the data in the 
spreadsheet to replace that in the database. For example, if the software finds a 
physician with the same site name and identifier in the database as in the import list, it 
will not replace the physician’s name or other information with that in the spreadsheet. 

OR

To replace the existing data, select Replace existing data on update. 

Group Number Group Name Insured Group Employer 
ID

Insured Group Company 
ID

Tax Identifier Plan Effective Date

Plan Expiration Date Insured Relationship Insured DOB

Insured Identifier

*Required

Column Column Column
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10. Indicate how the import software should treat blank columns in the spreadsheet. 

If you do not want any existing values to be replaced with spaces, select Do not 
replace original value with blank. For example, if the phone number and address 
columns in the spreadsheet are blank, the physician’s address and phone number 
remain intact in the database.

OR

To replace an existing value in the database with spaces when the corresponding 
spreadsheet column is blank, select Replace original value with blank on update. 

11. Click Next >> to continue. The system displays the results found. Any physicians who 
already exist appear with a check mark in the Exists column.

Your preferences for the import appear at the top of the dialog box. To change your 
preferences, click <<Previous to go back to the last step.

12. Click Import. The physicians are imported, and a confirmation message appears.
2
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Importing Non-Administrative Accounts

Creating the Excel File

For importing accounts, you must provide, at a minimum, the Site Name, Identifier, First 
Name, Last Name, Login Name, Role, and Password. Available roles include Attending, 
Editor, Fellow, Front Desk, Order Entry, Resident, and Technologist. 

Tip: You can omit the Password column if you intend to assign the same 
password to all the imported accounts. 

To give an account access to more than one site, you must include a separate row for each 
site. For example, a provider might be a Fellow at one site, but an Attending at another.

To give an account access to more than one site, you must include a separate row for each 
site. 

Importing the Non-Administrative Accounts

To import the non-administrative accounts:

1. Select the System tab in the Setup section.

2. Click Import Persons.... The Import Persons dialog box opens.
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3. Select Accounts/Physicians.

4. Click Browse..., and then navigate to and select the Excel file containing the accounts 
you want to import. Click Open. 

5. Select First line of import data includes column headings if your Excel file contains 
a row of heading labels. 

6. Click Next. A dialog box displays the columns (by name, if you specified heading 
labels in Step 5), a sample of each column’s contents, and a Field drop-down list for 
each column.

7. For each column, select the database field in which you want to insert the data. For 
example, map the column containing site names to the Site Name field in your 
database. For any columns you don’t want to include, select Skip Column. 

Note: At minimum you must map columns to First Name, Last Name, Site Name, 
Identifier, Login Name, and Role. 

You can import data into the following columns in the account database: 

Column Column Column

Login Name* Password** Last Name*

Identifier* Role* First Name*

Veriphy ID ACR ID Practice Group

Specialties Site Name* NPI

Is Physician Middle Name Prefix
4
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8. Click Next >>. The next dialog box in the import procedure opens.

Suffix Degree Street

Street2 City State

Zip Country Home Phone

Work Phone Mobile Phone Pager Phone

Fax Email IM

Insurance Plan Identifier Insurance Company 
Identifier

Group Number

Group Name Insured Group Employer 
ID

Insured Group Company 
ID

Tax Identifier Plan Effective Date Plan Expiration Date

Insured Relationship Insured DOB

*Required
**You can omit the password if you intend to assign the same password to all 
imported accounts.

Column Column Column
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9. Indicate what you want the import software to do when an account in the spreadsheet 
already exists in the database.

Select Do not replace existing data on update if you do not want the data in the 
spreadsheet to replace that in the database. For example, if the software finds an 
account with the same Site Name and Identifier in the database as in the import list, it 
will not replace the account’s address or other information with that in the spreadsheet. 

OR

If you do want to replace existing data, select Replace existing data on update. 

OR

If you want to replace the existing data only in the case of user accounts that have been 
deactivated, select Replace existing data only for inactive accounts. 

10. Indicate how the import software should treat login names, where it finds an existing 
account (that is, an account with the site name/identifier) in the database. 

Select Do not replace login name on update if you never want the import to change 
the account’s login name.

OR

Select Replace login name on update (except for radiologists with speech files). 
This option allows the import to change users’ login names, but preserves the login 
names of users for whom the system has begun collecting data for speech recognition. 

11. Indicate how the import software should treat users’ passwords, where it finds an 
existing account in the database. 

Select Do not replace password on update if you never want the import to change 
existing accounts’ passwords.

OR

Select Replace password on update if you want the import process to change 
passwords for existing accounts. 

OR

Select Replace password only if unchanged by the user if you want the import 
process to change the passwords only in accounts where the user has not yet logged in.

If you selected either of the Replace password options, you can assign the same 
password to all existing users, or to existing users who have not logged in. To use this 
option, specify the password you want to use (see example below).

12. Indicate how the import software should treat blank columns in the spreadsheet. 
6
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If you do not want any existing values to be replaced with spaces, select Do not 
replace original value with blank. For example, if the phone number column in the 
spreadsheet is blank, the provider’s phone number remains intact in the database.

OR

To replace an existing value in the database with spaces when the spreadsheet column 
is blank, select Replace original value with blank on update. 

13. Click Next >> to continue. The system displays the results found. Any accounts that 
already exist appear with a check mark in the Exists column.

Your preferences for the import appear at the top of the dialog box. If you want to 
change your preferences, you can click <<Previous to go back to the last step.

14. Click Import. The accounts are imported, and a confirmation message appears.
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Configuring Account Preferences

You can set preferences for the entire system, for the site, and for individual user accounts. To 
change a user’s preferences, follow the procedure below. 

Refer to Configuring the Basic System Settings, beginning on page 24 for some important 
points regarding the relationship between system, site, and account preferences. 

For information on setting system, site, or user account preferences, refer to Chapter 4.

Tip: You can copy the entire set of preferences from one user to another. Refer to Copying 
User Account Preferences, beginning on page 164. 

To assign user preferences:

1. From the Setup group, click the Accounts tab and select a user for whom you want to 
set preferences.

2. Click the Preferences tab. The Account Preferences dialog box opens with the 
Workflow tab selected by default.
8
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Tip: If a user has managed to accidentally hide windows or move toolbars in their 
application, click the Reset UI State link to return these items to their original positions 
and locations in the user’s client application windows.

Use the following table to select preferences on the Workflow tab. 

Account 
Preference Definition Default

Perform spell 
check at signoff

Automatically spell checks a report when the 
provider signs it. If the system finds errors, it 
prompts the user to correct them.

True

Perform Quality 
Check at signoff

Runs the Quality Check feature when a report is 
signed.

Note: Quality Check is a purchasable option. 
Please contact your Nuance account 
representative for more information.

True

Invoke FAX at 
signoff

Automatically opens the Fax dialog box when a 
provider signs a report. Allows user to select the 
person(s) to whom the report is faxed.

False

Enable wet reads

Select an option: 
Allowed: Radiologist can create a report either as a 
wet read or a draft. Provider can send these reports 
to an editor (if they are assigned the Allow 
correctionist workflow permission).
Always: All reports are automatically wet reads (as 
opposed to drafts). Provider cannot send these 
reports to an editor.
Disabled: Provider cannot create reports as wet 
reads. 

Disabled

Add note on reject

When the radiologist rejects a corrected/transcribed 
report, the Insert Note dialog box automatically 
opens, allowing her to create a note for the 
transcriptionist. This preference also applies when 
an attending provider rejects a report approved by a 
resident.

True

Prompt on GUI 
sign

When a radiologist signs a report by clicking the 
Sign button, he is prompted to confirm his 
signature. This preference also causes a prompt to 
appear when residents click Approve and when 
editors click Finish. 

False
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Warn if fields are 
empty when 
signing

The radiologist or resident is warned when signing 
or approving a report if the report contains empty 
fill-in or merge fields.

True

Warn on sign if 
new notes exist

Controls whether the user is alerted during the 
signing process if new notes have been added since 
the last time he opened the report. 

• Never: New notes do not trigger a warning.
• From Transcription: Notes are shown only 

when added by the transcriptionist.
• Always: Any new notes trigger a warning, 

including those from other radiologists, or 
notes the system automatically adds on certain 
actions, such as when an order is assigned to a 
radiologist.

From 
transcription

Account 
Preference Definition Default
0



Chapter 6: Creating Provider, Transcriptionist/Editor, and Other Accounts
3. Click the Permissions tab.

Refer to the table below to select preferences on the Permissions tab.

Note: Peer Review is a purchasable option. Contact your Nuance account executive for 
information.

Account 
Preference Definition Default

Allow report 
creation for non-
radiologists

Determines what types of reports, if any, users 
other than radiologists can create. Choices are: 
Reports and addendums; Reports only; 
Addendums only; or Not allowed. (Replaces the 
Allow report creation check box preference in 
previous versions.)

Not allowed

Allow order 
association

Controls whether the provider has the right to add 
unreported orders to existing reports, or to 
dissociate an order from a multi-accession report. 
This function is available only if your RIS/HIS 
permits multiple accessions per order. 

True

Allow 
correctionist 
workflow

Select this option to activate the Correct and 
Reject functions for radiologists. True

Enable mobile 
access

Allows users to sign reports and use Assisted 
Diagnosis from their mobile devices

True
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4. Click the Report Editing tab. (For better visibility, the illustration for this tab is 
shown on this page and the next.)
2



Chapter 6: Creating Provider, Transcriptionist/Editor, and Other Accounts
Refer to the following table to set preferences on the Report Editing tab.

Account 
Preference Definition Default

Default font face
Specifies the font typeface to use when viewing and 
editing reports. 

Arial

Default font size
Specifies the font size to use when viewing and 
editing reports.

11

Start with default 
AutoText

If you select this option, if an AutoText entry has 
been designated as the default for a particular type 
of exam, the AutoText is automatically inserted 
when a user creates a new report for an exam of that 
type.

True 
(selected)
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Move cursor on 
AutoText insert

This specifies where the cursor is placed after the 
user inserts AutoText.
Select an option: 

• End of AutoText: Cursor moves to the right of 
the AutoText

• First empty field: Cursor moves to the first 
empty field in the document.

• First field: Cursor moves to the first field in the 
document.

First field

Automatic 
AutoText 
categorization

Allows providers to automatically include 
procedures in their AutoText. The choices for this 
preference are:

• Always: Procedures in the report’s order(s) are 
added to any AutoText that providers insert.

• Prompt: Provider is prompted to accept 
categorization prior to the addition of any 
procedure(s).

• Disabled: Do not perform auto-categorization 
of AutoText.

Disabled

Fill-in field 
navigation

Select the status of fields to which your Tab button/
key navigates. This allows you to skip fill-in fields 
that already have content. Choices are All; Empty; 
None; or Unmodified.

All

Merge field 
navigation

Select the status of fields to which your Tab button/
key navigates. This allows you to skip merge fields 
that already have content. Choices are All; Empty; 
None; or Unmodified.

All

Cursor position on 
field selection

Select where to position the cursor in a field that 
you select or move to. Choices are Text is selected; 
Cursor at the end; or Cursor at the beginning. 

Text is 
selected

Monitor order data 
changes during 
reporting

 Notifies users if the order data has changed while 
they are dictating a report. Options are:

• Notify and apply changes

• Apply changes without notification

• Disabled

Notify and 
apply changes

Show image 
captions in report

When selected, captions appear under any images 
providers insert into their reports.

True 
(selected)

Image size on 
insertion

Default size of your inserted images.
Choose either Small, Medium, or Large.

Medium

Account 
Preference Definition Default
4
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Warn if open 
orders when 
signing

Controls whether the system warns radiologists 
signing (or residents approving) a report when there 
are unreported orders for the patient that are not 
filtered by the Open orders property match and 
Open orders maximum age preferences. The 
radiologist or resident might want to add one or
more of the open orders to the report before signing 
or approving it.
Note that the warning applies only to the Open 
Orders that are displayed when the report is first
opened.

True

Open orders 
property match

Show (in the Report Editor Order Data tab) only 
orders that match the selected properties of the
order(s) in the current report.
Choices include Modality, Location, Section, and 
others.

None

Open orders 
maximum age

Do not display (in the Report Editor Order Data 
tab) orders older than this value. Select a number of
hours or days from the drop-down list.
(Relative to the age of the order for the current 
report, or the oldest order if there are multiple 
orders in the current report.)

10 days

Enable Quality 
Check types

Select one or more of the Quality Checks (currently 
Critical Test Results, Gender Mismatches, and 
Laterality Mismatches), or select All.

Note: Quality Check is a purchasable 
option. Contact your Nuance account 
executive for information.

All

PowerShare image 
viewer

Select either the Basic or the Advanced 
PowerShare image viewer from the drop-down 
menu.

Advanced

Show brackets on 
fields

Place square brackets around all fill-in fields.
True

Account 
Preference Definition Default
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Enable talking 
fields

If you select this option, the name of the field is 
spoken out loud when a user takes one of the 
following actions: 

• Moves the cursor into a field
• Selects it in the field pane
• Navigates into it using the microphone buttons 

or Tab key

Note: Talking Fields requires that Dragon 
Text-To-Speech (TTS) be installed on the 
user’s workstation. Note that field names are 
not spoken while the dictation mode is active.

True

Highlight text on 
playback

Each section of the report text is highlighted as it is 
played back.

True

Add unmatched 
findings to report

Applies to Findings Only dictation mode in the 
PowerScribe 360 | Reporting client application. 
When the user clicks Apply Findings, the software 
creates a new item in the Field pane for each 
unmatched finding. The fields are named 
*Unmatched1, *Unmatched2, and so on. If you do 
not select this option, any unmatched findings 
remain in the Findings Only window.

False

Restrict diagnosis 
codes by exam 
type

The list of ICD-9 codes is restricted to those that 
are appropriate for the exam. 

Note: This behavior is controlled through a 
check box in the Diagnosis Coding dialog 
box.

False

Automatically 
load PACS studies

If you select this option and a ‘master’ PACS 
integration is configured, as soon as a report is 
opened in PowerScribe 360 | Reporting the 
corresponding study is automatically opened in the 
PACS selected for the site.

False

Focus application 
on PACS launch

If you select this option and a ‘slave’ PACS 
integration is configured, PowerScribe 360 | 
Reporting is brought to the front of all applications 
and activated when a dictation request is received 
from the PACS. 

Note: This function works only with some 
PACS systems.

True

Account 
Preference Definition Default
6
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Discard unedited 
new report on 
PACS close

Allows the radiologist to delete a report that 
contains an AutoText template without being 
prompted, minimizing their interruptions. 
Permitted only if the radiologist did not create any 
content (audio or text) for the report. 

Note: Reports created manually will still 
prompt you before allowing deletion. 

True

Set application 
window always on 
top

This preference keeps the PowerScribe 360 | 
Reporting application the top application in an 
environment with multiple applications present, 
and prevents you from having to switch between 
applications during the session.

False

Enable 
background report 
saving

If you select this option, when the user approves or 
signs a report, he is taken immediately back to the 
Explorer screen (or to next report, in AutoFeed 
mode) without waiting to see that the report has 
been saved to the database. 

True

Enable AutoFeed 
polling

If selected, the system automatically polls for 
reports when a provider’s AutoFeed queue is 
empty.

False

Enable clinical 
guidance alerts

Select this check box to alert the user that there is a 
clinical guideline that covers the finding(s) that he 
or she documented in their report. This gives the 
user the opportunity to review the guideline and use 
it for recommendations.

False

Account 
Preference Definition Default
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5. Click the Dictation tab. 
8
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Use the following table to assign preferences on the Dictation tab.

Account 
Preference Definition Default

Speech 
recognition mode

Controls how speech recognition is performed. 
• Text streaming: Automatically displays the 

dictated text as the provider dictates. 
• Press to transcribe: Requires the provider to 

press a button on the microphone. 
• Disabled, which means speech recognition is 

not loaded. The user, therefore, cannot record 
or play back audio. This option is typically 
assigned to technologist accounts.

Note: Do not select Disabled for editors; they 
need to be able to play back the audio to 
perform edits.

Text 
streaming

Cursor position on 
transcribe

Controls the position of the cursor after the 
provider presses the Transcribe button on the 
microphone.

• Cursor at the end: The cursor appears at the 
end of the transcribed text.

• Cursor at the beginning: The cursor appears 
at the beginning of the transcribed text.

• Text is selected: The transcribed text is 
highlighted.

Cursor at the 
end

Select utterances 
shorter than

When the provider dictates audio shorter than the 
number of characters you indicate here (for 
example, when she dictates short words, or the 
values in fill-in fields), the dictated content is 
automatically selected when she issues the 
“transcribe” command. She can then quickly edit 
the dictated content or move on to the next field.

Note: This preference is available only when 
you have selected either Cursor at the 
beginning or Cursor at the end as the 
Cursor position on transcribe preference.

0

Beep on dictation 
start/stop

Choose whether an audible tone sounds when the 
provider starts and/or stops dictation. Select either 
No beep, On start, or On start and stop.

On start

Beep on command 
recognized

An audible tone sounds when the software 
recognizes a voice command.

True

Use PC speaker 
for sound alerts

Uses the computer’s built-in speaker for beeps in 
the above two preferences.

True
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Turn off dictation 
when changing 
modes

If you select this option, dictation is automatically 
toggled off when the user switches screens, such as 
when moving from the Explorer screen to the 
Report screen, or when opening or closing dialog 
boxes that accept dictation input.

False

Prompt to save 
speech files

Controls saving modified speech files when a user 
logs out of the application. 

• Prompt: The user is asked whether or not to 
save. 

• Always save: Speech files are saved without 
prompting. 

• Never save: Speech files are never saved. 
Learning does not continue and new words 
added are not saved; the user must actively save 
any new words.

It is recommended that you select Prompt or 
Always save. For a user who has used the system 
for awhile and is satisfied with speech recognition 
accuracy, you might change this option to Never 
save.

Always save

AutoText voice 
command

The word or phrase you specify here is used as the 
voice command for inserting AutoText into a 
report. (The word Macro might be preferable for 
users accustomed to older speech-reporting 
applications.)

AutoText

Voice enable all 
default AutoText

Select to enable voice commands for all AutoText 
marked as default, regardless of relevance.

True

Enable 
microphone toggle

If you select this option and the start/stop button 
has been configured to turn the microphone on and 
off, the provider can press the start/stop button once 
to turn the microphone on, use voice commands to 
start and stop recording, and then press the start/
stop button to turn the microphone off. 

False

Microphone off 
idle time

The time the microphone is allowed to be idle 
before the system automatically turns it off.

3 minutes

Account 
Preference Definition Default
0
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Save audio with 
report

Controls whether the dictated audio is saved to the 
server. The default is False to minimize system 
load. Set this preference to True for: 

• Self-edit radiologists who want to play back 
their dictations 

• Radiologists who send their reports for 
transcription 

CAUTION: Enable this option for self-edit 
radiologists only if they need to play back their 
dictations. This option adds considerable overhead 
to the server and delays opening and saving of 
reports. 

True

Allow Dragon 
Formatting dialog

The user can access the Dragon Formatting tab, 
and modify the formatting settings for the 
application.

True

Allow Dragon 
Options dialog

The user can access the Dragon Options tab, 
allowing her to modify the options settings for the 
application.

True

Enable Dragon 
save correction to 
archive

Select this option if you want the speech 
recognition engine to collect correction data in the 
acoustic archive.

True

Enable Dragon 
data collection

If you select this option, the software selects data 
for troubleshooting purposes;
if recognition is unsatisfactory, a Nuance 
representative can use a log file to analyze the 
problem. 

True

Enable Dragon 
collect data for 
research

Select this option if you want the speech 
recognition engine to collect correction data for 
research purposes.

False

Enable Dragon 
insert rejections 
into document

Do not change this preference unless you are 
instructed to do so by Nuance. 

False

Enable Dragon 
greedy 
replacement

If selected, replaces an entire word that has
been only partially selected. For example, if a
provider highlights only the letters im in
superimposed infection, and then dictates
“mild”, the resulting text would show mild
infection.

True

Account 
Preference Definition Default
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6. Click the AutoCorrect tab. (Administrators can access individual user AutoCorrect 
rules, and either edit or delete the rules.)

Use the following table to assign preferences on the AutoCorrect tab.

Microphone off 
delay

Do not change this preference unless you are 
instructed to do so by Nuance. 

Disabled

Short utterance 
retry delay

Do not change this preference unless you are 
instructed to do so by Nuance. 

250 
milliseconds

Account 
Preference Definition Default
2
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To add a new AutoCorrect rule:

 a. Click the Create new item icon .

 b. In the Text field, type the text that you want to replace.

 c. In the Replacement field, type the text that you want to appear (instead of the word 
or words you entered in the Text field).

 d. Select the Ignore Case check box to ignore the case (uppercase or lowercase) of 
your text.

 e. Click the Commit changes icon .

To change an AutoCorrect rule:

 a. Click the Edit item icon to the left of the rule you want to modify. 

 b. Make the appropriate changes to the text.

 c. Click the Commit changes icon .

To remove an AutoCorrect rule:

• Click the Delete item icon to the left of the rule you want to remove.

To return without changing or deleting an AutoCorrect rule:

• Click the Cancel update icon to the left of the rule that you were modifying.

Account 
Preference Definition Default

Capitalize 
beginning of 
dictated sentences

Automatically capitalizes the first letter of the first 
word of a new sentence. 

Note: Using this function can disrupt audio 
playback functionality; you should not enable 
it for radiologists who use a correctionist 
workflow.

True

Replace text 
during dictation

If selected, the system automatically replaces words 
or phrases with different words or phrases during 
dictation. This feature is useful if the speech engine 
consistently makes the same mistakes over and 
over despite efforts to re-train.

True
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7. Click the Devices tab.

8. Click the Dictaphone PowerMic tab only if the provider is using a PowerMic. 
Otherwise, continue with Step 9 or Step 10, whichever is appropriate for the 
provider’s needs.

Note: All of the buttons on the Dictaphone PowerMic are configurable. Each 
drop-down list indicates the valid functions for each button. 

Actions you can assign to PowerMic buttons include: 

• Nothing: No action.

• Sign Report: Electronically sign the current report.

• Use deadman switch: Continue the action while the user holds the button down, stop 
when the button is released. 

• Deadman play audio: Plays recorded audio for as long as button is held
4
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• Toggle [action]: Begin the action when the user presses and releases the button. Stop 
the action when the user presses and releases the button again. Toggle items include 
Toggle dictation on off; Toggle play audio on off; Toggle rewind on off; Toggle 
microphone on off; and Toggle fast forward on off. 

• Toggle visibility: Toggles the application window (useful for single-workstation 
integrated PACS environments).

• Next field: Selects next field in reports that have multiple fields

• Previous field: Selects previous field in reports that have multiple fields

• Normal report: Creates and signs a normal report for the selected exam.

• New line: Inserts a new line into the report.

• New paragraph: Inserts a new paragraph into the report.

• Delete key: Deletes forward from current position.

• Delete last word: Deletes the last word dictated.

• Delete last utterance: Deletes the last group of words recognized (similar to the 
“scratch that” function).

• Save as draft: Saves current report to the draft folder.

• Transcribe: Convert the audio to text.

• Enter key: The key acts like the Enter key on the computer keyboard.

• Backspace: The key acts like the Backspace key on the computer keyboard.

• Next discrepancy: Highlights the next discrepancy located by the Assure consistency 
checker (which is a purchasable option).

• Previous discrepancy: Highlights the previous discrepancy located by the Assure 
consistency checker (which is a purchasable option).

• Correct report: Send report to an editor for transcription or editing

• STAT: Mark a report as STAT

• Sign as preliminary: Allows you to mark a report as Preliminary Sign.

• Next field or table cell: Assignable tasks that allow you to move to the next cell in a 
table that you have inserted into your report or AutoText.

• Previous field or table cell: Assignable tasks that allow you to move to the previous 
cell in a table that you have inserted into your report or AutoText.
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9. Click the Philips SpeechMike tab only if the provider is using a SpeechMike. 
Otherwise, continue with Step 10.

Note: All of the buttons on the Philips SpeechMike are configurable. Each drop-
down list indicates the valid functions for each button.
6



Chapter 6: Creating Provider, Transcriptionist/Editor, and Other Accounts
10. Click the Foot Pedal tab. (If the user does not have a foot pedal, skip this step, go to 
Step 11, and configure the Explorer Screen settings.)

Note: All of the buttons on the foot pedal are configurable. Each drop-down list 
indicates the valid functions for each button.

Notice that each button on the foot pedal can be configured for either an editor, an 
author, or both.
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11. Click the Explorer Screen tab.
8
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Refer to the following table to set preferences on the Explorer Screen tab.

Account 
Preference Definition Default

Enable Explorer 
Quick Search

Determines whether the Quick Search
section of the Explorer window is visible to 
providers. If not selected, the Quick Search
section is hidden from the specified user. Only 
administrators can access and change this setting.

True

Enable Explorer 
Browse

This drop-down box determines which sections of 
the Browse area in the Explorer window are visible 
to providers. You can choose:

• None: Hides the Browse section from the 
specified user

• Combination of one or more filters: Select 
individual filters to show to the user. Including 
one or more filters makes the Browse section 
visible to the specified user, showing only the 
filters you selected.All: Shows the Browse 
section and all its filters to the specified user

All

Barcode filter Enables the barcode filtering as configured by the 
administrator. Selecting this option activates the 
corresponding menu and toolbar button in the 
PowerScribe 360 | Reporting client application.

True

Enable batch 
signing

Select this check box to allow attending providers 
to sign several reports at the same time.

False

Detect accession 
length in search 
box

If you select this option, when the user enters an 
accession number in the Quick Search area, the 
system automatically begins the search when it 
receives the correct number of digits. This 
preference is applicable only if you have set the 
Accession Number Length preference to a value 
greater than zero. Automatic detection is not used 
when the Barcode filter preference (described 
above) is enabled. 

False

Show old resident 
drafts in My 
Reports

Allows attending radiologists to see (and sign) their 
residents’ drafts when they click the Drafts link in 
the My Reports section. This option helps ensure 
that a report is not lost if the resident does not 
complete it in a timely fashion. Attending providers 
can choose to show all resident drafts, or only those 
that are older than a certain number of hours.

Do not show

Show resident 
corrected reports 
in My Reports

Select this check box to show reports that were 
corrected by a resident and returned to the attending 
provider in the provider’s My Reports list.
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Show subscribed 
worklists only

Select this check box to show users only worklists 
to which they are subscribed.

False

Display addenda 
above report

If selected, displays addenda at the beginning of 
previewed reports. Previewed reports appear at the 
bottom of the Explorer window and in the Prior
Reports tab in the Report Editor window.

True

Account 
Preference Definition Default
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12. Click the Security tab.

Use the following table to assign preferences on the Security tab.

Account 
Preference Definition Default

Enable automatic 
log collection

Select this check box to enable the Collect logs 
feature automatically when the user logs off of the 
client application.

False

Enable application 
logging

Used for troubleshooting purposes, choose one or 
more selections from Disabled, Grammar Rules, 
Cursor Moves, Reco Mode Changes, Field 
Navigation, Report Workflow, Speech Session, 
Stray Toolbars, Performance, RAS, Microphone 
Button, or All.
With the Microphone Button item selected, events 
are written to the log file on DOWN, UP, and 
HOLD actions for each button. Events are logged 
for PowerMic, SpeechMike, and foot pedal devices.

Disabled
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Warn on logoff The software displays a warning message when the 
user exits the application or if the application is 
closed automatically. Choose from Never, Always, 
or If queue not empty.

Never

Block display of 
demographics

The patient’s Name and MRN appear as n/a, and 
are not displayed when the user views the report. 
(This option is usually activated for users with 
editor or technologist roles—assuming they do not 
need to see this patient information—so as to meet 
HIPAA requirements.)

False

Account 
Preference Definition Default
2
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13. Click the ACO/LMO tab.
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Use the following table to help you make your choices on the ACO/LMO tab.

14. When you have finished assigning preferences, click Save and Close.

Copying User Account Preferences

To copy preferences from an existing user account: 

1. Follow the procedure beginning on page 112 to create a new user, and modify the 
account preferences as needed. Or, edit an existing user’s preferences. When you have 
finished setting preferences, save your changes to the account. 

2. Begin creating another new user, or edit an existing user account.

3. On the Accounts tab, click Preferences.

The Account Preferences dialog box opens. 

4. In the Account Preferences dialog box, click Copy. The Copy Preferences dialog 
box opens.

5. From the drop-down list, select the name of the user whose preferences you want to 
copy. 

6. Click Copy. The preferences are copied to the user account you are creating or editing.

Account 
Preference Definition Default

Dragon LMO 
interval

Set the amount of time between language model 
optimizations, or select Disabled if you do not want 
to run LMO.

Daily

Dragon ACO 
interval

Set the amount of time between acoustic model 
optimizations, or select Disabled if you do not want 
to run ACO.

Weekly

ACO daily 
windows

Configure the time(s) during which you want the 
ACO to run.

None
4
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Auditing User Activity

The Accounts tab of the Setup group allows you to monitor activity by the users in your 
system. The Account Events window shows such activities as password changes, 
deactivation of users, and changes to preferences. 

LMO and ACO events appear in the Account Events window only when they are successful. 
Any failed LMO or ACO processes appear in the Exception tab in the Logs group. To see all 
activity on the Speech Utility Server, refer to the ACO/LMO tab in the Logs group.

Viewing the Audit Log
To view the audit log: 

1. Find the user account whose events you want to audit. Refer to Searching for Existing 
Users, beginning on page 169.

2. With the user account displayed, click Audit. The Account Events window opens, 
and displays all activity for this user.

3. If desired, select one or more criteria by which to filter the events list:
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• Select an event type from the Type drop-down list. The table below shows the 
available event types. 

Type Description

Create The account is added to the system.

Delete The account is removed from the system.

Change password The user assigns a new password to the account.

Change role The administrator modifies the role(s) that define this user’s system 
access. 

Log on The user signs on to the system. 

Log off The user signs off the system.

Activate The administrator reinstates an inactive account. Refer to page 171 for 
more information about activating and deactivating accounts.

Deactivate The administrator makes the account inactive. 

Reset speech The administrator performs a checkpoint restore (page 172). For this 
event, the Info column indicates whether the entire profile is restored, 
or just the acoustics. 

Checkpoint speech The user creates a checkpoint (backup of the current speech profile), or 
the system creates one automatically after the user performs training. 

Bad logon attempt The user entered an incorrect user name or password.

Change preferences The user or administrator changes one or more preferences that affect 
the account. 

Set speech to mock 
profile

The administrator creates a profile from the prototype (page 172). 

Delete speech profile The administrator removes the user’s profile (page 174). 

Set speech language The administrator assigns a language model to the account. 

Set speech acoustics The administrator assigns an acoustic model to the account. 

Delete speech acoustics The administrator selects Reset acoustics and retrain from the 
Roaming Profile menu. 

Optimize speech 
acoustics

The ACO process runs for the account. 

Optimize speech 
language

The LMO process runs for the account. 

Import speech 
vocabulary

The PowerScribe 360 | Reporting client application detects new words 
and adds them to the user’s profile.

Train speech The user used the train speech function.

Change Username An administrator changed the user name in a user’s profile.

Change Personal Info An administrator changed the personal information in a user’s profile.
6
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• Select a period of time from the Time Frame drop-down list. Or, to enter a date 
range, click Custom, select the start date from a calendar to insert it in the first text 
box. Then click the second text box and select an end date from the calendar. To 
revert back to choosing a time frame from a list, click List. 

• Select All, Admin, or Account from the Events drop-down list. If you select 
Admin, the search retrieves events caused by an administrator, such as a change to 
a preference, or the deactivation of a user account. 

Click Search to filter the events by your criteria. Only the events that meet your 
criteria are shown. 

If the search yields more than one page of results, click the page number at the bottom 
right corner of the grid to navigate to a specific page. To view the entire list, click the 
small down arrow at the right of the page number list. The arrow then reverts to an up 
arrow; click the up arrow to see the results one page at a time.

The table below describes each of the columns in the Account Events window. 

Change Admin Rights An administrator changed the Administrator rights in a user’s profile.

Change Sections An administrator changed the Sections information in a user’s profile.

Change Supervisors An administrator changed the Supervisors information in a user’s 
profile.

Change Specialties An administrator changed the Specialties information in a user’s 
profile.

Launch PowerShare 
study

The user accessed the PowerShare site to view a study.

Column Description

Time The time of day when the event occurred.

Realm The application that was running when the event occurred. 

Account The first and last name of the account owner. 

Administrator The administrator who acted on the account in the Administrator 
Portal, if applicable.

Workstation The identifier of the computer where the event occurred.

Type The event; for example, “Log off” or “Change password.” Refer 
to the table on page 165 for descriptions of the event types.

Info Information about the changes made. For example, if the event is 
a change to a user preference, this column shows the preference 
before and after the change. 

Type Description
167



16

PowerScribe® 360 | Reporting System Administrator Guide
Tip: Click on any column heading to sort the list; click the heading again to sort 
in reverse order.

Printing the Audit Log
You can send a copy of the audit log for a particular user to a printer on your network. 

To print the audit log:

1. With the audit log displayed, click Print this page…. A standard Print dialog box 
opens. 

2. Select the printer you want to use. To ensure that all the columns appear on the page, 
be sure to select landscape mode in the printer’s properties. 

3. Click Print. The log is sent to your printer. 

Duration The time it took to complete an acoustic or language model 
adaptation.

Audio The length of the audio used in an acoustic or language model 
adaptation. 

Text The number of characters in the text used in an adaptation. 

Log Contains a link to the zipped Dragon log for an adaptation.

Column Description
8
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Maintaining User Accounts

The Accounts tab in the Setup group allows you to search for and modify users, including 
their roles in the system. 

Searching for Existing Users

To display all existing users, 

Click the All link at the left of the alphabet.

To find users whose last names begin with a specific letter

Click one of the A through Z links.

To perform a filter search: 

1. Select one or more of the following criteria:

• Select a Site to find users at a particular site in the system.

• Select an option from the Authorization drop-down list to search by user role or 
whether the user is an administrator. 

• Select an option from the Status drop-down list to search for users by logon status, 
or whether the account is active or inactive.

2. Click Search. Any users who meet your criteria appear in the list. 

To search with the Look for field: 

1. In the Look for field, select Last Name, First Name, Email, Identifier, or 
Username.

2. Enter all or part of the text for which you want to search. 

Tip: In the Look for text field, you can use an asterisk (*) as a wild-card 
character. For example, if you do not know the exact last name of a provider but 
you know the name ends in the letters MAN, type *man and click Search.
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3. Click Search. Any users who meet your criteria appear in the list.

4. Click Reset to return all search fields (Site, Authorization, Status, and Look for) to 
their defaults.

Using the Results Area to View or Modify an Existing 
User

After you perform a search, the results appear below the search criteria.

To view the details of an account, click the user’s name in the Account column. The 
user’s information appears in the right side of the window.

Account Icons

The icons to the left of the account name identify whether an account has administrative 
rights (red icon ) or does not have administrative rights (blue icon ). A red circle 
with a white dash on an icon indicates an inactive account. For information on 
deactivating an account, refer to page 171. 
0
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Option Tabs for Users

Just above the user information portion of the window is a group of tabs that allow you to 
modify an existing user, or create a new user. These tabs are slightly different depending 
upon which of these two tasks you intend to perform.

Creating a New User

• Create New: Click this link after you’ve finished entering the information for a new 
user. (When the window refreshes, this tab becomes the Save Changes tab. In 
addition, the other dimmed tabs become active.)

• Clear: Removes the contents of the user information area. This link does not delete a 
user. It simply removes the information you’ve typed and allows you to begin again.

Modifying an Existing User

• Save Changes: Click this link after you’ve made changes to the user.

• Clear: Removes the contents of the user information area. This link does not delete a 
user. It simply removes the information you’ve typed and allows you to begin again.

• Delete: Deletes a user from the system. A dialog box containing the following text 
opens: Deleting this account will cause all its data, including its speech profile to 
be lost. Are you sure you want to continue? You can click either OK or Cancel.

• Password: Allows you to change or force a reset of the user’s password.

• Deactivate: Deactivates the user’s account. When clicked, this button changes to 
Activate, allowing you to reactivate the account if you choose to do so. Use 
Deactivate as an alternative to Delete to simplify system maintenance and preserve 
data integrity.

• Preferences: Opens the Account Preferences dialog box. (See Configuring Account 
Preferences, beginning on page 138.) 

• Audit: Opens the Account Events dialog box. From here you can view and print 
information about a user’s activities in the system. Refer to Auditing User Activity, 
beginning on page 165.
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Managing Speech Profiles
As administrator, you can use the Roaming Profile menu to: 

• Create a roaming profile for a user from a prototype, if one exists in your system. 

• Restore a user’s entire speech profile from a backup, or restore only the acoustic 
portion of the profile. 

• Reset the user’s acoustic model and begin training again.

• Delete a roaming profile.

Creating a Roaming Profile

You can assign a ‘dummy’ Dragon profile to a user who does not use speech recognition; 
with this profile, the user does not have to go through speech training on application 
startup. A prototype (trained) profile must exist in the Administrator Portal for this option 
to be available; this profile is put in place by Nuance personnel during system installation. 
(The folder where the prototype profile is located is: 
[DragonUserDirectory]\PS360_TrainedProfile.)

Note: You do not need to perform this procedure for transcriptionist/editor 
users; the ‘Transcriptionist’ language model is assigned to them by default at 
initial login. 

To create a roaming profile:

1. Find the user account in which you want to create the profile. 

2. Float your mouse cursor over the Roaming Profile link.

3. Select Create from Prototype. The profile is created in the user account.

Restoring a Profile

As administrator, you can overwrite a user’s current roaming speech profile with the last 
profile backup, or checkpoint. 

Every time a user performs training, or selects the Checkpoint Speech Files option from 
PowerScribe 360 | Reporting client application’s Speech menu, the software makes a 
backup of his or her speech profile. The system keeps only the most recent backup. If 
2
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necessary, you can restore the entire speech profile from the backup. Or, you can restore 
only the acoustic portion of the profile; use this option when you want to retain any 
vocabulary changes the user has made in the profile. 

To restore the entire speech profile:

1. Find the user account in which you want to restore the speech profile. 

2. Float your mouse cursor over the Roaming Profile link. 

3. Select Restore Checkpoint (Entire Profile). 

4. Click OK at the confirmation message. The profile is restored.

To restore only the acoustic portion of the profile: 

1. Find the user account in which you want to restore the speech profile. 

2. Float your mouse cursor over the Roaming Profile link. 

3. Select Restore Checkpoint (Acoustics Only). 

4. Click OK at the confirmation message. The acoustic portion of the profile is restored.

Resetting the Acoustic Model

As administrator, you can reset a given user’s acoustic model, while keeping intact any 
added, trained, or disabled words. You might take this action when there are enough 
recognition issues to warrant the user’s restarting the training process from scratch, but 
you want to retain any vocabulary changes the user has made. 

To reset a user’s acoustic model:

1. Find the user account in which you want to reset the acoustic model. 

2. Float your mouse cursor over the Roaming Profile link. 

3. Select Reset Acoustics and Re-Train. A confirmation message appears.

4. Click OK. The user is prompted to begin training again at the next login.
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Deleting a Speech Profile

You might need to delete a user’s speech profile if you want her to re-train without saving 
any added or trained words. If you use this option, the user is warned at the next login that 
a new profile will be generated, and will have to re-enroll. 

To delete a speech profile: 

1. Find the user account whose speech profile you want to delete. 

2. Float your mouse cursor over the Roaming Profile link. 

3. Select Delete Profile. A confirmation message appears. 

4. Click OK to delete the profile. 
4



Chapter 7

Profiles and Vocabulary
Management

Objectives
In this chapter, you will:

• Configure speech options

• Manage words in the system-wide vocabulary
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Speech Configuration Options

Overview of Speech Recognition
Speech recognition is a technology that interprets human speech patterns and converts 
them accurately into written text. The speech recognition process uses these files:

• The acoustic model (AM) represents how patterns of individual sounds are likely to 
occur in speech for an individual provider. 

• The language model (LM) represents the words providers are likely to say, how those 
words are pronounced, and how they are used. 

Tip: To increase accuracy for a user with a very strong accent, you can assign 
an accented acoustic model, preferably before the user trains. The appropriate 
accented model can help such users achieve better speech recognition. Models 
are now available for a variety of accents. Refer to page 115 for information on 
assigning an acoustic model to a user. 

Acoustic Optimization (ACO) is the process in which the system learns how the provider 
pronounces various sounds and modifies the provider’s acoustic model to increase 
recognition accuracy. It compares the dictation to the corrected speech-recognized text to 
improve overall speech recognition. 

Language Model Optimization (LMO) is the process in which the system analyzes signed 
reports, extracts words, and adds them to the language model. It improves speech 
recognition by identifying the words a provider says frequently.

What Qualifies a Report to Be Used for ACO?
All final reports with 30 seconds or more of audio will be used with the following 
exceptions:

• Specific words or phrases modified via keyboard correction are ignored.

• Specific words or phrases that are dictated over are ignored.

• Words or phrases entered or changed by a user other than the final author are ignored.

What Qualifies a Report to Be Used for LMO?
• Any final report with over 100 characters of text will be processed.

Assigning a System-Wide Acoustic Model
The system-wide acoustic model is the default for all sites and providers. You can 
override the default for a particular provider by assigning an acoustic model to the 
6
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provider’s account. Changing the system-wide acoustic model affects only users added to 
the system after the change. Jobs with multiple contributors, that is, jobs containing 
dictation by more than one provider, are not included in the acoustic optimization or 
language model optimization processes. 

To assign a system-wide acoustic model: 

1. In the Setup group, select the Speech tab. 

2. From the Acoustic Model drop-down list, select the appropriate acoustic model for 
the system.

3. Click Set as Default.

4. Click Save Changes. 

Assigning a System-Wide Language Model
The system-wide language model is the default for all sites and providers. You can 
override the default for a particular provider by assigning a language model to the 
provider’s account. Changing the system-wide language model affects only users added to 
the system after the change. Jobs with multiple contributors, that is, jobs containing 
dictation by more than one provider, are not included in the acoustic adaptation or 
language model adaptation processes. 
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To assign a system-wide language model:

1. In the Setup group, select the Speech tab. 

2. From the Language Model drop-down list, select the appropriate language model for 
the system.

3. Click Set as Default.

4. Click Save Changes. 

ACO and LMO Intervals
ACO and LMO run at the intervals you specify. You can set the intervals for the entire 
system and for individual users.

The current recommendations for ACO and LMO are as follows:

• ACO: At the system level, schedule the process to run weekly. 

Note: Some users who dictate more than they use AutoTexts might need to be set 
to run ACO more often; for example, every two days.

• LMO: At the system level, schedule the process to run daily. This job runs very 
quickly and does not consume many system resources.
8
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Scheduling ACO and LMO
Set the schedule for the entire system. Later, you can change the schedule for individual 
providers.

To schedule ACO and LMO for the system:

1. In the Setup group, select the System tab. 

2. Click Preferences, and then select the ACO/LMO tab. 

3. Set the Dragon LMO Interval to Every day. This should not be changed or disabled.

4. Set the Dragon ACO Interval to your preferred interval. The recommended setting is 
Weekly. 

5. Click Save and Close.

To schedule ACO and LMO for an individual provider:

1. In the Setup group, select the Accounts tab. 

2. Select the provider whose optimization schedule you want to modify. 

3. Click Preferences, and then select the ACO/LMO tab. 

4. Set the Dragon LMO Interval to your preferred interval. It is recommended that you 
leave this setting at Every day. 

5. Set the Dragon ACO Interval to your preferred interval. 

6. Click Save and Close.

Monitoring ACO and LMO Activity
If a dictator complains about recognition, you can monitor ACO and LMO by viewing the 
dictators profile.

To view a user’s LMO and ACO activity: 

1. In the Setup group, select the Accounts tab. 

2. Select the provider whose LMO and ACO activity you want to view. 
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3. Look at the lower-right portion of the user’s profile screen. You can see the last time a 
user went through ACO/LMO.

Note: Depending on the user’s dictation style (they do not add words, or add 
spoken / trained forms of words), they may not run ACO and /or LMO regularly.

If you are concerned about ACO for a user, you can force ACO to run to confirm that there 
is no technical issue, using the following steps:

1. Open the user’s vocabulary editor.

2. Search for the word tomato (you can use any other word you wish).

3. If there are multiple entries for the same word or phrase, delete any additional entries 
that have been added, which can be identified by a plus sign + next to them.

4. Select the word tomato from the vocabulary and add a spoken form for the word. A 
spoken form is how the word sounds when the user speaks it. (For example, tomato 
can be “ta mate oh” or “to mot oh” depending on the speakers accent.)

5. Click the Train button and have the user speak the word (usually twice) until the little 
LED flashes green.
0
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6. Click OK to close the vocabulary editor.

7. Check the user’s profile in 24 hours to verify if ACO has run.

Note: If you have a concern about a user who is not running ACO or LMO, contact your 
system administrator or open a ticket with Nuance support.

Vocabulary Management

Adding custom words to your language models can improve speech recognition. Custom 
words might include place names, or the names of drugs or persons. For example, if a new 
drug comes on the market, you can add the drug name to all the language models in your 
system. Adding words at the system level eliminates the need for providers to add the words 
themselves. 

You can add individual custom words or import a list of words from a file. Importing words 
saves time when you have many words to import, or when you need to add the same words to 
more than one language model. You can also delete one or more words. Adding or deleting 
words from one language model does not affect the others. 

Adding Custom Words
Follow the procedure below to add one or more words to a language model. 

To add custom words:

1. In the Setup group, select the Speech tab. 

2. Select the language model to which you want to add the word(s).

3. Click Add.
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The Add Word dialog box opens.

4. In the Word field, type the word or phrase you want to add. 

5. If desired, spell the word phonetically in the Spoken Form field. That is, spell the 
word the way it sounds. This helps the speech software to recognize the word when it 
is dictated. You might want to provide a spoken form for a word that is frequently 
being mis-recognized, or for a name with an uncommon spelling.

Note: The combined length of the Word and Spoken Form fields cannot exceed 
127 characters.

6. Click Save. The word or phrase is saved in the selected language model, and appears 
in the list along with the date and time it was added.

Importing Custom Words
You can import custom words from a text file. Use one word per line; use a back slash to 
separate a word from its optional spoken form. You can specify more than one spoken 
form for a word. For example:
2
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To import words:

1. In the Setup group, select the Speech tab. 

2. Select the language model into which you want to import the words.

3. Click Import.

The Import Words dialog box opens.

4. Click Browse.

5. Navigate to and select the file you want to import. 

6. Click Open. The file name and path appear in the Choose file field.
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7. Click Import. 

8. If you attempt to import a spoken form for a word that is already in the system with 
another spoken form, you see a warning message.

 a. Select an option: 

• None: Do not add the new spoken form.

• Add: Add the new spoken form. 

• Replace: Discard the existing spoken form, and add the new one in its place.

• Skip: Do not add the word. 

 b. Click Import to continue 

OR

Click Add All, Replace All, or Skip All. 

The words in the file are imported into the selected language model, and appear in the 
list. Any words already in the language model are skipped, unless you are adding a 
new spoken form. 

A message box indicates the number of words added and skipped.
4
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Searching for Words
Follow the procedure below to search for a custom word in a language model. 

To search for a word:

1. In the Setup group, select the Speech tab. 

2. Select the language model. 

3. To see all the words in the selected language model, click All. 

OR

Select a letter in the alphabet to see words beginning with that letter. 

OR

Use any of the search criteria to find the word: 

• In the field to the right of Word Actions, type all or part of the word or its phonetic 
spelling. 

• From the Time Frame field, select the period of time in which the word was added, 
if you know it. Or, click Custom and enter a specific date range. 

• If you know which administrator acted on the word, select the Administrator from 
the drop-down list. 

• From the Word Actions drop-down list, select All to see all words, select 
Additions to see words that were added, or select Deletions to see words that were 
deleted.

4. Click Search. Any words that meet your criteria appear in the list at the right. You can 
click on the Word, Spoken Form, or Date heading to sort the list by the selected 
column; click the column heading again to reverse the sort order.
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Deleting Words
To delete one or more words:

1. In the Setup group, select the Speech tab. 

2. Find the word you want to delete, using the procedure above.

3. Place a check mark next to the word(s) you want to delete. 

4. Click Delete. A confirmation message appears.

5. Click Yes to remove the word from the selected language model. A message indicates 
the number of words deleted.

6. Click OK. The word is removed from the language model, and appears crossed out in 
the list. 
6



Chapter 8

Working with
Procedure Codes

Objectives
In this chapter, you will: 

• Define the purpose of Procedure Master 
Translators (formerly known as ChargeMasters)

• Illustrate the importance of mapping procedure 
codes to modality and body regions.

• Create a sample Procedure Master Translator

• Demonstrate importing a Procedure Master 
Translator

• Demonstrate making changes to your imported 
Procedure Master Translator
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Introduction to Procedure Master 
Translators

In this chapter we will examine what Procedure Master Translators (formerly known as 
ChargeMasters) are used for in PowerScribe 360 | Reporting, as well as the diagnostic coding 
options available within the system, including ICD-9 and ICD-10. 

Your PowerScribe 360 | Reporting system uses imported procedure codes, along with 
modality and anatomy (also referred to as body region) mapping information in many areas. 
For example: 

• In the AutoText Categories dialog box, where you assign procedure codes to an AutoText 
entry, you search for procedure codes by modality and anatomy. The mapped data causes 
the codes to appear correctly in the Procedures list for the data you choose here. 

• Browse functions when logged into the client. Categories include Modality, Body Region 
and Sections (which are your modalities in the system).

• You can create Worklists to pull specific search criteria including: modality, body region, 
and or specific procedure codes. For example, a worklist could include a request to “show 
me all CT scans of the brain.”

• When you set up peer review (purchasable option), you select the modalities and intervals 
for the peer review process. The code and mapping data causes the modalities to appear 
correctly in the list. 

• When you create custom fields, you need to associate the fields with the appropriate 
procedure codes where applicable. In the Procedure Code selection dialog box, the 
correct display of codes, modalities, and anatomies depends on the procedure code data 
you imported and mapped.

Note: Your organization is responsible for ensuring that the modalities and anatomies are 
mapped correctly in PowerScribe 360 | Reporting. 

About the PowerScribe 360 | Reporting Database
When your system is installed, modalities and anatomies (pre-determined by Nuance) 
already exist in the database. If the pre-determined modalities are not what you are 
currently using, you can use Sections to accurately depict what your organization uses for 
modalities. The Nuance modalities will always be used to determine AutoText mappings 
and peer review mappings. You can, however, use sections in worklists or to run a query. 

For your procedure code, you can map more than one Nuance modality or Nuance 
anatomy. For example, for your procedure code ABC123, you can categorize abdomen 
and pelvis as the body regions, and CT and CTA as the modalities. 
8
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Using Procedure Master Translators to 
Maintain Your Database

You can provide either of the following two options to your Nuance representative for 
your Procedure Master Translator.

Option 1
If you are accustomed to maintaining a typical Procedure Master Translator in which 
clinical codes are used as the translator between your procedure codes and the database's 
modalities and anatomies, your Procedure Master Translator will include the following 
columns (the first three columns typically come from the billing system or RIS/HIS):

• Procedure code: The code that drives your order.

• Procedure code description: The description that is listed on the order for the 
procedure code.

• Modality: Can be a copy of the Section column (see below).

• Section: The modality that your facility recognizes. For example, the PowerScribe 
360 | Reporting system uses Radiography for x-rays; your system might use CR.

• Anatomy: We need this information from your system. In case the conversion does 
not have a direct match, this assists with ensuring the match.

• CPT Code: The clinical codes that might already be used in your billing system. If 
possible, retrieve an export of those codes.

• Mammo: Place a YES or NO in this field.
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Note: Once you have created the spreadsheet, email it to 
diagnosticproservices@nuance.com. An Optimization Consultant will work with you to 
ensure that your Procedure Master Translator is ready for importing.

To create the Procedure Master Translator, begin by exporting the procedure codes from 
your own billing or RIS system. Refer to your RIS system’s documentation for 
information on how to export the codes. Be sure to export them in the form of an Excel 
spreadsheet (.xls format). The columns in the spreadsheet can be in any order from left to 
right. You do not need to include a row of column headings, but these are helpful. Any 
empty rows will be ignored; you do not need to delete them. 

The following illustration shows an example of an Excel spreadsheet containing the data 
exported from a RIS system:

The MAMMO column is an optional fifth column if you intend to use the database's built-
in BI-RADS codes. 

Note:  If you have multiple clinical codes for one line item, place them in the same cell, 
using a comma to separate them. 
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Option 2
If you will be creating a Procedure Master Translator from scratch, your Procedure Master 
Translator will be a mapping of your procedure codes directly to modality and anatomy 
categories within the database. Your Procedure Master Translator will include the 
following columns: 

• Procedure Code

• Procedure Description

• Section

• Modality (select from the modality category list provided by Nuance)

• Anatomy (select from the body region category list provided by Nuance)

Note:  If the modalities or anatomies are different from what is displayed in the Nuance-
provided list, your Procedure Master Translator will fail to import properly. 

In this scenario, a procedure code, a procedure description, and a section are present. 
However, you must identify a modality and anatomy for each procedure code based on the 
PowerScribe 360 | Reporting database. Select appropriate modalities and anatomies from 
the category lists provided by Nuance.

Note: If you have multiple anatomies and modalities for one line item, place them in the 
same cell, using a comma to separate them. 
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Additional Information for Both Options
You can include the following information (by creating additional columns in your 
Procedure Master Translator) whether you used either Option 1 or Option 2:

• Relative Value Units (RVUs)

• Diagnostic Codes (ICD-9 or ICD-10)

Assign RVUs

You have the option of assigning professional, technical and global RVUs to each of your 
procedure codes for display in the radiologist's dashboard. 

To assign RVUs:

• Add the columns Prof RVU, Tech RVU and Glob RVU to your Procedure Master 
Translator. Each value must be a decimal number with up to 3 places to the left and 
two places to the right of the decimal point. 

Note: Providers can see the quota values in the client application dashboard (if a quota is 
set in the administrator preferences).

Diagnostic Codes

For information on adding diagnostic codes to your PMT, see Map Procedure Codes to 
Diagnostic Codes, beginning on page 212.
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Importing the Procedure Master 
Translator

After creating your Procedure Master Translator, your Nuance Optimization Consultant must 
approve it and then guide you through the importing process. Schedule an appointment with 
your Nuance Optimization Consultant to perform these two tasks. 

Please do not import your initial Procedure Master Translator on your own. Your 
project manager will set up a call to work directly with a Nuance Optimization 
Consultant to ensure that the Procedure Master Translator is imported accurately. 

The following directions are provided so that you understand the import process, especially 
for future importing of updated or new procedure codes. 

To import a Procedure Master Translator: 

1. In the Setup group, click the Procedures tab. 

2. Click the Import link. The Procedure Code Import dialog box opens.

3. Select the appropriate site from the Site drop-down list. 
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4. Click Browse. Navigate to and select the Procedure Master Translator file you want to 
import, and click Open. The path and file name appear in the File to import text box.

5. If your Procedure Master Translator file contains a heading row with column names, 
select the First line of import data includes column headings check box. 

6. Click Next to continue. The dialog box displays: 

• The number of codes the software found in the Excel spreadsheet

• The name of each column, along with a sample of that column’s contents. 

Note: If your Procedure Master Translator has a heading row with column 
names, the software uses these names. Otherwise, it uses the Excel identifier for 
the column name; for example, F6 
4
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• A drop-down list where you will indicate how you want the software to map the 
contents of each column during the import.

7. From each drop-down list in the Mapping column, select 
the name of the PowerScribe 360 | Reporting database 
column to which the software is to map the corresponding 
Procedure Master Translator column. For any column in 
your Procedure Master Translator that is not to be 
processed, select Skip Column. 

Note: Somewhat counter-intuitively, both Anatomy and 
Modality must be mapped to the Category selection in the drop-
down list. In addition, for Clinical Code or CPT Code, select 
Skip Column. 

Mappings List
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8. Click Next. This dialog box shows the default options you can use to control how the 
software handles the procedure codes you are importing.

9. In the Procedure code identification section, select Use code to match procedure 
codes.

10. In the Un-mapped procedure code action section, select Create new procedure 
code. 

11. In the Update Actions section, do not select any of the options for an initial import of 
your Procedure Master Translator.

The table below explains the Update Actions options.

Update Action Description

Update procedure code data
Updates only the description. It would not update 
the code; it would create a new entry.

Clear existing category 
mapping before import

Category mapping includes both the body region 
and modality mapping in the Nuance system.

Clear existing section mapping 
before import

Section mapping is cleared from procedure code to 
the section.

Clear existing diagnosis code 
mapping before import

Diagnosis coding mapping would be from procedure 
code to diagnostic code mapping.
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12. Click Import. The system imports the data from your Procedure Master Translator 
into the database. When it has finished, it displays a report like this one:

The Number of import errors/warnings appears in the bottom row of the report. 
Click View to see the errors/warnings. Warnings are typically duplicate messages, 
meaning that the code or section was mapped previously, whereas an error truly is an 
error or something did not exist.

Note: If you are unsure about the significance of an error or warning, contact 
your Nuance representative.

13. Click Close. 
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Using Procedure Master Translators to 
Add or Modify Codes

In most cases you do not need to add individual procedure codes to your system because they 
are added automatically as new orders are received through HL7. But if you find a need to do 
so, or if you have a need to modify procedure codes, there are two methods available to 
accomplish this:

• Create a new mini-Procedure Master Translator

• Manually manipulate the procedure codes in the system

Method 1: Create a New Mini-Procedure Master 
Translator
One method for adding and mapping new procedure codes in the database, or modifying 
procedure codes that have changed since the initial import, is to create a new Procedure 
Master Translator containing only your new or changed codes (referred to as a mini Procedure 
Master Translator), as shown in the image below.

This mini Procedure Master Translator is then imported into your database.

Note: Once you create this spreadsheet, you must send it to a Nuance representative at 
diagnosticproservices@nuance.com so that they can convert the clinical codes to 
modalities and anatomies. 

Tip: To avoid requesting a Nuance representative from converting the file, delete the 
Clinical Code column and add two new columns, one for the Nuance Modality and one for 
the Nuance Anatomy. (Requires that the modality and anatomy names appear exactly as 
they do in the Nuance database. Refer to the Modality and Anatomy Tables, beginning on 
page 625 of this guide for exact naming conventions.)

To use a Procedure Master Translator to add or modify codes: 

1. Create a new, mini Procedure Master Translator containing only the procedure codes 
you want to add or change, as in the example below.
8
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2. Begin the procedure for importing a Procedure Master Translator beginning on 
page 193. 

3. In the Update Actions group box, select the first three Update check boxes.

4. Click Import to complete the update procedure. The number of updated items is 
displayed. 
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Method 2: Manually Manipulate Procedure Codes

Create Procedure Codes

The steps below show the second method for adding or modifying procedure codes:

To create a procedure code:

1. In the Setup group, select the Procedures tab. 

2. Click the New link. The Edit Procedure dialog box opens. 

Note: Both the Site and Code fields are required (indicated by bold text titles).

3. Select the appropriate site from the Site drop-down list. 

4. In the Code field, enter the new procedure code.

5. Fill in the information for the remaining fields (Description, Mammography check 
box, and RVU information) if any are required for this site.

6. When finished, click Save.
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Edit Procedure Codes

If there are changes to one of your facility’s procedure codes, or to a small number of 
them, you can edit the codes manually in the PowerScribe 360 | Reporting Administrator 
Portal rather than importing a Procedure Master Translator. For example, you might need 
to change the description associated with a single code.

To edit a procedure code: 

1. In the Setup group, select the Procedures tab.

2. Search for the code you want to edit. To narrow your results, use the search filters in 
the left portion of the window: 

• Site: From this drop-down list, select one or more sites.

• Categorization: Choose Uncategorized, No Modality, No Anatomy, or All.

• Mammography: Choose Set, Not Set, or All. 

• Global RVU: Choose Set, Not Set, or All.

• Usage: Choose Never, At least once, or All.

• Look for: Type the first few letters of the procedure code, followed by an asterisk * 
(which acts as a wild-card character).

Note: These filters are additive, which means that if you select an item from 
more than one filter, both (or all) of the criteria will be considered, possibly 
reducing the number of results.

• Modality and Anatomy lists: These two areas are separate from the filters 
mentioned above and have their own Search button. Make one or more selections 
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to locate the procedure you want to edit. As shown in the note above, both these 
lists are additive as well.

3. Click the Search link. The codes that meet your criteria appear in the list.

4. Click the check box to the left of the code that you want to edit.

5. Click the Edit link. The Edit Procedure dialog box opens.

6. Make the necessary changes to the code, description, or both. Select or clear the 
Mammography check box, and add RVU information, as applicable. (Note that the 
Code field is the only required field.)

7. Click Save to save your changes. 
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Delete Procedure Codes

1. Search for one or more procedure codes. (Follow steps 1 through 3 shown in Edit 
Procedure Codes, beginning on page 201.)

2. From the search results list that appears, select the code, or codes, that you want to 
delete.

3. Click the Delete link. The Delete Procedures dialog box opens.

4. Click Delete to delete the code, or codes. Note that if the procedure code is associated 
with an order, it cannot be removed.
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Categorize and Uncategorize Procedure Codes

If you need to categorize, uncategorize, or re-categorize only a few codes, you can select a 
code through the PowerScribe 360 | Reporting Administrator Portal and categorize it 
manually. 

Categorize Procedure Codes

To categorize procedure codes: 

1. Search for one or more procedure codes. (Follow steps 1 through 3 shown in Edit 
Procedure Codes, beginning on page 201.)

2. From the search results list that appears, select the code, or codes, that you want to 
categorize. 

Note: Select more than one code to assign the same modality and anatomy to 
multiple codes.

3. Click the Categorize link. The Anatomy/Modality Assignment to Procedure dialog 
box opens.

4. Make your selections from the Modality and/or Anatomy drop-down lists. (These 
lists are quite extensive; use the scroll bar to move through the entire list.)
4
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Note: The items in the Modality and Anatomy lists come from the PowerScribe 
360 | Reporting system.

5. When finished, click Save to save your changes.

Uncategorize Procedure Codes

To uncategorize a procedure code: 

1. Follow the steps shown above to locate the code you want to uncategorize.

2. Select the code and click the Uncategorize link. The Uncategorize Procedures dialog 
box opens.

3. Select the Modality, Anatomy, or both check boxes to uncategorize.

4. When finished, click Save to save your changes. A message opens confirming that the 
uncategorize was successful.
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Another way to uncategorize a procedure code:

1. Search for one or more procedure codes. (Follow steps 1 through 3 shown in Edit 
Procedure Codes, beginning on page 201.)

2. From the search results list that appears, locate the code that you want to uncategorize. 

3. Click the red X in the Modality or Anatomy column. 

4. At the message box that opens, click OK to uncategorize the modality or anatomy, 
depending upon what you selected. The message box describes the action that will be 
taken if you click OK. (See example below.)

5. At the successful uncategorizing message box, click OK.
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Export Procedure Codes, Diagnosis Codes, Anatomy/Modality, 
and Section Data

Use the Export link to send a site’s procedure code, diagnosis code, anatomy/modality, 
and section data to an Excel spreadsheet. You can use the spreadsheet to import this 
information into another site, or just keep it for reference purposes.

To export procedure codes and other data: 

1. In the Setup group, select the Procedures tab.

2. Click the Export link.

The Export Procedures dialog box opens.

3. From the Site drop-down list, select the site whose data you want to export.
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4. From the Content drop-down list, select the type of data you want to export from the 
site you selected to an Excel spreadsheet. Choose one of the following selections:

• Procedures

• Procedures and Anatomy/Modality, Section Mappings

• Procedures and Diagnosis Code Mappings

• Procedures and Anatomy/Modality, Section, Diagnosis Code Mappings

• ICD-9 Diagnosis Codes

• ICD-10 Diagnosis Codes

5. After making your selection, click Export. A standard Windows Save/Open bar opens 
at the bottom of the window.

• Save: Saves the file to your Windows Downloads folder.

• Save As: Opens a standard Windows save dialog box from which you can select a 
location to save the file.

• Save and Open: Saves the file to Downloads and opens the file in Excel for 
viewing.

• Open: Opens the data file in Excel as a comma separated values (CSV) file. The 
content of the file is determined by the selection you made in the Content drop-
down list. An example of exporting the Procedures content selection is shown 
below.
8
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Exploring Diagnostic
Coding

Objectives
In this chapter, you will: 

• Define workflow diagnostic coding options in 
PowerScribe 360 | Reporting.

• Managing diagnostic codes in PowerScribe 360 
| Reporting.

• Demonstrate configuration of coding according 
to workflow diagnostic coding requirements.

• Demonstrate using the diagnostic coding in the 
client.
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Introduction

PowerScribe 360 | Reporting comes with both the ICD-9 and ICD-10 code sets installed in its 
database. Administrators can decide which version to install on a site-by-site basis. 

Diagnostic Coding in Reporting
Diagnostic coding allows administrators to:

• map procedure codes to diagnostic codes, 

• add codes to the system, 

• deactivate codes, and/or

• change the code descriptions.
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Workflow

PowerScribe 360 | Reporting allows both radiologists and residents to enter diagnostic 
codes. The workflows for each type of user are shown below.

Radiologist Workflow

Resident Workflow
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Map Procedure Codes to Diagnostic 
Codes

PowerScribe 360 | Reporting is installed with a master set of both the ICD-9 and ICD-10 
diagnostic codes. Each of your procedure codes can be mapped to diagnostic codes to 
specify valid diagnoses for those procedures. 

To map procedure codes to diagnostic codes:

1. Add the columns ICDCode and ICDDesc to your Procedure Master Translator. 

2. Add the diagnostic code information for the procedure codes as needed.

Note: If you have multiple diagnostic codes for one line item, place them in the same cell, 
using a comma to separate them. 

3. Save your spreadsheet.

4. Log in to the PowerScribe 360 | Reporting Administrator Portal.

5. Click Setup > Procedures > Import.

6. Select the appropriate site.

7. Browse for the spreadsheet file you created in steps 1 through 3 above.

8. Click Next.
2
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9. From the Mapping drop-down lists, select the item that matches your column heading 
name. See the illustration below for an example.

10. Click Next.

11. Click Import.
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12. At the results screen, review the summary and click Close.
4
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Import Diagnostic Codes

To import diagnostic codes: 

1. Create a spreadsheet that contains two columns: ICDCode and ICDDesc.

2. Add the ICD codes and the descriptions for those codes.

3. Save your spreadsheet.

4. Log in to the PowerScribe 360 | Reporting Administrator Portal.

5. Click Setup > Procedures > Import.

6. Select the appropriate site.

7. Browse for the spreadsheet file you created in steps 1 through 3 above.

8. Click Next.

9. From the Mapping drop-down lists, select the item that matches your column heading 
name. See the illustration below for an example.

10. Click Next.
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11. Click Import.

12. At the results screen, review the summary and click Close.
6
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Deactivate Diagnosis Codes

To deactivate diagnostic codes: 

1. Create a spreadsheet that contains two columns: ICDCode and Deactivate.

2. In the ICDCode column, enter the diagnosis codes you want to deactivate. 

3. In the Deactivate column, enter the word TRUE.

4. Save your spreadsheet.

5. Log in to the PowerScribe 360 | Reporting Administrator Portal.

6. Click Setup > Procedures > Import.

7. Select the appropriate site.

8. Browse for the spreadsheet file you created in steps 1 through 4 above.

9. Click Next.

10. From the Mapping drop-down lists, select the item that matches your column heading 
name. See the illustration below for an example.

11. Click Next.
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12. Click Import.

13. At the results screen, review the summary and click Close.
8
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Diagnostic Coding Configuration

Configuring diagnostic codes is a two-step process: 

1. Import diagnostic codes linked to procedure codes (optional)

2. Set your diagnosis coding preferences

Note: Notice that step one above is optional: Administrators can choose not to link the 
facility’s procedure codes to the diagnostic codes. However, this forces providers to 
search for the diagnostic codes they require for their reports. If an administrator does 
perform this step, the appropriate codes are available to the provider, based upon the 
procedure that is being reported on.

Step 1: Import Diagnostic Codes Linked to 
Procedure Codes (Optional)

Nuance uses a conversion tool to convert your Procedure Master Translator so that it 
includes your procedure codes. The conversion also provides a suggested diagnosis 
code to which the procedure code could be mapped. 

Note: Nuance has a list of suggested procedure code to diagnostic code 
mappings. This is a select list; it does not provide a mapping for every code.

If you want to perform these mappings, you must provide an import file in a specific 
file format. The illustration below shows an example of the file format and column 
headings required from our customers to allow Nuance to use the conversion tool.
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The illustration below shows an example of the worksheet Nuance returns to the 
customer after using the conversion tool.

Step 2: Set Your Diagnosis Coding Preferences
The diagnosis coding preferences described in this section can be set at either the 
System or Site level:

• If these preferences will be system wide, log in to the PowerScribe 360 | Reporting 
administrator portal and click Setup > System > Preferences > Workflow.

• If these preferences will differ from site to site (assuming your facility has multiple 
sites), log in to the PowerScribe 360 | Reporting administrator portal and click 
Setup > Site (select a site) > Preferences > Workflow.
0



Chapter 9: Exploring Diagnostic Coding
The illustration below shows an example of the System version of the diagnosis 
coding preferences. 

The following table describes the options for these preferences.

Setting Description Default

Diagnosis coding 
system

Select which diagnostic coding system to use. Choices are 
ICD-9, ICD-10, or Disabled. 

Disabled

Diagnosis coding at 
preliminary signoff

Controls whether PowerScribe 360 | Reporting requires 
diagnosis coding when a resident approves a report. 

Note: This preference does not apply when an 
attending saves a report as preliminary.

• Do not perform: Diagnosis coding is not invoked at 
preliminary signoff.

• Do not require codes: Diagnosis coding is invoked, if 
not already set for all the accessions of the report, but 
the user is allowed to cancel without assigning codes.

• Require codes: The report cannot be approved unless 
at least one code is entered for each order in the report. 

Note: This setting may override the behavior of 
the Diagnosis coding at final signoff preference as 
noted below.

Do not perform
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Diagnosis coding at 
final signoff

Controls whether PowerScribe 360 | Reporting requires 
diagnosis coding when the Attending provider signs a final 
report. 

Note: This setting is ignored if the Diagnosis 
coding at preliminary signoff preference is set to 
Require codes and at least one code is not entered 
for each order in the report. That is, if coding is 
required at preliminary signoff, but the report was 
not approved by a resident, coding will be required 
at final signoff regardless of the setting of this 
preference.

• Do not perform: Diagnosis coding is not invoked 
at final signoff. 

• Do not require codes: Diagnosis coding is 
invoked, if not already set for all the accessions of 
the report, but the user is allowed to cancel 
without assigning codes. 

• Require codes: The user cannot sign the report 
without entering one or more codes for each order 
in the report. 

Note: If codes were entered by the Resident, this 
setting will cause diagnosis coding to be invoked 
so that the Attending can review the codes entered 
by the Resident.

Do not perform

Setting Description Default
2
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Using Diagnostic Coding in the Client

This section shows providers how to use mapped diagnosis codes and non-mapped 
diagnosis codes.

Diagnosis Coding with Imported Mappings
If your organization has imported mappings for diagnosis codes, a short list of possible 
diagnosis codes is displayed for you to select from, as shown in the example 
illustration below.

1. After signing a report, the Diagnosis Codes dialog box opens.

2. Make sure that the Restrict to exam codes check box is selected. Selecting this 
check box limits the codes that are presented to the ones that are mapped to 
procedure codes.

3. From the search results list, select the check box next to the diagnosis code you 
want to use. The code then appears in the Selected Codes area of the window.

4. When finished, dictate “OK” to close the Diagnosis Codes window.
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Diagnosis Coding without Imported Mappings
If you did not import diagnosis code mappings, you will have to perform a search for 
the correct diagnosis code, as illustrated in the example below.

1. After signing a report, the Diagnosis Codes window opens.

2. With your mouse cursor in the Search field, dictate the code you want to add.

3. Dictate “Search.”

Note: The Restrict to exam codes check box must be cleared. If this box is 
selected, it limits the codes that are presented to the ones that are mapped to 
procedure codes. Once this box is cleared, you can do a partial search and 
select the codes you would like to incorporate. 
4
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4. From the search results list, select the check box next to the diagnosis code you 
want to use. The code then appears in the Selected Codes area of the window.

5. When finished, dictate “OK” to close the Diagnosis Codes window.
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Chapter 10

Provider Training—
Introduction and

Pre-Enrollment

Objectives
In this chapter you will:

• Demonstrate using the microphone and its 
proper positioning.

• Define the purpose of audio setup and reason for 
re-running it.

• Set expectations for reading the training screens

• Do not dictate punctuation marks or 
paragraph breaks

• Do not dictate capital for acronyms. 

• Do not dictate slashes or dashes for dates 
(Demonstrate all methodologies)
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Using Your Microphone

You can use PowerScribe 360 | Reporting with either a headset or a hand-held microphone. A 
headset is more practical if you dictate for long periods of time, or if you are in an 
environment that is not conducive to holding a microphone in your hand, such as pathology.

Note: If you use more than one microphone, you must perform the audio setup and general 
training steps (shown later in this section) for each device.

Types of Microphone Supported
• PowerMic II

Note: PowerMic II requires a USB 2.0 port; USB 3.0 ports are not currently 
supported.

• Philips SpeechMike

Note: The Philips SpeechMike requires a driver that must be installed before 
you plug the microphone into your computer. Either install the driver from the 
CD that came with the Philips microphone, or download it from the Philips Web 
site. 

Connecting the Headset or Handheld Microphone

USB Microphones

USB microphones do not connect to a sound card. If 
you have a USB microphone, plug it into one of your 
computer’s USB ports. If you experience trouble 
plugging in your USB device, follow the instructions 
that came with it.

Microphone Jacks

Microphone jacks are located on your computer, sound 
card, or monitor. Consult your computer documentation if you need help locating your 
microphone jack.
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Positioning a Handheld Microphone
To position your handheld microphone 
correctly for optimal speech recognition:

1. Hold the microphone in a comfortable 
position. Be sure not to hold it in an 
awkward, tiring position.

2. Point the microphone head close to and 
directly in front of your mouth.

3. Hold the microphone consistently every 
time you use it.

4. Do not use a microphone stand or holder because it will be harder to keep a consistent 
position and the stand could conduct noise.

5. Do not dictate into the side of the microphone.

Positioning a Headset 
Microphone

To position your headset microphone 
correctly and consistently for optimal 
speech recognition:

1. Adjust the headset so that it fits 
comfortably on your head.

2. Move the microphone element to 
the side of your mouth to avoid noise from breathing (about a thumb’s width from the 
side of your mouth).

3. Confirm that the front of the microphone points toward the side of your mouth. The 
front of the microphone might be indicated by a colored dot, or some other label.
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Using a Headset with the PowerMic II Microphone
Nuance sells the VXi TalkPro USB1 Computer USB Headset - Monaural for use with 
PowerScribe 360 | Reporting. 

MFG. P/N Nuance P/N Description

VXI 203008 5000078-001 HEADSET WITH MICROPHONE, USB1

The above headset will work as an input device for PowerScribe 360 | Reporting when 
used either standalone or in conjunction with a PowerMic II microphone.

Any headset attached to the VXi x100 or x200 audio adapter will support the PowerMic 
II/Headset combination.

Regarding the VXi X100 or X200 USB adapters, the V, P, and G series refer to the type of 
quick disconnect that attaches to the different headsets.

X100 USB Adapters 

X100-V USB Adapter (202926) - Compatible with VXi V-series, TalkPro SP or TuffSet headsets 

X100-P USB Adapter (202927) - Compatible with VXi P-series or Plantronics headsets 

X100-G USB Adapter (202928) - Compatible with VXi G-series or GN Netcom/Jabra headsets

X200 USB Adapters 

X200-V USB Adapter (202930) - Compatible with VXi V-series, TalkPro SP or TuffSet headsets 

X200-P USB Adapter (202931) - Compatible with VXi P-series or Plantronics headsets 

X200-G USB Adapter (202932) - Compatible with VXi G-series or GN Netcom/Jabra headsets
0
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Logging On and Logging Off

You can start the PowerScribe 360 | Reporting application from an icon on your desktop, or in 
some installations, from within a PACS system. 

To log on to PowerScribe 360 | Reporting: 

1. Double-click the Nuance PowerScribe 360 desktop icon (shown 
at right). 

2. Type the user name and password provided by your administrator. 

3. If this is your first login:

• Depending on your system configuration, you might be prompted to change your 
password on your first login. Type the new password in both fields and then click 
OK. 

• You are prompted run the Audio Setup Wizard to create your speech files (shown 
later in this section)

4. If you have more than one role at this site (for example, if you are both a resident and 
an attending physician), you are prompted to specify the role you want to use for this 
session. Select the role and click OK. 

There is a short delay while the speech files are loaded onto your workstation. Once 
they have been loaded, the Nuance PowerScribe 360 | Reporting window opens. 

To log off:

• To log out and close the application completely, click on the X (close window icon), in 
the upper right corner of the application, or select File > Exit from the menu bar.

OR

• To log off and return to the logon window, click File > Log Off. 
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Initial Voice Training 

Before you can begin dictating in PowerScribe 360 | Reporting, you must perform two voice 
training tasks:

• Audio Setup 

• General Training

General Training Dictation Guidelines
• Read the training screens in the environment in which you will be working.

• Do not dictate punctuation.

• You do not need to dictate dashes or slashes when dictating dates with those types of 
formats.

• Dictate acronyms, units of measure, blood pressures, dosages, and so on as you 
normally would.

• Speak in continuous phrases. Using this approach provides contextual clues about 
what you said and helps the software choose between homophones like “:” the 
punctuation mark, and “colon” the body part.

• Speak naturally at your normal rate, not too quickly or too slowly. 

• Do not Dictate. Only. One. Word. At. A. Time. 

• Fast dictation is acceptable as long as the words are spoken clearly and not slurred.

• Avoid clearing your throat and yawning while you are dictating. Do not talk through a 
yawn or when you clear your throat; please stop dictating.

• Eliminate utterances (urs, ahs, coughing) and similar sounds.

• Do not chew gum or eat while dictating.

Audio Setup 
Audio Setup automatically adjusts the volume level of your microphone to its optimal 
setting, providing the PowerScribe 360 | Reporting system with the best possible audio 
input, which in turn improves your speech recognition results. 

Running Audio Setup is a very important first step in ensuring the best possible speech 
recognition by the system. 

You must run Audio Setup the first time you log in to the system. In addition, if the 
microphone has been unplugged from the system (and then plugged back in) you must re-
run the wizard.

Audio Setup is a two-step process:
2
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• Volume Check: Adjusts the volume level of your microphone based on the loudness 
or softness of your voice as well as the dictation room’s ambient noise levels.

• Quality Check: Ensures that you have a high quality sound available from your 
microphone.

Note: If necessary, you can run Audio Setup by clicking Speech > Audio Setup on the 
menu bar once you are logged into the PowerScribe 360 | Reporting client.

To use Audio Setup (at your first login):

1. Log into the PowerScribe 360 | Reporting client application. In a few seconds, the 
Check Microphone window opens.

2. Review the text in this dialog box, adjust your microphone position if necessary, and 
click Next.
233



23

PowerScribe® 360 | Reporting System Administrator Guide
3. Click the Start Volume Check button and begin dictating the text in the box (“While 
you are reading this …”). The system is adjusting your microphone volume while 
you are dictating this text.

4. When you hear a beep and see the word Finished!, click Next.
4
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5. In the next window, click the Start Quality Check button and begin dictating the text 
in the box (“For Dragon to recognize your voice accurately…”). 

6. When you see the Check Microphone Passed message (in the black text box) click 
Finish to complete the audio setup.

General Training
Immediately after running Audio Setup the first time, you must go through a process 
called general training, which is the initial voice training for the system, before you can 
access the application. This training can last anywhere from 10 to 15 minutes. 

The purpose of general training is to give the system an opportunity to listen to the way 
that you pronounce the sounds that make up your words. For example, for the word 
radiology, the system hears ray-dee-awl-u-gee or something close to that. When you 
choose a general training script, you can choose any of the scripts available. The system is 
listening to the sounds that make up the word, not the word itself.

The dialog boxes for this training appear automatically on the first login, right after you 
complete Audio Setup.

Note: You can repeat general training by clicking Speech > General Training on the 
menu bar once you are logged into the PowerScribe 360 | Reporting client.
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To perform the General Training voice training (at your first login):

1. After completing the initial Audio Setup, the General Training dialog box opens.

2. Click Go and dictate the sentence “Welcome to general training” into your 
microphone. (There is one more short dictation in this section of the training: 
“Training is about to begin.”)

3. In the Select Text dialog box, select the training text you would like to use.

4. Click OK. 

5. Before you begin reading the text, review the following guidelines:

• Do not dictate punctuation you see on the screen.
6
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• If you want to take a break, click the Pause button (which then changes to a Go 
button you click to resume dictation).

• If you stumble over a phrase, click Redo and begin dictating again from the yellow 
arrow.

• Do not click Skip until you’ve read all the text on the screen, and the text color has 
changed from black to light gray.

• Once you have successfully read the text on the screen (all the text is light gray), 
the next screen opens automatically.

6. As you read the text in each dialog box: 

• A yellow arrow points to your current location in the dictation. Words that you’ve 
already dictated are grayed out as you speak.

• The bar directly below the text box is a volume level indicator. It moves to the right 
as your volume increases. Try to keep it in the green areas, avoiding the red area 
(which would appear in the far right side of the line). This bar turns yellow when 
you stop speaking.
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• The green dashed line (between the words Start and Finish) indicates your 
progress in the training. In the illustration above you can see that the user is almost 
finished.

Note: If you are unable to complete one of the training pages (the yellow arrow 
stops moving or appears to be stuck on a word), click the Skip button to move to 
the next training page and continue dictating. Providers with strong accents or 
pronunciation issues might encounter this occasionally during general training.

7. At the congratulations dialog box, click OK. The system displays an Adapting user 
files message while it finishes adapting your voice files. Once this process is finished, 
your login proceeds and the application opens, displaying the Explorer window (see 
illustration on next page).
8
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S

View of the Initial PowerScribe 360 | Reporting Explorer Window

Best Practice:  In Speech > Options > View, Set the Auto-hide delay to Never show. Also, 
in Speech > Options > Correction, clear the “Select” commands bring up Correction 
menu check box.

Menu Bar Tool Bar Search Results Table

Order Preview earch/Browse Filters
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Chapter 11

Provider Training—
Intermediate and

Advanced

Objectives
In this chapter you will:

• Review screen elements 

• Create a test report

• Create a test report containing AutoText

• Select facility-specific topics to cover with your 
providers

• Select advanced topics to cover with your 
providers
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Explorer Window Screen Elements

By default, the first window you see after logging in to the PowerScribe 360 | Reporting client 
is the Explorer window. Explorer is where you access your reports and worklists, and search 
for orders and reports. The following illustration shows the main components of the Explorer 
window. 

Menu Bar Toolbar Search Results Table

Report Preview (with Impression ScreenTip shown)
Search/Browse Filters
2
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Prior Au
Reports

ta
Create a Test Report

Initiate a Report

1. In the Quick Search section, make sure 
that the Look for field shows Single 
Accession.

2. Enter your initials followed by 123.

3. Click Search. Since this is a 
test report, a message 
window opens allowing you 
to create a temporary order. 

4. Click OK to create the 
order. The Report Editor 
window opens.

Menu Bar Toolbars Record/Playback Controls

toText
AutoFeed

Report Preview Area

Order Da
Tab

Navigation
Panel

PowerShare
StudiesMontage

Clinical
Guidance
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Dictate and Edit the Report
Note: As a best practice, have providers hold the microphone in their left hand and use the 
mouse with their right. For left-handed providers, it’s mouse left, microphone right.

1. Make sure your cursor is in the report preview portion of the window.

2. Dictate something you would normally dictate on a regular basis. Doing this lets you 
evaluate the quality of your speech recognition since the time you completed the 
general training. 

If you can’t think of anything, use the following findings and impression text as an 
example:

FINDINGS: The thoracic vertebral bodies are normal in height and alignment 
with normal CT density. Disc spaces are unremarkable with no disc bulge or 
focal disc herniation and the visualized spinal cord is intact. Visualized soft 
tissues are unremarkable.

IMPRESSION: No abnormality seen in CT scan of thoracic spine.

3. When finished, review the text you dictated and look for any dictation errors.

4. If you find an error, use the voice command “Select <x>” to highlight the word you 
want to change or delete. Using the text in the example above, you could say “Select 
unremarkable” to highlight the word unremarkable.

Note: Do not pause or take a breath between the command “Select” and the 
word you want to select. For example, if “Select unremarkable” does not 
immediately highlight unremarkable, the system interpreted what you said as 
dictation instead of a voice command. This occurs when you pause too long 
between the command itself and the word you want to select. 

5. With the text highlighted, you can now either dictate the correct word to replace it, or 
you can use another voice command “Scratch that” to delete the word completely.

Note: If you selected the word you want to delete with your mouse instead of the 
“Select <x>” voice command, you must use either the “Scratch that” or the 
“Delete that” voice command to remove the word. Otherwise, the audio file still 
contains the word, even though the text portion is gone. Using the voice 
command removes both the text and the audio.

6. Now use a new voice command, “Select <a> through <b>” to highlight a range of 
consecutive words. For example, in the impression section shown above, say “Select 
no abnormality through spine” to highlight all of the impression text. 

Note: You can use more than one word as a starting or ending point; in this 
example we used “no abnormality.” In some cases, a single word, especially 
articles such as “a” or “the” can cause the wrong text to be selected since they 
frequently occur more than once in many reports.
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7. Once again, either dictate the correct phrase to replace it, or say “Scratch that” to 
remove the text and audio completely.

8. When finished, click the Draft button on the toolbar to save your report and place it in 
your Drafts report queue.

Find, Open, and Sign the Draft Report 

1. In the My Reports section of the Explorer window, click the Drafts link. The report 
you just created is listed in the search results table. (Notice the number in parentheses 
next to the Drafts link. This indicates the number of draft reports that are in your 
queue.)

2. Double-click the report listing in the results table. The Report Editor window opens 
once again, displaying the contents of your report.

3. Sign your report either by clicking the Sign button on the toolbar, or by pressing the 
button on your microphone that performs the sign function. If you are prompted to 
sign the report with a message box, click Yes. The report is signed and you return to 
the Explorer window.

Create a Report That Contains AutoText

Initiate a Report

1. In the Quick Search section, make sure 
that the Look for field shows Single 
Accession.

2. Enter your initials followed by 456.

3. Click Search. Since this is 
a test report, a message 
window opens allowing 
you to create a temporary 
order. 

4. Click OK to create the 
order. The Report Editor 
window opens.

5. The AutoText tab is 
located at the bottom-left corner of the window. You should see an AutoText named 
template.

6. Use the voice command “AutoText template” to insert the AutoText into the report. 
(“AutoText” is a trigger word that tells the system to insert an AutoText. Your 
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organization might have chosen a different trigger word. Other choices are “Macro,” 
“PowerScribe,” or “Dictaphone” or a custom trigger word.)

This example AutoText contains three fields into which you can dictate: Clinical 
Information, Findings, and Impression.

7. Use the Tab buttons on your microphone to select the fields. You can tab forward and 
backward 

8. Tab to the Clinical Information field and dictate “Diabetes.”

9. Press the forward tab button to move to the Findings field and dictate the following:

The thoracic vertebral bodies are normal in height and alignment with normal 
CT density. Disc spaces are unremarkable with no disc bulge or focal disc 
herniation and the visualized spinal cord is intact. Visualized soft tissues are 
unremarkable.

10. When finished, press the forward tab button again to move to the Impression field and 
dictate the following:

No abnormality seen in CT scan of thoracic spine.

11. Practice your editing voice commands to see that they work with AutoText as well:
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• In any field, say “Select <x>” to select a word

• Say “Scratch that” to delete the selected word (text and audio) from your report.

• Say “Select <a> through <b>” to highlight a phrase or sentence.

12. When you have finished editing, sign your report either by clicking the Sign button on 
the toolbar, or by pressing the button on your microphone that performs the sign 
function. If you are prompted to sign the report with a message box, click Yes. The 
report is signed and you return to the Explorer window.

13. Click the Signed Today link in the My Reports section of the Explorer window to 
see the two reports you created and signed.
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Facility-Specific Features Check List

Not everyone has the same set of training requirements. Use the following check list to create 
a list of topics to cover for each customer. 

Addendums 

For information on this feature, see Addendums beginning on page 249.

Multiple Accession Numbers

For information on this feature, see Multiple Accession Numbers beginning on 
page 249.

Send to Editor Options 

For information on this feature, see Send to Editor Options beginning on page 250.

Report Transmit Grace Period

For information on this feature, see Report Transmit Grace Period beginning on 
page 250.

Reject a Report with Note

For information on this feature, see Reject a Report with Note beginning on 
page 251.

Worklists

For information on this feature, see Use a Worklist beginning on page 252.

Add Contributors

For information on this feature, see Add Contributors beginning on page 254.

Assign Orders 

For information on this feature, see Assign Orders beginning on page 255.

Attending Sign from Resident Workstation

For information on this feature, see Use Attending Sign from Resident Workstation 
beginning on page 255.

AutoFeed

For information on this feature, see AutoFeed beginning on page 256.
8
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Addendums 
If providers want to modify a report whose transfer status is either Queued or 
Sent (or any status other than Ready ), they must create an addendum to the report.

Multiple Accession Numbers
Customers whose RIS or HIS support multiple accession numbers per order can use 
Quick Search in the Explorer window to find an order that contains multiple accession 
numbers.

To find an order that contains multiple 
accession numbers: 

1. In the Quick Search portion of the 
Explorer window, select either Single 
Accession or Multiple Accession from 
the drop-down list.

2. Enter any one of the accession numbers 
and click Search.

3. In the results grid, double-click the report 
to open it. 

On the right side of the Report Editor 
window, the Order Data tab shows all of 
the accession numbers associated with 
the order (one in the example here). 

4. To add accession numbers: In the Open 
Orders area, select one or more 
accession numbers and click the Add 
selected orders to report link.

5. To remove one or more accession 
numbers from the order, select the 
number in the Accessions field and click 
the Remove this order from report link, 
located at the bottom of the Order Data 
window.

6. Continue dictating the report based on the 
remaining accession numbers.

7. When finished, sign or save the report.
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Send to Editor Options 
In some cases you might choose to send your reports to an editor instead of self-editing 
them. The editor corrects the report and returns it to you for signature.

Before sending a report to an editor, you can mark the report as STAT by clicking the 
STAT icon in the toolbar.

If you change your mind and want to self-edit the report, you can retrieve the report by 
clicking the Pending Correction link (under My Reports in the Explorer window) and 
opening the report once again. 

Note: If an editor has already opened the report, it will not appear in the Pending 
Correction queue and you can not access it.

To send a report to an editor:

1. Create or open a report to send to an editor.

2. Say “Correct Report” or click the Correct icon in the task bar.

The report is saved and sent to the editing queue. It is also added to the Pending 
Correction section of your My Reports search area (located below Quick Search). 
The Report Editor closes and you return to the Explorer window.

Report Transmit Grace Period
Many customers configure their PowerScribe 360 | Reporting system to allow providers a 
specific amount of time during which they can recall a report for further dictation or 
editing before it is uploaded to their RIS. 

With this feature enabled, a provider can retrieve a report from their Signed today queue 
if it has a Report Transfer Status (the column with the icon) of Ready, indicated by 
a single green arrow . 
0
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To open and edit a Ready report:

1. From the Explorer window, click the Signed today link under My Reports.

2. In the results grid, find the report you want to revise, making sure it is in the 
Ready state.

3. Double-click the report to open it in the Report Editor. 

4. Make the necessary revisions and sign the report once again.

If a provider double-clicks a report that has any other transfer status (Queued , 
Sent , and so on), he sees the following message box:

In these cases, the provider must create an addendum to the report in order to make 
changes or add to it.

Reject a Report with Note
Attending providers and residents can choose to reject a report. Rejecting a report returns 
a report to the last person who worked on it, and changes the report status from Corrected 
to Pending Correction. 

The following table shows which users can reject a report.

To reject a report:

1. In either Explorer or Report Editor, select the report you want to reject.

2. Click the Reject icon  in the toolbar (or click File > Reject). The Report 
Note dialog box opens, allowing you to either dictate or type a reason for rejecting the 
report.

User Reject Privilege

Attending Sends a report back to a Resident or an Editor for 
further corrections

Resident Sends a report back to an Editor for further 
corrections

Editor Editors cannot reject a report.
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3. Add a note to the report and click OK to return the report to the resident or editor for 
further work.

Note: Click Tools > Preferences > Workflow and make sure the preference Warn on sign 
if new notes exist is set to either Always or From Transcription. This ensures that you are 
notified when a new note has been added to a report that you are about to sign.

Use a Worklist
Worklists are filters your site administrator has configured; each worklist retrieves a 
specific set of orders, reports, or both. Worklists are very powerful, allowing virtually any 
combination of search criteria, and can span multiple sites if configured to do so. For 
example, a worklist might show all unreported pediatric CT exams from the Emergency 
Department that are more than one hour old.

Worklists are closely related to sections. An administrator assigns you to sections (for 
example, Abdominal, Chest, Thoracic, and so on). The administrator then associates the 
sections with worklists. You can filter which worklists appear in this list by changing your 
Sections preferences.

Example Worklist

The following illustration shows an example worklist created by an administrator.

The worklist is entitled Unreported ER CT Exams. The left side of the window contains 
all of the statements that make up the worklist expression. Notice in this example that the 
administrator is concerned with Report Status, Modality, and the date the report was 
Last Modified. Administrators can create worklists built on just about any criteria 
needed.
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To use a worklist to filter your Explorer screen results:

1. Expand one or more of the worklist groups in the Worklists search area.

2. Select a worklist as your filter. 

The results filtered by the worklist appear in the Explorer window.

Limiting Which Worklists You View

Note: Your system administrator can set a privilege that allows you to choose to see either 
all of the worklists, or only subscribed worklists. If you do not have this permission, you 
will not see the All and Subscribed items shown in the illustration below.

Depending upon how worklists are used at your facility, you can view all worklists, or you 
can limit the worklists that appear by selecting Subscribed Only from the menu bar.

To limit the worklists that appear in the Worklists search drop-down list: 

• Click View > Worklists and select Subscribed Only.
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Add Contributors
Use the Contributors dialog box to identify additional radiologists who helped create the 
report (other than the attending and resident).

Note: Adding a contributor to a report does not send a copy of the report to the 
contributor.

To insert a contributor into your report:

1. In the Report Editor window, select Properties from the navigation panel and click 
the Insert Contributors link (or click Insert > Contributors from the menu bar). The 
Contributors dialog box opens.

2. From the Radiologists list, select the name, or names of the radiologists you want to 
add as contributors and click Add.

3. To remove a contributor, select the name from the Contributors side of the dialog box 
and click Clear. To remove all contributors from the list, click Clear All.

4. When your contributors list is correct, click OK. The names you selected appear in the 
Contributors section of Properties.
4
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Assign Orders 
You can assign an unreported order to a radiologist. Assigned orders appear in the 
Assigned Orders queue under My Reports.

To assign an order:

1. Select an unreported order to assign.

2. Click Tools > Assign Order. The Assign Orders dialog box opens.

3. Select a radiologist from the drop-down list; the note is optional.

4. Click OK to assign the selected order.

Use Attending Sign from Resident Workstation
If your PowerScribe 360 | Reporting system administrator has selected a specific 
permission for your site (Allow attending signoff on resident login), an attending 
provider can sign a report from your workstation while you are logged into the 
workstation. 

To have an attending provider sign a report from your workstation:

1. In the Explorer window, select the report you want the provider to sign. (Or you can 
open the report in Report Editor if you choose.)

2. If you need to do so, click Tools > Change Attending and select the attending 
provider who is about to sign your report.
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3. Press the Shift key and click the Approve button (or press Shift+F12). The Confirm 
Password dialog box opens with the attending provider’s name shown next to the 
words Confirm for.

4. Have the attending provider enter her password and click OK.

AutoFeed
The AutoFeed tab shows a list of files that are in your orders queue, based on the type of 
search you performed in the Explorer window. As the reports from your search are loaded 
into your computer sequentially, the information turns from black to a gray text. In the 
illustration, the first three reports in the list have already been loaded; the others have not.

Example

If you selected the Signing Queue link (from the My Reports section) in Explorer, and 
then clicked the Start AutoFeed icon (in Explorer), the Report Editor opens, and the 
AutoFeed section also opens, showing the reports from your signing queue. The first 
report in the list appears in the Report Editor window. After you sign the first report, the 
second report automatically opens in the Report Editor, and so on.

Note: If you decide to start with a report other than the first one in your Explorer search 
results list, AutoFeed does not return to Explorer and pull in those first few reports. To 
access those first reports, you must return to the Explorer window and start AutoFeed 
again.
6
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If you did not click the AutoFeed icon in the Explorer window and want to view the 
queue, click the AutoFeed tab in the bottom left corner of the main screen. Note that the 
AutoFeed tab has a push-pin which allows you to hide the tab, or keep it open during your 
session.

Other AutoFeed Features

• From the Report Editor window, you can turn AutoFeed off or on by clicking the 
AutoFeed icon on the tool bar. If you turn off AutoFeed, you are returned to the 
Explorer window when you finish the current report.

• If there are no more orders or reports in your original query, you are returned to the 
Explorer window when you finish the last report.

• To view a list of upcoming reports from your query, click the AutoFeed tab located in 
the lower-left portion of the Report Editor window near the Prior Reports and 
AutoText tabs. (Note that this is a read-only list; you cannot select a report from it.)

• With this feature selected, a report that is in the process of being saved appears in the 
Explorer window in a gray italicized font. 

• If you attempt to open a report that is being saved, you will get a message box 
explaining that the report is being saved. 

• If you attempt to log out of the application while a report is being saved, a message 
box opens asking you to Please wait. 

• If you decide to log out of the application during the save, you are notified that you 
might lose some of your data. Best practice: wait until the save is completed.
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Advanced Training Topics

Not everyone has the same set of training requirements. Use the following check list to create 
a list of advanced training topics to cover for each customer.

Note: AutoText is considered an advanced training topic. For information on creating and 
using AutoText, see Chapter 8 of this manual, AutoText – Beginning and Advanced.

Review of Editing Techniques

For information on this feature, see Review of Editing Techniques beginning on 
page 259.

Additional Voice Commands

For information on this feature, see Additional Voice Commands beginning on 
page 259.

Training Pronunciation

For information on this feature, see Training Pronunciation: The Train Words 
Dialog Box beginning on page 260.

Using the Vocabulary Editor

For information on this feature, see Using the Vocabulary Editor beginning on 
page 263.
8
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Review of Editing Techniques
The following is a short review of the report editing voice commands and best practice 
tips presented earlier in this section:

• “Select <x>”: Use to select one or two words. Once selected you can either replace 
them by dictating, or delete them by using the “Scratch That” voice command.

• “Scratch that”: Deletes the selected word or words completely.

• “Select <a> through <b>”: Use to highlight a range of consecutive words. You can 
use more than one word as a starting or ending point. In some cases, a single word, 
especially articles such as “a” or “the” can cause the wrong text to be selected since 
they frequently occur more than once in many reports.

• As a best practice, have providers hold the microphone in their left hand and use the 
mouse with their right. For left-handed providers, it’s mouse left, microphone right.

• Do not pause or take a breath between the command “Select” and the word you want 
to select. For example, if “Select unremarkable” does not immediately highlight 
unremarkable, the system interpreted what you said as dictation instead of a voice 
command. This occurs when you pause too long between the command itself and the 
word you want to select. 

• If you selected the word you want to delete with your mouse instead of the “Select 
<x>” voice command, you must use the “Scratch that” voice command to remove 
the word. Otherwise, the audio file still contains the word, even though the text portion 
is gone. Using the voice command removes both the text and the audio.

Additional Voice Commands
The following table explains additional voice commands that more advanced users might 
find useful.

Voice Command Description
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Training Pronunciation: The Train Words Dialog Box
The two most commonly used methods that allow you to train words or phrases that are 
consistently misrecognized are Train Phrase and Vocabulary Editor. In each method, 
training takes place in the Train Words dialog box. 

This section first introduces you to the steps required to train a word or phrase, and then 
shows you methods you can use to access the Train Words dialog box, where you will 
use the steps to train your word or phrase.

Specific Steps for Training a Word or Phrase

Once you are in the Train Words dialog box (no matter which method you use to get 
there), be sure to use the following steps to train your word or phrase.

1. Say the word out loud two times, pronouncing the word as you would in one of your 
dictations.

2. After practicing the word twice, click Go to begin recording, and dictate the correct 
pronunciation of the word. The word or phrase is removed from the text box.

3. Click Go a second time to begin recording, and dictate the correct pronunciation of the 
word a second time. The gray dot below the text field briefly flashes green.

4. When finished, click Done to save your work and exit.

Methods for Accessing the Train Words Dialog Box

This section shows the two most commonly used methods (Train Phrase and 
Vocabulary Editor) to access the Train Words dialog box, as well as an alternate, less 
commonly used method (Add Word).

Use Train Phrase

1. Say “Train Phrase” (or click Speech > Train Phrase).

Note: If you say “Train Phrase” with no text selected, or if you select Speech > 
Train Phrase from the menu bar, the Training dialog box opens. Type the word 
or phrase you want to train, and click Train to open the Train Words dialog box.
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The Train Words dialog box opens, displaying the word or phrase you want to train.

Use Vocabulary Editor

1. Select Speech > Vocabulary Editor from the menu bar. The Vocabulary Editor 
dialog box opens.

2. Select the word you want to train.
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3. Click Train. The Train Words dialog box opens, displaying the word or phrase you 
chose to train.

Alternate Method: Add Word

A less frequently used method of adding and training words is through the Add Word or 
Phrase dialog box.

1. Click Speech > Add Word. The Add Word or Phrase dialog box opens.

2. Enter the word you want to add and select a category, if applicable.

3. To train the word from this dialog box, select the I want to train the pronunciation 
of this word or phrase check box.

4. Click Add. The Train Words dialog box opens.
2
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Using the Vocabulary Editor
Along with being an access point to the Train Words dialog box for training 
pronunciation, the Vocabulary Editor allows you to add words to the speech vocabulary 
and modify word properties. The Vocabulary Editor provides access to the written form 
and spoken form (if different) of all words in the vocabulary.

To add a word to the speech vocabulary:

1. Select Speech > Vocabulary Editor from the menu bar. The Vocabulary Editor 
dialog box opens.

2. In the Written form field, type the word as it is to appear in your documents. 

3. If the word is pronounced differently than it is spelled, type the word phonetically in 
the Spoken form field.

4. Click Add. The word and its pronunciation are added to the vocabulary. 
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To modify the properties of a word in the vocabulary:

Caution: Modifying the properties of an existing word in the Vocabulary Editor is 
intended for advanced users. Use extreme care when making changes to word properties, 
because unexpected results can occur. 

1. Select Speech > Vocabulary Editor from the menu bar. The Vocabulary Editor 
dialog box opens. 

2. Select the word you want to change and click Properties. 

3. Make the changes as needed.

4. Click OK.
4



Chapter 12

AutoText—Beginning and
Advanced

Objectives
In this chapter you will:

• Log into the PowerScribe 360 | Reporting client 
application as an administrator

• Create AutoText with fill-in fields:

- Text fill-in fields 

- Numeric fill-in fields

- Pick lists 

- Fill-in fields with default text or numeric 
values

• Create normal and default AutoText

• Use merge fields and custom fields in AutoText

• Design AutoText to work with Findings Mode

• Manage AutoText in the Administrator Portal
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Introduction to AutoText 

AutoText is standard text providers or transcriptionists can insert into reports. AutoText 
entries are sometimes referred to as macros or templates. They can be of any length and might 
contain plain text, standard headings, numbered lists, fill-in fields, data retrieved from the 
RIS, or other items. 

As administrator, you can create AutoText entries in the PowerScribe 360 | Reporting client 
application; providers can create their own AutoText entries for sharing with other users or for 
their own personal use. 

In the PowerScribe 360 | Reporting Administrator Portal, you can find, view, and edit some 
AutoText properties. You can associate AutoText entries with procedure codes. You can 
promote an AutoText entry created for personal use to make it available to all providers at a 
site, export AutoText entries from one site and import them to another, upgrade AutoText 
entries that were created in the RadWhere application for use in PowerScribe 360 | Reporting, 
and delete AutoText entries. 

Opening the AutoText Editor in the PowerScribe 360 | 
Reporting Client

To create AutoText entries, you will need to log in to the PowerScribe 360 | Reporting 
client application and use the AutoText Editor.

To open the AutoText Editor: 

1. Double-click the Nuance PowerScribe 360 icon on your desktop. 
The main PowerScribe 360 | Reporting client application Explorer 
window opens.

2. Select Tools > AutoText Editor from the menu bar.
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Use these
fields to 
define the
AutoText

Use the 
AutoText
Manager 
find 
AutoText
entries.
The AutoText Editor opens.

 

 
.

Type or dictate the 
AutoText entry in this 
work area.

 
to 

 

Select an 
AutoText 
entry…

…to see a 
preview 
here.
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Searching for AutoText Entries in the PowerScribe 
360 | Reporting Client

Follow the procedure below to search for one or more AutoText entries in the AutoText 
Editor. To find AutoText in the PowerScribe 360 | Reporting Administrator Portal, refer 
to Managing AutoText in the Administrator Portal, beginning on page 303.

To search for AutoText entries:

1. Select Tools > AutoText Editor from the menu bar. 

2. In the Browse pane, use one or more criteria to find the AutoText:

• Use the Owner drop-down list to filter the search by AutoText owner. If you select 
the Site item in the Owner drop-down list, the search retrieves all shared AutoText 
entries in the site, provided they belong to owners with an active PowerScribe 360 | 
Reporting role in the site. 

• Use the Name field to search by AutoText name or by the shortcut used to invoke 
it. You can use a wild-card character (*) to search by any part of the name or 
shortcut. 

• Use the Text field to search for an AutoText entry containing the entered search 
text. You can enter part of the text without using a wild-card character.

• Use the Modality drop-down list to filter the search by type of exam (for example, 
CT or MRI). 

• Use the Anatomy drop-down list to filter their search by body region (for example, 
Chest or Head & Neck). 

Note: For Modality and Anatomy search to function, you must configure the 
site’s procedure codes to Modality and Anatomy. Refer to Introduction to 
Procedure Master Translators, beginning on page 188.

• Use the Procedure drop-down list to filter by procedure. This list is empty if you 
have not selected a modality or anatomy, because without narrowing this criterion, 
there would be too many entries to fit in a drop-down list. It is also empty if there 
are no mappings between procedure codes and clinical codes. 
8
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3. Click Browse. Any AutoText entries that meet your criteria appear in the list.
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Creating an AutoText Entry

This section provides instructions for creating an AutoText entry containing only text. Other 
sections discuss creating AutoText with fill-in fields, pick lists, merge fields, and other 
advanced features. 

To create an AutoText entry: 

1. In the PowerScribe 360 | Reporting client Explorer application, select Tools > 
AutoText Editor from the menu bar. (If you are already editing a report in Report 
Editor, click the AutoText icon to open the AutoText Editor.)

The AutoText Editor window opens. 

2. Type a Name for the AutoText entry. This is the word or phrase the provider can 
dictate to invoke the AutoText. 

Follow these naming conventions to ensure that the speech software can distinguish 
the shortcut from other dictation: 

• Use at least two syllables.
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• Use lowercase, except for initials. For example, type CT chest.

All AutoText entries belonging to an account must have unique names.

3. In the Shortcut field, type the characters the transcriptionist/editor or dictation user 
can type to invoke the AutoText, if applicable. Do not include any spaces in the 
shortcut. Shortcuts for AutoText entries belonging to an account must be unique. 

4. Optional: Type a Description of the AutoText. 

5. Set a Lower and Upper age limit in years, if desired. If you set an age limit, the 
AutoText is available only for reports where the patient’s age falls within the specified 
range. For example, you might define a range of zero to 13 for AutoText that is 
exclusively for use in pediatric reports. A range from 0 to 13 years includes all patients 
up to 12 years, 23 months. 

6. Select a Gender if applicable. If you select a gender, the AutoText is available only 
during dictation of reports for patients of the indicated gender. Otherwise, it is 
available for all reports.

7. From the Class drop-down list, select a patient class, if applicable.

8. If desired, associate one or more procedure codes with the AutoText. Refer to 
Associating Procedure Codes with an AutoText Entry, beginning on page 290. 

9. Dictate or type the AutoText. The text appears in the work area. 
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10. When you have finished defining the AutoText, press Ctrl+S or click the Save icon in 
the toolbar. 

The AutoText is stored in the system and appears in the list at the bottom of the 
window.

11. Test the AutoText by using it in a dictation.

Creating AutoText with Fill-In Fields

In this section you will create AutoText with text fill-in fields, numeric fill-in fields, pick lists, 
and default values. 

A fill-in field is a simple way for a provider to insert variable information, for example, a 
dosage or a measurement, within a block of standard text. The provider can either dictate or 
type the information in the field.

The procedures below assume that you have created a new AutoText entry and that the 
AutoText is open for editing in the PowerScribe 360 | Reporting client application’s AutoText 
Editor. 

Creating a Text Fill-In Field
A text fill-in field contains alphanumeric characters. If you know the value a provider will 
most often enter or dictate in a particular fill-in field, you should assign a default value to 
the field. For more information on using default values in fields, refer to Creating Text or 
Numeric Fill-In Fields with Default Values, beginning on page 279.

To create a text fill-in field: 

1. With the AutoText open for editing, click to place the insertion point at the position 
where you want the fill-in field. 

2. Click the Fill-in button in the toolbar.
2



Chapter 12: AutoText—Beginning and Advanced
The Fill-in Field Definition dialog box opens. 

3. Type a Name for this fill-in field. This name does not appear in the final document, 
but is used by the software to reference the field and appears in the left column of the 
PowerScribe 360 | Reporting client window during dictation. For example, type Order 
Procedure Description. 

Tip: If you select the Enable Talking Fields preference, the field name you 
provide here is announced through the PowerMic II or SpeechMike when the 
user navigates to the field. Refer to page 68 for more information about talking 
fields. 

4. Select Text from the Type drop-down list.

5. Select the All Caps option if you want the entire contents of this field to appear in 
capital letters if the provider dictates over it. 
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Notes: 

• In most facilities, the Impression field is in all caps. Refer to Creating an 
Impression Field, beginning on page 301.

• For this feature to be active, the ‘Capitalize beginning of dictated sentences’ 
preference must not be in effect at the system or provider level:

6. Select Allow Empty if you want to allow providers to leave this field blank.

7. Click OK. The field appears in the AutoText.

Note: In this example, there are brackets around some fields. Providers can set 
brackets on or off in the AutoText preferences: Select Tools > Preferences, and 
then in the Reporting node, select Show brackets on fields. 
4
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Creating a Numeric Fill-In Field
Use a numeric fill-in field where the provider must type or dictate a number. For example, 
use a numeric field for a dosage, a percentage, or a number of days. 

Tip: Users can enter text values in numeric fill-in fields. Defining a field as numeric, 
however, causes the speech recognition software to expect numbers when that field is 
active (that is, while it contains the cursor and is accepting input), improving recognition.

To create a numeric fill-in field: 

1. With the AutoText open for editing, click to place the insertion point at the position 
where you want the fill-in field. 

2. Select the Fill-in button in the toolbar.

The Fill-in Field Definition dialog box opens.

3. Type a name for this fill-in field. For example, type Minutes for a field in which the 
provider must indicate for how long a procedure was performed. This name does not 
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appear in the final document, but is used by the software to reference the field and 
appears in the left column of the PowerScribe 360 | Reporting client window during 
dictation.

4. Select Numeric from the Type drop-down list. 

5. Select Allow Empty if you want to allow providers to leave this field blank.

6. Click OK. The field appears in the AutoText.

Note: Providers can set brackets on or off in the AutoText preferences: Select 
Tools > Preferences, and then in the Reporting node, select Show brackets on 
fields. 
6
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Creating a Pick List Fill-in Field
A pick list is a set of choices from which the user selects one. The choices appear in the 
AutoText, separated by slashes, while you are creating or editing it. The user can then tab 
to the field and dictate the desired choice; while the field is selected, the available options 
appear in the left column of the dictation window.

To create a fill-in field with a pick list: 

1. With the AutoText open for editing, click to place the insertion point at the position 
where you want the pick list. 

2. Select the Fill-in button in the toolbar.

The Fill-in Field Definition dialog box opens.

3. Type a name for this pick list. This name does not appear in the final document, but is 
used by the software to reference the field and appears in the left column of the 
PowerScribe 360 | Reporting client window during dictation. 
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4. Select Pick list from the Type drop-down list.

5. Click New.

The Choice Definition dialog box opens. 

6. In the Choice Text text box, type the first choice you want to place in the list. 
8
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If the choice is too long to be displayed easily in the list, enter a shorter Optional 
Label. Be sure to use a label that clearly identifies the item. The provider can dictate 
the abbreviated label to select the item; the report displays the full choice text.

7. Click OK. The choice appears in the list.

8. Repeat Steps 6 and 7 for each choice you want to add to the list.

Tip: You can rearrange the items in the pick list. Select an item and click the Up 
or Down arrow; repeat this process until the list is organized in the order you 
want the provider to see it.

Creating Text or Numeric Fill-In Fields with Default 
Values

If you know the value a provider will most often enter or dictate in a particular fill-in field, 
you can assign a default value to the field. The provider sees the default, and can change it 
if desired.

To create a fill-in field with a default text value: 

1. Create the AutoText, and click to place the insertion point at the position where you 
want to insert the fill-in field. 
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2. Select the Fill-in button in the toolbar.

The Fill-in Field Definition dialog box opens.

3. Type a Name for this fill-in field. 

4. Select Numeric or Text from the Type drop-down list.

5. In the Default text box, type the text or number that is to be the default value in this 
fill-in field. If the field type is Numeric, the default value must be a number.
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6. Click OK. 

Tip: While editing the AutoText, float your mouse cursor over a field to see any 
default text you have defined for it.

Editing a Fill-In Field
You can modify the properties of a fill-in field you have placed in an AutoText entry. 

To edit a fill-in field:

1. Open the AutoText entry for editing.

2. Right-click the field you want to edit. 

3. Select Edit fill-in field from the shortcut menu.
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The Fill-in Field Definition dialog box opens.

4. Modify the field’s properties as desired.

5. Click OK to return to the AutoText Editor.
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Creating Normal and Default AutoText 
Entries

A normal AutoText entry, referred to as a normal, is a block of text the provider invokes to 
report a normal finding. The provider ordinarily does not make any changes to the AutoText 
after invoking it, and the report is automatically approved or signed. Typically, a normal 
AutoText entry does not contain fill-in fields, although it can if they have default values. 

A default AutoText entry is one that is invoked automatically for a particular procedure, if the 
‘Start with default AutoText’ preference is in effect. For information on creating default 
AutoText, refer to Creating a Default AutoText Entry, beginning on page 285.

When you create a normal or default AutoText entry, you can associate it with one or more 
procedure codes. You can take that action either in the PowerScribe 360 | Reporting client 
(page 290) or in the PowerScribe 360 | Reporting Administrator Portal (page 306). If you do 
not associate an AutoText entry with a procedure code, the AutoText can be used as a generic 
or basic AutoText that can be relevant to all procedures.

Creating a Normal AutoText Entry
To create a normal AutoText entry: 

1. In the PowerScribe 360 | Reporting client application, select Tools > AutoText Editor 
from the menu bar.
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The AutoText Editor window opens. The items you can use to define and create new 
AutoText appear at the upper left of the window.

2. Type a Name for the AutoText entry. 

3. In the Shortcut field, type the characters the transcriptionist/editor can type to invoke 
the AutoText, if applicable. Do not include any spaces in the shortcut. 

4. Optional: Type a Description of the AutoText. 

5. Set a Lower and/or Upper age limit, if applicable. 

6. From the Gender drop-down list, select either Male or Female, if the AutoText is 
gender-specific. 

7. From the Class drop-down list, select a patient class, if applicable.

8. Select the Normal attribute.

9. Dictate or type the AutoText. The text appears at the upper right.

10. Refer to Associating Procedure Codes with an AutoText Entry, beginning on page 290 
to associate the AutoText with at least one procedure code. 

11. When you have finished defining the AutoText, press Ctrl+S or click the Save icon in 
the toolbar. 
4
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The AutoText is stored in the system and appears in the list at the bottom of the 
window.

In this example, the icon at the left of the AutoText name indicates that this AutoText 
has been designated as a normal. 

12. Test the AutoText by using it in a dictation.

Creating a Default AutoText Entry
On beginning a report, a provider sees a default AutoText if one exists in the system and if 
the Start with default AutoText preference is selected.
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You should always associate a default AutoText entry with at least one procedure code. 
Doing so causes the software to display the default AutoText to the provider only when a 
report is for that procedure.

Notes: 

• You cannot associate more than one default AutoText entry with the same procedure 
code, unless there exists another factor, such as age or gender, to differentiate 
between the AutoText entries. If you attempt to do so, you see a warning message 
similar to this one when you attempt to save the AutoText entry:

• Where a personal AutoText entry and a site AutoText entry have the same name and 
both are relevant to a report, if the site AutoText is marked as a default, but the 
personal AutoText is not, the site AutoText is used.

If a default AutoText entry 
exists for this procedure 
code, and the ‘Start with 
default AutoText’ 
preference is in effect, 
that AutoText loads when 
the provider begins the 
report.
6
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To create a default AutoText entry: 

1. In the PowerScribe 360 | Reporting client application, select Tools > AutoText Editor 
from the menu bar. 

The AutoText Editor window opens. The items you can use to define the new 
AutoText appear at the upper left of the window.

2. Type a Name for the AutoText entry. 

3. In the Shortcut field, type the characters the transcriptionist/editor can type to invoke 
the AutoText, if applicable. Do not include any spaces in the shortcut. 

4. Optional: Type a Description of the AutoText. 
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5. Set a Lower and/or Upper age limit, if applicable. 

6. From the Gender drop-down list, select either Male or Female, if the AutoText is 
gender-specific. 

7. From the Class drop-down list, select a patient class, if applicable.

8. Select the Default attribute.

9. Dictate or type the AutoText. The text appears in the work area.

Tip: The example below includes fill-in fields. Refer to Creating AutoText with 
Fill-In Fields, beginning on page 272.
8
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10. Follow the procedure on page 290 to associate the AutoText with one or more 
procedure codes. If you take this action, the AutoText automatically loads only when a 
provider begins a report on one of those procedures.

Caution: If you do not associate this AutoText with any procedure codes, it will 
load when a provider begins any report. If you attempt to save the AutoText 
without associating it with any procedure codes, you see the warning message 
below. It is strongly recommended that you click Cancel to close the message 
box, and then add at least one procedure code to the AutoText before saving it.

11. When you have finished defining the AutoText, press Ctrl+S or click the Save icon in 
the toolbar. 

The AutoText is stored in the system and appears in the list at the bottom of the 
window.

In this example, the icon at the left of the AutoText name indicates that this AutoText 
has been designated as the default for the procedure code(s) you specified. 

12. Test the AutoText by using it in a dictation.
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Associating Procedure Codes with an AutoText Entry
Follow this procedure to associate an AutoText entry with one or more procedure codes in 
the AutoText Editor. Because procedure codes are site-specific, you must perform this 
categorization process separately for each site.

To take this action in the PowerScribe 360 | Reporting Administrator Portal, refer to 
“Adding or Removing Procedures from a Normal, Default, or Relevant AutoText Entry” 
on page 306.

1. With the AutoText open, click the Categories  tool in the toolbar, or 
select a site name in the Categories group box. 

The AutoText Categories window opens.
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2. Select a site from the Sites drop-down list at the upper right, if the appropriate site is 
not already selected. 

3. Use any method to find the procedure code(s) you want to associate with this 
AutoText entry: 

• Enter all or part the procedure name and click Search, OR

• Click to place a check mark next to a Modality, OR

• Click to place a check mark next to an Anatomy.

Any procedure codes found appear in the Matching Procedure Codes list at the upper 
right. 

4. Select one or more procedures from the list. Hold down the Ctrl key and click each 
desired item, or hold down the Shift key and select the first and last desired item; then 
click Add. Or, click Add All to add the entire list. The selected procedure codes 
appear in the Assigned to AutoText list.

5. Click OK. The procedure codes are associated with the AutoText entry. 
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Creating AutoText with Merge Fields

Merge fields are data items retrieved from your RIS or HIS. You can use merge fields in 
AutoText to display patient information or other data, eliminating the need for the 
provider to enter or dictate this information. 

To create AutoText with merge fields: 

1. With the AutoText open for editing, click to place the insertion point at the position 
where you want the merge field.

2. Select the down arrow next to the Merge 
button in the menu bar, and select the desired 
item from the list of fields. 

Note: The table in Appendix B shows 
the full list of merge fields. Merge field 
data might contain data from the RIS or 
HIS or created in PowerScribe 360 | 
Reporting. In addition to the fields 
shown here, the list might also contain 
custom fields; refer to Custom Fields, 
beginning on page 325.

The name of the merge field appears in the 
AutoText. The data item will appear in the 
report at that position.
2
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Creating AutoText Entries Relevant to a 
Procedure

A radiologist might want to insert an AutoText entry into a report without having to select 
from a large number of entries not related to the procedure. To make it easier to locate the 
desired AutoText entry, you can design your entries so that only those relevant to a particular 
procedure appear in the drop-down list.

For example, a radiologist reporting on a chest x-ray might need to include findings related to 
pneumonia, lung cancer, or other disorders. The radiologist might want to see only the 
AutoText entries relevant to the chest x-ray procedure, not those relevant to x-rays of other 
regions, and not those related to other procedures performed on the chest. 

Relevant personal entries are those that are related to a procedure and belong to a particular 
user. These appear in the list when the user selects Relevant Personal. Relevant site entries 
are those related to a procedure and used by any user in the site. These items appear in the 
AutoText list when a user selects Relevant Site. 

Tip: The most important relevancy criterion for an AutoText entry is the exam procedure, 
but other criteria include the patient’s age and gender.

For the appropriate AutoText entries to appear in the list when the user selects Relevant 
Personal or Relevant Site, you will need to assign AutoText entries to a procedure code 
without marking any of these entries as Default. 

Note: Where both a personal AutoText entry and a site AutoText entry have the same 
name, and both are relevant, that is, both are categorized with the current procedure or 
both are uncategorized, the site AutoText entry does not appear in the Relevant Site list, 
but the personal AutoText entry appears in the Relevant Personal list. The voice command 
to invoke the AutoText will insert the personal AutoText. 

Relevant Personal AutoText Entries
Relevant personal entries are those that are related to a procedure and belong to a 
particular user. These appear in the list when the user selects Relevant Personal. 

To create a relevant personal AutoText entry:

1. In the PowerScribe 360 | Reporting client, select Tools > AutoText Editor from the 
menu bar. The AutoText Editor window opens.
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2. Create the AutoText entry, following the procedure beginning on page 270.

• Select the Private property. 

• Do not select the Default property. 

3. Assign the AutoText entry to the procedure code, following the procedure beginning 
on page 290. 

4. Repeat the process for all AutoText entries related to this procedure. 

Relevant Site AutoText Entries
Relevant site entries are those related to a procedure and used by any user in the site. 
These items appear in the AutoText list when a user selects Relevant Site. 

To create a relevant site AutoText entry: 

1. In the PowerScribe 360 | Reporting client, select Tools > AutoText Editor from the 
menu bar. The AutoText Editor window opens.

2. Create the AutoText entry, following the procedure beginning on page 270.

• Do not select the Private property. 

• Do not select the Default property. 

3. Assign the AutoText entry to the procedure code, following the procedure beginning 
on page 290. 

4. Repeat the process for all AutoText entries related to this procedure. 

Designing AutoText to Work with 
Findings Mode

In Findings Mode, the PowerScribe 360 | Reporting software automatically converts free-
form dictation to a structured report. This feature is helpful where the facility requires a 
structured report format, but providers are accustomed to, or prefer, free- form dictation. To 
support this mode, the fields embedded in AutoText are mapped to certain key words, called 
hyponyms. Hyponyms might be whole words, such as cardiac, thoracic, and renal, or 
fragments such as hepat and cirrho. The system considers the field’s name as the first 
hyponym. 

When the provider dictates a word that is a hyponym of one of the fields in the report, the 
software identifies the surrounding sentence or phrase as belonging to that field, and when the 
provider applies findings, it inserts the dictation in the field. For example, if the provider 
dictates “Hepatic...”, and a field named Liver has been defined with hepat as one of its 
hyponyms, the system takes the sentence containing “hepatic” and places it in the Liver field.
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Findings mode works only with AutoText that is structured with a single fill-in field per 
anatomical region. The AutoText need not include actual section headings for the anatomical 
regions; all that is required is that there be a single field per region. 

In the PowerScribe 360 | Reporting client application:

1. The user begins a report using structured AutoText. 

2. To start Findings Mode, he clicks Enter Findings Mode or dictates “Findings mode.” 
A special Findings box opens below the report body. 

3. The user dictates the study’s findings. He does not need to follow the order in which 
the anatomical regions appear in the AutoText, and does not need to use the exact 
words shown in any headings or field labels.
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4. The provider clicks Apply Findings or dictates “Apply findings.” The software 
captures any dictation that matches the hyponyms assigned to the fields in the 
AutoText and places it automatically in the appropriate fields.

 

After applying the findings, the provider can use the AutoText as usual; he can select 
and dictate over any field to change its content. 

Note: Enter and apply Findings Mode only once per report. If a provider enters 
Findings Mode a second time (after Applying Findings), anything dictated and 
applied to a section of the report that contained prior dictation will be 
overwritten with the new dictation. In addition, dictation in Findings Mode is 
not saved as an audio file, so it is expected that the provider will self-edit the 
report rather than send to editor when using Findings Mode.

Any dictation in the Findings box that does not match any of the hyponyms is either 
placed in the Fields list with a field name of ‘Unmatched1,’ ‘Unmatched2,’ and so on, 
or it remains in the Findings box, from where the provider can drag it to the 
appropriate place in the report.

Tip: The Add Unmatched Findings to Report preference determines how the 
software handles unmatched dictation. Refer to page 69 to configure this setting 
at the system or provider level. In the PowerScribe 360 | Reporting client, select 
Tools > Preferences, and under the Reporting node, select Add Unmatched 
Findings to Report. 
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Adding Hyponyms to Fields in AutoText
Any fields in the AutoText entries shipped with PowerScribe 360 | Reporting contain 
hyponyms, and you can design your own AutoText entries to accept findings-only 
dictation. 

If the PowerScribe 360 | Reporting client consistently fails to apply a particular finding to 
a field, you might be able to correct the problem by adding one or more hyponyms to the 
field. The system considers the field name to be the first hyponym, so you do not need to 
include the field name in the Hyponyms list. You should, however, include all variations 
of the name, to ensure that dictation containing any of the variations is captured and 
placed in this field. For a field named Thorax, you might include the word thoracic or the 
fragment thorac. For a field for pericardium findings, you might need to add the word 
pericardial. You can use uppercase, lowercase, or both; the system does not consider case 
in hyponyms.

To add hyponyms to a field: 

1. In the PowerScribe 360 | Reporting client, select Tools > AutoText Editor from the 
menu bar. The AutoText Editor window opens.

2. Double-click the AutoText entry that contains the field to which you want to add one 
or more hyponyms. The AutoText entry opens for editing.

Consistently unmatched 
findings might indicate 
a missing hyponym.
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3. Right-click the field and select Edit Fill-in Field.

4. Type the new hyponyms in the Hyponyms text box. Place each word, fragment, or 
phrase on a separate line.

5. Click OK. 

6. Click Close, and click Yes to save the AutoText.
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Copying a Field and its Hyponyms
When you copy a field, its hyponyms are copied along with it. 

To copy a field: 

1. In the PowerScribe 360 | Reporting client, select Tools > AutoText Editor from the 
menu bar. 

2. Double-click the AutoText entry that contains the field you want to copy. The 
AutoText entry opens for editing.

3. Right-click the field and select Select Field.

The field is highlighted.

4. Right-click the field and select Copy, or press Ctrl+C.

The field, with its properties, is copied to the Windows clipboard. 

5. Find the AutoText in which you want to insert the field. (Refer to Searching for 
AutoText Entries in the PowerScribe 360 | Reporting Client, beginning on page 268.)

6. Double-click the AutoText to open it. 

7. Place the insertion point at the position where you want to insert the field.

8. Right-click and select Paste. The field appears in the AutoText.
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To view the new field’s properties, right-click the field and select Edit Fill-in field.

The Fill-in Field Properties dialog box displays the field’s hyponyms and its other 
properties. 

9. Click OK. 

10. Click Close, and click Yes to save the AutoText.

Omitting a Field from Findings Mode
Some fields never contain findings and should not have findings applied to them. 

To omit a field from findings mode:

1. In the PowerScribe 360 | Reporting client, select Tools > AutoText editor from the 
menu bar. 

2. Double-click the AutoText entry in which you want to omit a field from findings 
mode. The AutoText entry opens for editing.

3. Right-click the field and select Edit Fill-in Field….
 

The Fill-in Field Properties dialog box displays the field’s properties. 

4. Select Does not indicate findings.

5. Click OK. When the provider applies findings, the software will not attempt to find 
matching text for this field. 
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Creating an Impression Field
The impression field contains the provider’s final remarks about the study. Some facilities 
use “summary,” “conclusion,” or another term for this field. 

When the provider dictates the word “impression,” “summary,” or “conclusion,” the 
software identifies the verbiage following it as the impression, and places it in the 
Impression field when it applies findings. It does not search this part of the dictation for 
text to match with the other fields in the document. 

To create an impression field:

1. In the PowerScribe 360 | Reporting client, select Tools > AutoText Editor from the 
menu bar. 

2. Double-click the AutoText entry in which you want to create an impression field. The 
AutoText entry opens for editing

3. If desired, type the word Impression, Summary, Conclusion, or another term in the 
AutoText. 

4. Click the Fill-in icon on the tool bar (or select Insert > Fill-in field from the menu 
bar).

5. Enter a Name for the impression field. 

6. Select Text as the Type. 

7. If desired, enter a value in the Default text box.
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8. Select Impression field. The Does not indicate findings option is automatically 
selected.

9. Click OK. 
2
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Managing AutoText in the Administrator 
Portal

Navigating to the AutoText Tab
As administrator, you can manage AutoText entries through the AutoText tab in the 
Setup group. This tab provides access to all AutoText entries in the system.

From this tab, you can: 

• Search for AutoText entries (page 304)

• Add or remove procedure codes from AutoText entries (page 306)

• Import and export AutoText (page 309)

• Promote, upgrade, and delete AutoText entries (page 321)

You cannot use this tab to add new AutoText or to edit fill-in fields or other features of 
existing AutoText; you must use the PowerScribe 360 | Reporting client application for 
those functions. Refer to Creating an AutoText Entry, beginning on page 270. 
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Searching for AutoText Entries in the Administrator 
Portal

The AutoText tab in the Setup group allows you to search on various criteria to find a 
specific AutoText entry. 

To search for AutoText entries in the Administrator Portal:

1. On the AutoText tab of the Setup group, use one or more criteria to find the AutoText: 

• Select a Site to search for AutoText entries belonging to a particular site (if your 
organization has multiple sites). 

• Use the Owner drop-down list to filter the search by AutoText owner. If you select 
the Site item in the Owner drop-down list, the search retrieves all shared AutoText 
entries in the site you selected from the Site drop-down list, provided they belong 
to owners with an active PowerScribe 360 | Reporting role in the site. 

• In the Type field, select AutoText, Text Shortcut, or All. Select AutoText to 
search for AutoText entries that do not have text shortcuts; select Text Shortcut to 
search for those that do. Select All to includes both types of AutoText entries in 
your search.

• In the Attribute field, select Default, Normal, Private, or All. 

• Use the Modality drop-down list to filter the search by type of exam (for example, 
CT Scan or MRI). 

• Use the Anatomy drop-down list to filter their search by region (for example, 
Chest or Head). 

Note: For Modality and Anatomy search to function, you must configure the 
site’s procedure codes to Modality and Anatomy. Refer to Introduction to 
Procedure Master Translators, beginning on page 188.

• Use the Procedure drop-down list to filter by procedure. This list is empty if you 
have not selected a modality or anatomy, because without narrowing this criterion, 
there would be too many entries to fit in a drop-down list. It is also empty if there 
are no mappings between procedure codes and clinical codes. 

• Use the Patient Class list to search by a patient class such as Inpatient, 
Outpatient, Obstetrics, and several others.

• Use the Name/Shortcut field to search by AutoText name or by the shortcut used 
to invoke it. You can use a wild-card character (*) to search by any part of the name 
or shortcut.

• Use the Text field to search for an AutoText entry containing the entered search 
text. You can enter part of the text without using a wild-card character.
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2. Click Search. Any AutoText entries that meet your criteria appear in the list. Click the 
link in the Name column to see a preview of the AutoText (in the lower right pane).
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Adding or Removing Procedures from a Normal, 
Default, or Relevant AutoText Entry

The PowerScribe 360 | Reporting Administrator Portal allows you to associate procedure 
codes with an AutoText entry and to remove procedure codes from the entry. To take 
these actions in the PowerScribe 360 | Reporting client, refer to Associating Procedure 
Codes with an AutoText Entry, beginning on page 290.

To add procedures to an AutoText entry:

1. Find the AutoText entry. Refer to Searching for AutoText Entries in the Administrator 
Portal, beginning on page 304.

2. Click the Name of the AutoText you want to modify. The AutoText entry’s properties 
are displayed in the pane at the right.

3. Click Procedures. The Procedure Code Selection window opens.
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4. Find the procedures you want to associate with this AutoText. Place a check mark next 
to any modality or anatomy whose codes you want to display. Then click Search. Any 
procedures connected to the items you chose appear in the All Procedures list.

5. In the All Procedures list, place a check mark next to each procedure you want to add 
to this AutoText. 
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6. Click Add. The procedure(s) appear in the Selected Procedures list at the right.

7. Click Close Window when you are finished adding codes.

To remove procedures from an AutoText entry: 

1. Find the AutoText you want to modify. Refer to Opening the AutoText Editor in the 
PowerScribe 360 | Reporting Client, beginning on page 266.

2. Click the Name of the AutoText entry you want to modify. The AutoText entry’s 
properties are displayed. 

3. Click Procedures. The Procedure Code Selection window opens.

4. In the Selected Procedures list at the lower right, place a check mark next to each 
procedure you want to remove from this AutoText entry. 

5. Click Remove. The procedures are removed.

6. Click Close Window.
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Importing and Exporting AutoText
You can import AutoText entries or macros from the RadWhere application or from the 
Agfa TalkStation application. You can also import .xml files you have exported from 
within PowerScribe 360 | Reporting; this allows you to copy AutoText entries from one 
site or user account to another. Refer to Exporting AutoText, beginning on page 319. 

Importing AutoText Entries from RadWhere or PowerScribe 360 | 
Reporting

Follow this procedure to import AutoText entries you have exported from an PowerScribe 
360 | Reporting user account or site, or from the RadWhere application.

Extended Multi Select

Throughout the PowerScribe 360 | Reporting Administrator Portal, you select an item on 
which to perform an action by selecting a check box at the left of the item. You can act on 
multiple items by selecting more than one check box, or you can select the check box in 
the header to select all items. 

The Web Portal option Enable extended multi select, which is set in the system 
configuration, determines whether you can select and act only upon items visible on the 
current page, or on multiple pages. This option’s default value is False; if you place a 
check mark in the header check box to select all items, only the items visible on the 
current page are automatically selected, and if you perform an action such as ‘Delete,’ 
only the selected items on the current page are deleted. 

The process for importing AutoText is likely to present more than one page of AutoText 
entries. To save time, you can temporarily set Enable extended multi select to True. You 
can then select AutoText entries on, for example, pages one, three, and four, and import 
them all at one time; with it set to False, you can select and import AutoText entries only 
on the page currently displayed. 

Caution: If you change the setting to True, you must set it back to its default value of False 
after completing the AutoText import. 

For information on setting system options, refer to Chapter 3.
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To import AutoText entries from RadWhere or PowerScribe 360 | Reporting:

1. On the AutoText tab of the Setup group, click Import.... The Import AutoText 
dialog box opens.

2. Select the Import target from the drop-down list. For example, you can import 
AutoText entries to a single user account. Or, you can import them to a site for use by 
all users at the site. 

3. Select RadWhere/PowerScribe.

4. Click Browse... and then navigate to and select the .xml file you want to import. 
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5. Click Next. A dialog box opens that allows you to make decisions about resolving 
name conflicts, importing categories, procedure code matching, and Default and 
Normal conflicts.

The following table (continued on the next page) explains the selections and their impact 
on one another:

Item Selection Description/Availability

utoText name-conflict 
esolution

Rename and Import AutoText Allows you to rename an imported 
AutoText that has the same name as an 
existing AutoText.

Overwrite existing AutoText Overwrites an existing AutoText that has 
the same name.

Do Not Import AutoText Does not import an AutoText that has the 
same name as an existing AutoText.
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6. Click Next. The software reads the file and determines the status of each entry in 
relation to those already in the system. 

utoText categorization

Import categorization
(Only available when Rename and 
Import AutoText is selected)

Imports the procedure categorization of an 
AutoText when a matching procedure 
code and/or description exists in the 
import target. The behavior of this 
selection is dependent on what is selected 
for Procedure code matching (described 
below).

Reset existing categorization
(Only available when Overwrite 
existing AutoText is selected)

Resets the existing categorizations to that 
of the imported AutoText.

Merge categorization
(Only available when Overwrite 
existing AutoText is selected)

Retains the current procedure 
categorizations and imports the new 
procedure categorizations.

Do not import categorization Select this option to NOT import 
procedure categorization even though a 
matching procedure might exist in the 
import target.

rocedure code matching

Use Code & Description Imports the AutoText categorizations 
when both the Procedure Code and the 
Procedure Description are identical to 
those in the target site. 

Use Code Imports the AutoText categorizations 
when the Procedure Code is identical to 
the Procedure Code in the target site. 

Use Description Imports the AutoText categorizations 
when the Procedure Description is 
identical to the Procedure Description in 
the target site.

mport Default/Normal

For categorized AutoText only Imports the AutoText Default/Normal 
attributes when the imported AutoText is 
categorized to matching procedures.

Clear imported settings Retains the original Default/Normal 
attributes and does NOT import Default/
Normal attributes of categorized 
AutoTexts.

mported Default/Normal 
verrides conflicting

Check box Select this check box to have the imported 
Default and Normal AutoTexts override 
any existing Default and Normal 
AutoTexts with which they conflict.

Item Selection Description/Availability
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A table displays the entries found in the file.

The Status column displays each AutoText entry’s status with relation to those already 
in the system. 

• New: The AutoText entry is being added to the system for the first time. 

• Conflicting: The entry has the same names/shortcut combination as an entry 
already in an account or site in the system. You have the opportunity to change the 
name, to overwrite the existing entry with the new one, or to omit the entry from the 
import process. 

• Unmodified: The AutoText entry exists in the system, with the same name/shortcut 
or with a different one, and has not been changed. 

• Modified: An AutoText entry with the same internal ID exists in the system, with 
the same name/shortcut or with a different one, and has been changed.

To change a conflicting AutoText entry’s name: 

 a. Type the new name in the Name column.

 b. Click the Save icon.
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7. Place a check mark next to each AutoText entry you want to import, or check the box 
in the heading to import all the entries in the list.
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8. Click Import. The AutoText entries are imported. A message box indicates the results 
of the import process.

• Processed: Entries found in the import file.

• Ignored: Entries you chose not to import. 

• Renamed: Conflicting entries that were imported with new names.

• Overwritten: Conflicting entries that were imported and replaced existing entries. 

• New count: New entries that were added to the site/account

• Modified: Modified entries that were imported.

• Failed: Entries that could not be imported. 
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Importing AutoText Entries from PowerScribe Workstation

Follow this procedure to import AutoText entries you have exported from the 
PowerScribe Workstation application.

To import AutoText entries from PowerScribe Workstation:

1. On the AutoText tab of the Setup group, click Import.... The Import AutoText 
dialog box opens.

2. Select RadWhere/PowerScribe.

3. Click Browse... and then navigate to and select the file you want to import. 

4. Select the Import target from the drop-down list. For example, you can import 
AutoText entries to a single user account. Or, you can import them to a site for use by 
all users at the site. 

5. Click Next. 
6
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A table displays the entries found in the file.

The Status column displays each AutoText entry’s status with relation to those already 
in the system. 

• New: The AutoText entry is being added to the system for the first time. 

• Conflicting: The entry has the same names/shortcut combination as an entry 
already in an account or site in the system. You have the opportunity to change the 
name, to overwrite the existing entry with the new one, or to omit the entry from the 
import process. 

To change a conflicting AutoText entry’s name: 

 a. Type the new name in the Name column.

 b. Click the Save icon.

6. Place a check mark next to each AutoText entry you want to import, or check the box 
in the heading to import all the entries in the list.
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7. Click Import Selected. The AutoText entries are imported. A message box displays 
the results of the import process.

• Processed: Entries found in the import file.

• Ignored: Entries you chose not to import. 

• Renamed: Conflicting entries that were imported with new names.

• Overwritten: Conflicting entries that were imported and replaced existing entries. 

• New count: New entries that were added to the site/account.

• Failed: Entries that could not be imported. 

Importing Macros from the Agfa TalkStation Application

In the TalkStation application, all macros for a particular user are stored in a single folder. 
Therefore you need only specify the path and folder name; all macros in any files in the 
folder are imported. 

To import macros from the Agfa TalkStation application: 

1. On the AutoText tab of the Setup group, click Import.... The Import AutoText 
dialog box opens.

2. Select Talk. 

3. Specify the path and folder name. The folder you specify must contain a subfolder 
called Macros; that folder contains the files from which you will import the macros. 
8
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Note: For a network drive, use the original UNC path name. Or, you can copy 
the files from the network location to a folder on your own computer. In either 
case, the Administrator Portal must have read access to the path you specify. 

4. Select the import target from the drop-down list. You can import macros to a single 
user account, or you can import them to a site for use by all users in the site. 

5. Click Next. The software reads the file and determines the status of each macro found 
in relation to those already in the system. 

• New: The macro is being added to the system for the first time. 

• Conflicting: The macro has the same names/shortcut combination as an entry 
already in an account or site in the system. You have the opportunity to change the 
name, to overwrite the existing entry with the new one, or to omit the entry from the 
import process. 

6. Place a check mark next to each macro you want to import. 

7. Click Import Selected. The macros are imported, and handled according to the 
options you selected. A message box indicates the number of entries processed. 

Exporting AutoText

You can export selected AutoText entries to an .xml file. You can then import the .xml file 
to add the AutoText entries to another user or site. 

If you export an AutoText entry that has been associated with one or more procedure 
codes, its procedure codes are exported. If that AutoText is then imported back to the 
same system—for example, from one account to another— then the procedure codes are 
all imported along with it. 

On the other hand, if it is imported to another system, which has its own procedures, then 
the codes found in the .xml file are used to map to procedures in the new system. If no 
such mapping exists, the imported AutoText entries appear as uncategorized (that is, they 
have no associated procedures). Note also that since the mappings relationship is by 
definition many-to-many, you will need to review the AutoText entries in the new system 
and ensure that they are associated with the correct procedure codes. 

To export AutoText: 

1. Find the AutoText entry or entries you want to export. Refer to “Searching for 
AutoText Entries in the Administrator Portal” on page 304.
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2. Place a check mark next to each AutoText entry you want to export. To export all the 
AutoText entries in the list, place a check mark in the heading.

3. Click Export. You are prompted to open or save the file AutoTextExport.xml.
0
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4. Click Save. The Save As window opens.

5. Navigate to and select the folder in which you want to save the .xml file, and then click 
Save. The file is stored at the location you specified.

Promoting, Upgrading, and Deleting AutoText 
Entries

In the PowerScribe 360 | Reporting Administrator Portal, you can: 

• Promote AutoText entries—make private AutoText entries available to all providers in 
a site. AutoText names and shortcuts must be unique within the site. 

• Upgrade AutoText entries—remove unnecessary code from AutoText entries 
originally created in the RadWhere application. 

• Delete AutoText entries—remove AutoText entries from the system for any reason.

Promoting an AutoText Entry

To promote a private AutoText entry for use at the site level: 

1. Use the search feature to find the AutoText you want to promote. Refer to Searching 
for AutoText Entries in the Administrator Portal, beginning on page 304.

Tip: Use the Owner drop-down list to find AutoText belonging to the provider 
who created private AutoText entries. Private AutoText entries have a key icon.

2. Place a check mark next to the AutoText you want to promote. 
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3. Click Promote. You see a confirmation message.

4. Click OK to proceed. The AutoText becomes available to all providers in the site. 
2
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Upgrading AutoText Entries

Note: Use the Upgrade button only when upgrading from a version of the RadWhere 
software product to PowerScribe 360 | Reporting. You do not have to upgrade AutoText 
entries when upgrading from one version of PowerScribe 360 | Reporting to another.

This task strips the font information and other hidden code, unnecessary in the current 
version, from all site and account AutoText entries in the legacy RadWhere software 
product. This action prevents any undesired formatting when AutoText is inserted into a 
report.

To upgrade an old AutoText entry: 

1. Select the AutoText tab in the Setup group. 

2. Click Upgrade. You see a confirmation message.

3. Click OK to proceed. You see a confirmation message indicating how many AutoText 
entries were modified.

4. Click OK.
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Deleting AutoText Entries

You can delete AutoText entries you no longer want to keep in the system. 

To delete an AutoText entry: 

1. Use the search feature to find the AutoText you want to delete. Refer to “Searching for 
AutoText Entries in the Administrator Portal” on page 304.

2. Place a check mark next to each AutoText entry you want to delete.

3. Click Delete. You see a confirmation message.

4. Click OK. The items you selected are deleted from the system.

Printing AutoText Entries

You can print a list of AutoText entries belonging to an individual user, for the system, or 
through the Reporting feature in PowerScribe 360 | Reporting. Refer to Running the 
AutoText—Verbiage Report, beginning on page 531. 
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Custom Fields

Objectives
In this chapter you will:

• Manage custom fields in the Administrator 
Portal

• Create custom fields for populating exam data in 
AutoText.

• Create custom fields for exporting in the HL7 
message.
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Introduction to Custom Fields

Custom fields are data items (also called metadata) associated with a particular order. You can 
use custom fields:

• as merge fields to populate exam data in an AutoText, such as measurements, radiation 
dosage information, flags, and so on.

• to export an HL7 message to the RIS, such as when a mammography exam requires a 
follow-up letter to the patient. 

Custom fields can be automatically populated with data by an interfaced RIS and/or imaging 
machine. In addition, radiologists, editors, technologists, and administrators can populate data 
in custom fields. As an administrator, you can define custom fields for each of your facility's 
sites. 
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Creating Custom Fields

You can create a custom field as a free-text field or as a pick list. For example, you could 
create a free-text field for assigning an exam measurement, while a pick-list field would be 
appropriate for selecting a significant findings alert. If the custom field is marked as required, 
it must be populated with a value by the radiologist prior to signing the report. 

Create a Free-Text Custom Field

1. In the Administrator Portal, click Setup > Sites.

2. From the drop-down list at the upper right, select a site.

3. In the Custom Fields section, click the Create new item icon to begin creating a 
custom field.

4. Type a Name for your custom field (see Practical Examples for Using Custom Fields, 
beginning on page 340).

5. Type a Description (optional).

6. Act (active) is automatically selected, which causes the field to appear in the merge 
field Custom drop-down listing in the PowerScribe 360 | Reporting client application.
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7. If applicable, select Exp which causes the data in the field to be exportable in the HL7 
message by the Bridge to the RIS. 

8. If applicable, select RF which requires that the radiologist populates the field with a 
value prior to signing a final report.

Note: If the custom field you are creating applies only to specific procedure 
codes, do not select this check box until you have assigned the specific 
procedure codes.

9. If applicable, select RP which requires that the radiologist populates the field with a 
value prior to signing a preliminary report.

10. Click the Commit changes icon to save the new field. The illustration below 
shows an example of a free-text custom field.

Create a Pick List Custom Field

1. In the Choices column for one of your custom fields, click Edit. The Custom Field 
Choices dialog box opens.

2. Click the Create new item icon. 

3. Enter the first Value. (Your RIS may limit what you enter here because the text in the 
Value field is exported in the HL7 message). 

4. Enter a corresponding Label which will display in a drop-down list of choices for the 
user to see and select (either by voice or mouse click). 
8
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5. Enter an Export Value. The export value is sent in the OBX5 segment of the HL7 
message during the report upload, allowing more flexibility to configure the Value 
field as a custom merge field in AutoTexts

6. Set the Active check box as needed.

7. To allow a user to select more than one of these choices when using the custom field, 
select the Allow multiple selections check box. With this check box selected, the user 
will see individual check boxes for each custom field choice.

8. Click the Commit changes icon to save the new choice.

9. Repeat steps 2 through 8 for each new choice to add to the pick list.

10. Click Close Window link to return to the Custom Fields section.

Associate Procedure Codes with a Custom Field
Associating one or more procedure codes with a custom field ensures that the custom field 
is available to populate with exam data applicable to the associated procedures. For 
example, when custom fields are built for carotid ultrasound measurements, those fields 
are available to populate when carotid ultrasound procedures are performed on patients. 

1. After creating a free-text or pick-list custom field as described above, click Add under 
the Procedures column in the row of the newly created custom field. The Procedure 
Code Selection dialog box opens.
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2. Enter the search parameters for the procedures you want to associate with the custom 
field using one of the following methods:

• Select a Modality and Anatomy.

• Type a procedure code or procedure description in the Procedure Code/
Description field.

3. Click Search to display the applicable procedures in the All Procedures list.

4. In the All Procedures list on the left, select each procedure you want to associate with 
the custom field and click Add. The procedures appear in the Selected Procedures list 
on the right. 

To dissociate a procedure code from a custom field, select the procedure code to 
remove in the Selected Procedures list and click Remove. 

5. Click Close Window in the upper right to return to the Custom Fields section.
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Inserting Custom Fields into AutoText

In order to have custom fields populate exam data into an AutoText, create an AutoText 
containing those custom fields as merge fields.

1. From the client application AutoText Editor screen, place your cursor where you want 
to insert the custom field.

2. In the toolbar, click the down arrow next to Merge. Float your mouse over Custom 
and select the desired custom field from the submenu. (Or use the Merge Fields tab 
located on the right side of the AutoText Editor window.)
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The field appears in the AutoText.

3. Repeat steps 1 and 2 above to insert additional custom fields into the AutoText.

4. Save and close the AutoText.
2
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Assigning Values to Custom Fields

Assigning values to custom fields may be very useful for reporting in that it can alleviate the 
radiologist from having to dictate exam measurements. Editors and technologists can assign 
values to custom fields on unreported orders using the PowerScribe 360 | Reporting client. 
Radiologists can also use the client to assign values to custom fields during the reporting 
stage. Alternatively, editors and technologists can use the PowerScribe 360 | Reporting 
Administrator Portal to assign values to custom fields on unreported orders. Administrators 
can assign values to custom fields at any time using the administrator portal.

Assigning Custom Fields Using the 
PowerScribe 360 | Reporting Client

You can assign custom field values in the client application from either the Explorer 
screen or the Report Editor screen. 

Assigning Custom Fields from the Explorer Screen

1. Search for and select the applicable exam. With the exam highlighted, click the Insert 
Custom Fields link on the Order Data tab. The Custom Fields dialog box opens. 
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2. Click the Value column to assign a value to the custom field. Some custom fields are 
set up with drop-down lists while others require that you type in a value. 

Note: You do not have to assign values to all the custom fields; only for those 
that pertain to your report. In the above illustration, BI-RADS would not be 
applicable to the report and would, therefore, be skipped. 

3. To view only custom fields that relate to your current role in the system (Attending, 
Resident, Editor, and Technologist), select the Filter by role check box. Selecting this 
check box allows you to work with only the custom fields in a report that relate to your 
particular role.

4. When finished populating the custom fields for your report, click OK. The image 
below shows the populated custom fields in the Order Data tab.
4
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Assigning Custom Fields from the Report Editor Screen

1. Select Properties from the navigation panel and click the Insert Custom Fields link 
(or click Insert > Custom Fields from the menu bar). The Custom Fields dialog box 
opens.

2. Click the Value column to assign a value to the custom field.    

3. When finished populating the custom fields for your report, click OK. 
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The custom fields appear in the Custom Fields section of Properties in the navigation 
panel.
6



Chapter 13: Custom Fields
Assigning Custom Fields Using the 
PowerScribe 360 | Reporting Administrator Portal

The portal view differs depending on the role of the user (i.e., whether the user is an 
editor, technologist or administrator). An administrator can populate or change custom 
fields at any stage of reporting, even after the report is final.

Assigning Custom Fields as an Editor or Technologist

1. As an editor or technologist logged into the portal, search for the applicable exam 
under the Explorer tab. Select the Custom Fields tab and click Insert Custom 
Fields, which opens the Order Custom Fields dialog box. 
337



33

PowerScribe® 360 | Reporting System Administrator Guide
2. Click the Value column to assign a value to the custom field.    

3. When finished populating the custom fields for your report, click Save Changes and 
Close Window.

Assigning Custom Fields as an Administrator

1. Log in to the portal as an administrator, search for and select the applicable exam 
under the Explorer tab. 

2. Click Actions and select Edit Custom Fields, which opens the Order Custom Fields 
dialog box.

3. Click the Value column to assign a value to the custom field. 

4. When finished populating or changing the custom fields, click Save Changes and 
Close Window. 
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Attempting to Sign a Report without Assigning Values to Custom 
Fields

If a custom field is required (which means that the RF and/or RP check boxes were 
selected when the field was created), the radiologist must assign a value to the custom 
field prior to signing the report. If the radiologist attempts to sign a report containing an 
empty, required custom field, the Custom Fields dialog window opens. If the radiologist 
clicks OK or Cancel without assigning a value to the custom field, a message window 
opens stating Please fill in the required custom fields for all the accessions of the 
report.
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Practical Examples for Using 
Custom Fields

Example 1: Mammography BI-RADS
Custom fields can be used for mammography BI-RADS when a hospital requires two 
separate codes, one to convey the BI-RADS score, and the other to send an HL7 message 
to the RIS to trigger a follow-up letter to the patient when her score indicates a level of 
suspicion for the possibility of breast cancer. The BI-RADS value as well as the HL7 
follow-up message are selected from pick-list custom fields by the radiologist during 
reporting and prior to signing the report.

1. Create and save a pick-list custom field named BIRADS with the Act, Exp, and RF 
and/or RP check boxes selected.

2. Under Choices, click the Edit link.
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3. Edit the Choices column to enter each Value, Label, and Export Value as pick list 
selections.

4. Click the Close Window link.

5. Under the BIRADS custom field’s Procedures column, click Edit. 
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The Procedure Code Selection dialog box opens.

6. Search for and select the applicable mammography procedures. 

7. Click Add to copy the procedures to the Selected Procedures column. 

8. Click the Close Window link. The procedures you selected are now associated with 
the BIRADS custom field.

9. Create and save a pick-list custom field named Follow-up Recommendation with the 
Act, Exp, and RF and/or RP check boxes selected.
2
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10. Under Choices, click the Edit link.

11. Enter a value and label for each pick-list selection.

12. Click the Close Window link.
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13. Under the Follow-up Recommendation custom field’s Procedures column, click 
Add.

14. Repeat steps 6 through 8 above to search for, select and add the applicable 
mammography procedures to associate them with the Follow-up Recommendation 
custom field.
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Note: If you want to have the BI-RADS and Follow-up Recommendation text appear in the 
dictated report, then create an AutoText containing those fields as either custom merge 
fields or pick list fill-in fields (see Creating a Pick List Fill-in Field, beginning on 
page 277). 
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Example 2: Carotid Ultrasound
Using AutoText custom fields that contain exam data, such as carotid ultrasound 
measurements, can help reduce report turnaround times. Exam data can be added 
automatically by an imaging machine, or manually by a technologist, so the radiologist 
does not have to dictate the measurements during reporting.

1. Create and save several free-text custom fields, one per carotid artery measurement, 
with Act (Active) check box selected.

Tip: Begin the Name of each custom field with the same word (Carotid in this 
example) followed by a numeric sequence (0.1, 0.2, and so on, in this example). 
Doing this causes the fields to appear in a logical sequence in the client 
application Custom Fields drop-down list.
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2. Under the custom field’s Procedures column, click Edit.

The Procedure Code Selection dialog box opens.

3. Search for and select the applicable carotid procedures. 

4. Click Add to copy the procedures to the Selected Procedures column. 
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5. Using the client application, create a carotid AutoText and insert the custom fields as 
merge fields. 
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6. Assign values to the custom fields for the exam accession number.

7. The following illustration shows the pre-populated carotid custom fields in the 
AutoText prior to report dictation.
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Example 3: Alerts
You can use a custom field to send an HL7 message to the RIS in order to communicate an 
alert for a significant finding. For example, if the results of an exam demonstrate acute 
appendicitis requiring immediate surgery for treatment, a radiologist can send an HL7 red 
alert message by using a custom field. 

1. Create and save a pick-list custom field named Alert with the Act, Exp, and RF and/
or RP check boxes selected.

Note: Because we want the Alert custom field to apply to all procedures, do not 
add any specific Procedures (last column) to this alert.
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2. Click Edit in the Choices column to enter each value, label, and export value as pick 
list selections.
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The following illustrations show the radiologist selecting a value for the Alert custom 
field, and the results of selecting that field as it appears in under Properties to the left.
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Creating a Custom Fields Worklist

You can create a worklist to retrieve only those orders and reports containing a custom field 
that was assigned a particular value, such as a red alert for a significant finding requiring 
immediate treatment.

1. From the Administrator Portal, select the Setup group and click the System tab.

2. In the Worklists section, click the Create New icon.

3. Enter a Name and a Description (optional) for the worklist.

4. Click the Commit Changes icon.
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5. In the Worklists section on the row where the new worklist was added, click Edit 
under the Definition column. 
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6. The Worklists dialog box opens, showing the name of the worklist and the tree 
structure to be used to design the query. Click the Composite Expression link on the 
left side of the window.

7. From the drop-down list on the right, select Simple Expression and click Add.
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8. Select the applicable field name, such as Alert in this example, from the Field drop-
down list.
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9. Select the applicable Operator (Equals in this example) from the Operator drop-
down list.
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10. Select the applicable Value (Red in this example) from the Values drop-down list.

11. Click Update. The newly created expression now appears on the left side of the 
window.

12. Click Save and Close.
8
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Searching Using the Custom Fields 
Worklist

You can now search using the newly created custom fields worklist to retrieve those orders 
and reports containing the particular value, such as Red alert in this example.

1. From the Administrator Portal, select the Exams group and click the Explorer tab.

2. In the WL search section, select the applicable worklist from the drop-down list.
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3. Click Search. Any reports containing the Red alert custom field appear in the results 
grid.

Running the Custom Fields Report

For information on running the Custom Fields management report, see Report Custom Fields, 
beginning on page 536.
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AutoFormatting Rules

Objectives
In this chapter, you will:

• Configure autoformatting options
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Setting Autoformatting Rules for 
Dictated Text

The autoformatting rules, also referred to as post-processing rules, determine how text 
appears in finished reports. You can change the default settings for these rules to fit your 
organization’s standards. The Formatting dialog box allows you to set formatting rules for 
your entire facility. 

Tips for AutoFormatting Rules
• When administrators configure AutoFormatting rules using the Admin Portal (Setup > 

Speech > Edit Formatting Options), the rules apply to all users in all sites throughout the 
system.

• Providers who were granted the Allow Dragon Formatting Dialog dictation preference 
can set their own rules. If necessary, remind providers that they can click Restore 
Defaults to return these options to their original settings.

• Administrators can configure an individual provider’s AutoFormatting rules, but only by 
logging into the provider’s account using the provider’s user name and password.
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Configuring the AutoFormatting Rules
To set the autoformatting rules: 

1. In the Setup group, select the Speech tab. 

2. Click Edit Formatting Options. The Speech Formatting dialog box opens.
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3. Set the options on the General, Capitalization, Numbers, Units and Dates, 
Abbreviations; Section Headings; Vertebrae; and Miscellaneous tabs. On each of 
these tabs, the green, bracketed text at the far right next to each option shows the 
default value; True means the check box is selected, False means the check box is 
cleared. Where the option name is shown in bold text, you have changed the value 
from the default. 

• General (page 365)

• Capitalization (page 375)

• Number, Units, and Dates (page 378)

• Abbreviations (page 385)

• Section Headings

• Vertebrae

• Miscellaneous (page 396)

Tips: To set all the values on a tab to ‘True’, click Check All. Likewise, select 
Uncheck All to set all the values on the currently selected tab to ‘False.’ Click 
Restore Defaults to set all values to their original defaults.

4. Click Save and Close to save your changes. The users will see the changes after their 
next login. 
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General Tab
This tab contains rules for various items such as dates, numbers, and measurements.
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Format Dates

This option determines whether the software converts dictated dates to your selected date 
format.

* = Default selection

Date Format

This option controls how the software formats dates when the user dictates the day, 
month, and year.

Selection Results

Checked* The dictated dates are placed in the format you 
select.

Not checked The dates are unformatted and appear in the
document as dictated.

Selection Results

Date as spoken* No formatting; dates appear as dictated.

Month D, YYYY March 3, 2013

Month DD, YYYY May 03, 2013

Mon D, YYYY Oct 3, 2013

Mon DD, YYYY Oct 03, 2013

M/D/YYYY 2/4/2013

M/D/YY 2/4/13

MM/DD/YYYY 02/04/2013

MM/DD/YY 02/04/13

MM-DD-YY 03-11-13

D Month, YYYY 27 March, 2013

D/M/YYYY 2/3/2013

D/M/YY 2/3/13

DD/MM/YYYY 02/03/2013

DD/MM/YY 02/03/13

YYYY-MM-DD 2013-05-23

* = Default selection
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Format Times

Turns on automatic formatting of standard time formats. For example, if the user dictates 
“Six thirty PM,” the software transcribes 6:30 PM. Dictating standard time runs on a 
12-hour clock, letting the user make the distinction between AM and PM.

Format Common English Abbreviations

This option enables the software to recognize most standard abbreviations. 

* = Default selection

Expand Common English Contractions

Select this option if you want the software to spell out contractions in full, rather than 
showing them as contractions. 

In some situations, a contraction is ambiguous. For example, the phrase “It’s always” 
might mean either “It is always” or “It has always,” depending on the word that follows. 
In this situation, the software expands the contraction regardless of how you have set this 
option.

* = Default selection

Selection Results

Checked* 6:30 p.m.

Not checked Six thirty p.m.

* = Default selection

Selection Results

Checked Dept.
Inst.
vs.
Corp.

Not checked* Department
Institute
versus
Corporation

Selection Results

Checked He is
It is

Not checked* He’s
It’s
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Abbreviate Common English Units of Measure

Use this option to turn on automatic formatting of standard units of measure such as feet 
and inches.

Format Street Addresses

Turns on automatic formatting of postal addresses. 

For UK English users, this option also enables the proper formatting of UK and Canadian 
post codes. US English users can enable UK and Canadian post codes by selecting the 
Format UK and Canadian Postcodes option.

Format UK and Canadian Postcodes

This option applies only to US English. With the option selected, the software properly 
formats UK and Canadian postal codes.

* = Default selection

Selection Results

Checked* Patient weighs 150 lbs.
9 mm

Not checked Patient weighs 150 pounds.
9 millimeters

* = Default selection

Selection Results

Checked* 100 Main Street, New York, NY 10007

Not checked 100 Main Street New York New York 10007

* = Default selection

Selection Results

Checked London, W2 4RJ
Toronto, Ontario M5H 2L2

Not checked* London, W24RJ
Toronto, Ontario M5 H2 L2
8
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Abbreviate Titles

This option inserts abbreviations for titles.

Format ISO Currency Codes

You can select this option if you have selected the Format Prices option. This setting 
enables the software to display currency amounts with the international code for the 
language you have chosen in the Windows Regional and Language Options tool in the 
Control Panel.

* = Default selection

Format prices

Inserts prices and currencies in the proper format with the appropriate currency symbol.

Format phone numbers

Select this option to turn on automatic formatting of telephone numbers. 

For US English users: Turns on automatic formatting of North American telephone 
numbers when the user dictates a sequence of seven or ten numbers. 

Selection Results

Checked* Mr.
Dr.

Not checked Mister
Doctor

* = Default selection

Selection Results

Checked USD10

Not checked* 10 dollars

Selection Results

Checked* $200
$200.50
€50 

Not checked 200 dollars
200 dollars and 50 cents
50 euros

* = Default selection
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Notes: 

• Vanity phone numbers such as 1-800-EXAMPLE are not supported. 

• The automatic formatting of North American telephone numbers is not supported 
for UK English users.

For UK English users:   Turns on automatic formatting of UK telephone numbers.

Notes: 

• Country code +44 can be dictated as “four four,” “forty four,” or “double four” 
with preceding “plus” or “plus-sign.” For example, if the user dictates “plus-sign 
four four two nine two oh seven four seven seven four seven,” the software 
transcribes “+44 29 2074 7747”.

• Area codes that are dictated without the preceding country code must be dictated 
with leading zero. For example, when the user dictates “zero two nine two oh eight 
seven nine three two seven,”, the software transcribes “029 2087 9327”. 

• When the user dictates a 6-digit number, the software transcribes the number with 
no spaces. When the user dictates a seven- or eight-digit number, the software 
transcribes the number with a space before the last four digits. 

• The automatic formatting of UK telephone numbers is not supported for US English 
users.

Format Other Numbers

This option enables formatting of all numbers not covered by other formatting options, 
such as negative numbers, numbers with punctuation, fractions, decimals, and Roman 
numerals. 

Selection Results

Checked* 212- 555-1000

Not checked 2125551000

* = Default selection

Selection Results

Checked* 1,205.7
22,500.7

Not checked 1205 .seven
22,500 .seven

* = Default selection
0
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Format Web and E-mail Addresses

Web and email addresses are formatted automatically, allow the user to dictate them in a 
natural manner. Names are concatenated and the word at is converted to the @ symbol.

“million” instead of “,000,000”

Inserts numbers as a combination of text and Arabic numerals. 

Format US Social Security Numbers

This option applies only to US English. With this option selected, if the user dictates nine 
numbers in sequence, automatic formatting of social security numbers is activated.

* = Default selection

Allow Pauses in Formatted Phrases

A speaker is likely to pause while dictating a number with many digits. If you select this 
option, the speech recognition software does not attempt to interpret a number until the 
speaker finishes dictating all the digits and begins dictating the next word. Then, it uses 
the context to interpret the number as an MRN, a phone number, a social security number, 
or another type of number.

Selection Results

Checked* doctor@hospital.com

Not checked Dr. at hospital.com

* = Default selection

Selection Results

Checked* 5 million

Not checked 5,000,000

* = Default selection

Selection Results

Checked Social security number is 123-45-6789.

Not checked* Social security number is 123456789.

Selection Results

Checked* A number is not immediately formatted 
when the speaker pauses. 

Not checked Pauses in number dictation can result in
premature number formatting.

* = Default selection
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Rewrite “mass-effect” to “mass effect”

Removes the hyphen from the term “mass-effect.”

* = Default selection

Drop the number “12” in expressions “12 noon” and “12 
midnight”

Removes the number 12 from time expressions, leaving only either “noon” or “midnight.”

* = Default selection

Allow dictation of years as a sequence of 4 digits

For example, allows providers to dictate “two zero one three” to indicate the year 2013.

* = Default selection

Insert Two Spaces After Period

Adds two spaces after the end of a sentence instead of a single space.

* = Default selection

Selection Results

Checked* “mass effect”

Not checked “mass-effect”

Selection Results

Checked “12 noon” or “12 midnight”

Not checked* “noon” or “midnight”

Selection Results

Checked 2013

Not checked* two zero one three

Selection Results

Checked Two spaces after a period.

Not checked* One space after a period.
2
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Replace profanities with variations of [expletive], delete them, or 
leave them as dictated

Allows you to decide how to treat profanities.

* = Default selection

Use military rank abbreviations appropriate for the branch 
selected

Adds the appropriate rank based upon military branch selected.

* = Default selection

Determine how “q.d.”, “q. day”, and “q. daily” are written out

Choose the preference used by your sites.

* = Default selection

Numbers, if Greater Than or Equal to

Numbers below the one you select are spelled out in full. Numbers equal to or greater than 
this number appear as digits.

Selection Results

Default is as dictated Choose from as dictated; no output; 
[EXPLETIVE]; or [expletive]

Selection Results

Default is None Choose from Army; Navy; Air Force; 
Marines; or None

Selection Results

Default is as dictated Choose from q.d.; daily; q. day; q. daily; or as 
dictated

Selection Results

0 The dictated number “zero” appears as zero, and 
the numbers one and higher appear as 1, 2, 3, 4, 
and so on. 

* = Default selection
373



37

PowerScribe® 360 | Reporting System Administrator Guide
Caps Lock Key Overrides Capitalization Commands

This option provides a reliable way to enter text in all capital letters. If you select this 
option, when the user activates Caps Lock by pressing the Caps Lock key or 
pronouncing the corresponding voice command, the following capitalization commands 
have no effect: Cap <word>, Caps On, Caps Off, All-Caps <word>, All-Caps On, All-
Caps Off, No-Caps <word>, No-Caps On, and No-Caps Off. The Cap That, All-Caps 
That, No-Caps That and Capitalize <words> commands, however, work as they 
normally do. 

* = Default selection

2* The dictated numbers “zero” and “one” appears 
as zero and one, and the numbers two and higher 
appear as 2, 3, 4, and so on. 

10 The dictated numbers “zero” through “nine” 
appears as zero through nine, and the numbers 
ten and higher appear as 10, 11, 12, and so on.

100 The dictated numbers “zero” through “ninety-
nine” appear as zero through ninety-nine, and 
the numbers one hundred and higher appear as 
100, 101, 102, and so on. 

No formatting All numbers are spelled out, except where 
another formatting rule applies to them.

Selection Results

Checked While Caps Lock is on, the Cap <word>, Caps
On, Caps Off, All-Caps <word>, All-Caps
On, All-Caps Off, No-Caps <word>, No-Caps
On, and No-Caps Off commands have no
effect.

Not checked* All capitalization commands work as usual
while Caps Lock is on.

* = Default selection
4
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Capitalization Tab
Use this tab to set capitalization rules for the names of persons, departments, drugs, and so 
on.
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Person Name Capitalization

Department Name Capitalization

Drug Name Capitalization

Capitalize the Word After a New Line

Selection Results

Standard* Jason T. Myers

All caps JASON T. MYERS

* = Default selection

Selection Results

Standard* Nuclear Medicine Department

All caps NUCLEAR MEDICINE DEPARTMENT

* = Default selection

Selection Results

Initial caps Aspirin
Buspar

Standard* Aspirin
BuSpar

All caps ASPIRIN
BUSPAR

* = Default selection

Selection Results

Checked* First word after a line break is automatically 
capitalized. 

Not checked First word after a line break is not automatically 
capitalized, unless another capitalization rule 
applies to it. 

* = Default selection
6
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Capitalization/Expansion of Special Words and Phrases

Selection Results

allergy, allergies ALLERGY, ALLERGIES

against medical advice* AGAINST MEDICAL ADVICE

AMA AGAINST MEDICAL ADVICE

code blue* CODE BLUE

code R* CODE R

code status* CODE STATUS

code S* CODE S

code T* CODE T

do not intubate
do not resuscitate*

DO NOT INTUBATE
DO NOT RESUSCITATE

DNI
DNR

DO NOT INTUBATE
DO NOT RESUSCITATE

durable power of attorney* DURABLE POWER OF ATTORNEY

fish FISH

left and right LEFT, RIGHT

living will LIVING WILL

NKDA NO KNOWN DRUG ALLERGIES

PO2
PCO2*

pO2
pCO2

RBC/hpf
WBC/hpf

RBC/HPF
WBC/HPF

trauma alert* TRAUMA ALERT

room; emergency room* ROOM 25; EMERGENCY ROOM 1

* = Default selection
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Numbers, Units, and Dates Tab
On this tab you can specify how the software is to treat various numbers and 
measurements.
8
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Treat Ambiguous Numeric Strings

This option determines whether the software interprets dictated strings of numbers as 
dates, or as ID numbers. 

• If you choose As Dates, select the Format dates option on the General tab, and then 
select a format from the Date format drop-down list. Do not select Dates as Spoken 
as the date format. 

• If you choose As IDs, the software converts dictated numbers to a series of digits 
without spaces. For example, if the user dictates “five six oh nine,” the software 
transcribes the string as 5609. If the user dictates “eight eight six seven three five 
five,” the software transcribes it as 8867355. The user can then punctuate the series of 
numbers as desired. 

Rewrite “cc” after a number as “mL” 

Inserts mL after a number if the user dictates “cc” followed by a number.

Write “degree” and “degrees” after a number as “°” and 
abbreviate “Fahrenheit” and “Celsius” to “F” and “C”

Inserts correctly formatted temperatures. 

Selection Results

As IDs 020310 

As Dates* 02/03/2010 (depending on date format selected) 

* = Default selection

Selection Results

Checked 3 mL 

Not checked* 3 cc 

* = Default selection

Selection Results

Checked 98.6° F

Not checked* 98.6 degrees Fahrenheit

* = Default selection
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Use Roman numerals for diabetes types

Inserts Roman numerals instead of Arabic numerals for diabetes types.

Insert a hyphen between a number and the word “French”

Inserts a hyphen when the user dictates, for example, “Five French” to describe a type of 
equipment.

* = Default selection

Format of expressions involving feet and inches

Use this option to determine how the software is to format expressions with feet and 
inches.

Write one-digit ordinals from “third” to “ninth” in hybrid form 
(“3rd” to “9th”)

This option determines how the software transcribes ordinal numbers. 

* = Default selection

Selection Results

Checked Type II diabetes

Not checked* Type 2 diabetes

* = Default selection

Selection Results

Checked 19-French sheath

Not checked* 19 French sheath

Selection Results

Spell out feet and inches* 6 feet 2 inches

Symbols with one space 6’ 2”

Symbols surrounded by spaces  6’ 2”

Symbols without spaces 6’2”

* = Default selection

Selection Results

Checked 3rd

Not checked* third
0
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Insert a space between “mm” and “Hg”

The option determines whether the software inserts a space between the abbreviations for 
“millimeter” and “mercury.” 

* = Default selection

Write “o’clock” as a word

Use this option to specify where the software is to spell out the word “o’clock.” 

Format numbers as times when followed by phrases such as “in 
the morning”

Note: This option is not fully implemented in this version. 

Inserts numbers as times when followed by phrases like “in the morning” or “at night.”

* = Default selection

Selection Results

Checked mm Hg

Not checked* mmHg

Selection Results

Always At 4 o’clock, the 6 o’clock position

Only before “position” At 4:00, the 6 o’clock position

Never* At 4:00, the 6:00 position

* = Default selection

Selection Results

Checked Numbers followed by these phrases are 
formatted as times of day: “Ten at night” 
becomes 10:00 PM. 

Not checked* Numbers followed by these phrases are
formatted as times only if they end in 00, 15, 30,
or 45, or if they are followed by a.m. or p.m.
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Military time suffix

Controls whether the software inserts the word “hours” or the abbreviation “hrs” after 
military time. 

Write “%” as “percent”

This option inserts the % symbol in place of the word “percent.” 

* = Default selection

Write the word “number” as “#” prior to numerals

Inserts the “#” character in place of the word number prior to a numeral.

* = Default selection

Write plural forms of formatted numbers with an apostrophe (e.g. 
50’s)

For example, “A patient who was in her 50’s.”

* = Default selection

Selection Results

Remove “hours” 17:30

Keep “hours”* 17:30 hours 

Abbreviate as “hrs.” 17:30 hrs

* = Default selection

Selection Results

Checked 100 percent

Not checked* 100%

Selection Results

Checked* #7

Not checked number 7

Selection Results

Checked 50’s

Not checked* 50s
2
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Write single digit + “point” in hyphenated form when not followed 
by another digit

Note: This option is not fully implemented in this version. 

Use this option to insert a digit, a hyphen, and the word “point” when a dictated digit is 
not followed by another digit.

* = Default selection

Write out “positive” and “negative” before numbers and for blood 
types and Rh factors

If you select this option, the software inserts the word “positive” or “negative” rather 
than the plus or minus symbol before numbers. For blood types and Rh factors, it spells 
out the word “positive” or “negative.” 

* = Default selection

Format of each item in a numbered list

Controls the number format of your numbered lists. 

Selection Results

Checked Restraint changed from 3-point to 4-point

Not checked* Restraint changed from 3. to 4.

Selection Results

Checked negative 3
blood type A positive 
Patient is Rh positive

Not checked* -3
blood type A+
Patient is Rh+ 

Selection Results

No indentation, no #* <Text>

No indentation, number 
preceded by #

 #1

Indentation, no #      <Text>

Indentation, number preceded 
by #

     #1

* = Default selection
383



38

PowerScribe® 360 | Reporting System Administrator Guide
Before a numbered list item, automatically insert

Controls line/paragraph break before a numbered list. 

Expect temperatures to be dictated in Celsius rather than 
Fahrenheit

When the user dictates a temperature, the software transcribes it with the C abbreviation.

* = Default selection

Selection Results

New line*

New paragraph

Nothing

* = Default selection

Selection Results

Checked Temperature is 37° C. 

Not checked* Temperature is 37° F.
4
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Abbreviations Tab

Use this tab to indicate whether you want the following abbreviations to be expanded.

Selecting the option means the acronym or abbreviation is always expanded when it 
appears in draft text; otherwise it appears unexpanded (as an acronym or abbreviation.)
385



38

PowerScribe® 360 | Reporting System Administrator Guide
     Term Result when item is selected

ACL anterior cruciate ligament

ADHD attention deficit/hyperactivity disorder

ADL activities of daily living

AICD automatic implantable cardiac defibrillator

AKA above-knee amputation

 alk phos* alkaline phosphatase

ALS amyotrophic lateral sclerosis

AMI acute myocardial infarction

ASAP as soon as possible

ASHD atherosclerotic heart disease

ASM atrial systolic murmur

AST aspartate aminotransferase

AUS artificial urinary sphincter

AVD aortic valve disease

BCG bacille Calmette-Guerin

BHP benign hyperplasia prostate

 bicarb* bicarbonate

bili bilirubin

BKA below-knee amputation

BPH benign prostatic hypertrophy

BP blood pressure

BSO bilateral salpingo-oophorectomy

BX biopsy

CABG coronary artery bypass graft

CAD coronary artery disease

CAF chronic atrial fibrillation

 cath* catheter

CAT scan computed axial tomography scan

CBC complete blood count

CCU Critical Care Unit

 chemo* chemotherapy

CHF congestive heart failure

* = Default selection
6
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CMP complete metabolic panel

CNS central nervous system

coag coagulation

COPD chronic obstructive pulmonary disease

CPK creatine phosphokinase

CPR cardiopulmonary resuscitation

crit hematocrit

CT scan computed tomography scan

CVA costovertebral

C. diff Clostridium difficile

C. diff.*  C. difficile

D&C dilatation and curettage

DC’d discontinued

DESD detrusor-external sphincter dyssynergia

DJD degenerative joint disease

DM diastolic murmur

DSM delayed systolic murmur

DTR deep tendon reflex

DVT deep vein thrombosis

EBL estimated blood loss

EBV Epstein-Barr virus

ECG electrocardiogram

 E. coli* Escherichia coli

EC ejection click

EF ejection fraction

EKG electrocardiogram

EOMI extraocular movements are intact

ERT estrogen replacement therapy

ER Emergency Room

ESM ejection systolic murmur

ESWL extracorporeal shock wave lithotripsy

 ex lap* exploratory laparoscopy

fem-pop* femoropopliteal

     Term Result when item is selected

* = Default selection
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 flex sig* flexible sigmoidoscopy

FT4 free T4

gastroc gastrocnemius

GERD gastroesophageal reflux disease

GI gastrointestinal

GSW gunshot wound

GU genitourinary

H&H hemoglobin and hematocrit

HCTZ hydrochlorothiazide

HIV human immunodeficiency virus

HPI* history of present illness

HPV human papilloma virus

HRT hormone replacement therapy

IBS irritable bowel syndrome

ICA internal carotid artery

ICD implantable cardiac defibrillator

ICU Intensive Care Unit

IDA iron deficiency anemia

IDDM insulin dependent diabetes mellitus

IHD ischemic heart disease

IHSS idiopathic hypertrophic subaortic stenosis

IMCU Intermediate Care Unit

ITP idiopathic thrombocytopenia purpura

IUD intrauterine device

IU* international units

IVP intravenous pyelogram

KUB kidney, ureter, and bladder

LAD left anterior descending

LAE left atrial enlargement

LAH left anterior hemiblock

lap chole* laparoscopic cholecystectomy

LBBB left bundle branch block

     Term Result when item is selected

* = Default selection
8
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LCL lateral collateral ligament

leuk trase leukocyte esterase

lites electrolytes

LLQ left lower quadrant

LSM late systolic murmur

LUQ left upper quadrant

LVEDP left ventricular end-diastolic pressure

LVH left ventricular hypertrophy

MCL medial collateral ligament

MDI metered dose inhaler

meds medications

MI myocardial infarction

MMR measles/mumps/rubella

MOM Milk of Magnesia

MRI magnetic resonance imaging

MVA motor vehicle accident

MVP mitral valve prolapse

MVR mitral valve replacement

neb nebulizer

NEC nonejection click

neph nephrostomy

NICU Neonatal Intensive Care Unit

NIDDM non-insulin-dependent diabetes mellitus

 nitro* nitroglycerin

NSAID nonsteroidal anti-inflammatory drug

NSR normal sinus rhythm

NSVD normal spontaneous vaginal delivery

02 oxygen

ObGyn* OB/GYN

OS opening snap

OTC over-the-counter

PCL posterior cruciate ligament

     Term Result when item is selected

* = Default selection
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PCN percutaneous nephrolithotomy

PEC pulmonary ejection click

PERRLA pupils are equal, round, and reactive to light and 
accommodation

PFT pulmonary function test

PID pelvic inflammatory disease

PIH pregnancy-induced hypertension

PMI point of maximal impulse

postop postoperative

PRI PR interval

pro time prothrombin time

PSA prostate-specific antigen

PSIS posterior superior iliac spine

PSM pansystolic murmur

PTCA percutaneous transluminal coronary angioplasty

pulse ox pulse oximetry

PVR post-void residual

q.h.s.* daily at bedtime

q.o.d.* every other day

RBBB right bundle branch block

rehab* rehabilitation

RLQ right lower quadrant

RPOC retained products of conception

RPR RPR test

RSR regular sinus rhythm

RSV respiratory syncytial virus

SBE subacute bacterial endocarditis

SDM systolic-diastolic murmur

 sed rate* sedimentation rate

segs segments

SEM systolic-ejection murmur

SIDS Sudden Infant Death Syndrome

     Term Result when item is selected

* = Default selection
0
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SI sacroiliac

SLE systemic lupus erythematosus

SLR straight leg raising 

SM systolic murmur

SOB shortness of breath

SSRI selective serotonin reuptake inhibitor

SS summation sound

STD sexually transmitted disease

subcu subcutaneous

SVD spontaneous vaginal delivery

SVG saphenous vein graft

SVT supraventricular tachycardia

TAH/BSO total abdominal hysterectomy with bilateral 
salpingo-oophorectomy

TAH total abdominal hysterectomy

TB tuberculosis

TEE transesophageal echocardiogram

temp temperature (when it occurs before a number)

TIA transient ischemic attack

tib-fib tibia-fibula

t.i.w.* 3 times a week

 T-max*
T-current*

MAXIMUM TEMPERATURE
CURRENT TEMPERATURE

TMJ temporomandibular joint

TM tympanic membrane

TSH thyroid-stimulating hormone

TURB transurethral resection of the bladder

TURP transurethral resection of the prostate

UA urinalysis

UC urine culture

URI upper respiratory infection

UTI urinary tract infection

VBAC vaginal birth after cesarean section

VCUG voiding cystorurethrogram

     Term Result when item is selected

* = Default selection
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A fib and V fib atrial fibrillation and ventricular fibrillation

VL vastus lateralis

VMO vastus medialis oblique

V tach and sinus 
tach

ventricular tachycardia and sinus tachycardia

WNL within normal limits

     Term Result when item is selected

* = Default selection
2
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Section Headings Tab
Use this tab to determine how your section headings and subheadings appear.

Enable headings formatting

* = Default selection

Section headings will appear in all caps

* = Default selection

Selection Results

Checked Allows headings formatting

Not checked* Prevents headings formatting

Selection Results

Checked* IMPRESSION

Not checked Impression
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The word “allergies” will be treated as Section Heading with 
special formatting rules

* = Default selection

Subheading options

* = Default selection

Section subheadings will appear in all caps

Saying “paragraph” inserts two new lines; that is, the result is the same as when saying 
“new paragraph” or “next paragraph.”

* = Default selection

Selection Results

Checked*

Not checked

Selection Results

Default is No subheadings Select either No subheadings; Subheading 
phrases can be major headings, and vice 
versa; or Subheading phrases may only be 
used as subheadings

Selection Results

Checked* KIDNEYS

Not checked Kidneys
4
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Vertebrae Tab
Use this tab to determine how your vertebrae range dictations will appear.

Hyphenate vertebrae ranges such that “C1 7” becomes “C1-7”

* = Default selection

Automatically insert second letter into vertebrae range such that 
“C1 7” becomes “C1 C7”

* = Default selection

Selection Results

Checked* C1-7

Not checked C1 7

Selection Results

Checked C1 C7

Not checked* C1 7
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Miscellaneous Tab

Use this tab to set preferences for spelling, punctuation marks, word substitutions, and 
expansions.
6
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Treat “paragraph” as a paragraph break, not as the word

Saying “paragraph” inserts two new lines; that is, the result is the same as when saying 
“new paragraph” or “next paragraph.”

* = Default selection

Treat paragraph breaks as equivalent to line breaks

Saying “New paragraph” or “Next paragraph” inserts a single line break instead of a 
paragraph break, that is, the result is the same as when saying “New line.” 

* = Default selection

Insert commas or spaces into oncology “T N M” expressions

Note: This option is not fully implemented in this version. 

Determines the delimiter used to separate T N M parameters. 

* = Default selection

Selection Results

Checked* Patient complains of moderate chest pain for the 
past two days. No history of trauma.

Pulse is 120. Blood pressure is normal. 

Not checked Patient complains of moderate chest pain for the 
past two days. No history of trauma. Paragraph 
pulse is 120. Blood pressure is normal.

Selection Results

Checked Patient complains of moderate chest pain for the 
past two days. No history of trauma.
Pulse is 120. Blood pressure is normal. 

Not checked* Patient complains of moderate chest pain for the 
past two days. No history of trauma.

Pulse is 120. Blood pressure is normal.

Selection Results

Default is spaces Choose from commas; spaces; no separator
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Replace “&” with “and”

“And” is substituted when the user dictates “ampersand.”

* = Default selection

Treat “bracket” as equivalent to “parenthesis”

Inserts a parenthesis instead of a square bracket when the user dictates “open bracket,” 
“close bracket,” “left bracket,” or “right bracket.” 

* = Default selection

Write “dash” as:

Determines what the software inserts when a user dictates the word “dash.”

* = Default selection

Write “AP” before the word “diameter” as “A-P”

This option inserts “A-P” when the user dictates “AP diameter.”

Selection Results

Checked D and C

Not checked* D & C

Selection Results

Checked (emergency room)

Not checked* [emergency room]

Selection Results

Double hyphen surrounded by 
spaces

The patient -- unless symptoms improve -- 
should return for another assessment.

Single hyphen* The patient-unless symptoms improve-should 
return for another assessment.

Single hyphen surrounded by 
spaces

The patient - unless symptoms improve - should 
return for another assessment. 

Double hyphen The patient--unless symptoms improve--should 
return for another assessment.

Selection Results
8
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* = Default selection

Spell “BI-RADS” as “BIRADS”

With this option selected, the software inserts the acronym BIRADS when the user 
dictates “BIRADS.” Otherwise, it displays the acronym as BI-RADS.

* = Default selection

Remove hyphen from words such as “intra-axial”

This option removes the hyphen from certain hyphenated words.

* = Default selection

Spell “calyx” and related words with an “i”

* = Default selection

Spell “disc” and related words with a “k”

* = Default selection

Checked A-P diameter

Not checked* AP diameter

Selection Results

Checked BIRADS

Not checked* BI-RADS

Selection Results

Checked* intraaxial

Not checked intra-axial

Selection Results

Checked calix
coccix

Not checked* calyx
coccyx

Selection Results

Checked disk

Not checked* disc
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Spell “orthopedics” and related words with “ae”

* = Default selection

Rewrite “dad”, “kid”, “mom”, “sib” as “father”, “child”, “mother”, 
“sibling”

* = Default selection

Rewrite “off of” as “off”

* = Default selection

Rewrite “I to E” with “I:E”

* = Default selection

Selection Results

Checked orthopaedics
paediatric
encyclopaedia

Not checked* orthopedics
pediatric
encyclopedia

Selection Results

Checked father
child
mother
sibling

Not checked* dad
kid
mom
sib

Selection Results

Checked The patient was lifted off the table.

Not checked* The patient was lifted off of the table.

Selection Results

Checked I:E

Not checked* I to E
0
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Rewrite “hours” to “h.” in dosage abbreviations like “q.2 hours”

* = Default selection

Expand dosage abbreviations

* = Default selection

Abbreviate units names where there is no accompanying number

* = Default selection

Remove periods from dosage abbreviations

* = Default selection

Remove spaces from dosage abbreviations

* = Default selection

Selection Results

Checked q.2 h.

Not checked* q.2 hours

Selection Results

Checked* twice daily

Not checked b.i.d.

Selection Results

Checked cc

Not checked* cubic centimeter

Selection Results

Checked tid

Not checked* t.i.d.

Selection Results

Checked tid

Not checked* t i d
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Format a single letter followed by a single digit (or vice versa)

* = Default selection

Viewing Workstation Updates

The changes you make to the formatting rules above are reflected on the users’ 
workstations next time they log in. To confirm that an update has occurred, you can check 
the date and time of the most recent update to a workstation.

To view the workstation updates: 

1. In the Setup group, select the Speech tab. 

2. Click View Workstation Updates. The Workstation Formatting dialog box displays 
the date and time of the most recent update on each workstation in your system. 

Selection Results

Default is Default Select either DigitLetter, Digit Letter; 
LetterDigit; Letter Digit; or Default

Not checked* C1-2
2
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Creating Worklists

Objectives
In this chapter you will:

• Define worklists as they are used in 
PowerScribe 360 | Reporting 

• Review some sample worklists

• Create a worklist using a simple expression

• Create a worklist using a composite expression

• Create a provider worklist

• Use sections to control worklist access
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Introduction to Worklists

Worklists are predefined searches that retrieve reports and orders. Administrators can create 
worklists for providers, for transcriptionists, and for themselves. A user can search for reports 
and orders by selecting one of these worklists from the Worklist drop-down list in the 
PowerScribe 360 | Reporting client application; the worklist determines which reports appear 
in the Explorer window, and the order in which they appear. You can save time for 
transcriptionists, administrators, and providers by creating worklists for frequently-used 
searches.

Worklists are very powerful, allowing virtually any combination of search criteria, and can 
span multiple sites. For example, you can create a worklist that shows all unreported pediatric 
MRI Brain exams performed in the Emergency Room more than an hour ago. Worklists can 
be simple or complex, depending on your needs.

Here is an example of a worklist:

The worklist above retrieves reports that are pending delivery—that is, reports whose status is 
rejected, failed, or held—and draft reports created in the last four hours.

About the Worklists in this Chapter
This chapter describes several worklists and gives instructions for creating them. For your 
reference, the table below shows where to find each of the sample worklists in this 
chapter.

This worklist… Retrieves… Page

Simple expression 
example

Retrieve RIS upload failures 413

Composite expression 
example

Editor Queue 417

Provider worklist Unreported CT exams less than 24 hours old 423
4
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Understanding the Elements of a Worklist
Worklists are composed of expressions. An expression is a clause, or statement, that the 
software uses to filter reports and orders from the database. The software retrieves only 
reports that meet the conditions in the expression. Here is an example of an expression: 

• Patient class equals Inpatient

The expression contains a field (Patient class), an operator (equals) and a value 
(Inpatient). In a worklist containing only this expression, the software retrieves all reports 
or orders for persons treated on an inpatient basis. 

A worklist can consist of a single expression like the one above. The real strength of 
worklists, however, lies in using the logical operators AND and OR to build more 
complex queries.

Simple and Composite Expressions

A worklist can contain simple expressions and composite expressions. 

A simple expression is the basic building block for creating a query. A simple expression 
usually contains a field name, an operator, and one or more values. 

Here are some examples of simple expressions: 

• Transfer status is in range Ready, Sent

• Order date is older than three hours

• MRN starts with 120

• Site is equal to Site 21

• Section is not in range 200, 400

• ‘Order is STAT’ is true

A composite expression contains more than one expression; the expressions are connected 
by logical operators AND or OR. A composite expression might be composed entirely of 
simple expressions, or it might have other composite expressions nested within it. This 
concept is similar to using parentheses in a math problem to indicate which operations to 
perform first. 

Here are two composite expressions. Each example contains two simple expressions 
connected by a logical operator: 

• Site equals Site 1
AND
Section is not in range 100, 300

• MRN equals 1234567
OR
Order date is older than seven days
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Using OR and AND

You can use the OR and AND logical operators to build complex worklists tailored 
precisely to your needs. 

OR: When you use OR to connect two expressions, the search retrieves reports that meet 
the conditions in either expression. For example: Your worklist is designed to find reports 
that have MRI as the modality OR brain as the anatomy. The OR operator means that the 
worklist finds any MRI—brain or otherwise (abdomen, pelvis, and so on)—and any brain 
exam—MRI or otherwise (CT, X-ray, and so on)—and returns all of those results. 

AND: The AND logical operator is much more limiting than OR. When you use AND to 
connect two expressions, the search retrieves only reports that meet the conditions in both 
expressions. Example: Your worklist is designed to find reports that have MRI as the 
modality AND the brain as the anatomy. The worklist retrieves only reports for MRI scans 
of the brain, not other types of scans, and not MRI scans of other regions.

OR and AND in Composite Expressions

Here is an example of a composite expression that contains one embedded composite 
expression and one simple expression; the expressions are joined with OR. 

In Example 1, the software first identifies any reports whose status is ‘Completed,’ and 
whose order date is February 2, 2014. Then it identifies those for patients whose last name 
contains the string mar. It retrieves reports that fall into either of those groups. 

Here is another example of a composite expression; this one also contains one embedded 
composite expression and one simple expression. The expressions are joined with AND. 

In Example 2, the software identifies reports last modified during either of the two date 
ranges in July. From within this group of reports, it retrieves only those for Emergency 
patients. 

Example 1

(Status equals Completed
AND
Order Date equals February 2, 2014)
OR
Last name contains mar

Example 2

(Last modified date is between July 1, 2014 
and July 10, 2014
OR 
Last modified date is between July 22, 2014 
and July 25, 2014)
AND
Patient class equals Emergency
6
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Note that in Examples 1 and 2, the embedded composite expressions are shown here 
enclosed in parentheses. As in a math problem, the parentheses indicate the order in which 
the software is to evaluate the expressions. When you build a worklist in the PowerScribe 
360 | Reporting Administrator Portal, however, you do not see parentheses; instead, a tree 
structure shows this hierarchy. Here is how the expression in Example 2 appears when 
you have built the worklist in the Administrator Portal: 

A worklist can contain as many levels of embedded expressions as you need. This feature 
allows you to build complex searches that retrieve only the orders and reports you want to 
see. 

Understanding How Worklists Filter Reports from 
the Database

The purpose of a worklist is to retrieve only the reports you want to see, not all the reports 
in the database. Now that we’ve looked at the expressions that make up a worklist, let’s 
take a closer look at how a worklist determines whether or not to retrieve a particular 
report. 

For a report to be retrieved by a worklist, the worklist as a whole must be true with regard 
to that report. Here is an example of a worklist containing one simple expression:

When you run this worklist, the software compares this statement with the values in each 
of the reports in your system. If the Patient Class field in a given report is equal to 
‘Inpatient,’ then the expression “Patient Class equals ‘Inpatient’” is true, and therefore the 
report is accepted and will appear in your results list. 
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Now let’s look at a more complex worklist. 

Let’s see how the software determines whether a report satisfies this worklist’s conditions. 
Here is a report that might be found in your database:

To find out whether the worklist will retrieve this report, let’s see how it evaluates the 
expressions in the worklist and compares them with the values in the report.

The worklist contains two expressions. The first is a composite expression containing two 
simple expressions connected with OR.

Last Modified Between 7/1/2014 and 7/10/2014 

OR

Last Modified Between 7/22/2014 and 7/25/2014

❶

8
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❶

❷

For this OR expression to be true, either or both of the expressions it contains must be 
true. Because our report’s Last Modified date is 7/24/2014, and this date falls between
7/22/2014 and 7/25/2014, the second of the two expressions is true, therefore Expression 1 
is true: 

Because the Patient Class of this report is ‘Outpatient,’ Expression 2 is false:

Because Expression 1 and Expression 2 are connected with AND, they must both be true 
for this worklist’s conditions to be met. Expression 1 is true and Expression 2 is false, 
therefore the worklist’s conditions have not been met, and the report does not appear in the 
results list. 

TRUE❶

Last Modified Between 7/1/2014 and 7/10/2014 

OR

Last Modified Between 7/22/2014 and 7/25/2014 

FALSE

TRUE

❷ Patient Class = Emergency FALSE

TRUE

Last Modified Between 7/1/2014 and 7/10/2014 

OR

Last Modified Between 7/22/2014 and 7/25/2014

AND

Patient Class = Emergency

FALSE

TRUE

FALSE

FALSE
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Building Worklists with Simple and 
Composite Expressions

Now that we’ve looked at some simple and composite expressions and seen how they are used 
to filter reports from the database, let’s review the procedures for building worklists for two of 
the searches described in the previous section.

Creating a New Worklist
To create a new worklist, you must assign a name to it and specify some of its properties. 
The section below describes the features of the Worklists area on the System tab, where 
you create and maintain your worklists. The procedure for creating a new worklist begins 
on page 411.

Elements of the Worklist Area

The illustration below shows the Worklists area of the System tab. In this example, 
several worklists have already been created. 

Icons

 Delete: Delete the worklist from the system.

 Create New: Begin creating a worklist.

 Edit: Edit the Name and Description of an existing worklist. 

Save or Cancel Update: When you click the Edit icon, it turns into this two-icon 
group. Click the Save (disk) icon to save your changes, or the curved arrow to 
cancel your changes. Again, these actions affect only the Name and Description 
of your worklist.
0
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Other Elements

• Name: Enter a name for the worklist (required).

• Description: Add a description of the worklist (optional).

• Definition

– Clone: Copy an existing worklist; you can then modify and rename the copy. This 
feature is useful when you create a worklist only slightly different from an existing 
one.

– Edit…: Edit the worklist’s definition. (This is where most of the work lies in 
creating a worklist; refer to Editing a Worklist, beginning on page 413.)

• Sections

– Edit: Assign sections—groups of related procedure codes—to your worklist. Refer 
to Adding Sections to a Site, beginning on page 103 for more information on 
sections. You can use sections to control users’ access to worklists (page 424). 

• Snapshot: If your worklist is designed to return unreported orders, non-final reports, 
or both, select this option to make it run more quickly and efficiently.

• Admin: Select this option to hide this worklist from users who do not have 
administrative rights; only administrators see Admin worklists.

• Active: When editing or creating a worklist, select this check box to make the worklist 
active. If you clear this check box (making it inactive), the worklist is not visible to 
providers in the client application. When you want providers to be allowed to use the 
worklist, click Edit and select the Active check box to make it visible to providers.

Creating a Worklist

Creating a worklist is a two-part process: first you must name the query and save it; then 
you must edit the worklist to build a query that will retrieve the results you want. 

Follow the instructions below to create a new worklist, give it a name, and assign some 
basic properties. Once you have assigned your worklist a name and saved it, you are ready 
to edit the worklist to build your query. This chapter provides instructions for building 
several kinds of worklists, beginning with a simple one consisting of a single expression, 
and then continuing with more complex worklists for transcriptionists, administrators, and 
providers. 

About Using the Snapshot Option

The Snapshot option causes worklists to retrieve their data from a special database table 
that contains: 

• Unreported orders of the last three months with a status of Completed, Scheduled, or 
Temporary

• Non-final reports or addenda

• Final reports or addenda of the last two days
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Using this option causes worklists intended to retrieve orders or reports in these categories 
to run quickly and efficiently. For optimal performance, it is important that you always 
select this option for worklists to which it is applicable. 

To create a new worklist:

1. From the Administrator Portal, select the Setup group and click the System tab. 

2. In the Worklists section, click the Create New icon.

3. Enter a Name and a Description for the worklist.

4. Select Snapshot if the worklist is to return unreported orders or non-final reports. 
Using this option makes the worklist retrieve data more quickly and efficiently from 
the database. 

5. Select Admin if this worklist is to be seen only by administrators. 

6. Click the Save  icon.

7. Refer to the sections below to build your worklist: 

• Building a Worklist with One Simple Expression (RIS Upload Failure), beginning 
on page 413

• Building a Worklist with One Composite Expression (Editor Queue), beginning on 
page 417

• Creating a Provider Worklist (Unreported CT Exams Less Than 24 Hours Old), 
beginning on page 423
2
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Editing a Worklist
Most of the work in creating a worklist lies in editing the tree structure that represents 
your worklist. After you have named the worklist, you are ready to begin editing it.

This section provides instructions for creating three worklists, one based on a simple 
expression, one based on a composite expression, and a provider worklist.

Building a Worklist with One Simple Expression (RIS Upload 
Failure)

This procedure assumes that you have added (but not yet configured) a new worklist 
called RIS Upload Failure using the procedure shown on page 411.

To build a worklist with one simple expression:

1. In the Worklists section, on the row where you added your worklist, click Edit under 
the Definition column. The Worklists dialog box opens, showing the name you 
selected and the tree structure in which you will design the query.

2. Click the Composite Expression link on the left side of the window. A drop-down list 
appears at the right.
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3. Select Simple Expression from the drop-down list and click Add.

This places a new expression in the tree, and presents some options in the work area at 
the right.

4. Select Transfer Status from the Field drop-down list and Is in range from the 
Operator drop-down list. The Values drop-down list appears.
4
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5. Select Failed from the Values drop-down list, and click Add. 

6. From the Values drop-down list, select Rejected, and click Add.
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7. Click Update. The expression you created now appears on the left side of the window.

8. Click Save and Close.

9. Test the worklist, which is now available in the admin portal and the dictation client 
application.
6
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Building a Worklist with One Composite Expression (Editor 
Queue)

This procedure assumes that you have added (but not yet configured) a new worklist 
called Editor Queue using the procedure shown on page 411.

To build a worklist with one composite expression:

1. In the Worklists section, on the row where you added your worklist, click Edit under 
the Definition column. The Worklists dialog box opens, showing the name you 
selected and the tree structure in which you will design the query.

2. Click Composite Expression. The Add drop-down list appears at the right.

3. Select Simple Expression from the drop-down list, and click the Add link to the left 
of the drop-down list.
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A New Expression label is added to the tree, and your definition options appear at the 
right.

4. Select Report Status from the Field drop-down list, and Equals from the Operator 
drop-down list. The Values drop-down list appears. 

5. Select Pending Correction from the Values drop-down list, and click Update. The 
complete expression appears in the tree, in place of the label.
8
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6. Click the Composite Expression link again, to begin adding a second simple 
expression. A drop-down list for the logical operator appears at the right, next to the 
word with.

7. Select Simple Expression from the Add drop-down list, and select Or from the 
logical operator drop-down list.

8. Click Add. 

A New Expression label appears in the tree, connected with the item above it with Or, 
and your definition options appear at the right.

9. Select Report Status as the Field, and select Equals as the Operator. 

Note: Leave the Logical Operator set to Or.

10. Select Correction Rejected from the Values drop-down list.

11. Click Update. The expression appears in the tree in place of the New Expression 
label, and the worklist is complete.
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Note:  Use the Negate check box to “Show me everything EXCEPT . . .” what you have 
selected for your value. If you select Equals from the Operator drop-down list, and select 
the Negate check box, the expression looks for things that are Not Equal to your value. 
For example, f you selected Negate in the example below, your results would include all 
reports except those with a status of Correction Rejected. 

Sorting Your Results

Use the following steps to have your search results sorted by Priority and Last Modified 
(first in/first out).

1. Click the Add Sorting link.

2. Select Priority from the from the drop-down list, and select the Descending button. 
0
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3. Click Add Sorting again.

4. Select Last Modified from the drop-down list, leaving the sort order set to its default 
value (Ascending).

5. Click Save and Close.
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Assign Worklist to the Editors Section

Now assign this worklist to the Editors section. 

Note: If you do not have an Editor section, Create an Editors Section, beginning 
on page 422.

1. In the Editor Queue worklist item, click Edit under the Section column.

2. From the Sections list that appears, select the Editors check box.

3. Click Save and Close.

Create an Editors Section

1. Click Sites.

2. Click the Add icon under Sections.

3. Enter the section name and click the Save icon.

4. Click System and assign the worklist to the section as shown in the previous topic, 
Assign Worklist to the Editors Section.

Assign Editors to the Editors Section

Once you’ve assigned the worklist to the section, you must assign the editors to the section 
to make the worklist available to the editors.

1. Click Accounts.

2. From the Authorization drop-down list, select Editor and click Search. A list of the 
editors in your system appears.

3. For each editor perform the following steps:

 a. Click the editor’s name.

 b. Click the Edit link next to the Sections label.

 c. Select the Editors check box.

 d. Click Save and Close.
2
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Creating a Provider Worklist (Unreported CT Exams Less Than 24 
Hours Old)

The following worklist is an example of a worklist you might be asked to create. 

1. Click System.

2. Click the Add icon in the Worklists section.

3. Enter the name Unreported CTs < 24 hrs for this example.

4. Click the Save icon.

5. Click the Edit link under the Definition column.

6. Add the three following simple expressions (remember to click the Composite 
Expression link, then select Simple Expression and click Add for each entry):

• Field: Report Status; Operator: Equals; Values: Unreported; click Update

• Field: Modality; Operator: Equals; Values: CT; Logical Operator: And; click 
Update

• Field: Last Modified; Operator: Is more recent than (days); Values: 1; Logical 
Operator: And; click Update

Your final result should look like the illustration below.

7. Click Save and Close.
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Using Sections to Control Worklist 
Access

You can use sections to determine which worklists users see in the Worklists drop-down box 
in the PowerScribe 360 | Reporting client application. 

Note: A radiologist sees all the worklists in the system by default, and can run any 
worklist. A worklist, however, will not return reports/orders for a site in which the 
radiologist does not have an active role. That is, for a user to whom you have assigned a 
role only in Site A, a worklist designed to retrieve orders only from Site B retrieves no 
results, and a worklist designed to retrieve orders from Site A and Site B retrieves only 
reports/orders from Site A. 

Subscribing Radiologists to Sections
Radiologists in the PowerScribe 360 | Reporting client can execute all the worklists in the 
system. They can choose to view all worklists, or only those belonging to sections to 
which you have subscribed them or to which they have subscribed themselves. 

For example, you might assign the Nuclear Medicine section to a worklist and also assign 
that section to Dr. Katharine Brown’s user account. When Dr. Brown selects View > 
Worklists > Subscribed Only, she sees only worklists belonging to the Nuclear Medicine 
section and to any other sections to which she is currently subscribed. 
4
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As administrator, you can subscribe a user to a section by assigning the section to the 
user’s account in the Administrator Portal.

In the PowerScribe 360 | Reporting client, users have the ability to subscribe or 
unsubscribe to sections associated with sites to which they have access. To subscribe to 
425



42

PowerScribe® 360 | Reporting System Administrator Guide
6

sections, a radiologist can click Tools > Preferences > Sections, select a site, if 
applicable, and then select one or more check boxes.

When the user is not subscribed to any sections, the Worklists drop-down list displays all 
worklists for all sections and sites. 

When the user is subscribed to one or more sections, she can select View > Worklists > 
Subscribed Only to confine the drop-down list to worklists associated with those 
sections, or select View > Worklists > All to see all worklists.

The list shows only 
sites to which you 
have given the user 
access (page 117).
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Using Sections to Limit Transcriptionists’ Access to 
Worklists

Transcriptionists are always limited to worklists for the sections to which they belong. For 
example, you might want a particular transcriptionist to work only on pediatric reports. 
You can:

1. Create a worklist that retrieves only pediatric work, and assign the Pediatric section to 
it.

2. Assign the Pediatric section to the transcriptionist’s user account. 

In the Worklists drop-down list, the transcriptionist sees only worklists assigned to the 
Pediatric section. 

Assigning Sections to a Worklist
To assign a section to a worklist: 

1. From the Administrator Portal, select the Setup group and click the System tab.

2. In the Worklists area, the Sections column shows the number of sections assigned to 
each worklist. 
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3. Click the Edit … link next to the worklist. The Sections dialog box opens.

4. Select the sections you want to assign to this worklist. 

5. Click Save and Close. The Sections column is updated to show the number of 
sections assigned. 
8
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Editor Training

Objectives
In this chapter you will:

• Explain how to log in to the editor application

• Define the screen elements in the Explorer 
window

• Explain the four main steps in the editor’s 
workflow

• Retrieve a list of reports to edit using Worklists, 
My Reports, and Browse 

• Open a report and explain how to play back the 
audio portion

• Edit the report by typing or inserting AutoText

• Finish editing the report and return it to the 
provider who created it

• Create a text AutoText in the AutoText Editor 
window

• Describe other types of information you can add 
while editing a report

• Demonstrate initiating a report

• Modify your user preferences
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Logging In and Logging Out

To log in to PowerScribe 360 | Reporting: 

1. Double-click the Nuance PowerScribe 360 desktop icon. 

2. Type the user name and password provided by your administrator. 

3. If this is your first login:

• Depending on your system configuration, you might be prompted 
to change your password on your first login. Type the new password in both fields 
and then click OK. 

After a few seconds, the Nuance PowerScribe 360 | Reporting window opens. 

To log out:

• To log out and close the application completely, click on the X (close window icon), in 
the upper right corner of the application, or select File > Exit from the menu bar.

OR

• To log out and return to the login window, click File > Logout. 

Changing Your Password
To change your login password:

1. Click Tools > Change Password.

2. In the New Password field, type your new password.

3. In the Confirm field, re-type the new password.

4. Click OK.
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S
(

Explorer Window Screen Elements

By default, the first window you see after logging in to the PowerScribe 360 | Reporting client 
is the Explorer window. Explorer is where you access your reports and worklists, and search 
for orders and reports. The following illustration shows the main components of the Explorer 
window. 

Menu Bar Tool Bar Search Results Showing Reports

Report Preview earch and Browse Filters
Quick Search, My Reports, Worklists, and Browse)
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Overview: The Editor Workflow 

An editor’s workflow consists of the following general steps:

1. Search for a report that requires editing (in the Explorer window, using Worklists, My 
Reports, or Browse)

2. Select and open the report (from the Search Results section)

3. While listening to the audio portion of the report, and comparing it to the speech-
recognized text that appears, edit the report (in the Report Editor) as needed by 

• using the keyboard and foot pedal,

• inserting AutoText (explained later in this chapter),

• attaching a note containing specific comments for the provider to review.

4. Send the report back to the provider for signature or further revision 

This section explains each of these steps in greater detail.

Step 1: Searching for Reports

Worklists
When a provider creates a report and issues a command to have the report reviewed and 
corrected by an editor, the report is sent to an editor/transcriptionist for correction. Site 
administrators create worklists, which are pre-defined searches that filter reports based on 
virtually any combination of criteria, making it easier for editors (and providers) to 
retrieve their work. In many cases, editors work on reports for specific departments, or 
work on a specific modality. Worklists allow administrators to assign these specific types 
of reports to an editor, allowing her or him to work more efficiently.

The following examples describe what different worklists might show:

• All reports sent for editing marked as STAT 

Note: Your system administrator can configure the system so that STAT reports 
always appear at the top of any worklist.

• All reports sent for editing by the cardiology group

To use a worklist to filter your Explorer 
screen results: 

1. Click a worklist in the Worklists search 
area. (If you are not sure which worklist 
to select, contact your administrator.)The 
results filtered by the worklist appear in 
the search results section of the Explorer 
window.
2
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My Reports
My Reports is a quick way to find your most common types of reports.

On the left side of the Explorer window, click one of the selections under the My 
Reports heading. Numbers to the right of a search type indicate the number of reports of 
that type.

Note: Once you begin editing, these report queues begin to become more relevant. For 
example, until you’ve attached a note to a report, you won’t see any items listed in your 
Annotated queue. In addition, you might not see all of the report types listed in this 
section; the list depends upon the type of editing work you have performed. 

Correction Queue

The Correction queue search returns all 
reports that were assigned to you, and that are 
awaiting some action by you.

Corrected Today

The Corrected Today search retrieves all 
reports that have the status of Corrected, 
Pending Signature, or Final (see status 
definitions in the Browse section below). 

Touched Today

The Touched today search retrieves all reports you opened or edited throughout the day. 

Drafts

The Drafts search retrieves all reports with a status of Draft: reported, but not finished; it 
finds only reports you created, not those assigned to you. 

Annotated

The Annotated search retrieves all non-final reports that belong to or are assigned to you 
and have one or more order/report/patient notes. 
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Browse
Note: If you do not see the Browse search section on your screen, your system 
administrator has disabled this feature. In addition, if you do not see all of the browse 
items shown in the illustration below, your administrator has disabled those specific 
browse parameters.

Another search section, the Browse pane, 
allows you to search for orders and reports 
that match the criteria you specify. The 
criteria you select remain in place until you 
change them, and the system remembers 
them when you log in again.

To use the Browse search:

1. Select the applicable choices from one or 
more of the drop-down lists. Editors 
commonly use the following criteria:

• Status: Select either a report status or 
an order status. Definitions are shown 
in the following table: 

Status Description

Addended One or more addenda have been created for a final report. Addenda are 
reports themselves and the aforementioned statuses apply to them too.

All Uses all report statuses in the search

Completed (All) and 
Completed (Unreported)

Exam has been performed and is ready for dictation.

Final Report has been completed and signed by an attending.

Pending Correction Report has been dictated and queued for correction.

Preliminary Pertains to any report whose status is not final.

Rejected Appears when a corrected report is returned to an editor by an attending or 
resident, or when a Pending Signature report is returned to a resident by an 
attending.
4
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• Time Frame: Choose from a wide range of time frames

• Modality: Specify a modality, such as CT or MRI, a subset of a modality, or select 
All. 

• Anatomy: Select a general body section, a specific part, or select All.

• Radiologist: Contains all resident and attending accounts that have an active role 
on the selected site.

Note: The Section, Ordering, and Location filters become available when you 
select a specific site. If you select All for Sites, these filters are grayed out.

2. When you have selected the criteria for the filter, click Browse. Any orders/reports 
that meet the criteria appear in the Search Results table on the right side of the 
window. 

Tip: To set all the criteria back to the default settings, click Reset Filters. 

Excessive Number of Items in the List

Note: The number of results returned is set by an administrator.

By default, the system is set up to return a maximum of 500 items for any given search. If 
your browse exceeds the number set by your administrator (500 in the following 
illustration), a message box opens.

When you click OK, only 500 results are returned. The report you are searching for might 
or might not be there; the list is incomplete. As the message suggests, select additional 
filters and run the query again. Or, use one of your worklists.

Scheduled Exam has been scheduled but not yet completed. Sometimes, the exam has 
been completed but the status has not been updated in the RIS. In this case, 
reports can be dictated, but are not delivered to the RIS until they are marked 
complete. Some sites may choose not to allow dictation for scheduled orders.

Temporary Exam has not been received by PowerScribe 360 | Reporting so a temporary 
order has been created. In this case, reports can be dictated, but are not 
delivered to the RIS until the actual order is received.

Unreported No report has been dictated for the order.

Wet Read A “pre-draft” state. Either attending or resident providers can create a wet 
read report. Any attending or resident provider can promote a wet read report 
to a Draft status. The text of the wet read is maintained once the report is 
promoted to Draft status.

Status Description
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Step 2: Selecting and Opening a Report

After you’ve searched for reports to edit (using either a Worklist, My Reports, or Browse) 
your results appear on the right side of the Explorer window. 

Best Practice for Selecting a Report
Open a report only if you plan to correct and finish it. This helps you to work more 
efficiently and reduce turnaround time (TAT). If you begin to correct a report and decide 
to finish it at a later time, the report is placed in your Drafts queue where only you can 
open and finish it. 

Search Results Area
The following illustration (divided into two sections for clarity) shows an example of 
search results.

The column headings are self-explanatory, with the exception of the first four columns, 
which are described below.
6
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First Four Columns
The first four columns in your search results are identified by the following icons. 

Tips for Working with the Columns
• To rearrange the order in which the columns appear in Explorer, click and drag the 

column heading name to a new position. 

• Right click anywhere on the column headings to see a menu that allows you to further 
modify your view of columns.

Column Icon Description

The lock column indicates a report’s locking and assignment 
status. The icon can be either yellow or blue. 

Yellow indicates that the report is open and therefore locked. 
Hovering your mouse over the lock icon shows who has 
locked the report.
Blue indicates an order that is assigned to another 
radiologist. Depending upon a site preference, you might, or 
might not, be able to open these types of reports.

This column shows the report transfer status. Hover your mouse 
over the order’s icon to see the status:

Ready: report is flagged for inspection; when it is sent 
depends upon its status and interface options.
Queued: report is queued for transmission
Force Send: report is queued for immediate re-transmission
Sent: report has been successfully delivered
Final Exported: final report has been successfully 
transmitted
Rejected: the RIS rejected the report
Failed: an error occurred
Held: an administrator paused the transmission

This column uses icons to indicate an order’s priority: 
No icon: Routine priority

STAT priority
ASAP (red)
Timing-critical; Callback; or Pre-op (yellow)
Low priority (green)

No icon This column is simply a numerical list of your search results.
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• To remove a column, right-click in the column heading and click Remove. To display 
the column once again, use the Columns dialog box (shown in the next bullet item).

• To select which columns to view, as well as rearrange the order of the columns, right-
click on the column headings, then click Columns menu item. In the Columns dialog 
box, select or clear columns you want to display. Use the Move Up and Move Down 
buttons to reorder the columns. 

• To sort reports based upon one of the column headings, right-click a column heading 
and select Show in Groups. You can then click any column heading to see a different 
view of the results content. Click the plus sign + to expand a group or the minus sign - 
to minimize it. Right-click any column heading and click Show in Groups again to 
return to the original view.
8
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• For some columns, more detailed information is available by hovering the mouse over 
that column to display a tool tip. 

Preview an Order or Report
Once you select an order, the Order Preview window is populated with additional 
information tabs described below.

Order Data Tab

The Order Data tab displays information about the order, including patient information 
(age, site, and so on), exam details, and providers. You can show or hide this information 
by clicking the Order Data vertical tab (located on the left side of this section) or by 
clicking the push-pin icon (located on the right side).

Tip: To keep the Order Data from automatically hiding itself, click the push-pin one time. 
If you want to hide the Order Data, click the push-pin again.

Clinical Data Tab

The Clinical Data tab shows the reason for the study, history, and so on. 

Note: If no clinical data is available (from your RIS or HIS) for an order, this tab is does 
not appear.
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Report Tab

If the order you selected has a report already associated with it, click the Report tab to see 
the text of the report. If no report has been created, the Report tab does not appear.

Notes Tab

The Notes tab allows you to create a text or audio note to associate with the report. For 
details, see Adding a Note to a Report beginning on page 460.

Attachments Tab

The Insert Report Attachments link allows you to add images or documents to a report.

For details, see Adding an Attachment to a Report beginning on page 461.

Priors Tab

Select the Priors tab to view any prior studies for this patient. If prior studies exist, you 
can select one from the list and view the text of the report in the area below the list.
0
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Report Data Tab

The Report Data tab contains information only when a report has been dictated on the 
order. Otherwise this tab has no content. You can show or hide this information by 
clicking the Report Data vertical tab (located on the right side of this section) or by 
clicking the push-pin icon (also located on the right side). 

Tip: To keep the Report Data from automatically hiding itself, click the push-pin one time. 
If you want to hide the Report Data, click the push-pin again.
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Prior R
Ta
The Report Editor Window
After you select and open an order or report from the Explorer window, the Report Editor 
window opens. The Report Editor is where you actually correct a report and insert other 
information that is associated with the report (if necessary).

This illustration below shows the components that make up the Report Editor window.

Menu Bar Tool Bar Playback Controls

eports
b

AutoText
Tab AutoFeed

Tab
Navigation

Panel

AutoText and
Formatting
Tool Bars

Report Content

Order Data
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Report Editor Navigation Panel

The navigation panel on the left of the 
report screen displays a variety of 
information depending on which mode 
is selected. 

Select the buttons at the bottom of the 
panel to change the mode. The 
following modes are available: 
Properties, Fields, Notes, 
Attachments, and Assure. The 
illustration at the right has the Fields 
mode selected.

Note: The Assure consistency checker is 
a purchasable feature. Contact your 
Nuance account executive for more 
information. 

Properties

Use the Properties mode to display 
report properties including the 
Attending, Resident, report Status, 
and Transfer status. There is a check 
box for you to quickly mark the report 
priority as STAT. There are also links 
to insert Diagnosis Codes and Custom 
Fields.

Fields

Use the Fields mode to display a list of 
fill-in fields for an AutoText that has 
been inserted into the report. Click a field name from the list to move the cursor to that 
field in the report and select the contents of that field. 

The Tab and Shift+Tab keyboard keys can also be used to move forward and backward 
through fields respectively.

Findings Only Dialog Box

Click the Enter Findings Mode link to open the Findings Only dialog box.

Notes

Click the Notes button to display any notes that have been created for the current patient 
or report. Click the Insert Note link to add a note to the report. (You can also insert a note 
by clicking Insert > Notes on the menu bar.) You can associate a note with the patient or 
with the report. By default, a note is associated with the specific report. Select the Patient 
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Note check box to associate a note with the patient (otherwise, the note is associated only 
with this specific report).

Editors can create only text notes. 

Attachments

Click the Attachments button to display files that have been attached to the report. Click 
the Insert Report Attachment link to select a file to attach to your report. (You can also 
insert an attachment to your report by clicking Insert > Attachment on the menu bar.)

Note: Attachments are not uploaded to your RIS.

About the Push-Pin

Some tabs in the Explorer and Report Editor windows have a push-pin on their title bar. 
A push-pin has two positions, horizontal and vertical.

• Horizontal position: In this position, the tab hides itself when your mouse pointer 
is no longer over the tab's contents, allowing more room for other window elements.

• Vertical position: In this position, the tab’s contents are visible at all times.

Click the push-pin to change its orientation from vertical to horizontal.

Using the Foot Pedal
The foot pedal is one of the most useful and common tools for editors. The following 
tables show the default foot pedal settings as well as the optional settings for each button.

Default Settings for the Foot Pedal Buttons

Optional Settings for the Foot Pedal Buttons

Button Default Setting

Left Fast forward: Fast-forwards for as long as button is held.

Center Toggle Play audio on/off: Toggles audio playback on or off; remains that 
way until toggled again.

Right Rewind: Rewinds for as long as button is held.

Button Optional Settings

Left, Center, and 
Right

• Previous field: Moves cursor to the previous field
• Next field: Moves cursor to the next field
• Dead man play audio: Plays audio as long as button is held; stops 

playback when button is released.
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Keyboard Shortcuts
The following table shows the keyboard shortcuts used most frequently by editors. 

Keyboard Shortcut Description

Playback Controls (in Report Editor and AutoText Editor)

F6 Play/pause toggle

Alt+Home Go to beginning

Alt+Left arrow Rewind

Alt+Right arrow Fast forward

Alt+End Go to end

Alt+Insert Increase volume

Alt+Delete Decrease volume

Alt+Up arrow Speed up

Alt+Down arrow Slow down

Ctrl+Up arrow Faster winding

Ctrl+Down arrow Slower winding

Explorer Window

Ctrl+N New report

Ctrl+O Open report

Ctrl+P Print report

Ctrl+T Toggle AutoFeed on/off

Ctrl+B Barcode on/off

F1 Open Explorer help

F5 Refresh view

F8 Save as Normal

F9 Save as Draft

F12 Finish report

Report Editor Window

Ctrl+S Save report without closing

Ctrl+C Copy text

Ctrl+V Paste text

Ctrl+X Cut text

Ctrl+A Select all

Ctrl+F Find
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Ctrl+H Replace

Ctrl+T Toggle AutoFeed on/off

Ctrl+B Bold selected text

Ctrl+I Italicize selected text

Ctrl+U Underline selected text

Ctrl+Z Undo

Ctrl+Y Redo

Ctrl+P Print report

Ctrl+Alt+C Delete concordance

Alt+U Make the selected text all UPPERCASE

Alt+L Make the selected text all lowercase

Alt+C Begin each selected word or words with 
an Initial Capital letter

Alt+Home Go to the beginning of the report

Alt+End Go to the end of the report

F1 Open Report Editor help

Alt+F3 Create a new AutoText from selected text

F6 Play/pause toggle

F7 Spelling

F8 Save as Normal

F9 Save as Draft

F12 Finish report

AutoText Editor Window

Ctrl+N Start a new AutoText

Ctrl+O Open the selected AutoText

Ctrl+S Save report without closing

Ctrl+C Copy text

Ctrl+V Paste text

Ctrl+X Cut text

Ctrl+A Select all

Ctrl+F Find

Ctrl+H Replace

Ctrl+B Bold selected text

Keyboard Shortcut Description
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Using the AutoFeed Feature
The AutoFeed tab shows a list of files that are in your reports queue, based on the type of 
search you performed in the Explorer window. As the reports from your search are loaded 
into your computer sequentially, the information turns from black to a gray bold text. In 
the illustration, reports 15, 16, and 17 have already been loaded; the others have not.

Example

If you selected the Correction Queue link (from the My Reports) in Explorer, and then 
clicked the Start AutoFeed icon (in Explorer), the Report Editor opens, and the 
AutoFeed also opens, showing the reports from your correction queue. The first report in 

Ctrl+I Italicize selected text

Ctrl+U Underline selected text

Ctrl+Z Undo

Ctrl+Y Redo

Ctrl+P Print report

Alt+U Make the selected text all UPPERCASE

Alt+L Make the selected text all lowercase

Alt+C Begin each selected word or words with 
an Initial Capital letter

Alt+Home Go to the beginning of the AutoText

Alt+End Go to the end of the AutoText

F1 Open AutoText help

F7 Check spelling

Keyboard Shortcut Description
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the list appears in the Report Editor window. After you correct the first report, the second 
report automatically opens in the Report Editor, and so on.

Note: If you decide to start with a report other than the first one in your Explorer search 
results list, AutoFeed does not return to Explorer and pull in those first few reports. To 
access those first reports, you must return to the Explorer window and start AutoFeed 
again.

If you did not click the AutoFeed icon in the Explorer window and want to view the 
queue, click the AutoFeed tab in the bottom left corner of the main screen. Note that the 
AutoFeed tab has a push-pin which allows you to hide the tab, or keep it open during your 
session.

Other AutoFeed Features
• From the Report Editor window, you can turn AutoFeed off or on by clicking the 

AutoFeed icon on the tool bar. If you turn off AutoFeed, you are returned to the 
Explorer window when you finish the current report.

• If there are no more orders or reports in your original query, you are returned to the 
Explorer window when you finish the last report.

• To view a list of upcoming reports from your query, click the AutoFeed tab located in 
the lower-left portion of the Report Editor window near the Prior Reports and 
AutoText tabs. (Note that this is a read-only list; you cannot select a report from it.)

• With this feature selected, a report that is in the process of being saved appears in the 
Explorer window in a gray italicized font. 

• If you attempt to open a report that is being saved, you will get a message box 
explaining that the report is being saved. 

• If you attempt to log out of the application while a report is being saved, a message 
box opens asking you to Please wait. 

If you decide to log out of the application during the save, you are notified that you might 
lose some of your data. Best practice: wait until the save is completed.
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Step 3: Editing the Report

Playing Back the Report’s Audio
Most editors play, rewind, and fast forward the audio portion of a report using a foot 
pedal. (You can also use your keyboard or your mouse.) 

To play back audio using a foot pedal: 

1. Press the middle button on your foot pedal. The audio begins to play and the 
corresponding text is highlighted (or underlined, depending upon your preference 
settings). 

2. Lift your foot off of the pedal when you come to a word or phrase that needs 
correction. The system highlights the last word that was played back.

Note: If necessary, use your mouse to select additional words to correct or 
replace.

Replacing or Inserting Text in a Report
Once you’ve selected the text you need to replace, or you’ve placed your cursor at the 
location in the report at which you want to insert some text, do one of the following: 

• Type over the selected text (or simply begin typing at the cursor location if no text is 
selected)

• Insert AutoText into the report.

Typing over, or simply typing in text, is self-explanatory. However, there are several ways 
to insert AutoText into your report. 

Inserting AutoText into a Report

AutoText is pre-defined text commonly used in normal test results that you can insert into 
reports. For example, an AutoText named thr might be used to insert text describing a 
normal thoracic spine exam. 

You can insert AutoText in three different ways:

• Begin typing the AutoText shortcut name: If an AutoText includes a shortcut name, 
begin typing the shortcut name. Once you’ve typed enough letters for the system to 
locate the AutoText, the shortcut name and the AutoText content appear. You can then 
press Enter to insert the AutoText into the report. In the illustration below, the editor 
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typed the letters noa, which located a normal abdomen AutoText with the noab 
shortcut name, and displayed its content.

• Click the AutoText drop-down list from the 
menu bar (see illustration at right): Use this 
method if you do not recall the name of the 
AutoText you want to insert. Select the AutoText 
you want to use to insert it into your report.

• Click the AutoText tab (located in the bottom-left 
corner of the window): Use this method if you are not sure which AutoText you want 
to insert. Select an AutoText to display its content in the right side of the window. 
When you find the correct AutoText, double-click it to insert it into your report.
0
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Using the AutoText Tab

The AutoText section shows a list of AutoTexts (also known as macros or shortcuts) 
available on the system. 

To see this section, click the AutoText tab in the bottom left corner of the main screen.

Use the List drop-down to determine which set of AutoText to display:

• Select Relevant to show only AutoText categorized with a procedure code that exists 
in the current order, or no categorization assigned at all.

• Select All Personal to show all of your own AutoText regardless of categorization.

• Select All Site to show all site-defined AutoText, regardless of categorization.

• Select Relevant Personal to show your own AutoText categorized with a procedure 
code that exists in the current order.

• Select Relevant Site to show site-defined AutoText categorized with a procedure code 
that exists in the current order.

• Select All Author to show all of AutoText created by this AutoText’s author 
regardless of categorization.

• Select Relevant Author to show AutoText created by this AutoText’s author 
categorized with a procedure code that exists in the current order.

• Select All Users to show all AutoText created by site users regardless of 
categorization.

Each AutoText is flagged with up to three icons to convey information at 
a glance (see illustration at right). From left to right the columns indicate 
if the Auto Text is Normal, Default, or Site-defined. The remaining columns in the grid 
indicate the name of the AutoText, and the last time it was inserted into a report.

Located above the preview window are buttons used to Create, Edit, and Delete 
AutoText.

For more information on AutoText, see Creating a Text AutoText Entry beginning on 
page 453.
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Step 4: Finishing the Report

After editing your report, finish the report to complete the process.

To finish the report: 

1. Click the Finish Report icon  on the toolbar.

2. If you are asked to verify that you want to finish the report, click Yes.

3. If you are asked to confirm your password, retype it in the dialog box and click OK.

4. After finishing, you return to the Explorer window where you can select other reports 
to edit.

Note: If you have the AutoFeed feature enabled, you will not return to the Explorer 
window. Instead, your next report opens for you to edit and finish.
2
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Aut
Creating a Text AutoText Entry

One of your most powerful tools is the AutoText Editor. Use this tool to create AutoText 
entries, which add blocks of commonly used text into your reports. Using AutoText helps you 
to work more efficiently and increases the report’s accuracy.

Opening the AutoText Editor
From the Explorer window: Click Tools > AutoText Editor.

From the Report Editor window: Click the Create AutoText icon. 

AutoText Editor Screen Elements
The illustration below shows the components that make up the AutoText Editor window.

oText Properties Toolbars

AutoText Manager

AutoText Editor
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AutoText Properties

Name

Enter a name for the AutoText in this field. 

Shortcut

You can assign a shortcut to an AutoText. A 
shortcut is a keystroke sequence you assign 
to an AutoText. For example, you might 
type the shortcut ncx for a normal chest 
x-ray AutoText. When you begin to type in 
the report editor, and enough text is typed to 
uniquely identify a single AutoText shortcut, 
the name and content of the AutoText 
appear. You can then press Enter to insert 
the AutoText, or backspace until the text you 
typed is removed.

AutoText Manager
Use the AutoText Manager, located in the lower half of the AutoText Editor, to search 
for, select, and preview AutoTexts.

Browse

This section filters which AutoText appear in 
the results grid. You can filter results by name, 
a word or phrase within an AutoText, anatomy, 
modality, or procedure.

Use the Reset Filters button to clear all filters.

The Browse button refreshes the results grid 
based on the specified filters.
4
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Results Grid

The icons in the first three columns 
indicate if the Auto Text is flagged 
as Normal, Default, or Private, 
respectively. The next column is 
the AutoText name. The last two 
columns are Modality and 
Anatomy. The Modality and 
Anatomy are inferred from the 
procedure code(s) associated with 
the AutoText, and are available 
only if the site has categorized the procedure codes to their respective Modality and 
Anatomy.

AutoText Preview

The AutoText preview window 
displays the AutoText selected in the 
results list. An AutoText can be 
opened for editing in the main editor 
window by double clicking the 
desired AutoText in the results list or 
by clicking the Open AutoText 
button from the toolbar.

Cloning an AutoText

The Clone function is a quick way to copy an AutoText and open it for additional editing.

Note: If you have the Edit AutoText administrative privilege on the system, and you 
modify an AutoText, you are changing that AutoText for everyone, not just yourself. To 
change an AutoText for you only as a provider, log in as a provider who does not have that 
administrative privilege.

To clone and AutoText:

1. From the AutoText Editor window, search for the AutoText that you want to clone.

2. Double-click the AutoText. If the AutoText is marked as Normal or Default, you are 
asked whether you want to retain those settings in the clone.

3. Make your changes to the AutoText. 

Note: When cloning your own AutoText, you must change the name of the cloned 
AutoText. The name is automatically selected after using the Clone command, 
allowing you to rename it. In addition, if your original AutoText contained a 
shortcut, you will have to rename the shortcut as well.

4. When finished, click Save to save your cloned AutoText. 
455



45

PowerScribe® 360 | Reporting System Administrator Guide
AutoText with Merge Fields
Merge fields contain provider and patient information from your facility's database. When 
you insert an AutoText that contains a merge field, the system looks at the database and 
populates the field automatically (assuming the information requested exists in the 
database; otherwise the field remains blank).

To place a merge field in your AutoText:

1. Place your cursor at the location in your AutoText in which you want the merge field 
to appear.

2. Click the Merge drop-down list.

3. Click the merge field you want to insert.

4. Repeat for any other merge fields you want to add.
6
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Facility-Specific Features

Not everyone has the same set of training requirements. This section shows some additional 
features commonly used by editors. 

Adding Information to a Report
In addition to typing information into a report, there are many other types of information 
which you can add.

• Diagnosis Codes

• Custom Fields

• Notes

• Attachments

Adding Diagnosis Codes to a Report

If your facility is configured to use diagnosis codes, you can use the Diagnosis Codes 
dialog box to associate codes with the order(s) in your report.

To insert diagnosis codes into your report:

1. In the Report Editor window, select Properties from the navigation panel and click 
the Insert Diagnosis Codes link (or click Insert > Diagnosis Codes from the menu 
bar). The Diagnosis Codes dialog box opens.
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2. In the Available Codes section, type the diagnosis code you want to associate with 
your report. (If you don't know the entire code, type the first few numbers of the code, 
or a word from the description.)

Note: To show only those codes that match the procedure, select the Restrict to 
exam codes check box.

3. Click Search. The code or codes you searched for appear in the list.

4. Select the check box next to each code you want to associate with your report. The 
codes appear in the Selected Codes list.
8
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5. When finished, click OK. The codes you selected 
appear in the Diagnosis Codes section of the 
Properties list (see illustration at right).

Adding a Custom Field to a Report

Tip: For more information, see Custom Fields, 
beginning on page 325. 

Custom fields are sets of metadata for an order (such as 
measurements, radiation dosage, flagged studies, and so 
on) that administrators can customize for each site.

Custom fields can be:

• Populated by technologists on unreported orders, by 
administrators, or by radiologists during reporting. 

• Defined as free-text or pick lists, and marked as 
required, in which case the radiologist is forced to 
give them a value before signing the report. 

• Used as merge fields in AutoTexts

In addition, custom fields can be categorized (associated with one or more procedure codes) 
by an administrator. In this case custom fields are presented only for orders with matching 
procedures.

To insert custom fields into your report:

1. In the Report Editor window, select Properties from the navigation panel and click the 
Insert Custom Fields link (or click Insert > Custom Fields from the menu bar). The 
Custom Fields dialog box opens.
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2. Click the Value column to assign a value to the custom fields. Some custom fields are 
set up with drop-down lists, while others require that you type in a value.

Note: You do not have to select values for all of the custom fields; only for the 
fields that pertain to your report. In the above example illustration, only the 
Interesting Case and Study Appropriateness fields would appear in the Custom 
Fields section.

3. When finished populating the custom fields for your report, click OK. The selected 
custom fields appear in Custom Fields section of Properties.

Adding a Note to a Report

Click the Notes button to display any notes that have been created for the current patient 
or report. You can insert a note by going through the menu bar, Insert > Notes, or by right 
clicking in the Notes pane and selecting Create New. A note can be associated with the 
patient or with the report. 

Note: By default, a note is associated with the current report only. Select Patient Note to 
associate the note with all reports for this patient. An example of when to use Patient Note 
might be when the patient has a specific drug allergy.

To open the Report Note dialog box:

• In the Report Editor window, select Notes from the navigation panel and click the 
Insert Note link (or click Insert > Note from the menu bar). The Report Note dialog 
box opens.

To insert a note into your report: 

1. Type your text in the Report Note text box.

2. If you want to associate your note with the patient, select the Patient note check box. 
Otherwise the note is associated with the report itself.
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3. When finished, click OK. The note appears in the Notes list with your name, the date 
and time you added the note, and the text of your note.

Adding an Attachment to a Report

There are actually two locations from which you can add an attachment to a report:

• From the Explorer window Attachments tab, shown below, or

• From the Report Editor window Attachments navigation button.

To insert an attachment from the Explorer window:

1. From the Explorer window, select a report.

2. Click the Attachments tab.

3. Click the Insert Report Attachment link and browse for the file that you want to 
attach.

4. Click OK to insert the attachment. The attachment file appears on the Attachments 
tab.

5. To view your attachment, double-click it or right-click and select Open.

6. If you want to attach another image or document, click Insert Report Attachment 
again.
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Find Reports with Quick Search
Note: If you do not see the Quick Search section on your screen, your system 
administrator has disabled this feature.

In addition to with Worklists, My Reports, and Browse, you can also search for orders 
and reports using Quick Search. Use this section to search for orders or reports based 
upon Single Accession, Multiple Accessions, MRN, or Patient Last Name. 

To search for an order or report using Quick Search: 

1. Select a site from the Site drop-down list, which lists all the sites in which you have an 
active role. (The Site drop-down does not appear if you have an active role in only one 
site, or if your organization does not use multiple sites.) 

2. In the Look for drop-down list, select either Single Accession, Multiple Accessions, 
MRN, or Patient Last Name. 

Note: You can search for multiple accessions by entering each accession 
number on a separate line; after each accession number, press Enter.

3. In the text entry area, type the data to find. You can use the asterisk (*) or the 
percentage sign (%) as wild-card search characters if you do not know the exact name 
or number. For example, enter Smi* to look for all patients whose last name begins 
with those letters.

4. Click the Search button. The Search Results Table lists all reports that match the 
search criteria you specified.

Tips for Quick Search

• Quick Search by accession number is more efficient if the site uses a fixed number of 
characters for its accession numbers. In this scenario, the search is executed 
automatically when the proper number of characters is entered. In any case, if one or 
more orders are found when searching by accession, they are automatically opened for 
reporting, as long as the user has the proper rights. On the other hand, if the specified 
accession is not found, you can create a temporary order with that accession number.
2
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Changing Your Preferences

To help tailor the system to your needs, several of the settings in the PowerScribe 360 | 
Reporting application can be modified.

To change your preferences, click Tools > Preferences. Refer to the following topics as a 
guide for modifying your preferences.

Note: Many preferences do not apply to editors. Only the ones that apply to editors are 
listed and described in the following tables.

Changing Your General Preferences
Click Tools > Preferences, click the plus sign (+) next to Reporting, and select General.

Preference Description Default

Highlight text on 
playback

If selected, the text you hear during 
audio playback is highlighted. If not 
selected, the text is underlined.

Yes

Warn on application 
exit

If selected, the application displays a 
warning dialog box when the user 
attempts to exit the application.

No

Move cursor on 
AutoText insert

Controls the behavior of the cursor when 
inserting an AutoText:

• End of AutoText: The cursor 
automatically moves to the end of the 
inserted AutoText.

• First Empty Field: The cursor 
automatically moves to the first blank 
fill-in field.

• First Field: The cursor automatically 
moves to the first fill-in field, 
regardless of whether it is blank or 
contains default text.

End of 
AutoText
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Changing Your Fonts and Colors Preferences
Click Tools > Preferences, click the plus sign (+) next to Reporting, and select Fonts 
and Colors.

Changing Your Dictation Preferences
Click Tools > Preferences, and select Dictation.

Preference Description Default

Default font face
Allows you to select the type of font 
to use in your reports (for example, 
Arial, Times New Roman, and so on).

Arial

Default font size Allows you to select the size of your 
selected font (in points). 12

Restore defaults 
button

Returns the font preferences to their 
default system settings n/a

Enable custom colors

When selected, allows you to customize 
the colors used for the various types of 
text in your reports:

• Select colors for Plain Text, Dictated 
Text, AutoText Text, Field Highlight, 
Merge Field Text, and Hyperlink Text

• Select the color for highlighting text 
as it is played back (if you selected the 
Highlight Text on Playback 
preference)

• Select colors for the Normal 
Background (when you are not 
dictating) and the Dictation 
Background

n/a

Preference Description Default

Use PC speaker for 
sound alerts

If selected, audible tones are 
reproduced using the speaker in your 
computer.

Yes
4
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Changing Your Workflow Preferences
Click Tools > Preferences, and select Workflow.

Changing Your Foot Pedal Preferences
Click Tools > Preferences, and select Foot Pedal.

Note: If you do not have a foot pedal connected to your computer, this section does not 
appear.

Default Settings for Each Foot Pedal Button

See “Optional Settings for the Foot Pedal Buttons” beginning on page 444 to see a table 
of all possible settings for each foot pedal button.

Preference Description Default

Perform spell check 
at signoff

If selected, the spelling checker 
automatically runs before signing the 
report.

No

Warn if fields are 
empty when signing

If selected, a prompt appears alerting 
you that there are empty fields before 
you sign off on a report.

Yes

Button Default Setting

Left Fast Forward

Center Toggle Play on/off

Right Rewind
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Chapter 17

Order and Report
Management

Objectives
In this chapter, you will:

• Manage orders and reports on the Explorer tab

• Use the Dashboard tab

• Create templates for print, fax, and cover sheets
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Wor
Sea
Managing Orders and Reports on the 
Explorer Tab 

You can use the Explorer tab in the Exams group to find and manage orders and reports. This 
tab provides access to the orders and reports in your system. It contains a search area for quick 
search by accession numbers and patients, another to invoke worklists, and another for using 
search filters. The system remembers your filter selections from one session to the next.

Once you have found the order you want to see, you can take various actions on it. You can: 

• Associate an order with a report 

• Reset an order’s status to ‘Draft’

• Modify an order’s priority level

• Modify a report’s diagnosis codes

• Change values in the custom fields

• Change a patient’s MRN

• Download a printable version

Quick 
Search

klist 
rch

Search 
Filters
8



Chapter 17: Order and Report Management
Report audio is available in the Explorer only if the Save Audio with Report dictation 
preference is in effect (see page 74). A Nuance representative must configure the amount of 
time the system is to save the audio files.

Searching for Orders or Reports Across All Sites
Use the Look for field to search for orders or reports across all sites in a multi-site system.

Note: The Look for search option does not take into account any of the other drop-down 
filters on this tab. These filters do not apply when you are doing a quick search. 

To search for orders or reports:

1. In the Look for drop-down list, select the criterion for the search you want to perform: 
Accession Number, Patient MRN, or Patient Last Name. 

2. In the text entry field, type all or part of the accession number, MRN, or name. 

3. Click Search. Any orders or reports that match your criteria appear in the results grid.

Tips: 

• You can use an asterisk as a wild-card character; for example, select Patient Last Name 
and then type Smi* to find patients whose last names begin with Smi. Or, select 
Accession Number and then type 1234, *56*. The search returns the accession number 
1234 and all the accessions that contain the string 56. 

• You can use the percent character as a wild-card replacement for one or more 
characters; for example, select Patient MRN and type 1111%2. The search returns 
MRNs such as 11102, 11142, 11162, and 11192. 

• To search for multiple accessions, enter each accession followed by a comma. 

Retrieving Worklists
In the WL (worklist) box, you can execute previously-defined, system-wide worklists. For 
information on creating worklists, refer to Chapter 15.

To retrieve a worklist:

1. In the WL drop-down list, select the desired worklist.

2. Click Search. Any orders or reports that meet the criteria in the worklist appear in the 
results grid. 

Using the Search Filters
This set of filters allows you to search for orders, reports, or both that meet the criteria you 
select. Filters with a value other than All create a logical AND expression; that is, the filter 
retrieves only orders and reports that meet all your criteria. 
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To search using the filters:

1. Select or enter one or more of the following criteria for your search. 

• Site: In a multi-site system, search for orders and reports in a particular site.

• Order Status: Search for orders of a particular status. The table below describes 
each status:

• Patient Class: Search for a particular type of patient (Inpatient, Outpatient, 
Pre-Admit, Emergency, Recurring Patient, or Obstetrics). 

• Account: Search based on the resident who dictated the report, or the attending 
physician who dictated or is assigned to the report. Or, search by the transcriber or 
technologist. Inactive user accounts are omitted from the list. 

• Locking: Search based on a report’s lock status (All, Locked, Unlocked, Assigned, 
Unassigned, Locked or Assigned, Unlocked and Unassigned). Locked reports are 
those currently being dictated. 

• Report Status: Search for reports of a particular status. The table below describes 
each status:

Status Description

All Uses all order statuses in the search.

Canceled Order was cancelled.

Completed Order has been completed and is ready for reporting.

Scheduled Order has been scheduled but not performed.

Temporary Indicates a temporary order.

Dictated Ext.

Status Description

Addended One or more addenda have been created for a final report. Addenda are 
reports themselves and the aforementioned statuses apply to them too.

All Uses all report statuses in the search.

Completed (All) and 
Completed (Unreported)

Exam has been performed and is ready for dictation.

Draft
Draft (A)
Draft (T)

Report has been started and saved, but not completed.
A indicates an addendum
T indicates temporary

Final Report has been completed and signed by an attending.

Pending Correction Report has been dictated and queued for correction.

Pending Signature Report has been dictated and queued for signature.

Preliminary Pertains to any report whose status is not final.
0
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• Section: Search based on customized site sections. This filter is disabled if you 
have not selected a site.

• Ordering Physician: Search for exams ordered by the selected physician from a 
site. This filter contains only active physicians who have ordered at least one exam, 
and is disabled if you have not selected a site. Begin typing the physician’s name, 
and then select the name from the list that appears.

• Time Frame: Search for orders or reports based on a period of time. For unreported 
orders, the filter is based on the time of the exam. For reported orders, the filter is 
based on the time the report was last modified. This filter includes values such as 
Past hour, Past 4 hours, Today, Yesterday, Past 2 days, Past 3 days, Past week, Past 
2 weeks, Past month, Tomorrow, All Future, and No limit. To specify a range, click 
Custom and then indicate the start and end dates. These dates are inclusive.

• Transfer Status: Use this filter to search based on report transfer status (All, 
Exceptional, Not Ready, Ready, Sent, Rejected, Failed, Held, Queued, Force Send).

• Location: Use this filter to search based on the site location associated with the 
order. This filter is disabled if you have not selected a site. 

2. Click Search. Any orders or reports that meet your criteria appear in the results grid.

Rejected Appears when a corrected report is returned to an editor by an attending or 
resident, or when a Pending Signature report is returned to a resident by an 
attending.

Scheduled Exam has been scheduled but not yet completed. Sometimes, the exam has 
been completed but the status has not been updated in the RIS. In this case, 
reports can be dictated, but are not delivered to the RIS until they are marked 
complete. Some sites may choose not to allow dictation for scheduled orders.

Temporary Exam has not been received by PowerScribe 360 | Reporting so a temporary 
order has been created. In this case, reports can be dictated, but are not 
delivered to the RIS until the actual order is received.

Unreported No report has been dictated for the order.

Wet Read A “pre-draft” state. Either attending or resident providers can create a wet 
read report. Any attending or resident provider can promote a wet read report 
to a Draft status. The text of the wet read is maintained once the report is 
promoted to Draft status.

Status Description
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d

Using the Search Results
The results grid shows all reports and orders that meet your search criteria.

Tip: 

• If a report is associated with multiple orders, each order that satisfies the search 
criteria appears separately in the grid. 

• If the report has an addendum, the properties listed (status, attending, and so on) refer 
to the addendum. 

• If the search yields more than one page of results, click the page number at the bottom 
right corner of the grid to navigate to a specific page. To view the entire list, click the 
small down arrow at the right of the page number list. The arrow then reverts to an up 
arrow; click the up arrow to see the results one page at a time.

• Hover your mouse cursor over the page label to see the total number of items found. 

Results Gri
2
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• Click any column heading to change the sort order. The software remembers the order 
you selected. Click the heading again to sort in reverse order.

• If you invoke a worklist that contains a sort order, the results initially appear in this 
order, and the grid footer displays the order. Apply a different sorting by clicking a 
column heading.

Note: There is a limit on the number of orders you can retrieve at one time. This limit is set 
by default to 500 in the Maximum Explorer Search Records system preference, found on 
the Explorer Screen tab in the System Preferences window. 

The Locking and assignment status, Report transfer status and Priority columns 
provide some important information about the reports and orders that appear in the list. 

Column Description

Locking and assignment status The icon in this column can be either yellow or blue. 
Yellow indicates that the report is open and therefore locked. 
Hovering your mouse over the lock icon shows who has 
locked the report.
Blue indicates an order that is assigned to a radiologist other 
than the logged-in user. Depending upon a site preference, 
(page 58) you might, or might not, be able to open this order.

Report transfer status Hover your mouse over the order’s icon to see the status:
Ready: Report is flagged for inspection; when it is sent 
depends upon its status and interface options.
Queued: Report is queued for transmission.
Force Send: Report is queued for immediate 
re-transmission.
Sent: Report has been successfully delivered.
Final Exported: Final report has been successfully 
transmitted.
Rejected: The RIS rejected the report.
Failed: An error occurred.
Held: An administrator interrupted the transmission.

Priority This column uses icons to indicate an order’s priority: 
No icon: Routine priority

STAT priority
ASAP (red)
Timing-critical; Callback; or Pre-op (yellow)
Low priority (green)

TAT Deadline Indicates reports that have reached or surpassed their turnaround 
time deadline:

Indicates the report is past its deadline. Hover your mouse 
cursor over the icon to see a tool tip describing how far past 
the deadline the report is.
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Order/Report Preview 
Each accession number in Accession column of the results grid is a hyperlink to an order 
and report preview page. This printer-friendly page also provides patient data, exams 
associated with the report, the report’s addenda, and any notes, custom fields, or 
attachments.

In addition to the preview, there is an audit trail for the order and report, showing when the 
report was received from the RIS, when it was created, edited, signed, and so on. In the 
4
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Content column of the audit grid, there are icons you can click to download the report 
content at various steps in the reporting process.

You can download the plain text (.txt), the formatted text (.rtf), or the dictated audio (.wav) 
of the current report independently of the audited content. These files are available for the 
number of days specified in the Keep Content Audit for Final Reports option in the 
System Configuration dialog box (Setup > System > Configuration). Final reports are 
typically deleted after a few days so that the database does not grow too rapidly. 

Holding, Releasing, or Sending an Order or Report
If you hold a report, it is not sent to the RIS, even if it has been signed as preliminary or 
final. To make a held report or order eligible for transfer, you must use the Release option. 
You can release only completed orders and final reports that have been held. 

Note: You can release preliminary reports only if you have set the Send 
Preliminary Results option and the Send Dictated Status Updates option for the 
Bridge service (Setup > Bridge). 

• The Release option changes the report’s transfer status from Held to Ready, which 
prepares the report to be examined by the Bridge software. The report may or may not 
be sent, based on the options configured for the Bridge and for the destination systems. 

• The Send Now option forces the report to be sent within a few seconds, regardless of 
the way the Bridge options are configured.

To hold an order or report: 

1. Find the report or order you want to hold. 

2. Place a check mark next to the report or order. 

3. Click Hold. You see a confirmation message. 

4. Click OK. A Held icon appears in the Report Transfer Status column next to 
the order or report, indicating that it is being held. 

To release an order or report:

1. Find the report or order you want to release. 
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Tip: Use Held as the Transfer Status filter to search for all held orders and 
reports. 

2. Place a check mark next to the report or order. 

3. Click Release. You see a confirmation message. 

4. Click OK. A Ready icon appears in the Report Transfer Status column next to 
the order or report, and the order or report is now eligible to be sent. 

To send an order or report immediately:

1. Find the report(s) or order(s) you want to send. 

2. Place a check mark next to the report(s) or order(s). 

3. Click Send Now. You see a confirmation message.

4. Click OK. The report or order is transferred. 

Faxing an Order or Report
You can fax one or more reports or orders from the Explorer tab. 

To fax orders or reports: 

1. Find the report or order you want to fax.

2. Place a check mark next to each item you want to fax. 
6
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3. Click Fax…. The Fax Report dialog box opens.

4. In the To: field, select the recipient’s name. The default destination is the ordering 
physician, or the referring physician if the ordering physician name is unavailable.

5. In the Number: field, type the fax number. 

6. If you want a cover page to accompany the fax, select Cover Page and type the 
Subject and Message that are to appear on the cover page. For information on defining 
cover page templates, refer to Creating a Fax Cover Sheet, beginning on page 502.

7. Click Send to send the fax(es). 

Unlocking an Order
While a provider is dictating a report on an order, the order is locked to prevent other users 
from opening it. Later, the order is unlocked. The order might remain locked in some 
circumstances, such as a loss of network connection. When the provider logs in again 
when the connection is restored, any locks are automatically cleared. You can use the 
method below to unlock an order manually, if necessary. 

To unlock an order: 

1. Find the order you want to unlock.

Tip: Use the Locking Status filter to search for all locked orders.

The locked order shows a padlock icon next to it. 

2. Place a check mark next to the order. 

3. Click Unlock. The lock is cleared. 
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Associating an Order with a Report
Use this feature to associate an order with a report. You can:

• Add another order to a report. Any orders already associated with it remain in place.

• Replace an order with another one. 

• Remove an order from a report that has multiple orders.

To associate an order with a report:

1. Find the report to which you want to associate an order.

2. Float your mouse cursor over the Action link next to the report, and select Associate... 
from the shortcut menu. The Order Association dialog box opens.

3. Indicate the action you want to take: Add an order to this report, or replace the existing 
order with another one. Or, if there are multiple orders associated with a report, you 
have the option of removing the currently selected order. 
8
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4. Click Next >>. A list of unreported accessions for this patient is displayed.

5. Select the order you want to associate with the report and click Next >>. A 
confirmation message indicates the association has been made, or removed, depending 
on the action.

6. Click Close. The original list is updated to reflect your change. 

Resetting a Report’s Status to ‘Draft’
To reset a report to ‘draft’: 

1. Find the report whose status you want to reset. 

2. Float your mouse cursor over the Action link next to the report, and select Reset to 
draft from the shortcut menu. A confirmation message appears.

3. Click OK. The report’s status reverts to ‘draft.’
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Modifying an Order’s Priority Level
To modify an order’s priority level:

1. Find the order whose priority you want to reset. 

2. Float your mouse cursor over the Action link next to the order, and select 
Set Priority … from the shortcut menu. The Set Priority dialog box opens.

3. Select the priority level you want to assign to this report. 

4. Click Change. The report’s priority is changed to the level you selected. An icon 
appears in the Priority column to show the priority:

Modifying a Report’s Diagnosis Codes
This feature allows you to set diagnosis codes for reported orders.

To modify a report’s diagnosis codes: 

1. Find the report whose diagnosis codes you want to modify.

2. Float your mouse cursor over the Action link next to the order, and select Edit 
Diagnosis Codes… from the shortcut menu. The Order Diagnosis Codes dialog box 
opens. 

Routine: No icon

Low priority:

Timing-critical, 
callback, or pre-op:

ASAP:

STAT:
0
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3. Find the diagnosis code you want to assign to the report. 

To find a code:

 a. Type all or part of the code or its description in the Diagnosis Code/Description 
field. You can use an asterisk as a wild-card character. 

 b. Click Search to find the codes. Select the Restrict to exam codes option if you 
want to search only amongst exam codes, and not diagnostic codes. The codes 
appear in the All codes list at the left.

4. Place a check mark next to each code you want to assign to this order. Or, place a 
check mark in the heading to select all the codes in the list. 
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5. Click Add. The selected codes are added to the Selected Diagnosis Codes list at the 
right. To remove a code, place a check mark next to it and click Remove.

6. Click Save and Close to assign the codes to the order. 

7. Repeat Steps 3 through 6 until you have added all the desired codes to the order. 

8. Click Close Window.

Modifying an Unreported Order or Report’s Custom 
Field Values

Note: For more information on custom fields, see Custom Fields, beginning on page 325.

You can change the values the radiologist or other user has inserted in the custom fields in 
an unreported order or report. 

To modify the custom fields:

1. Find the order or report whose custom field values you want to change. 
2
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2. Float your mouse cursor over the Action link next to the order or report, and select 
Edit Custom Fields… from the shortcut menu. The Order Custom Fields dialog box 
opens.

3. Enter or select the appropriate value for each of the custom fields in the order or 
report. 

4. Click Save Changes. 

5. Click Close Window to return to the report list.

Changing a Patient’s MRN
To change a patient’s MRN:

1. Find the order or report in which you want to change the patient’s MRN. 

2. Float your mouse cursor over the Action link next to the report, and select Change 
Patient MRN from the shortcut menu. The Change Patient Identifier dialog 
box opens.

3. Type the patient’s new MRN. 
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4. Click Change. A notification message appears.

5. Click OK. 

Canceling an Order
Because some RIS do not send order cancellations through HL7, you can set the status of 
an exam to Canceled to keep the data synchronized between PowerScribe 360 | Reporting 
and your RIS. You can cancel only unreported orders whose status is not Temporary or 
Entered.

To cancel an order: 

1. Find the order you want to cancel. 

2. Float your mouse cursor over the Action link next to the order, and select Cancel from 
the shortcut menu. A confirmation message appears.

3. Click OK. The order’s status changes to Cancelled. 

Printing an Order or Report
You can print any order or report in the system; the report will appear in the same format 
as it does when the radiologist prints it from the PowerScribe 360 | Reporting client 
application. The report will include any headers, footers, page numbering, or other 
features you defined in the default print template for the system, site, or site location. For 
more information on setting up print templates, refer to Creating a Print Template, 
beginning on page 489.
4
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To download a printable report: 

1. Find the report(s) you want to print. 

2. Place a check mark next to each report you want to print. 

3. Click Printable…. The standard File Download window opens.

4. If you want to view the report(s), click Open. The report opens in a Word or WordPad 
window, depending on the file type. From here, you can save or print the document. 

OR

To save a copy of the report(s), click Save. A standard Save As window opens. 
Navigate to and select the folder where you want to save a Word file containing the 
report(s), and click Save. The file is stored at the location you specified. 

Deleting Reports and Orders
Caution: Deleting reports or orders is not recommended and should not be done except in 
rare cases where your RIS is out of synch with your PowerScribe 360 | Reporting system. 

Deleting a report or an order removes it from the PowerScribe 360 | Reporting system, but 
does not remove it from the RIS. In most cases, you do not need to delete reports or orders 
from the system. If an unusual situation requires you to delete a report or order, follow the 
procedure below. 

To delete a report or order:

1. Find the order or report you want to delete. 

2. Place a check mark next to the order or report. 

3. Click Delete. A confirmation message appears.
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The options you see depend on the order or report you selected. For example, if you 
delete an order associated with a visit that has no other unreported orders, you have an 
option to delete the visit:

4. Select the appropriate option(s) and click Delete. A message indicates the successful 
deletion of the item(s).
6
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Using the Dashboard Tab

The Dashboard tab in the Exams group provides a real-time view of exam activity in the 
system. It has three tabs, each showing a different set of exam-related activities.

• User Activity: Shows all users currently logged into the system, including Portal 
users, how long they have been logged in, the workstations they are using, the exams 
on which they are working, and the last action taken on these exams. 

• Inbound Activity: Shows all recent messages received from the RIS. 

• Outbound Activity: Shows all recent messages sent to the RIS. 

• DICOM Activity: If you purchased the DICOM option, this tab is available.

Use the Configuration page in the Setup group to specify how often the data is updated on 
the Dashboard. The default is every 30 seconds.
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Introduction to Templates

You can create print, fax, and cover sheet templates for your facility’s needs. You can design 
templates for the entire system, for individual sites, and for locations within sites. If your 
facility is converting from the RadWhere application, you can use your existing RadWhere 
templates in PowerScribe 360 | Reporting. 

Templates allow your reports to have a consistent appearance when they are printed or faxed. 
If you assign a template to the system, all reports printed in the system use that template, 
unless you also assign templates to individual sites or locations within sites. With a template, 
a report has the same appearance whether a radiologist prints it from the client application or 
an administrator prints it from the Explorer tab in the Administrator Portal.

To tailor a template to your facility’s needs, you can use advanced features such as merge 
fields, tabs, page numbering, headers, footers, tables, and embedded graphics such as logos. 
And, you can design a template to show a different header or footer on the first page than on 
the other pages. (Nested tables and separator lines are not supported.) 

If desired, you can design separate templates with different headers and footers for each site or 
location; for example, you might want reports to display a different department name and 
address at the top of the page depending on the site or location. You can create the same or 
different templates for printing and faxing. 

You can create and edit simple templates in WordPad; for the more advanced features, you 
will need to use Microsoft Word. You must save print and fax templates as .rtf files, not as 
.doc files, before you upload them to your system in the Portal. You can use any .rtf file as a 
basis for a new template. 

Note: Cover sheet templates are not .rtf files; these have a .cov extension and you can 
create them only in the Microsoft Fax Cover Page Editor utility that comes with Windows.

Use the procedures below to create and edit templates that will be available to all users in the 
system, for individual sites, or for locations within sites. 
8
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LEXIMER Recommendations
To obtain the best results from the LEXIMER algorithm, it is recommended that you 
follow these practices:

• Create standard departmental templates with consistent headings. LEXIMER searches 
the text of unstructured radiology reports and uses primary headings (Findings, 
Impression, Summary, Conclusion) in its first-pass analysis to identify areas of 
relevancy. Below is a sample template:

• LEXIMER reads the report text from bottom up and will be more accurate if reports 
are formatted with Impressions at the bottom. To optimize analysis accuracy, it is 
suggested that the Impression section be placed at the bottom of the template rather 
than at the top. 

Creating a Print Template

To add a new print template at the system or site level, you must first create the template 
as an .rtf file in Microsoft Word or WordPad. Once you have created it, you must add it to 
your PowerScribe 360 | Reporting system. 

To create the template:

1. Create the template file in Microsoft Word or WordPad. 

• Use Word’s advanced features to add headers, footers, page numbering, and so on, 
if desired.

• A print or fax template must, at the minimum, contain the <maintext> merge field. 
This field will contain the text of the report; you must place this field at the position 
where you want the body of the report to appear. 

COMPARISON: […]
TECHNIQUE: […]

FINDINGS: 
[…]

IMPRESSION: 
[…]

[Recommendation] (Blank field to use as 
placeholder for follow-up recommendations)
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• You can add other merge fields such as the patient name, patient MRN, attending 
name, and so on. Below is an example of a print template with merge fields.

To see a list of all available merge fields: 

 a. On the System or Sites tab in the Setup group, click Templates….

 b. Click the icon at the upper right of the Print Template tab.

Place the <maintext> 
merge field at the position 
where you want the body 
of the report to appear. 
0
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A window showing the list of merge fields opens. 

You can copy any merge field from the list to insert it in the document. For example, to 
insert the visit number, copy the field <401:Visit Number> and paste it at the position 
in your template where you want the visit number to appear. Although you can use the 
field number alone or the field name alone, it is recommended that you copy the field 
exactly as it appears, including the brackets. 
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Tip: To insert a custom field, use this format: <10000:Custom:Custom Field 
Name>. For example, if the custom field name is Radiation Dose, type 
<10000:Custom:Radiation Dose>. 

Appendix B in this manual also contains a list of the merge fields you can use in your 
print templates. 

2. When you have finished creating the template, save it as an .rtf file. Make a note of the 
path and folder location where you saved the file. Then continue with the procedure 
below to upload the template to your system. 

To add a print template to the system, site, or location:

1. To add a print template at the system level: 

 a. On the System tab in the Setup group, click Templates.

 b. Select the Print Template tab.

OR

To add a print template at the site level: 

 a. On the Sites tab in the Setup group, select the site from the drop-down list at the 
upper right. 

 b. Click Templates. 

 c. Select the Print Template tab.

OR

To add a print template at the site location level: 
2
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 a. On the Sites tab in the Setup group, select the site from the drop-down list at the 
upper right. 

 b. Next to the location for which you want to add a template, click Edit in the 
Templates column.

2. Click New. 

The Create Template dialog box opens.

3. Type a Name for the new template. 

4. Click Browse.

5. Navigate to and select the file you created in Word or Wordpad. Click Open. The path 
and file name appear in the File field.
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6. Click Save. The template appears in the plain-text preview window.

7. To preview the template as it will appear with a report, click the link below the editing 
window. At the prompt, click Open. A sample report appears in a preview window. 
4
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(This preview does not display any real data in the merge fields, but shows how a 
typical report might appear in the template.)

 

Close the preview window when you have finished viewing the sample report.

8. Click Save and Close to save the template on your server. 
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Show Addendum at the Top of Printed Reports
Merge fields are available for printable templates that allow a report’s addenda to appear 
at the top of the report, rather than near the end, allowing report recipients to be alerted 
immediately to the most recent information about a patient.

Note: The merge fields can also be used to create other highly customized print templates, 
including control over the headers and separators that appear with each section.

Print Template Merge Fields

Simple Approach
<maintextreverse> - Prints report with addendums at top in reverse chronological 
order, using hard coded headers and separator lines between each addendum and the 
original report.

Complex Approach (for customers who want more control of separators)
<addendum-start> <addendum-end> <addendumtext>

<originalreport-start> <originalreport-end> <originalreporttext>

<report-start> <report-end> <reporttext>

Notes: 

• <originalreport> may be used as a synonym for <originalreporttext>, <report> is 
a synonym for <reporttext>, and <addendum> is a synonym for <addendumtext>.

• <originalreportextt> refers to the original report only when an addendum exists. 
Thus, both the <originalreporttext> and <reporttext> tags may be used in the same 
template to customize the output for the original report when addendums exist, such 
as to add a different banner.

• If an addendum exists, but the report template does not include an 
<addendumtext> tag, the template is considered invalid since the addendum(s) 
cannot be included in the printout. Since this represents a potential patient safety 
issue, the custom tags will be ignored and <maintext> will be implied.
6
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Two example templates (Simple Reverse Template and the Complex Reverse 
Template) and their example results are shown on the next two pages, using the new 
merge fields to position the addendum text at the top of a printed report.

Simple Reverse Template Example and Result
497



49

PowerScribe® 360 | Reporting System Administrator Guide
Complex Reverse Template Example
8
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Creating a Fax Template

To create a fax template: 

1. Create the fax template file in Microsoft Word or WordPad.

• Be sure to include at least the <maintext> merge field. To see a list of all available 
merge fields: 

 a. On the System or Sites tab in the Setup group, click Templates.

 b. Click the icon at the upper right portion of the Fax Template dialog box.

A window showing the list of merge fields opens. 

 c. To insert a merge field in the Word document, copy the field from the list. Be sure 
to copy the field exactly as it appears, including the brackets. 

2. Save the template as an .rtf file.

To add the fax template at the system, site, or site location level: 

1. To add the fax template at the system level: 

 a. On the System tab in the Setup group, click Templates.

 b. Select the Fax Template tab.
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OR

To add the fax template at the site level: 

 a. On the Sites tab in the Setup group, select the site from the drop-down list at the 
upper right. 

 b. Click Templates…. 

 c. Select the Fax Template tab.

OR

To add the fax template at the site location level: 

 a. On the Sites tab in the Setup group, select the site from the drop-down list at the 
upper right. 

 b. Next to the location to which you want to add a fax template, click Edit… in the 
Templates column.

 c. Select the Fax Template tab.

2. Click New.

3. Type a Name for the new fax template. 
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4. Click Browse.

5. Navigate to and select the file you created in Word or Wordpad. Click Open.

6. Click Save. The template appears in the plain-text preview window.

To preview the template as it will appear with a report, click the link below the editing 
window. At the prompt, click Open. A sample report appears in a Word window. 
Close the window when you have finished.

7. Click Save and Close to save the fax template.
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Creating a Fax Cover Sheet

Creating a Fax Cover Sheet in Windows 7
In Windows 7 you can create a fax cover sheet using the Windows Fax and Scan program.

To create the fax cover sheet in Windows XP: 

1. Click the Start button , click All Programs, then click Windows Fax and Scan.

2. Make sure you’re in the Fax view by clicking Fax at the bottom of the left pane.

3. Click the Tools menu, click Cover Pages, and then click New. A blank window 
containing the available cover page tool opens.

4. To add commonly used label and text boxes to the cover page, click the Insert menu, 
and then do one or more of the following:
2
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• Click Recipient, and then click the type of recipient information that you want the 
cover page to display.

• Click Sender, and then click the type of sender information that you want the cover 
page to display.

• Click Message, and then click the type of message information that you want the 
cover page to display.

5. To add text, click the Text button on the toolbar, and then drag your pointer to 
draw a text box. Type the text that you want the cover page to display.

6. The following illustration shows an example fax cover sheet.

7. When finished, click File > Save and save the file to your preferred location. The 
cover sheet file is saved with a .cov file extension. 
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Creating a Fax Cover Sheet in Windows XP
Begin by creating a fax cover page in the Microsoft Fax Cover Page Editor utility. 

Note: To use this utility in Windows XP, you must first install the Fax service. Refer to your 
Windows documentation for information on installing this or other Windows components. 

To create the fax cover sheet in Windows XP: 

1. Select Start > All Programs > Accessories > Communications > Fax > Fax Cover 
Page Editor. The editing window opens.

2. Use the utility’s editing features to create the cover sheet. For more information, refer 
to the Fax Cover Page Editor’s online help. 
4



Chapter 17: Order and Report Management
Note: The utility allows you to insert merge fields by selecting Insert from the 
menu bar and then selecting fields from the Recipient, Sender, and Message 
submenus. The PowerScribe 360 | Reporting application supports only the 
following fields: 

Recipient: Name, Fax Number

Sender: Name, Fax Number

Message: Note, Subject, Date Sent, Number of Pages

3. Click File > Save As….

4. Save the cover sheet to a folder on your computer. The cover sheet file has a .cov file 
extension. 

Adding a Fax Cover Sheet
Use the following steps to add the fax cover sheet you created (regardless of which 
version of Windows you used to create it).

To add the fax cover sheet:

1. To add the fax cover sheet at the system level: 

 a. On the System tab in the Setup group, click Templates.

 b. Select the Cover Sheet tab.
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OR

To add the fax cover sheet at the site level: 

 a. On the Sites tab in the Setup group, click Templates…. 

 b. Select the Cover Sheet tab.

OR

To add the fax cover sheet at the site location level: 

 a. On the Sites tab in the Setup group, select the site from the drop-down list at the 
upper right. 

 b. Next to the location to which you want to add a fax template, click Edit… in the 
Templates column.

 c. Select the Cover Sheet tab.

2. Click New….

3. Enter a name for the cover sheet. 
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4. Navigate to and select the cover sheet file and click Open. Cover sheet files have a 
.cov extension.

5. Click Save. The template appears in the Select Template list.

6. Click Save and Close to save the template.

Modifying a Template

You can modify a print, fax, or cover sheet template for your system or site, and you can 
modify a template for a location within a site. 

Modifying Print and Fax Templates
To modify a print template: 

1. To modify a print template at the system level:

 a. In the Setup group, select the System tab. 

 b. Click Templates….

 c. Select the Print Template tab. 

OR

To modify a print template at the site level:

 a. In the Setup group, select the Sites tab. 

 b. Click Templates…. 

 c. Select the Print Template tab. 

OR

To modify a print template at the site location level: 

 a. On the Sites tab in the Setup group, select the site from the drop-down list at the 
upper right. 
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 b. Next to the location to which you want to modify a print template, click Edit… in 
the Templates column.

 c. Select the Print Template tab.

2. Download the template file from the server, if the current version is not on your 
computer. Otherwise you can skip this step. To download the file:

 a. Select the template you want to modify from the list. The template appears in the 
plain-text preview window. 

 b. Click Download. 

 c. At the prompt, click Save. 

 d. Navigate to and select the folder in on your computer in which you want to store the 
template file.

3. In Word, open and edit the template file as desired. Save and close the file. 

4. Click Edit…. Navigate to and select the file you edited. The edited file appears in the 
plain-text preview window. To preview the template in Word, click the link at the 
bottom of the window; click Open to view a sample report. Then close the preview 
window. 

5. Click Save and Close to save your changes. 

To modify a fax template: 

1. To modify a fax template at the system level:

 a. In the Setup group, select the System tab. 

 b. Click Templates….

 c. Select the Fax Template tab. 

OR

To modify a fax template at the site level:

 a. In the Setup group, select the Sites tab. 

 b. Click Templates…. 

 c. Select the Fax Template tab.

OR

To modify a fax template at the site location level:
8
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 a. On the Sites tab in the Setup group, select the site from the drop-down list at the 
upper right. 

 b. Next to the location to which you want to modify a fax template, click Edit… in the 
Templates column.

 c. Select the Fax Template tab.

2. Download the template file from the server, if the current version is not on your 
computer. Otherwise you can skip this step. To download the file:

 a. Select the template you want to modify from the list. The template appears in the 
plain-text preview window. 

 b. Click Download. 

 c. At the prompt, click Save. 

 d. Navigate to and select the folder in on your computer in which you want to store the 
template file.

3. Open and edit the template file as desired. Save and close the file. 

4. Click Edit…. Navigate to and select the file you edited. The edited file appears in the 
plain-text preview window. To preview the template, click the link at the bottom of the 
window; click Open to view a sample report in an editing window. Then close the 
preview window. 

5. Click Save and Close to save your changes. 

Modifying Fax Cover Sheet Templates
To modify a fax cover sheet template: 

1. To modify a fax cover sheet template at the system level:

 a. In the Setup group, select the System tab. 

 b. Click Templates….

 c. Select the Cover Sheet tab. 

OR

To modify a fax cover sheet template at the site level:
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 a. In the Setup group, select the Sites tab. 

 b. Click Templates…. 

 c. Select the Cover Sheet tab.

OR

To modify a fax cover sheet template at the site location level:

 a. On the Sites tab in the Setup group, select the site from the drop-down list at the 
upper right. 

 b. Next to the location for which you want to modify a fax cover sheet, click Edit… in 
the Templates column.

 c. Select the Cover Sheet tab.

2. Download the template file from the server, if the current version is not on your 
computer. Otherwise you can skip this step. To download the file:

 a. Select the template you want to modify from the list. 

 b. Click Download. 

 c. At the prompt, click Save. 

 d. Navigate to and select the folder in on your computer in which you want to store the 
template file.

3. In the Windows Fax Cover Page Editor utility, open and edit the template file as 
desired. Save and close the file. 

4. On the Cover Sheet tab in PowerScribe 360 | Reporting, click Edit…. Navigate to 
and select the cover sheet you edited. 

Note: The preview feature is not available for fax cover sheets.

5. Click Save and Close to save your changes. 
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Chapter 18

Management Reports

Objectives
In this chapter, you will:

• Distinguish between the following types of 
reports:

- Author productivity

- AutoText

- Editor productivity

- Reports

- Turnaround time (TAT)

- Quality Check (purchasable option)

- Clinical Guidance (purchasable option)
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Introduction

Reporting in PowerScribe 360 | Reporting allows administrators to look at several aspects of 
productivity on the system, including author and editor productivity, and turnaround time. In 
addition, several reports supply information on aspects of the reports that providers create in 
the system.

Types of Reports
Note: Customers who purchase the Quality Check (formerly Assure) or Clinical Guidance 
options will see reports that are available for those features.

The reports are divided into the following categories:

• Author productivity

• AutoText

• Editor productivity

• Reports

• Turnaround time (TAT)

Features Common to All Reports
Each PowerScribe 360 | Reporting report provides a unique set of information. However, 
there are several features common to all the reports: the toolbar, the ability to select new 
report parameters, and the ability to hide the report parameters section.

Toolbar

Near the top of each report, just above the data and chart portion, is a toolbar. 

The toolbar allows you to perform several tasks:

• Navigate through the pages in each report: From the left, the controls indicate First 
Page, Previous Page, Next Page, and Last Page. Click an icon to perform each task.

• To main report returns you to the main report after you have clicked a link taking you 
to a sub-report. (This icon is not available in all reports.)

Navigate Resize Search Export Refresh

PrintTo main report Show/Hide
2
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• Resize your view of the report: Choose a smaller or larger size in which to display 
your report.

• Search for specific terms in the report: Enter a term in the search field and use the 
Find and Next links to find instances of your term.

• Export report data in any of several different formats: Choose .xml, .csv (comma-
delimited), ..pdf, MHTML web archive, Excel, TIFF, or a Word document. You can 
choose to either open or save the file in your selected format.

• Refresh the report data: Click this icon to update the data in your current report.

• Print the report: Prints the full report to a printer associated with the computer on 
which you have run the report.

• Show/Hide temporarily hides the report parameters section, giving you more area on 
your screen for the report. Click this icon again to show the parameters.

Select New Report Parameters

After you view your report, the parameters you first selected appear above the toolbar. 
(The example below shows the parameters for the TAT - summary author signature 
averages report.)

These parameters are displayed again so you can immediately run the same report using 
different dates, accounts, sites, and so on. 

Refer to the individual reports in this document for descriptions of each of these parameter 
fields.

Note: All reports with a date range allow you to specify a time of day, if desired. To 
indicate a date and time, first select the date from the calendar, and then enter the time 
manually. Use either a 24-hour format (example: 14:30:00) or a 12-hour format 
(example: 2:30:00 PM). A day is considered to begin at midnight and end at 11:59:59 PM. 

Hide the Report Parameter Fields

To allow more area to view the report contents, you can temporarily hide the report 
parameters (for example, Signed From, Signed To, Site, Author, and so on). To do this, 
click the Show/Hide  icon. Click a second time to display them again.
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Character Count and Line Count Calculation Examples
• The total number of characters in a report is calculated at the time the editor saves the 

report. If an editor opens a report, makes changes, and saves the report (or Finishes 
correcting, sending the report back to the radiologist), the total number of characters 
increases or decreases depending upon the changes the editor made. This number is 
placed in the TranscribedCharCount column in the report table. 

• The line count calculation takes the number of characters (from the 
TranscribedCharCount column) and divides it by the number of characters specified 
in the CharsPerLine parameter. (Default is 65.) The formula for the calculation is 
Round(TranscribedCharCount/CharsPerLine). The resulting number is rounded to 
one decimal place (for example, 123.1).
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Author Productivity Reports

The reports in this section allow you to examine information about providers’ productivity.

Author Productivity—Detailed Activity
This report shows the start and end time of each report within the supplied date range, as 
well as the time that the report was signed by the radiologist. Unsigned reports do not 
appear in this report.

Running the Author Productivity—Detailed Activity Report

To run this report:

1. On the Reports tab, select the Author Productivity—Detailed Activity report from 
the drop-down list.

2. Use the following table as a guide for entering values.

3. Click View Report.

Parameter Definition

Created From 
and Created To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates for your report. Beginning and ending times are 
required. 

Site
If your organization has multiple sites, select the site or sites on 
which you want to run the report. Otherwise, this drop-down list 
is not visible.

Correction 
Workflow

Select All, Self-edit, In-house, or Delegated.

Author Select the person who dictated the report from the drop-down 
list, or select All.

Editor Select the person who transcribed or edited the report from the 
drop-down list, or select All.

Reports Select the type of reports to include: Originals only, Addendums 
Only, or All
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Results Screen and Explanations

The Author Productivity—Detailed Activity report includes the following information:

• Accession: The identifying number assigned in the RIS. This column can contain 
multiple values.

• A: The addendum’s sequence number. For an original report, this column is blank.

• Site: The site where the report was created

• Author: First and last name of the provider who initiated the report

• Editor: First and last name of the editor who corrected the report, if applicable

• Created: Date and time that the provider initiated the report

• Sent to Editor: Date and time that the provider clicked the Correct button on the 
PowerMic or other microphone or in the dictation window

Note: Sent to Editor shows the time that the provider first clicked the Correct 
button. The date and time do not update if the provider dictates additional text. 

• Approved: Date and time a resident approved the report, if applicable.

• Signed: Date and time the attending provider signed the report

Author Productivity—Hourly Detail
This report shows the number of reports providers dictated during each hour of the day 
during a specified date range. It provides subtotals by author and grand totals for the 
morning and evening periods.
6



Chapter 18: Management Reports
The Author Productivity—Hourly Detail—Past Day report and Author Productivity—
Hourly Detail—Past week reports are identical to the Author Productivity Hourly Detail 
report, except that they show activity during the past 24 hours and past week, respectively. 

Running the Author Productivity—Hourly Detail Report

To run this report:

1. From the Reports tab, select the Author Productivity—Hourly Detail report from 
the list.

2. Use the following table as a guide for entering values:

3. Click View Report.

Results Screen and Explanations

The Author Productivity—Hourly Detail report shows the following information:

• The last and first name of the person who dictated the report

• Number of reports the provider dictated during the AM hours, broken down by hour

Parameter Definition

Created From 
and

Created To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site Select one or more sites for your report, if your organization has 
multiple sites.

Author Select an author, or all authors, from the drop-down list.
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• Number of reports the provider dictated during the PM hours, broken down by hour

• Grand totals for AM reports, broken down by hour

• Grand totals for PM reports, broken down by hour

Author Productivity—Monthly Summary
This report lists by provider the number of daily reports as well as a monthly total for each 
provider. Also provides a graphical representation of each provider’s monthly 
performance.

Running the Author Productivity—Monthly Summary Report

To run this report:

1. On the Reports tab, select the Author Productivity—Monthly Summary report 
from the list.

2. Use the following table as a guide for entering values:

3. Click View Report.

Parameter Definition

Created From 
and 

Created To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates for your report. Beginning and ending times are 
required.

Site Select one or more sites for your report, if your organization has 
multiple sites.
8
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Results Screen and Explanations

The Author Productivity—Monthly Summary report shows the following information:

• Author: The person who dictated the report.

• First Dictation: The date the provider first performed dictation during this date range

• Last Dictation: The date the provider last performed dictation during this date range

• Days Dictated: The number of days on which the provider performed dictation

• Daily Dictations: The average number of dictations a provider performed on days on 
which he performed dictation

• Total Dictations: The total number of reports dictated during the date range

• Monthly Performance (graph): Each point in the graph represents the number of 
reports the provider dictated during a given month in the report’s date range. 

Author Productivity - RVU
This report provides statistics on Relative Value Unit (RVU) measurements, by site and 
author.

Running the Author Productivity—RVU 

To run this report:

1. On the Reports tab, select the Author Productivity—RVU report from the list.
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2. Use the following table as a guide for entering values:

3. Click View Report.

Results Screen and Explanations

The Author Productivity—RVU report shows the RVU statistics of reports broken into 
the following categories:

• Dictated Reports: Reports initiated by providers, residents, or fellows

• Approved Reports: Reports corrected by an editor

• Signed Reports: Reports signed by the provider

• RVU Sum: Number of RVUs for all reports per author.

• Average TAT: Average turnaround time for all reports per author.

Parameter Definition

Created From 
and 

Created To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site Select one or more sites for your report, if your organization has 
multiple sites. 

Author Select the person who dictated the report from the drop-down 
list, or select All.
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Author Productivity—Summary Activity
This report shows the number of different reports for a provider divided into categories, 
such as reports dictated, transcribed, speech-recognized, and signed. The average report 
length and the total report length for the selected time period are also shown.

Running the Author Productivity—Summary Activity Report

To run this report:

1. On the Reports tab, select the Author Productivity—Summary Activity report from 
the list.

2. Use the following table as a guide for entering values:

3. Click View Report.

Parameter Definition

Created From 
and 

Created To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site Select one or more sites for your report, if your organization has 
multiple sites. 

Correction 
Workflow

Select All, Self-edit, In-house, or Delegated.

Author Select the person who dictated the report from the drop-down 
list, or select All.

Editor Select the person who transcribed or edited the report from the 
drop-down list, or select All.
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Results Screen and Explanations

The Author Productivity—Summary Activity report shows the number and audio 
duration of reports broken into the following categories:

• Dictated Reports: Reports initiated by providers, residents, or fellows

• Corrected Reports: Reports corrected by an editor

• Signed Reports: Reports signed by the provider

• Average Report Audio Duration: The average length of all reports (dictated, 
recognized, and so on) for each author. Durations are shown as days, hours, minutes, 
and seconds.

• Total Reports/Total Duration: Totals in each of the categories.

Author Productivity—Summary Detail
This report provides a breakdown of reports by author and site, based upon the number of 
reports and the number of words.

The Author Productivity—Summary Detail—Past Week snapshot report is identical to 
this report except that it shows activity during the past seven days. 
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Running the Author Productivity—Summary Detail Report

To run this report:

1. On the Reports tab, select the Author Productivity—Summary Detail report from 
the list.

2. Use the following table as a guide for entering values:

3. Click View Report.

Results Screen and Explanations

The Author Productivity—Summary Detail report shows the following information for 
the selected period:

• Author: The last and first name of each provider who dictated reports

• Reports (Count)

Parameter Definition

Created From 
and 

Created To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site
Select one or more sites for your report.
Only applicable to organizations who have multiple sites.

Author Select the person who dictated the report, or select All.
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– Authored: Number of reports dictated by the provider

– Signed: Number of final reports signed by the provider

• Words (Average)

– Total: Average number of words in the provider’s reports. In addition to dictated 
and transcribed words, the total might include words typed by the provider, pasted 
into the report from another document, or inserted by an RIS.

– Dictated: Average number of words dictated by the provider

– Transcribed: Average number of words transcribed for each provider during the 
selected period

– AutoText: Average number of AutoText words in the provider’s reports 

– Merged: Average number of words in merge fields in the provider’s reports

• Average

– Audio Duration: Average length of audio in the provider’s reports. Durations are 
shown as days, hours, minutes, and seconds.

– AutoText: Average number of AutoText entries in this provider’s reports

Tip: If a provider inserts AutoText in a report and then undoes the action, or 
later selects and deletes the AutoText, the AutoText usage is still counted in this 
report. The average might therefore be based on a number greater than the 
actual number of AutoText entries that remain in the provider’s reports.

Author Productivity—Summary Overview
This report shows, for each provider who dictated reports, how many reports were 
self-edited and how many sent to an editor. In addition, it gives a total number of reports 
and minutes dictated for each provider, and a grand total for all providers.

Running the Author Productivity—Summary Overview Report

To run this report:

1. From the Reports tab, select the Author Productivity - Summary Overview report 
from the list.

2. Use the following table as a guide for entering parameters for this report:

Parameter Definition

Signed From 
and 

Signed To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site
Select one or more sites from the drop-down list.
If your organization has multiple sites, select the site or sites on 
which to run the report.
4



Chapter 18: Management Reports
3. Click View Report.

Results Screen and Explanations

The Author Productivity—Summary Overview report, without details, shows the 
following information for each dictation provider: 

• Author: The provider’s last and first name

• Sent to Editor:

– Number of reports sent for editing

– Percentage of reports sent for editing

• Self-Edited: 

– Number of reports the provider edited

– Percentage of reports the provider edited

• Total Reports: The number of reports initiated by the provider

Show Details
Select Yes to show individual reports or No to show overall 
results only. Yes gives you a detailed version of the report, while 
No gives a summary version. No is the default.

Reports Select All, Originals Only, or Addendums Only.

Parameter Definition
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• Audio Duration: Total days, hours, minutes, and seconds of report audio recorded by 
the provider

The Author Productivity—Summary Overview report, with details, shows the 
following additional information for each report: 

Report number: The report’s accession number(s). If there are multiple accession 
numbers associated with a report, they appear in the same row. 

A: The addendum’s sequence number. For an original report, this column is blank.

Sent to Editor: ‘X’ appears in this column if the report was sent for editing. 

Self-edited: ‘X’ appears in this column if the report was self-edited. 

Audio duration: The length of the audio file in hours, minutes, and seconds. 

Author Productivity—Words Dictated
For reports each provider signed during the selected period, this report shows the 
percentage of words dictated by the provider as opposed to words typed.

Running the Author Productivity—Words Dictated Report

To run this report:

1. On the Reports tab, select the Author Productivity—Words Dictated report from 
the list.
6
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2. Use the following table as a guide for entering values in this screen:

3. Click View Report.

Results Screen and Explanations

The Author Productivity—Words Dictated report shows the following information:

• Author: Last name, first name, middle name of the person who dictated the report.

• % Dictated Words: The number of words in the dictated audio divided by the total 
number of words in the final, signed document. A low percentage here can indicate 
that the provider used many dictation AutoText entries.

• Graph: The green line represents the percentage of words dictated; the blue line 
represents the percentage of words typed. As one percentage increases, the other 
decreases. 

Parameter Definition

Signed From 
and 

Signed To

Indicate the date range for this report. 
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.
The report will be blank if the date range is less than one month. 

Site If your organization has multiple sites, select the site or sites on 
which to run the report.
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AutoText Reports

Note that if a provider inserts AutoText and then removes it, the AutoText usage still counts in 
these reports. The totals, therefore, might reflect a number of AutoText uses greater than the 
number of AutoText entries remaining in the documents

AutoText—By Account
This report shows Site-level AutoText usage by each author within a designated time 
frame, plus a detail report of which Site-level AutoTexts were actually used.

To run this report:

1. On the Reports tab, select the AutoText—By Account report from the list.

2. Use the following table as a guide for entering values in this screen:

3. Click View Report.

Results Screen and Explanations

The AutoText—By Account report provides the following information: 

Parameter Definition

Used From and 
Used To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site Select one or more sites for your report. This parameter is 
applicable only to organizations with multiple sites.
8
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• Author (last name, first name): Each author’s name is a link to a more detailed report 
showing exactly which AutoText the author used (see illustration below).

Note: To return to the original report, click the left-pointing arrow next to the 
zoom size.

• First Used (date)

• Last Used (date)

• Count

• Monthly Average

AutoText—Summary
This report provides a summary of Site-level AutoText usage within a designated time 
frame, plus a detail report showing which authors used each Site-level AutoText. 

To run this report:

1. On the Reports tab, select the AutoText—Summary report from the list.

2. Enter your parameters for this report:

3. Click View Report.

Parameter Definition

From Date and 
To Date

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site Select one or more sites for your report. This parameter is 
applicable only to organizations with multiple sites.
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Results Screen and Explanations

The AutoText—Summary report provides the following information: 

• AutoText (name): Each AutoText name is a link to a more detailed report showing 
which author(s) used the AutoText (see illustration below). 

• First Used (date): The first time this user invoked AutoText during the selected time 
frame

• Last Used (date): The last time this user invoked AutoText during the selected time 
frame
0
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• Monthly Use: The average number of times this AutoText entry was used per month 
in the selected date range

• Total Use: The total number of times this user invoked AutoText during this time 
frame

AutoText—Verbiage
This report shows the AutoText entries used by a specific provider or by all providers.

Running the AutoText—Verbiage Report

To run this report:

1. From the Reports tab, select the AutoText—Verbiage report from the list.

2. Type the user name to see AutoText used by a specific provider.

OR

Type an asterisk (*) to see all system and personal AutoText used by all providers. 

OR

Type an ampersand (&) to see all system AutoText used by all providers. 

3. Click View Report.

Results Screen and Explanations

The AutoText—Verbiage report provides the following information: 
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• Username: The login ID of the person who used the AutoText

• AutoText: Name of the AutoText entry used

• Shortcut: The shortcut for this AutoText entry, if applicable

• AutoText Content: The full AutoText as it appears in the report

Editor Productivity Reports

The reports in this section allow you to examine information about editors’ productivity.

Editor Productivity—Hourly Detail
This report shows the number of reports edited during each hour of the day during a 
specified date range. It provides subtotals by editor and grand totals for the morning and 
evening periods. 

The Editor Productivity—Hourly Detail—Past Day report and Editor Productivity—
Hourly Detail—Past week reports are identical to the Editor Productivity Hourly Detail 
report, except that the show activity during the past 24 hours and past week, respectively.

Running the Editor Productivity—Hourly Detail Report

To run this report:

1. From the Reports tab, select the Editor Productivity—Hourly Detail report from the 
list.

2. Use the following table as a guide for entering values in this screen:

3. Click View Report.

Parameter Definition

Corrected From 
and 

Corrected To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site
Select one or more sites for your report.
Only applicable to organizations with multiple sites.

Editor Select one or more editors from the drop-down list.
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Results Screen and Explanations

The Editor Productivity—Hourly Detail report shows the following information:

• The last and first name of the editor 

• Number of reports edited during the AM hours, broken down by hour

• Number of reports edited during the PM hours, broken down by hour

• Grand totals for AM reports, broken down by hour

• Grand totals for PM reports, broken down by hour

Editor Productivity—Summary
This report provides information on all editors about total number of lines, total number of 
characters, average lines, and average characters each editor produced based on the 
selected date range.

Running the Editor Productivity—Summary

To run this report:

1. On the Reports tab, select the Editor Productivity—Summary report from the list.

2. Use the following table as a guide for entering parameters for this report:
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3. Click View Report.

Results Screen and Explanations

The Editor Productivity—Summary report with details shows the following 
information:

• Editor: The last and first name of the editor who corrected the reports

• Accession: Accession number of the study on which the report was dictated

• A: The addendum’s sequence number. For an original report, this column is blank.

• Reports: Number of reports for each editor, including a grand total for all editors at 
the bottom

Parameter Definition

Corrected From 
and 

Corrected To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site Select one or more sites for your report. This parameter is 
applicable only to organizations that have multiple sites.

Characters Per 
Line

Select the number of characters that make up a line from the 
drop-down list. The default setting for characters per line is 65.

Show Details

Select True or False
If you select True for Show Details, the information for each 
report by each editor is shown (as opposed to the total for all 
reports for each editor).

Reports Select All, Originals Only, or Addendums Only.
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• Lines: Number of lines (based on the Characters Per Line setting) in the report, with 
a total for the editor and a grand total

• Characters: Number of characters in the report, with a total for each editor and a 
grand total

• Avg. Lines: Average number of lines in the editor’s reports, with a grand total

• Avg. Chars: Average number of characters in the editor’s reports, with a grand total
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Reports Type Reports

Report Custom Fields
The Custom Fields report shows information about reports in which certain custom fields 
contain specified values. 

Running the Custom Fields Report

To run this report: 

1. On the Reports tab in the Logs group, select Report custom fields from the 
drop-down list. 

2. Select a beginning and ending Order Time Frame. Click in each field to display a 
calendar from which you can select each date.

3. Select a custom field from the list, and then click Add. Note that if you have access to 
more than one site, the site name precedes the custom field name.

4. Select Equals, Not equals, or Contains. 

5. Select a value (if there is a drop-down list of choices) or type in a value.

6. Select the check box next to any field whose contents you want to see in the report. 
The software will use the unchecked fields for selection, but will not display them in 
the report. 

7. Repeat steps 2 through 6 for each custom field you want to include. You can delete any 
field by clicking the Remove link next to it. 
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8. Click View Report. Any reports that contain the values you indicated appear in the 
report.

Reports—Anatomy Modality Summary
This report shows a summary of reports submitted, organized by body region and 
modality. 

Running the Anatomy Modality Summary Report

To run this report:

1. On the Reports tab, select the Reports—Anatomy Modality Summary report from 
the list.

2. Use the following table as a guide for entering values in this screen:

3. Click View Report.

Parameter Definition

Signed From 
and 

Signed To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site Select one or more sites for your report. This parameter is 
applicable only to organizations with multiple sites.
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8

Results Screen and Explanations

The illustration below shows the content of the Anatomy Modality Summary report.

The Reports—Anatomy Modality Summary report shows the following information in 
its table: 

• Each row: Shows a body region, such as Spine or Head & Neck

• Each column: Shows the modalities, such as CT or MR, found within the report’s 
date range, with totals for each anatomical region and grand totals for each modality. 

Click the plus sign next to an anatomical region or modality to see more specific 
details:
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Reports—Embedded Images
This report shows information on images that were added to reports.

Running the Embedded Images Report

To run this report:

1. On the Reports tab, select the Reports—Embedded Images report from the list.

2. Enter your parameters for the report:

Results Screen and Explanations

The Reports—Embedded Images report shows the following information:

• Accessions: The identifying number assigned in the RIS

• A: The addendum’s sequence number. For an original report, this column is blank.

Parameter Definition

Created From 
and 

Created To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site Select one or more sites for your report.This parameter is 
applicable only to organizations with multiple sites.

Account Select the user whose account you want to view, or select All.

Reports Select the type of reports you want to include: Originals only; 
Addendums only; or All.
539



54

PowerScribe® 360 | Reporting System Administrator Guide
• Procedure: The type of procedure that generated the images

• Site: Site from which the report originated

• Resident: Last name, first name, and middle name of the resident who created the 
report, if applicable

• Attending: Name of the attending radiologist who signed the report

• Signed: Date the report was signed

• Images Count: Number of images inserted into the report

• Images Avg. Resolution: Average screen resolution (in pixels) of the images in the 
report

• Images Avg. Size: Average size (in inches) of the images in the report

Reports—Medical Order with Barcode
This report shows the medical order information, including the barcodes for both the 
patient and the study, based on the Order Number.

Running the Medical Order with Barcode Report

To run this report:

1. From the Reports tab, select the Medical Order with Barcode report from the list.

2. Select the site. 

3. Enter the order number (usually the accession number).

4. Click View Report.
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Results Screen and Explanations

The illustration below shows the content of a typical PowerScribe 360 | Reporting report 
using the Reports—Medical Order with Barcode report.

Reports—Peer Reviews
Note: The peer review feature is a purchasable option in PowerScribe 360 | Reporting. 
For more information, contact your Nuance account executive.

This report provides information about any peer reviews that were performed during the 
selected time frame for specific sites and/or authors.

To run this report:

1. On the Reports tab, select the Reports—Peer Reviews report from the list.

2. Enter your parameters for the report:

Parameter Definition

Reviewed From 
and 

Reviewed To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site Select one or more sites for your report.This parameter is 
applicable only to organizations with multiple sites.
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Results Screen and Explanations

The Reports—Peer Review report shows the following information:

• Accession: The identifying number assigned in the RIS

• Modality: The type of device used to perform the diagnostic exam.

• Site: Name of the site where exam was performed.

• Location: Shows location of exam (within the site)

• Resident: The name of the resident who dictated the report, if applicable

• Attending: The name of the attending radiologist

• Reviewed: Date that the report was peer reviewed.

• Auto: Shows whether the user was automatically prompted to perform the peer 
review. A check mark indicates that the user was automatically prompted.

• Reviewer: Name of the reviewing peer

• Rating: Numeric peer review rating, based on the ACR definitions.

• CS: Clinically Significant. Refers to the ACR’s b ratings: 2b, 3b, 4b. A check mark 
appears in this column if the report was clinically significant.

• Custom Fields: Lists the custom fields used in the report.

• Reviewer Comments: Comments made by the person performing the peer review.

• Verified: Date the peer review was verified. Peer reviews rated 2b, 3a, 3b, 4a, and 4b 
must be verified to comply with the ACR. 

• Verifier: Name of person who verified the peer review. Peer reviews rated 2b, 3a, 3b, 
4a, and 4b must be verified to comply with the ACR. 

Author Select a specific author, or leave the default All as your criteria.

Rating Select one or more ratings, or leave the default All as your 
criteria.

Parameter Definition
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Reports—Report List
This report shows all reports that meet your criteria. For example, you can view all reports 
that include a particular AutoText entry, or that are concerned with a certain anatomical 
part. 

To run this report:

1. On the Reports tab, select the Reports—Report List report from the list.

2. Enter your parameters for the report:

Results Screen and Explanations

Parameter Definition

Last Modified 
From and 

Last Modified To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site Select one or more sites for your report.This parameter is 
applicable only to organizations with multiple sites.

Anatomy Select an anatomical part, or select All Anatomies. The report 
includes documents that are related to the anatomy you specify.

Modality
Select one or more modalities for your report. The report 
includes only documents concerned with the modalities you 
select.

Account Select one or more user accounts to include in the report.

AutoText Used Select an AutoText entry, or select Any AutoText. The report 
includes only the documents that contain the AutoText.

Reports Select Originals Only, Addendums Only, or All.
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The Reports—Report List report shows the following information:

• Accession: The identifying number assigned in the RIS

• A: The addendum’s sequence number. For an original report, this column is blank.

• Patient: Last name, first name, and middle name of the patient who is the subject of 
the report

• MRN: The unique identifying number assigned to the patient

• Resident: The name of the resident who dictated the report, if applicable

• Attending: The name of the attending radiologist

• Status: The current state of the report

• Modified: The date the report was last changed

Reports—Unsigned
This report lists reports that are currently unsigned by attending or resident providers. 
Unsigned reports do not include those sent to an editor. 

Running the Reports—Unsigned Report

To run this report:

1. From the Reports tab, select the Reports—Unsigned Reports report from the list.

2. Use the following table as a guide for entering values in this screen:

3. Click View Report.

Parameter Definition

From Date and 
To Date

Indicate the date range for this report.
Click the calendar icons and select the beginning and ending 
dates. Beginning and ending times are required.

Site Select one or more sites for your report. This parameter is 
applicable only to organizations with multiple sites.

Correction 
Workflow

Select Self-edit, In-house, Delegated, or All. 

Author Select an author from the drop-down list, or select All.

Editor Select an editor from the drop-down list, or select All.

Reports Select Originals only, Addendums only, or All.
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Results Screen and Explanations

The Reports—Unsigned report shows the following information:

• Accession: The identifying number assigned in the RIS

• A: The addendum’s sequence number. For an original report, this column is blank.

• Site: The site where the report was created

• MRN: The unique identifying number assigned to the patient

• Dictated: Date and time the report was created

• Editor: Name of the individual who corrected the report

• Author: Name of the provider who dictated the report

• Corrected: Date and time the report was edited

• Approved: Date and time the report was approved

• Audio Duration: The length of the report’s audio, in hours, minutes, and seconds
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Turnaround Time (TAT) Reports

In PowerScribe 360 | Reporting, turnaround time (or TAT) falls into three categories: 
Dictation, Correction, and Approval.

• Dictation TAT: The time period from the beginning of dictation to the end of dictation.

• Correction TAT: The period from the time a provider clicks the Send to Editor button (or 
the Transcribe button in a Send to Editor workflow) to the time the editor clicks Finish. 

• Approval TAT: The period from the time a resident clicks the Send to Editor button (or 
the Transcribe button in a Send to Editor workflow) to the time the resident clicks 
Approve. 

TAT—Reports Sent to Editor by Attending
This report shows the turnaround time (TAT) for each report within the supplied date 
range. In this case, TAT is defined as the amount of time, in minutes, from the beginning 
of the dictation (when the provider initiated the report) to the end of the correction. In 
addition, this report provides an average of report lengths and average TATs for the 
supplied date range. Reports must be final to appear in this report. 

Running the TAT—Reports Sent to Editor by Attending Report

To run this report:

1. From the Reports tab, select TAT—Reports Sent to Editor by Attending from the 
list.

2. Use the following table as a guide for entering values in this screen:

3. Click View Report.

Parameter Definition

Signed From 
and 

Signed To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site Select one or more sites for your report. This parameter is 
applicable only to organizations with multiple sites.

Author Select an author, or all authors, from the drop-down list.

Editor Select an editor, or all editors, from the drop-down list.

Reports Select All, Originals Only, or Addendums Only.
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Results Screen and Explanations

The TAT—Reports Sent to Editor by Attending report includes the following 
information:

• Accession: The identifying number assigned in the RIS

• A: The addendum’s sequence number. For an original report, this column is blank.

• Site: The site at which the report was dictated.

• Attending: Last name, and first name of the attending provider who initiated the 
report

• Editor: Name of the person who corrected or transcribed the report

• Sent to Editor: The date and time the provider sent the report for correction. 

• Corrected: The date and time that the editor finished work on the report

• Audio Duration: Length of the dictated report in hours, minutes, and seconds

• Correction TAT: Number of minutes from the time the provider sent the report to be 
edited until the editor finished work on the report

TAT—Reports Sent to Editor by Resident Report 
This report is identical to the TAT—Reports Sent to Editor by Attending report 
described above, except that it reports on residents instead of attending radiologists. All 
parameter fields and result fields are the same as the TAT—Reports Sent to Editor by 
Attending report.

TAT—Summary Author Dictated to Signature
This report shows, for each author, the average turnaround from the time dictation began 
to the time the report was signed.
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Running the TAT—Summary Author Dictated to Signature Report

To run this report:

1. From the Reports tab, select the TAT—Summary Author Dictated to Signature 
report from the list.

2. Use the following table as a guide for entering values in this screen:

3. Click View Report.

Results Screen and Explanations

The TAT—Summary Author Dictated to Signature report shows the number of reports 
that fall into each of nine turnaround time ranges with separate totals for self-edited 
reports and those sent to an editor. The ranges are:

• Less than 5 minutes

• Between 5 and 15 minutes

Parameter Definition

SIgned From 
and 

Signed To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site
Select one or more sites for your report. This parameter is 
applicable only to organizations with multiple sites.

Author Select an author, or all authors, from the drop-down list.

Editor Select an editor, or all editors, from the drop-down list.
8
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• Between 15 and 30 minutes

• Between 30 minutes and one hour

• Between one and two hours

• Between two and four hours

• Between four and eight hours

• Between eight and 24 hours

• Greater than 24 hours

The two rightmost columns show the total reports and the average turnaround time for all 
reports in the date range. The bottom row gives a total count for each of the categories.

TAT—Summary Author Order to Signature
This report is identical to the TAT—Summary Attending Dictated to Signature report 
described above, except that it shows the average TATs from the time the film was 
ordered (as opposed to dictated) to the signature time. All parameter fields and result 
fields are the same as the TAT—Summary Attending Dictated to Signature report.

TAT—Summary Author Signature Averages
This report shows the average report signature TATs, divided into ranges. 

The TAT—Summary Author Signature Averages—Past Day and TAT—Summary 
Author Signature Averages—Past Week reports are identical to this report, except that 
they show only activity during the past 24 hours and the last seven days, respectively. 
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Running the TAT—Summary Author Signature Averages Report

To run this report:

1. On the Reports tab, select the TAT—Summary Author Signature Averages report 
from the list.

2. Use the following table as a guide for entering values in this screen:

3. Click View Report.

Results Screen and Explanations

The TAT—Summary Author Signature Averages report shows the number of reports 
that fall into each of nine turnaround time ranges. The ranges are:

• Less than 5 minutes

• Between 5 and 15 minutes

• Between 15 and 30 minutes

• Between 30 minutes and one hour

• Between one and two hours

Parameter Definition

Signed From 
and 

Signed To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site
Select one or more sites for your report.This parameter is 
applicable only to organizations with multiple sites.

Author Select an author from the drop-down list, or select All.
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• Between two and four hours

• Between four and eight hours

• Between eight and 24 hours

• Greater than 24 hours

The two columns at the far right show the total reports and the average turnaround time for 
each provider. The bottom row gives a total count for each of the categories.

TAT—Summary Author to Editor
This report shows, for each editor, the number of reports whose turnaround time fell into 
each of several ranges. The report also shows each editor’s total number of corrected 
reports and average TAT in hours, minutes and seconds. 

The TAT—Summary Author To Editor—Past Day and TAT—Summary Author To 
Editor—Past Week snapshot reports are identical to this report, except that they show only 
activity during the past 24 hours and the last seven days, respectively. 

Running the TAT—Summary Author to Editor Report

To run this report:

1. From the Reports tab, select the TAT—Summary Author to Editor report from the 
list.

2. Use the following table as a guide for entering values in this screen:

3. Click View Report.

Parameter Definition

Signed From 
and 

Signed To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site
Select one or more sites for your report.This parameter is 
applicable only to organizations with multiple sites.

Editor Select an editor, or all editors, from the drop-down list.
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Results Screen and Explanations

The TAT—Summary Author to Editor report shows the number of reports that fall into 
each of nine turnaround times ranges. The ranges are:

• Less than 5 minutes

• Between 5 and 15 minutes

• Between 15 and 30 minutes

• Between 30 minutes and one hour

• Between one and two hours

• Between two and four hours

• Between four and eight hours

• Between eight and 24 hours

• Greater than 24 hours

The bottom row gives a Grand Total for each of the categories.

The last column shows the Avg TAT (average turnaround time) for each editor during the 
date range.

TAT—Summary Resident to Editor Report
This report is identical to the TAT—Summary Author to Editor report described above, 
except that it reports on residents instead of attending radiologists. All parameter fields 
and result fields are the same as the TAT—Summary Author to Editor report.
2
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TAT—To Radiologist Signature
This report lists the details on the amount of time it takes for a radiologist to sign a report. 

Running the TAT—To Radiologist Signature Report

To run this report:

1. From the Reports tab, select the TAT—To Radiologist Signature report from the list.

2. Use the following table as a guide for entering values in this screen:

3. Click View Report.

Parameter Definition

Signed From 
and 

Signed To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. Beginning and ending times are required.

Site
Select one or more sites for your report.This parameter is 
applicable only to organizations with multiple sites.

Correction 
Workflow

Select Self-Edit, In-house, Delegated, or All.

Author Select an author from the drop-down list, or select All.

Editor Select an editor, or all editors, from the drop-down list.

Reports Select Originals Only, Addendums Only, or All. 
553



55

PowerScribe® 360 | Reporting System Administrator Guide
Results Screen and Explanations

The TAT—To Radiologist Signature report shows the following information: 

• Accession: The identifying number assigned in the RIS

• A: The addendum’s sequence number. For an original report, this column is blank.

• Site: The site where the report was dictated.

• Author: Last and first name of the provider who initiated the report

• Editor: Last name of the report’s editor

• Created: Date and time the provider initiated the dictation 

• Audio Duration: Length of the report in hours, minutes, and seconds

• Correction TAT: Elapsed time from the point when the provider clicks the Send to 
Editor button (or the Transcribe button in a Send to Editor workflow) to the point 
when the editor clicks Finish.

• Approval TAT: Elapsed time from dictation initiation, including correction time (even 
if sent to an editor), to the point when the provider clicks Approve.

• Signature TAT: Elapsed time from dictation initiation, including correction time 
(even if sent to an editor), to the point when the provider clicks Sign.
4
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Reports for Purchasable Options

Note: The Quality Check and Clinical Guidance features are purchasable options in 
PowerScribe 360 | Reporting. For more information, contact your Nuance account 
representative.

If your organization has purchased the Quality Check or Clinical Guidance options, the 
reports shown in this section are available.

Note: Quality Check is the new name for the Assure consistency checker.

Quality Check - by author
This report provides information about any Quality Check consistency checks that were 
run during a specific time frame, based on a specific radiologist. 

Running the Quality Check - by author Report

To run this report:

1. On the Reports tab, select the Quality Check - by author report from the list.

2. Use the following table as a guide for entering values in this screen:

3. Click View Report.

Parameter Definition

Signed From 
and 

Signed To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. A date range is required.

Site Select one or more sites for your report. This parameter is 
applicable only to organizations with multiple sites.

Author Select a radiologist, or use the default Select All.
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Results Screen and Explanations

The Quality Check - by author report shows the following information:

• Author: First and last names of the person who authored the report.

• Report Count: Total number of reports for each author.

• Quality Check Executed: Number/percentage of reports where Quality Check was 
run. 

• Quality Check Finding: Number/percentage of reports that Quality Check detected a 
finding of any type.

• Gender Mismatch: Number/percentage of reports where gender mismatches were 
detected.

• Laterality Mismatch: Number/percentage of reports where laterality mismatches 
were detected.

• CTR/Actionable Finding: Number/percentage of reports where critical test results or 
actionable findings were detected.

• Communication Statement: Number/percentage of reports where a critical test result 
communication statement was issued.
6
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Quality Check - detailed results 
Note: Quality Check is the new name for the Assure consistency checker.

This report provides detailed information about any Quality Check consistency checks 
that were run during a specific time frame. 

Running the Quality Check - detailed results report

To run this report:

1. On the Reports tab, select the Quality Check - detailed results report from the list.

2. Use the following table as a guide for entering values in this screen:

3. Click View Report.

Parameter Definition

Signed From 
and 

Signed To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. A date range is required.

Site Select one or more sites for your report. This parameter is 
applicable only to organizations with multiple sites.

Account Select a provider, or use the default All Accounts.

Modality Select a modality, or use the default All Modalities.

Anatomy Select an anatomy, or use the default All Anatomies.

Accession If known, enter the accession number for the study.

Reports Select either Checked, Mismatches, CTR/Actionable 
Findings, Communication, or All.

CTR/Actionable 
Findings Select either Shown, Filtered, or All.

Check Select either Automated or Manual.
557



55

PowerScribe® 360 | Reporting System Administrator Guide
Results Screen and Explanations

The Quality Check - detailed results report shows the following information:

• Accession: The identifying number assigned in the RIS

• A: The addendum’s sequence number. For an original report, this column is blank.

• Procedure: Type of procedure performed.

• Site: Site that generated the report.

• Resident: First and last names of the resident, if one exists for this report.

• Attending: First and last names of the attending provider.

• Processed: Date and time the report was created.

• Mismatch: Shows by check mark the type of mismatch detected, if any.

• CTR/Actionable Finding: Indicates whether critical test results or actionable findings 
were detected.

• Comm: Indicates whether a critical test result communication statement was issued. 
8
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Quality Check - session listing
Note: Quality Check is the new name for the Assure consistency checker.

This report lists any Quality Check sessions that occurred during the selected time frame. 

Running the Quality Check - session listing report

To run this report:

1. On the Reports tab, select the Quality Check - session listing report from the list.

2. Use the following table as a guide for entering values in this screen:

3. Click View Report.

Parameter Definition

Processed From 
and 

Processed To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. A date range is required.

Site Select one or more sites for your report. This parameter is 
applicable only to organizations with multiple sites.

Account Select a radiologist, or use the default Select All.

Accession If known, enter the accession number for the study.
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Results Screen and Explanations

The Quality Check - session listing report shows the following information:

• NUS DocID: Identifier automatically generated by PowerScribe 360 | Reporting.

• Accessions: The identifying number, or numbers, assigned in the RIS

• A: The addendum’s sequence number. For an original report, this column is blank.

• Resident: First and last names of the resident, if one exists for this report.

• Attending: First and last names of the attending provider.

• Report Created: Date and time the report was created.

• Quality Check: Date and time the Quality Check consistency check was run.

• Error Message: Error message, if one is included.
0
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Clinical Guidance - detailed results
This report contains detailed information on the use of the clinical guidance guidelines. 

Running the Clinical Guidance - detailed results report

To run this report:

1. On the Reports tab, select the Clinical Guidance - detailed results report from the 
list.

2. Use the following table as a guide for entering values in this screen:

3. Click View Report.

Parameter Definition

Signed From 
and 

Signed To

Indicate the date range for this report.
Click the calendar icons and select the beginning and 
ending dates. A date range is required.

Site Select one or more sites for your report. This parameter is 
applicable only to organizations with multiple sites.

Account Select a radiologist, or use the default All Accounts.

Modality Select a modality, or use the default All Modalities.

Anatomy Select an anatomy, or use the default All Anatomies.

Accession If known, enter the accession number for the study.

Guidance Select one of the Guidance guidelines, or use the default All.

Modified Select Modified, Unmodified, or use the default All.
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Results Screen and Explanations

The Clinical Guidance - detailed results report shows the following information:

• Accession: The identifying number assigned in the RIS

• A: The addendum’s sequence number. For an original report, this column is blank.

• Procedure: Type of procedure performed.

• Site: Site that generated the report.

• Resident: First and last names of the resident, if one exists for this report.

• Attending: First and last names of the attending provider.

• Signed: Date and time the report was signed.

• Guidance: Shows which clinical guidance guideline was used.

• Modified: Indicates whether the clinical guidance guideline was modified.
2
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System Maintenance

Objectives
In this chapter, you will:

• Perform system maintenance, including

- Antivirus exclusions

- Microsoft updates

- Backups

- System logs

- Daily client workstation reboots

- Daily server checks

- Rebooting your system

- Rebooting your hot spare (if implemented)

• Access customer support options
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Introduction

Nuance provides the PowerScribe 360 | Reporting System Maintenance information to its 
customers for record keeping and troubleshooting purposes. Customers are responsible for 
performing the items listed and are strongly recommended to use this information to keep 
their systems up to date on a daily basis. 

Antivirus Exclusions

Most antivirus programs implement a real-time scanning feature that, unless properly 
configured, can interfere with the normal operation of PowerScribe 360 | Reporting and the 
Dragon speech engine. 

Setting the antivirus exclusions correctly for PowerScribe 360 | Reporting application 
installed with Microsoft Windows 2003 Server, Windows 2008 Server, or Windows 2012 
Server operating systems (OS), and Client Workstations with Windows 8, Windows 7, and 
Windows XP OS can help to eliminate the following conflict issues:

• Latency at log in or log out

• Latency when opening a report

• Latency when signing a report

• Workstation appears to be locked up or unresponsive

• User profiles and/or language models not processing properly

• Server CPU utilization consistently high

The best practice to prevent interference of PowerScribe | Reporting with an antivirus 
program is to set the following exclusions described in this section.
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Advanced Settings
Many antivirus and malware applications have advanced settings that allow the program 
to look for patterns in files to help it decide if the file is dangerous. Be sure to disable these 
advanced or heuristic settings. The illustrations below are from Symantec Antivirus. Your 
antivirus or malware application may use different names or controls.

If your application has a setting to trust files from trusted Internet sites, enable the setting. 

Also, add the PowerScribe 360 | Reporting system URL to your Internet Explorer 
Trusted Sites settings.
565



56

PowerScribe® 360 | Reporting System Administrator Guide
Windows 7 and Windows 8
Exclude the following process:

• Natspeak.exe

Exclude the following folders, subfolders, and/or file extensions:

• PACS integration folders for XML integrations (i.e. C:\Nuance) 

– XML

• C:\ProgramData\Nuance Folder

– BD, BIN, DAT, DFT, DRA, DVC, ENH, GSB, GRM, GRX, INI, LCK, NWV, SIG, 
SVC, USR, VER, VOC, WAV, XML

• C:\Users\<Windows USER_ID>\AppData\Local\Temp Folder and subfolders

– BD, BIN, DAT, DFT, DRA, DVC, ENH, GSB, GRM, GRX, INI, LCK, NWV, SIG, 
SVC, USR, VER, VOC, WAV, XML

• C:\Users\<Windows USER_ID>\AppData\Roaming\Nuance\Dragon SDK Client 
Edition12 (or 10)\

– Dragon.log

– Dragon.bak.log

• C:\Users\<Windows USER_ID>\AppData\Roaming\Nuance\Dragon SDK Client 
Edition12 (or 10)\results

Web/SQL Server(s)
Exclude the following processes:

• C:\Windows\System32\LocalFileManager*.exe

• C:\Windows\PSEXESVC.exe 

Note: C:\Windows\PSEXESVC.exe might not yet exist on a Web server until the 
SUS server has had a chance to run.

Exclude the following folders, subfolders, and/or file extensions:

• X:\Nuance folder and all subfolders

– DAT, DFT, DRA, ENH, ENWV, INI, LCK, LDF, LOG, MDF, NWV, SIG, SLT, 
TXT, USR, VER, VOC, WAV, XML

• C:\Windows\Temp\es_export folder and all subfolders (may not exist)

• C:\Program Files (x86)\Nuance\ All files and sub folders

For an Accelerator, add these exclusions:

• <Installation Drive>\Nuance

• %SYSTEMROOT%\system32\config\systemprofile\AppData\Local\Temp\agw\

• %APPDATA%\Local\Temp\smrgw
6
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• %SYSTEMROOT%\system32\config\systemprofile\AppData\Local\Temp\agwdist*

SUS Server
Exclude the following processes:

• C:\Windows\System32\LocalFileManager*.exe

• Natspeak.exe

• For 64-bit (x64) SUS servers:

X:\Program Files (x86)\Nuance\Speech Utility Server\psexec.exe

C:\Program Files\Nuance\Speech Utility Server\ 
Nuance.ConversionServer.ClientApp.exe

Note: The default (and most common) for the X: drive, is drive C:, but it could be 
a different drive if the installation technician chose a different drive during the 
installation.

• For 32-bit (x86) SUS servers:

X:\Program Files\Nuance\Speech Utility Server\psexec.exe

C:\Program Files (x86)\Nuance\Speech Utility Server\ 
Nuance.ConversionServer.ClientApp.exe

Note: The default (and most common) for the X: drive, is drive C:, but it could be 
a different drive if the installation technician chose a different drive during the 
installation.

Exclude the following folders, subfolders, and/or file extensions:

• C:\ProgramData\Nuance Folder and all subfolders

– BD, BIN, DAT, DFT, DRA, DVC, ENH, GSB, GRM, GRX, INI, LCK, LDF, LOG, 
MDF, NWV, SIG, SVC, USR, VER, VOC, WAV, XML, ZIP

• C:\Users\<Windows USER_ID>\AppData\Local\Temp Folder and subfolders

– BD, BIN, DAT, DFT, DRA, DVC, ENH, GSB, GRM, GRX, INI, LCK, LDF, LOG, 
MDF, NWV, SIG, SVC, USR, VER, VOC, WAV, XML, ZIP

• C:\Users\<Windows USER_ID>\AppData\Roaming\Nuance\Dragon SDK Client 
Edition12 (or 10)\

– Dragon.log

– Dragon.bak.log

• C:\Users\<Windows USER_ID>\AppData\Roaming\Nuance\Dragon SDK Client 
Edition12 (or 10)\results\
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Interface Server
Exclude the following folders, subfolders, and/or file extensions:

• X:\PowerXpress2008 folder and all of its subfolders

Note: The default (and most common) for the X: drive, is drive C:, but it could 
be a different drive if the installation technician chose a different drive during 
the installation.

– MDF, LDF

Montage Server
Exclude the following processes:

• Montage

– Montage.exe 

– Searchd.exe 

– Indexer.exe

• PostgreSQL 

– Postgresql.exe

• Python

– Python.exe

– Pythonservice.exe

Exclude the following folders, subfolders, and/or file extensions:

• C:\Montage folder and all of its subfolders

• C:\MontageBackups folder and all of its subfolders

• X:\Montage\Data (if Montage data is stored to a separate drive)

• Python installation folder (i.e. C:\Python 27) and all of its subfolders

• PostgreSQL installation folder (i.e. C:\Program Files (x86)\PostgreSQL) and all of its 
subfolders

• Erlang installation folder (i.e. C:\ Program Files (x86)\erl5.8.5) and all of its 
subfolders

• RabbitMQ installation folder (i.e. C:\ Program Files (x86)\RabbitMQ Server) and all 
of its subfolders

• Apache installation folder (i.e. C:\ Program Files (x86)\Apache Software Foundation) 
and all of its subfolders
8
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Addressing Vulnerabilities
SQL and IIS Vulnerabilities: When Microsoft releases new security patches and service 
packs for the PowerScribe platforms that use IIS and SQL, Nuance Technical Support 
applies the updates to its QA automation system and verifies that the product runs without 
issues. The Microsoft security updates are reviewed by the engineering team to assess if 
there are vulnerabilities that need to be addressed within the product. If a vulnerability is 
found, Nuance will work on providing a solution to resolve the vulnerability.

Security Issues (such as Heartbleed, POODLE, Shellshock): As security alerts related 
to industry-known vulnerabilities are received, the vulnerabilities are reviewed by the 
engineering team to assess if the vulnerabilities need to be addressed within the product. If 
a vulnerability is found, Nuance will work on providing a solution to resolve the 
vulnerability.
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Third-Party Updates

Applying Microsoft and other non-Nuance service packs and updates is the customer’s 
responsibility. Apply Microsoft and other third-party updates to your servers (web server, 
SQL server, interface server, and so on) and client workstations according to your 
organization’s third-party patching and update policies.

To determine if new Microsoft of other third-party service pack/patch/hotfix is not 
recommended, please refer to Nuance iSupport Solution 14686 and view PowerScribe 360 
| Reporting Support for Third-Party Software Updates.

Note: Make sure you reboot each server and workstation after you complete the updates. 

SSL Certificates
SSL Certificates are the responsibility of the Customer to obtain and install. Only SSL 
Certificates from valid vendors (e.g., Veritas, GoDaddy, Symantec, etc.) are supported. 

Self-signed certificates are supported and will function properly with PowerScribe 360 | 
Reporting software. However, it is the customer’s responsibility to manage these 
certificates and install them on the client workstations and servers.

Backups

Database, file and system Backups are the responsibility of the customer. Nuance will set up a 
default backup plan for the SQL server database when the system is first installed. The site 
should make any modifications they deem necessary to meet their internal requirements. In 
addition to backing up the database, the site should also set up a backup plan that also protects 
the file portions of the system.

On a daily basis, make sure that the database and transaction log backups are being performed 
by checking the backup dates.

To verify the database backups: 

1. Connect to the SQL server, launch SQL Server Management Studio and connect to 
your local server.

2. In the Object Explorer panel to the left, expand your server, expand SQL Agent, and 
expand Jobs.

3. Find the jobs labeled Comm4Backup.Hourly Transaction Log Backup and 
Comm4Backup.Full Backup. 

4. Right click and select View History on each. 

5. Confirm that there are no error messages under either.
0
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Verify Folder Backups Completed

On a daily basis, back the directories listed below from the Nuance directory. Nuance 
recommends that backups occur immediately after the database backups have completed.

• X:\Nuance\BridgeLogs (HL7 History)

• X:\Nuance\DragonUsers (Required)

• X:\Nuance\Wave (Audit History)

System Logs

The Logs are primarily for Nuance Support and Engineering to use investigating a reported 
issue. A site administrator does not have to review the logs on a regular basis, but may need to 
use them on occasion to provide data to Nuance Support.

The following section describes the logs shown in the Administrative Portal.

Communications Logs
The communication logs display communications from PowerScribe 360 | Reporting 
including fax, email, critical findings, and support requests. To review the communication 
logs sent from PowerScribe 360 | Reporting, use the Communications tab in the Logs 
group. The search box on the Communications tab allows you to use various 
specifications to search for logs.
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Exception Logs
When a client machine reports an error or exception, it is stored in the database. This log 
provides Nuance engineers more data on the error. 

Note: You may see various messages posted to this log. The presence of a message does 
not indicate an issue. These logs are designed for deeper evaluation of issues reported by 
end users to Nuance support.

Bridge Logs
The PowerScribe 360 | Reporting Bridge service exists to share patient information and 
orders with HIS or RIS systems. The Bridge service receives inbound order and patient 
information and stores it in the PowerScribe 360 | Reporting database. As radiologists 
create reports and sign them, the Bridge service sends them out to the HIS or RIS systems 
in the proper format for the receiving systems.

Use the Bridge tab in the Logs group to monitor inbound and outbound activity through 
the Bridge service. You can use various search criteria to narrow your search to the 
activity you want to see. For example, you can look for outbound orders that failed, or 
successful activity during the past two weeks. Some commonly-used searches are 
predefined for your use; these search links show totals in each category where events 
exist. 
2
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To use a pre-defined search:

• Click Recent Inbound to view incoming messages during the past hour. 

• Click Recent Outbound to view outgoing messages during the past hour.

• Click Failed Today to view messages that failed to be sent today or were rejected 
today.

To search for messages by accession or patient name or MRN: 

1. In the Logs group, select the Bridge tab. 

2. In the Look for drop-down list, select Accession numbers, Patient last name, or 
Patient MRN. 

3. Enter all or part of the accession number, name, or MRN. 

4. Click Search. Any items that meet your criteria appear in the list. 

To search for messages by other criteria: 

1. In the Logs group, select the Bridge tab. 

2. Select one or more criteria:

• Interface: Select the Bridge interface from the list.

• Direction: Inbound, Outbound, or All. 

• Time frame: Select a period of time, or select Custom and select the beginning and 
ending dates and times. 

• Type: Select All, Ack (acknowledged), ADT (admission, discharge, or transfer), 
Order, Result, or Unknown. 

• Status: All, All Failed/Rejected, Error, Ignored, Local Failure, Remote Failure, 
Remote Reject, or Success.

3. Click Search. Any messages that meet your criteria appear in the results grid.
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ACO/LMO Logs
The ACO/LMO logs are for the Nuance Support Engineers to use when investigating 
reported issues with a profile not processing ACO/LMO. 

Daily Client Workstation Reboot

Reboot all client workstations on a daily basis. This is a recommendation by Nuance and 
Microsoft due to the large amount of memory reads and writes that the applications and PACS 
systems perform. Rebooting allows the operating system and applications to run optimally for 
best performance.

Daily Server Checks

Verify Services Running
To verify that the Services are running, select Start > Settings > Control Panel > 
Administrative Tools > Services. (The path may differ slightly, depending on the 
operating system.)

Verify that the following services are running:

• SQL Server

• SQL Server Agent

• World Wide Web

• Nuance RadBridge

Check the drive space for the following: 

• Operating System Drive (C): 10 GB free space minimum

• Data Drive (D or E): 20 GB free space minimum

SUS Server
Go to Start > Settings > Control Panel > Administrative Tools > Services. (The path 
may differ slightly, depending on the operating system.)

Verify that the following services are running:

• SQL Service

• SPARK Host Manager Service

• SPARK Speech Node Manager
4
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• SPEECH Utility Server

• SPARK Core Services

Check the drive space for the following: 

• Operating System Drive (C): 10 GB free space minimum

• Data Drive (D or E): 20 GB free space minimum

Interface Server
Verify that the following services are running:

• PX2008 
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Rebooting Your System

Note: Nuance does not require routine server rebooting to maintain normal PowerScribe 
360 performance. 

Servers/systems should be rebooted according to your facility’s internal guidelines to 
maintain optimal performance, and after applying third-party updates such as those from 
Microsoft and your antivirus vendor.

Note: It is the customer’s/site personnel’s responsibility to schedule and reboot the 
servers at each site. 

Reboot Your System
Reboot the servers using the following steps:

1. Log all users off of the system.

2. Stop the following service on the Interface Server (HL7 server), if used:

• PX2008

3. Stop following service on the SUS Speech Node Server(s): 

• SPARK speech node manager 

4. Stop following services on the SUS Server(s): 

• SPARK core services 

• SPARK host manager service 

• SPARK speech node manager 

• Speech utility server 

5. Stop the following services on the Application (Web) Server: 

• Nuance RadBridge 

• IIS Admin Service

6. Stop the following services on the MSSQL Server: 

• SQL Server

7. Reboot the MSSQL Server (if separate from the Application server).

8. Reboot the Application (Web) Server.

9. Reboot the Interface Server (HL7 server), if used.

10. Reboot the SUS Server(s).

11. Reboot the SUS Speech Node Server(s).

12. Select Start > Settings > Control Panel > Administrative Tools > Services (the path 
may differ slightly, depending on the operating system) and verify that the following 
services are running on each of the servers:

• On the Application/SQL Server:

– SQL Server
6
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– SQL Server Agent

– World Wide Web

– Nuance RadBridge

• On the SUS Server:

– SQL Service

– SPARK Host Manager Service

– SPARK Speech Node Manager

– SPEECH Utility Server

– SPARK Core Services

• On the Interface Server:

– PX2008 

13. Have a user log in and verify that the system is operating as expected.
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Customer Support

Microphone Replacement
For microphone/foot pedal replacement, call 800-339-7683. You must have your 
microphone serial number and customer account number on hand when you call. 

iSupport Documentation and Assistance
iSupport is an Internet-based support site where you can search Nuance’s dynamic 
knowledge base for answers to your questions, access the library of operational manuals 
and quick reference guides, view the latest product enhancements and fixes, and submit 
online requests for service.

In order to use the full feature of iSupport and/or contact Technical Support, you must be a 
registered iSupport User. Complete instructions for registering can be found by going to 
the following link:

Getting Started with iSupport in the PowerScribe Family of Products

This link opens a document which provides step-by-step instructions on how to register, 
configure, and use iSupport. It also includes a link to access an online recorded training 
session which demonstrates every learning objective included in the document. You may 
have to paste the link in your web browser to access this document.

For help with iSupport, send an email to isupport.admin@nuance.com. 

Note: You must be a registered iSupport User to access the iSupport Knowledge Base 
Solution and documentation references in this manual.

eTIPS
Nuance also has Customer Support in the form of eTIPS Newsletters.Click the link below 
to access eTIPS registration and sign up for Newsletters:

Register for eTIPS and Sign Up for Newsletters

In addition, refer to solution #14415 in iSupport to search for and view archived eTIPS. 
8
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Nuance Healthcare Technical Support 
A dedicated Nuance Healthcare Technical Support team, available 24x7x365, services our 
PowerScribe 360 | Reporting customers who have an active maintenance contract with 
Nuance.

Our team can offer assistance via remote on-line connectivity to your systems, and it is 
available toll-free 800 833-7776 via our Say Anything menu. At the prompt, say: 
“PowerScribe 360 Reporting Support.”

Or, you can access the Nuance Healthcare Support Center through our iSupport, Internet-
based website at https://isupport.nuance.com. If you are not an iSupport subscriber, click 
iSupport Timesaver for information about how you can get started.

Nuance Depot Repair Service
Click here for a Web Form to submit a Depot Repair Service Request for a Connexions 
Station (C-phone), Optic Mic, PowerMic, Philips Speech Mic, tape-based recording 
device, digital recorder, and so on. iSupport members can save time by logging in to 
iSupport (https://isupport.nuance.com) and submitting a service request, choosing Depot 
as the Request Type.

Note: You do not have to submit a Depot Repair Service Request on a PowerMic under a 
current Nuance Maintenance Contract. Call Nuance's Customer Account Management 
team at 800-339-7683 to get the broken PowerMic replaced. At the prompt say, 
“PowerMic replacement.”
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Chapter 20

Order Entry

Objectives
In this chapter you will:

• Describe the prerequisites for using the Portal’s 
Order Entry feature.

• Enter an order in the system.
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Prerequisites for Order Entry

The Order Entry Portal allows users assigned the Order Entry role to add orders to the system. 
The Order Entry feature is generally used in facilities where there is no RIS, when a site 
requiring order entry is not connected to a RIS, or when the RIS is temporarily unavailable.

For you or your order entry personnel to use the Order Entry Portal, the following 
prerequisites must have been met:

• It is recommended that your physician database contain all of the ordering clinicians 
before you begin creating orders. Refer to Importing Persons, beginning on page 124 for 
information on importing the physician data from a spreadsheet. If necessary, however, 
you can follow the instructions in this chapter to add individual physicians. 

• You or another administrator must configure order entry preferences.

• Create a user with both Administrator and Order Entry privileges.

Configure the Order Entry Preferences
Preferences related to order entry are on the Order Entry tab in the System or Site 
Preferences dialog box. Set the preferences to the values indicated below. 

To set the order entry preferences: 

1. Select the System tab or the Sites tab in the Setup group. 

2. Click Preferences…. 

3. In the System or Site Preferences dialog box, select the Order Entry tab. 
2
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4. Use the following table as a guide when configuring the Order Entry preferences: 

5. When finished, click Save and Close.

Order Entry Preferences: Click Setup > System > Preferences > Order Entry tab

Type System Preference Definition Default

Site
Order entry generate 
Accession

Select to allow the order entry system to 
automatically generate accession numbers.

False

Site
Order entry Accession 
prefix

Enter a prefix that will appear before each of 
your accession numbers.

Site
Order entry Accession 
counter

Enter the starting value for your accession 
numbers.

Site
Order entry generate 
MRN

Select to allow the order entry system to 
automatically generate MRNs. 

False

Site Order entry MRN prefix
Enter a prefix that will appear before each of 
your MRNs.

Site Order entry MRN counter Enter the starting value for your MRNs.

Site
Printable order entry 
confirmation

Select if you want to allow printing order entry 
confirmation messages.

False
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Create an Order Entry/Administrator User
While you are not required to create a dual Order Entry/Administrator role, you may 
decide to do so to allow added accessibility to your Order Entry staff. The user you create 
in this section will be able to toggle between Order Entry and Administration by selecting 
a role from the drop-down list at the upper right corner of the Portal.

In the Administration role, this user can create physicians and edit patients. In the Order 
Entry role, the user can create orders and add patients to the system. 

To create an order entry/administrator user: 

1. In the Setup group, click the Accounts tab. The left side of the page lists all the users 
in the system, and the right side displays a form you can use to create a new user.

Note: If a user’s information already appears in the right side of the window, 
click Clear. Remember that Clear simply removes the data from the window; it 
does not delete the user from the system. 

2. Enter a Username and Password for the order entry/administrator user. 

3. Enter a First name and a Last name for the order entry/administrator user.

4. Select the Administrator check box.

5. Click Create New to save the user. The user’s name appears in the list at the left of the 
page.

6. Click Edit Rights.... The Administrative Rights dialog box opens.

7. Select either System Administrator or Site Administrator. (The example below 
shows a System Administrator; however, the selections are the same for a Site 
Administrator.)

8. If needed (if you want to limit this user’s system administrator rights, select Limited 
access with the following rights, and select these rights: 

• View Database Reports: Allows access to Reporting Services.

• View Exams: Allows read-only access to Explorer, Order Entry, Dashboard, 
Patients, and Physician pages.

• Edit Physicians: Allows editing physician data.

• Edit Patients: Allows editing patient data.
4
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• Edit Orders: Allows editing order properties (for example, priority) and metadata 
that are order-related, like custom fields. It also allows assigning orders to 
radiologists, deleting unreported orders, unlocking orders, and associating/
dissociating orders to or from a report.

• Edit Order Entry: Allows managing order entry requests, including authorization.

You can also select any other rights this user needs. When you have finished, click 
Save and Close.

9. For each site at which this user needs order entry capability:

 a. Enter an Identifier. 

 b. Select Order Entry as the role. 

 c. Click Create. 

The user’s site access information is added to the list at the left of the page.
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Using the Order Entry Portal

Users assigned the Order Entry role are authorized to perform only order entry tasks; these 
users see the Order Entry Portal upon logging in. They can: 

• Create new orders and add new patients

• View a list of the exams ordered today

• View a list of unreported orders

• Use any combination of search criteria to find orders

They can also use the Order Entry Portal to manage their user profiles, including changing the 
password, address, phone, and other information.

Order Entry users who are also administrators can create and manage physicians through the 
Physicians tab in this Portal. 

Log In to the Order Entry Portal
To log in to the Order Entry Portal:

• Log into the Administrator Portal with a user ID and password for an account that has 
been assigned the Order Entry role. The Order Entry Portal opens.
6
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The Order Entry window is divided into two main sections:

• Patient Search: Allows you to search for a patient who already exists in your system; 
add a new patient to the system; create orders for new or existing patients. (See Patient 
Search Section: Locate an Existing Patient, beginning on page 588 for more 
information.)

• Order Search: Allows you to search for, view, and manage orders based upon their 
status. (See Order Search: Search for an Existing Order, beginning on page 592 for 
more information.)
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Patient Search Section: Locate an Existing Patient
To locate an existing patient:

1. Select a Site from the drop-down list.

2. Enter the first few letters of the patient’s last name or MRN in the appropriate text 
field, followed by an asterisk (*). The asterisk is a wild-card character.

3. Click Search. A list of patients who meet your search criteria opens in the right side of 
the window. In the example below, 23* was entered in the MRN field.

4. Click the name in the Patient column for the patient for whom you want to add an 
order. The Order Create dialog box opens, with the patient’s demographic 
information already populated.

Note: Notice that the Edit Patient link in the upper right corner of the Order Create 
window is unavailable for existing patients. You can only edit patient demographic 
information on patients that you add to the system manually. Patients originally entered 
through a RIS or other interface cannot be edited from the Order Entry application.
8
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Add a New Patient and Create an Order
To add a new patient to the system:

1. Click the Add New Patient link. The Order Create dialog box opens. (For new 
patients, you must enter the required patient demographic information at the top of the 
window.)

2. Fill in the information for the required patient demographic fields: 

• Site: Select the patient’s site

• MRN: Enter the patient’s MRN. Note that in the example above, the MRN field is 
not available. This means that the system has been set up to automatically generate 
MRNs; this field will be populated once the patient/order information is created and 
saved.

• DOB: Enter the patient’s date of birth. You can click the month/year on the 
calendar to select different months/years, or you can type directly into this field.

• First: Enter the patient’s first name.

• Last: Enter the patient’s last name.

3. Fill in the order information:

• Accession: Enter the accession number. Note that in the example above, the 
Accession field is not available. This means that the system has been set up to 
automatically generate accession numbers; this field will be populated once the 
patient/order information is created and saved.
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• Start Date: Enter the date and time for this order. You can select the date from the 
calendar or type directly into this field. Date format is m/d/yyyy. Time format is 
either h:mm AM/PM, or 24 hour (military) time hh:mm.

• Procedure: Type the first few letters of the procedure for this order. A list of 
procedures that begin with those letters opens, allowing you to make a specific 
selection.

4. Once you have entered the required information, click Create Order. The Order 
Summary window opens.

Notice that the automatically generated accession number (from our example) now 
appears in the order.

5. From here you can either click Done to return to the main order entry window or click 
Print this page to print the order and scan the barcode into your RIS or the 
PowerScribe 360 | Reporting system.
0
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owed

s

Actions Link (in Patient Search Results)

The Actions link for each patient appears on the far right side of the patient search results 
window. Depending upon how the patient was added to the system, use this link to edit or 
delete patients:

• Patients added through the Order Entry application: You are allowed edit or delete 
these patients. A green Actions link indicates that these actions are available.

• Patients added through a RIS: You are not allowed to edit or delete these patients. A 
gray Actions link indicates that no actions are available. If you hover your cursor over 
the grayed out Actions icon, the following message opens: This entity has been 
updated by the RIS and can no longer be edited/deleted here.

Edit/Delete 
this patient

No actions all

Available action
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Order Search: Search for an Existing Order
The Order Search section of the Order Entry window allows you to work with orders that 
already exist in the system. 

Links
• My orders today: Click to generate a list of all the orders you entered today.

• My unreported orders: Click to generate a list of all the orders you entered that are 
still unreported.

Look for 

1. In the Look for drop-down list, select either Accession Numbers, Patient Last 
Name, or Patient MRN. Enter the first few letters of the patient’s last name or MRN 
in the appropriate text field, followed by an asterisk (*). The asterisk is a wild-card 
character.

2. Click Search. A list of patients who meet your search criteria opens in the right side of 
the window. 
2
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Order Search Results
After searching using one of the above methods, orders that meet you search criteria are listed 
in the right side of the window. The example below shows the results after clicking the My 
orders today link. (Due to the width of the window, the image below is split into two parts.)

The next two sections of this document examine the Accession link and the Actions menu.
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Accession Link (View Your Order Details)

1. Click a link in the Accession column to view the order’s details, including any 
changes that you performed to the order. In the illustration below, the View, Create, 
and Edit items indicate this order’s history.

2. After viewing the order details, or printing this order, click the Close Window link to 
return to the main order entry window.

Actions Link (in Order Search Results)

The Actions link allows you to perform specific tasks (Edit, Delete, Print) on orders you 
created, depending upon the status of the order and how the order was entered in the 
system.

Order Entry users are allowed to:

• Edit orders that were imported or updated through the RIS

• Edit orders associated with final reports

• Edit orders entered by other Order Entry users

• Edit Temporary orders created by radiologists in the Windows client

• Edit non-final reported orders even if the order is locked

Order Entry users cannot:

• Delete reported orders

• Delete orders imported or updated through the RIS
4
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To perform an action:

1. Hover your cursor over the Action link to view the available options.

2. Select the action you want to perform. (Edit and Print behave as described earlier in 
this section.)

3. If you select Delete Order, a message box opens notifying you that you can only 
delete unreported orders. Click OK to delete the order or Cancel to return to the main 
order entry window without deleting the order.
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4. If you attempt to delete an order that has a status of Final, you see a warning at the top 
of the Order Search results list telling you that the order cannot be deleted.
6
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Printing an Order from the Reports Tab
You can also use the Medical Order with Barcode report to find and print an order. 

To print an order from the Medical Order with Barcode report:

1. Log in as an Order Entry/Administrator user.

2. Select the Reports tab in the Logs group. 

3. Select Reports - Medical Order with Barcode. 

4. Select the Site. 

5. Enter the Accession number of the order you want to print. 

6. Click View Report. 

7. Click the Print icon. 

8. Select the desired print options, and click Print. The order is sent to the printer you 
selected. 
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Creating and Managing Physicians

Order Entry users who are also administrators can view, create, modify, and delete physicians 
through the Administrator Portal 

To create a physician: 

1. Log in to the PowerScribe 360 | Reporting Administrator Portal as an Order Entry/
Administrator user. The Order Entry Portal opens. 

2. Select Administration from the drop-down list at the upper right. The Administrator 
Portal opens and displays the Physicians tab in the Exams group.

The Physicians tab provides access to all the physicians in the system. On this tab, 
you can create and manage physician accounts. 

3. From the drop-down list, select the Site to which this physician belongs. 

4. Type the identifier by which this physician is known to the RIS. 

5. Enter the NPI (National Provider Identifier) for this physician. 

6. Type the physician’s First and Last names. 

7. Enter any other information you have for this physician.

8. Click Create New. 

9. If desired, indicate the specialities for this physician. Click the Edit link, select one or 
more specialties, and then click Save and close.
8
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Term Definition

.cov The file extension for fax cover sheet files created by the Microsoft Fax 
Cover Page Editor utility

.dra The file extension for files created by the Dragon speech-recognition 
software. 

ACO Acoustic Optimization. The process in which the system compares the 
dictation audio to the corrected speech-recognized text. In this way, it 
learns how the provider pronounces various sounds, and adjusts the 
acoustic model for better speech recognition. 

acoustic model A file that represents the way patterns of individual sounds are likely to 
occur in speech for an individual provider.

addendum Additional text a provider attaches to a report after it has been finalized. 

administrator A user who have been granted some or all of the administrator rights. An 
administrator might also be assigned to a specific role. 

Administrator 
Portal

A web-based application in which to set up user accounts, configure the 
PowerScribe 360 | Reporting system, create sites, set preferences, and 
perform many other administrative tasks to obtain the full benefit of the 
system’s features. 

attending An attending radiologist is certified and is authorized to create and sign 
his own medical reports and those authored by residents.

Audit Log A record of user account events such as account creation, logon, logoff, 
ACO, and LMO.

autoformatting The process in which the speech recognition software places the 
recognized text in the format it will appear in the final document. It 
follows a set of rules you define, for example, preferences for the way 
certain words are abbreviated. 

AutoText Standard text providers or transcriptionists can insert in reports. Also 
referred to as macros or templates.

BI-RADS code Breast Imaging-Reporting and Data System code. A standard numeric 
code a radiologist assigns to a mammography report. As administrator, 
you enter the BI-RADS codes and descriptions for your PowerScribe 360 
| Reporting system through the Administrator Portal. 

Bridge A service that receives inbound order and patient information and stores it 
in the PowerScribe 360 | Reporting database. As radiologists create 
reports and sign them, the Bridge service sends them out to the HIS or RIS 
systems in the proper format for the receiving systems. 
0



Glossary
Procedure Master 
Translator

An Excel spreadsheet that contains columns with your facility’s procedure 
code, your facility’s description, the treatment modality, the clinical code, 
and ‘yes’ or blank to indicate whether the procedure is a mammogram. 
You use Procedure Master Translators to map your facility’s procedure 
codes to the standard AMA clinical codes, and to update the code 
information in your system’s database.

clinical code One of a set of standard, radiology-related procedure codes published by 
the AMA. As an administrator, if building the Option 1 Procedure Master 
Translator, you must map your organization’s codes to the standard 
clinical codes. See also: procedure code

composite 
expression

In a worklist, a condition that contains more than one expression; the 
expressions are connected by logical operators AND or OR. For example: 
Site equals Site 1
AND
Department is not in range 100, 300

custom field A data item associated with a particular order. Custom fields might 
include measurements, radiation dosage information, flags, and so on. You 
can tailor custom for each site. Technologists and front desk personnel can 
assign values to custom fields on unreported orders through the 
PowerScribe 360 | Reporting Administrator Portal; radiologists can do so 
during reporting in the PowerScribe 360 | Reporting client application. 
Administrators can assign values to custom fields in the Administrator 
Portal at any stage.

custom words Words you add to your language models to improve speech recognition. 
Custom words might include place names, or the names of drugs or 
persons.

Dashboard A tab in the Exams group that provides a real-time view of exam activity 
in the system including inbound, outbound, and user activity. 

default AutoText The AutoText a provider sees on beginning a report, if a default AutoText 
exists in the system and if the Start with default AutoText preference is 
in effect. You should always associate a default AutoText entry with at 
least one procedure code.

draft report A report that is ready to be corrected by a transcriptionist/editor. A draft 
might have gone through speech recognition, or might have been created 
by a self-edit user. 

editor A transcription user who corrects draft documents received from the 
speech recognition software. 

Term Definition
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extended multiselect An option in the system configuration that determines whether users can 
select and act only upon items visible on the current page, or on multiple 
pages. With this option set to the default value of False, if you place a 
check mark in the header check box to select all items, only the items 
visible on the current page are automatically selected, and if you perform 
an action such as ‘Delete,’ only the selected items on the current page are 
deleted. 

fellow A visiting physician who has been invited to serve at a healthcare 
institution. A fellow’s role is similar to a resident’s, but a fellow might 
have the privileges of an attending provider if certified in a specialty. 
When logging in as a fellow, the user can select either the attending or 
resident role. Depending on your facility, a fellow might have signing 
privileges on some reports, but resident privileges (non-signing) on others.

Findings Mode A dictation mode in which the PowerScribe 360 | Reporting software 
automatically converts free-form dictation to a structured report when the 
user selects or dictates the “Apply Findings” command. This feature is 
especially helpful where the facility requires a structured report format, 
but providers are accustomed to, or prefer, free-form dictation. 

Front Desk A user role with limited rights on the Administrator Portal. For example, 
you might set up front desk users to scan patient insurance cards into the 
system.

group In the Administrator Portal, one of three sets of tabs used for configuring a 
particular set of options. On logging in the first time you see the Exams 
group; on all subsequent logins, you return to the group and tab on which 
you last worked.

hyponym A word or word fragment associated with a field embedded in AutoText. 
Defining hyponyms for fields in the AutoText allows providers to dictate 
in Findings Mode. 

impression A field that contains the provider’s final remarks about the study. Also 
referred to as the “summary” or “conclusion.”

language model A file that represents the words providers are likely to say, how those 
words are pronounced, and how they are used.

LDAP A method for authenticating user login in a single place; this method 
eliminates the need to maintain passwords in PowerScribe 360 | Reporting 
or to synchronize them with other systems such as PACS (Picture 
Archiving and Communication System). You can configure LDAP 
settings through the Administrator Portal.

Term Definition
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LEXIMER Lexicon Mediated Entropy Reduction. A patented Natural Language 
Processing (NLP) engine. The LEXIMER code extracts any positive 
findings, that is, abnormalities found in the image, from the Impression 
text. The PowerScribe 360 | Analytics application uses the resulting 
structured documentation for its data analysis.

LMO Language Model Optimization. The process in which the system analyzes 
signed reports, extracts words, and adds them to the language model. It 
improves speech recognition by identifying the words a provider says 
frequently.

location A specific area within a site. You can define a separate report template for 
each location, if needed.

merge field A data item in a report. Merge fields might contain data from the RIS or 
HIS, or created in PowerScribe 360 | Reporting.

nesting Placing an expression within another expression in a worklist definition, 
just as you might place parentheses in a mathematical operation to 
indicate which statements are to be evaluated together.

normal AutoText A block of text the provider invokes to report a normal finding. The 
provider ordinarily does not make any changes to the AutoText after 
invoking it, and the report is automatically approved or signed. Typically, 
a normal AutoText entry does not contain fill-in fields, although it can if 
they have default values. 

order A request that a study be performed. Administrators can manage orders 
and reports through the Explorer tab in the Exams group. Users set up 
with the Order Entry role can create orders in the Order Entry portal. 

Order Entry A role you can assign to a user account. Users with this role can create 
orders in the system.

PACS Picture Archiving and Communication System. PowerScribe 360 | 
Reporting is designed to integrate with one or more PACS systems. In 
most cases, your Nuance representative configures the site for your PACS.

peer review The process in which a radiologist reviews the work of another and 
assigns a score to it. If your system setup includes the peer review feature, 
you can configure the scores and their definitions, and you can configure 
the system to prompt a user to perform a peer review after dictating a 
certain number of reports for a particular modality. (Peer review is a 
purchasable option. Contact your Nuance account executive for 
information.)

Term Definition
603



60

PowerScribe® 360 | Reporting System Administrator Guide
physician The person who refers a patient for treatment. A physician can log in only 
to the Administrator Portal, where she can perform order entry or view 
reports for which she is the referring physician. 

Physician accounts are accepted from the HL7 feed; you can also maintain 
them on the Physicians tab in the Exams group. Physicians cannot access 
the PowerScribe 360 | Reporting system unless you create accounts for 
them. Each physician is associated with a single site (that is, a single RIS). 
The same physician might have multiple physician records, one per site, 
each with a different site identifier. You can link these physicians by 
creating an account for them for use in PowerScribe 360 | Reporting.

postprocessor The software that formats the final report according to a set of rules set up 
in the Administrator Portal. 

practice group Groups are used in PowerScribe 360 | Decision Support to help assistant 
personnel order exams. You can also use them to limit ordering 
physicians’ access to PowerScribe 360 | Reporting reports.

procedure code A string of alphanumeric or numeric characters that represents a medical 
exam or treatment. Some medical facilities use the industry-standard 
codes and descriptions, others have their own.

prototype A speech-recognition profile created by Nuance personnel at installation 
of your system. You can copy the prototype to create a ‘dummy’ profile 
for users who need access to the system but do not dictate. With this 
profile, the user does not have to go through speech training on application 
startup. 

provider The person who provides dictation audio to the system. A provider can 
create reports in the PowerScribe 360 | Reporting client application, and 
can edit reports in the Administrator Portal. You can set up provider 
accounts in the Administrator Portal. 

relevant AutoText AutoText that is related to a procedure. To make it easier for the provider 
to locate the desired AutoText, you can design the AutoText entries so that 
only those relevant to a particular procedure appear in the drop-down list. 
Relevant personal entries are those that are related to a procedure and 
belong to a particular user.

Resident The role assigned to a provider who is not yet certified. Residents can 
author medical reports but are not authorized to sign them; they can only 
approve the reports, which are later signed by an attending provider. In 
most cases, the resident has a designated attending radiologist (or group of 
attending radiologists) who eventually signs the report.

RIS Radiology Information System. PowerScribe 360 | Reporting has the 
capability to interact with multiple RIS. 

Term Definition
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roaming profile A ‘dummy’ Dragon profile you can assign to a user who does not use 
speech recognition; with this profile, the user does not have to go through 
speech training on application startup. A prototype (trained) profile must 
exist in the Administrator Portal for this option to be available; this profile 
is put in place by Nuance personnel during system installation.

ROEDS Order entry rules, required for order entry to be performed on the system. 
Usually, your Nuance support or field service representative uploads the 
ROEDS data at system installation.

role A property you assign to a user, depending on the functions the user is to 
perform in the system. Roles include Attending, Resident, Fellow, Editor, 
Front Desk, Order Entry, and Technologist. Roles determine which 
features users see when they log into the Portal. A user might have the 
same role in all sites to which she has access, or a different role in each 
site. 

section An item you can define as part of the site configuration. For example, you 
might create a section that represents work coming from a particular 
dictation provider, or studies of a certain type. To control the work a user 
receives, you can associate a section with a user account and the same 
section with one or more worklists.

simple expression The basic building block for creating a worklist query. A simple 
expression usually contains a field name, an operator, and one or more 
values. For example: Transfer status is in range Ready, Sent. See also: 
composite expression.

site A facility, clinic, hospital, or other separate entity within your 
organization. You must configure at least one site; in a single-site 
installation, you need only configure one site.

snapshot An option you can assign to a worklist to cause it to retrieve data from a 
special database table. This table contains unreported orders of the last 
three months with a status of Completed, Scheduled, or Temporary, non-
final reports or addenda, and final reports or addenda of the last two days. 
Always select this option for worklists designed to retrieve these type of 
reports.

speech profile Data the system uses to obtain optimal speech recognition for a particular 
provider. As administrator, you can use the Speech Utility tab in the 
system configuration to specify the location for your system’s speech 
profiles. 

Speech Utility 
Server

The server on which the speech recognition software resides.

Term Definition
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Technologist A role you can assign to a user account. Before the radiologist dictates a 
report on an order, a technologist might supply some data that has not 
been sent in HL7 as part of the order. Alternately, a technologist can create 
a draft report without dictation; the report is then finalized by a 
radiologist.

worklist A predefined search that retrieves reports and orders. Administrators can 
create worklists for providers, for transcriptionists, and for themselves.

Term Definition
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Installing the Client Software

Installing the PowerScribe 360 | Reporting client application is a two step process. Be sure to 
perform the steps in Client Workstation Requirements before installing the client application.

• Client Workstation Configuration: Before you install the client, review and/or perform 
all of the steps in the workstation configuration section of this document.

• Client Installation: After verifying that the workstation meets the requirements, install 
the client using the steps in the client installation section of this document.

Client Workstation Configuration
Note: Be sure to validate and configure workstations to meet the published requirements 
and settings before installing the client application software. For all of the system 
technical requirements and specifications, click here to view or download a pdf of the 
requirements.

Notes on Hardware/Software Requirements
• Ensure that all Microsoft updates have been applied to each workstation.

• Apply the latest root certificate update to each workstation.

Antivirus Exclusions

Note: All exclusions can be accomplished with either folder or extension exclusions in the 
antivirus software configuration, depending on the site preference and capabilities of the 
specific antivirus solution.

Running antivirus software in the real-time mode can compromise the operation of 
PowerScribe 360 | Reporting. Antivirus software should be run on PowerScribe 360 | 
Reporting workstations, but with the following restrictions:

• You must refer to the iSupport Solution 14686, document P36A036, for the current 
exclusions for PowerScribe 360 | Reporting client workstations and apply them on all 
machines.

• This solution is updated when exclusions are added. Download the latest copy and 
delete any older copies frequently to make sure that the servers and client workstations 
are always up to date.

• You will be instructed to disable the antivirus application before installing the 
PowerScribe 360 | Reporting software and to re-enable it after a successful 
installation.
8
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Failure to Launch PowerScribe 360 from Philips iSite - Antivirus Conflict

If PowerScribe 360 | Reporting fails to launch from Philips iSite on a client workstation, 
there may be a conflict with the antivirus software. This was concluded at a site running 
ESET NOD32 V4.2.40.0 antivirus software. It might not apply to all antivirus software or 
all PACS integrations, but is presented here as a possible troubleshooting solution.

To resolve the conflict:

1. Under Web Access Protection, open HTTP, HTTPS followed by Web Browsers.

2. Clear (remove the check mark from) the following:

• C:\Program Files\Nuance\Dragon SDK Client 
Edition<version>\Program\natspeak.exe 

• C:\Program Files\Philips\iSiteRadiology\<version>\iSiteRadiology.exe

eScription and Transcription Client on One Machine

Note: The following are the mandatory requirements if you wish to run eScription and the 
PowerScribe 360 | Reporting Transcription Client on the same machine.

• You must have sufficient room on the machine for both applications.

• You must have sufficient RAM for each application.

• You do not run both applications at the same time.

Rights

The person installing the PowerScribe 360 | Reporting software must use a Local 
Administrator account and User Account Control (UAC) must be off during installation. 
After installation, UAC can be re-enabled.

Turn Off Control Panel/Power Options

The Power Options will vary depending on the exact hardware configuration and 
operating system of the workstation.

To disable the options, open the Power Options applet in the Control Panel.

Disable the following:

• Turn off hard disks

• System standby

• System hibernate

• Hibernate (on the Hibernate tab)

• Any Power Options, on any tab, that may freeze an application or disk drive when the 
computer is left idle
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PowerMic II Firmware Updates

Make sure that each PowerMic II is updated with the latest version of the PowerMic II 
firmware. As of the date on this document, the current version is 2.04 (and 2.03 for the 
scanner portion if you have a scanning PMII).

To download and use the PowerMic II Firmware Upgrade Tool, log in to the Nuance 
iSupport web site and search for solution 13102. When the solution opens, click the 
PowerMic Firmware Update Utility link. Download and install the utility, reboot the 
computer, and then run the utility from the Windows Start menu. The utility shows you 
the current version for your PowerMic II and tells you whether an update occurred.

Tip: You don't have to install the utility on all of the workstations. Install the utility on only 
one workstation, and then check each PowerMic II, one at a time, from that one 
workstation.

Disable USB Root Hub Power Management

Verify that the Power Management is disabled for the USB Root Hubs. This will prevent 
disconnects in the application. You can use Device Manager to change the power 
management settings for the USB Root Hub. To disable this setting in Device Manager:

1. Expand Universal Serial Bus Controllers.

2. Right-click the USB Root Hub.

3. Click Properties.

4. Click the Power Management tab.

5. Clear the Allow the computer to turn off this device to save power check box.

6. Repeat for all hubs.

Disable NIC Card Power Management

Verify that the Power Management is disabled for the NIC Card. This will prevent 
disconnects in the application. You can use Device Manager to change the power 
management settings for a network adapter. To disable this setting in Device Manager:

1. Expand Network Adapters.

2. Right-click the adapter.

3. Click Properties.

4. Click the Power Management tab.

5. Clear the Allow the computer to turn off this device to save power check box.

Make Internet Explorer the Default Web Browser

1. Open Internet Explorer.

2. Click Tools > Internet Options > Programs.
0
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3. In the Default web browser area, click the Make default button. If Internet Explorer 
is already the default web browser, this button is unavailable (grayed out).

4. Select the Tell me if Internet Explorer is not the default web browser check box.

5. Click Apply.

Internet Explorer Options Settings

Open Links from Other Programs Item

1. Open Internet Explorer.

2. Click Tools > Internet Options > General.

3. In the Tabs area, click Settings.

4. In the Open links from other programs in area, select the A new window option.

5. Click Apply.

Trusted Sites

1. Click Tools > Internet Options > Security > Trusted Sites > Sites.

2. Enter the URL of the PowerScribe 360 | Reporting server and click Add.

3. Click Close.

4. Recommended: Set the trusted site security level slider to Low.

Disable UAC on Windows Clients

For machines running Microsoft Windows, you should disable the User Account Control 
(UAC) prior to installing the PowerScribe 360 | Reporting software. After installing the 
software, you may change the settings back so that the client workstation is secure.

1. Open the Control Panel and enter UAC in the start menu or search box.

2. Click the Change User Account control settings link.

3. Note the setting. You will change this back after installing the PowerScribe 360 | 
Reporting software.

4. Drag the settings button all the way to the bottom to disable UAC.

5. Reboot the computer.

Disable the Windows Firewall

Nuance recommends that you disable the Windows Firewall on all work stations and 
servers. Not disabling the firewall could cause the firewall to block communications to the 
application server and other integrated applications.
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Install the Client Application
To install the client application on a provider's computer:

1. Open Internet Explorer and enter the PowerScribe 360 | Reporting Client site using 
the web address shown below:

http://<servername>/PS360ReportingClient/ 

where <servername> is the name of your PowerScribe 360 | Reporting web server 
(do not include the surrounding brackets < > when you type in the server name).

2. Click the Download link.

3. At the Welcome dialog box that opens, click Next.
2
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4. At the System Configuration Checks dialog box, verify that the system meets the 
minimum requirements and click Next. (The Available column will vary from system 
to system.)

5. At the Dragon Naturally Speaking Setup Type dialog box, select the appropriate 
version of Dragon and click Next.
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6. At the Ready to Install the Program dialog box, verify the items to be installed and 
click Install. The system begins to install the necessary components. Note that this can 
take several minutes to complete.
4
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7. At the Completed dialog box, click Finish.

8. Reboot the provider’s computer.

9. Once logged in to the provider’s computer, double-click the Nuance 
PowerScribe 360 icon on the desktop.
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10. At the Application Run dialog box, click Run.

11. When the application has finished installing, ask the provider to log in and have him/
her perform the microphone wizard and training dictations.

12. Set the following required permissions on the client workstation:

Windows

• C:\ProgramData\Nuance Folder and all subfolders: All users must have read, 
write and modify permissions.

PACS Integration using XML (e.g., C:\Nuance\<PACS/RIS drop folder>)

• All users must have read, write, and modify permissions.

13. Set and verify the following required rights on the client workstation: 

• The client must be able to update the registry. 

• The client must have Read and Write access to the following keys:

• HKEY_LOCAL_MACHINE\SOFTWARE\Nuance

• HKEY_CURRENT_USER\SOFTWARE\Nuance
6
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DVD Image Install/Upgrade Procedure
This installation method can be used for remote workstations that cannot easily download 
the Dragon components of the PowerScribe 360 | Reporting client software installation, 
due to Internet bandwidth restrictions.

The DVD files are created during the installation of the system and are stored on the 
Application (IIS) server.

This method installs the Dragon components and the integration components, and places a 
shortcut on the desktop for the application. When this shortcut is executed, the .Net 
components will be updated on the workstation and the application will launch.

To install or upgrade the client software from the DVD image:

1. Download the DVD installation folder and burn to a DVD for distribution.

2. Place the DVD into the DVD drive on the workstation.

3. Browse to the DVD and double-click the setup.exe file.

The rest of the steps are the same as in the standard installation.
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Merge Fields

The table below displays the merge fields you can use in AutoText, in templates, or in both. 
For more information on how to insert merge fields in AutoText, refer to Creating AutoText 
with Merge Fields, beginning on page 292. To use merge fields in templates, refer to Creating 
a Print Template, beginning on page 489.

ID Merge Field Name Use in 
AutoText

Use in 
Templates

N/A maintext 

102 Current Date  

104 Site  

302 Patient Name  

303 Patient SSN 

304 Patient Address 

305 Patient Street 

306 Patient City 

307 Patient State 

308 Patient Zip 

309 Patient Home Phone 

310 Patient Work Phone 

311 Patient Mobile Phone 

313 Patient Fax 

314 Patient Email 

316 Patient MRN  

317 Patient DOB  

319 Patient Age  

320 Patient Gender  

321 Patient Deceased Date 

323 Patient Last Name 

324 Patient First Name 

325 Patient Middle Name 

326 Patient Country 

401 Visit Number 

402 Hospital Service 
0
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403 Patient Account Number 

404 Admit Date  

406 Discharge Date  

408 Point Of Care 

409 Room 

410 Bed 

411 Facility 

416 Location Description  

417 Patient Class 

419 Attending Name  

420 Attending Address 

425 Attending Home Phone  

426 Attending Work Phone  

427 Attending Mobile Phone  

428 Attending Pager Phone  

429 Attending Fax 

430 Attending Email  

432 Referring Name  

433 Referring Address 

434 Referring Street 

435 Referring City 

436 Referring State 

437 Referring Zip 

439 Referring Work Phone  

440 Referring Mobile Phone  

441 Referring Pager Phone  

442 Referring Fax 

443 Referring Email  

445 Consulting Name 

446 Consulting Address 

451 Consulting Home Phone 

452 Consulting Work Phone 

ID Merge Field Name Use in 
AutoText

Use in 
Templates
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453 Consulting Mobile Phone 

454 Consulting Pager Phone 

455 Consulting Fax 

456 Consulting Email 

458 Admitting Name 

459 Admitting Address 

464 Admitting Home Phone 

465 Admitting Work Phone 

466 Admitting Mobile Phone 

467 Admitting Pager Phone 

468 Admitting Fax 

469 Admitting Email 

470 Location  

471 Referring Last Name 

472 Referring First Name 

473 Referring Middle Name 

502 Accession Numbers  

504 Order Date  

506 Relevant Clinical Info  

507 Reason For Study  

508 Provider ID 

509 Provider Name  

510 Provider Address 

511 Provider Street 

512 Provider City 

513 Provider State 

514 Provider Zip 

515 Provider Home Phone 

516 Provider Work Phone 

517 Provider Mobile Phone 

518 Provider Pager Phone 

519 Provider Fax 

ID Merge Field Name Use in 
AutoText

Use in 
Templates
2
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520 Provider Email 

521 Provider Last Name 

522 Provider First Name 

523 Provider Middle Name 

524 Comments 

525 History  

526 Priority 

606 Report Create Date  

607 Report Sign Date  

608 Report Preliminary Date  

609 Report Corrected Date  

611 Report Work Type 

612 Report Status 

613 Addendum Sequence 

627 Signer Name  

640 Dictator Name  

652 Signer Last Name 

653 Signer First Name 

654 Signer Middle Name 

655 Signer ID 

656 Dictator Last Name 

657 Dictator First Name 

658 Dictator Middle Name 

659 Dictator ID 

660 Contributor Names  

661 Contributor Names with ID 

662 Creator Name  

663 Creator Last Name 

664 Creator First Name 

665 Creator Middle Name 

666 Wet Reader Name  

667 Wet Reader Last Name 

ID Merge Field Name Use in 
AutoText

Use in 
Templates
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668 Wet Reader First Name 

669 Wet Reader Middle Name 

670 Creator ID 

671 Wet Reader ID 

672 Editor Name  

673 Editor Last Name 

674 Editor First Name 

675 Editor Middle Name 

676 Editor ID 

677 Signed by Name  

678 Signed by Last Name 

679 Signed by First Name 

680 Signed by Middle Name 

681 Signed by ID 

682 Report Create Workstation  

683 Report Sign Workstation  

802 Procedures  

804 Diagnosis Codes  

805 Procedure Codes 

10000 Custom  

100000 DICOM 

ID Merge Field Name Use in 
AutoText

Use in 
Templates
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Overview

The tables in this appendix list the modalities and anatomies that are available for 
categorization in PowerScribe® 360 | Reporting. It is very important to spell these items 
correctly when creating a spreadsheet to map your procedure codes to the Nuance modalities 
and anatomies.

Note: Some of the modalities and anatomies in these tables contain one or more levels of 
sub-categories, which appear in the columns to the right of the main item. In the 
PowerScribe 360 | Reporting Administrator Portal (under Sites > Procedures > 
Categorize) a category that has a small plus sign (+) to the left of it contains additional 
sub-categories.

Note: Peer Review customers must be aware that only certain modalities are supported by 
the American College of Radiology (ACR). If you are going to use the Send to ACR 
feature within the peer review application, you must map your applicable procedures to 
the supported ACR modalities, as indicated in the right-hand column of the Modality 
Table in this document.
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Modality Table

Modality Sub-Category 1 Sub-Category 2 Supported by ACR?

Absorptiometry No

DEXA No

X-Ray - Absorptiometry Yes

CT Yes

Calcium Scoring Yes

CTA Yes

Echocardiography Yes

EEG No

ETT No

Fluoroscopy No

Fluoroscopy - Dynamic No

Invasive Yes

Angiography Yes

Angioplasty Yes

Arterial Procedure Yes

Arthrography Yes

Atherectomy Yes

Bronchography Yes

Cardiac Procedure Yes

Catheter Drainage Yes

Catheter Infusion Yes

Catheterization Cardiac Yes

Catheterization Transcervical Yes

Cholangiography Yes

CT - Guided Biopsy Yes

Cysternography Yes

Dacrycystography* Yes

Diskography Yes

Endoscopic Procedure Yes
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Modality Sub-Category 1 Sub-Category 2 Supported by ACR?

Invasive (continued) Epidurography Yes

Fistologram* Yes

Fluoroscopy Guidance Yes

GI Procedure Yes

GU Procedure Yes

Gyn Procedure Yes

Image Guided Biopsy Yes

Laryngography Yes

Lymphangiography Yes

Mammography Procedure Yes

MRI - Guided Biopsy Yes

Myelography Yes

OB Procedure Yes

Obstetrical Yes

Pacer Insertion Yes

Peritoneogram Yes

Sialography Yes

Sinogram Yes

Spinal Procedure Yes

Splenoportography Yes

Stent Placement Yes

Thrombectomy Yes

Thrombolysis Yes

Transcatheter Therapy Yes

US - IVUS Yes

US Procedure Yes

Vascular Procedure Yes

Venography Yes

Vertebroplasty Yes

Mammography Yes

Ductogram No

MEG No
8
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Modality Sub-Category 1 Sub-Cagegory 2 Supported by ACR?

MR Yes

MRA Yes

MRI Yes

MRI - Flow Mapping Yes

MRI - Functional Yes

Spectroscopy Yes

Nuclear Medicine Yes

Gamma Camera Imaging - Planar Yes

NUC - Spect Yes

NUC - Venography Yes

Urea Breath Test Yes

PET Yes

PET - Perfusion Yes

PET w/ CT Yes

Post Processing No

3D Render No

Radiography Yes

Cephalogram Yes

Cholecystography Yes

Pelvimetry Yes

X-Ray - Dental Yes

X-Ray - Diskography Yes

X-Ray - Magnification Yes

X-Ray - Specimen Yes

X-Ray - Standard Yes

X-Ray - Stereoscopic Yes

X-Ray w/ Fluoroscopy Yes

US Yes

Sonohysterography Yes

US - Duplex Yes

US - Obstetrical Yes

US - Ophthalmic Yes
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Modality Sub-Category 1 Sub-Category 2 Supported by ACR?

US (continued) US - Transcranial Yes

US - Transesophageal Yes

US - Transrectal Yes

Vascular Lab Yes
0
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Anatomy Table

Anatomy Sub-Category 1 Sub-Category 2 Sub-Category 3

Abdomen & Pelvis

Abdomen

Abdominal Vessels

Adrenal Vessels

Hepatic Vessels

Renal Vessels

Adrenal

Bile Ducts

Biliary Tract

Gallbladder

IVC

Kidney

Liver

Pancreas

Peritoneum

Portal Circulation

Renal

Spleen

Stomach

Abdominal & Pelvic 
Arteries

Abd/Pelv 1st Order Arteries

Abd/Pelv 2nd Order Arteries

Abd/Pelv 3rd Order Arteries

Abd/Pelv Additional Arteries

Abdominal Aorta

Pelvic Arteries

Visceral Arteries

Bladder

Colon
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Abdomen & Pelvis
(cont.)

Pelvis Fallopian Tube

Male Genital Tract

Pelvic Vessels

Pelvis - Lymph Node

Prostate

Sacrum

Uterus

Vagina

Rectum

Retroperitoneum

Small Intestine

Upper GI Tract

Urinary Tract

Breast

Cardiac
Coronary Arteries

Heart

Chest

Airway

Bronchial Tree

Chest - Lymph Node

Chest Wall

Lungs

Pleura

Ribs

SVC

Thoracic Arteries

Internal Mammary Artery

Pulmonary Arteries

Thoracic 1st Order Arteries

Thoracic 2nd Order Arteries

Thoracic 3rd Order Arteries

Thoracic Additional Arteries

Thoracic Aorta

Thoracic Esophagus

Thoracic Vessels

Anatomy Sub-Category 1 Sub-Category 2 Sub-Category 3
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Anatomy Sub-Category 1 Sub-Category 2 Sub-Category 3

External Genitalia
Penis

Testis

Extremity

Lower Extremity

Ankle

Foot

Hip

Knee

Leg

Lower Extremity Arteries

Leg Arteries

Lower Extr. 1st Order 
Arteries

Lower Extr. 2nd Order 
Arteries

Lower Extr. 3rd Order 
Arteries

Lower Extr. 
Additional Arteries

Lower Extremity Joint

Lower Extremity Vessels

Lymphatics

Thigh

Upper Extremity

Arm

Elbow

Fingers

Forearm

Hand

Shoulder

Upper Extremity Arteries

Brachial Artery

Upper Extr. 1st Order 
Arteries

Upper Extr. 2nd Order 
Arteries

Upper Extr. 3rd Order 
Arteries

Upper Extr. Additional 
Arteries
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Anatomy Sub-Category 1 Sub-Category 2 Sub-Category 3

Extremity (cont.) Upper Extremity (cont.)

Upper Extremity Joint

Upper Extremity Vessels

Wrist

Head & Neck

Head

Brain

Dental

Ear

Internal Auditory Meatus

Intracranial Vessels

Mastoids

Nasolacrimal Duct

Orbit Vessels

Orbits

Posterior Fossa

Salivary Glands

Skull

Temporomandibular Joint

Max-Face

Face

Facial bones

Mandible

Nasal Bones

Paranasal Sinuses

Neck

Cervical Esophagus

Extracranial Vessels

Larynx

Neck - Lymph Node
4
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Anatomy Sub-Category 1 Sub-Category 2 Sub-Category 3

Head & Neck (cont.) Neck (cont.)

Neck Arteries

Carotid Arteries

External Carotid 
Arteries

Neck 1st Order 
Arteries

Neck 2nd Order 
Arteries

Neck 3rd Order 
Arteries

Neck Additional 
Arteries

Vertebral Arteries

Parathyroid

Pharynx

Thyroid

Other

Veins
Ovarian Vein

Systemic Veins

Vessels

Additional Vessels

Initial Vessel

Systemic Vessels

Spine

Celiac Plexus

Cervical Spine

Coccyx

Lumbar Spine

Sacral Spine

Sacroiliac Joints

Thoracic Spine

Whole Body Bone Appendicular Skeleton
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Index
A
abbreviating titles 369
abbreviations 367

formatting 385
Abbreviations tab 385
accented characters, formatting 398
accession numbers, multiple per order 249
account events 167
account preferences 138

copying 164
accounts

adding to sections 108
creating 15
importing 112
maintaining 169
modifying 170
resetting acoustic model for 173
searching for 169

ACO
daily windows for 95, 164

ACO and LMO
intervals 93
logs 574
most recent 94
scheduling

for system 97
for user 97

time windows for 95
ACO/LMO

preferences
for account 164

tab 164
acoustic model 176

assigning for system 176
deactivating unused 181
resetting 173

Acoustic Optimization. See ACO
activity, auditing 165
Add note on reject 139
Add unmatched findings to report 146
addendums to reports 249

adding
codes, with charge masters 198
contributors to reports (providers) 254
custom words 181
information to reports (editors) 457
notes to reports (editors) 460

addresses, autoformatting for 368
administrative rights 17
administrators 113

creating 15
searching for 15

advanced provider training 241
check list for 258

Agfa macros, importing 318
Allow correctionist workflow 141
Allow Dragon Formatting dialog 151
Allow Dragon Options dialog 151
Allow order association 141
Allow report creation 141
AM. See acoustic model
ambiguous numeric strings, formatting 379
ampersand 398
Annotated link 433
application server, configuring 25
assigning orders (providers) 255
attachments

adding to reports (editors) 461
Attachments tab 440
attending 112

signature at resident workstation 255
audio retention 3
Audio Setup Wizard 232–235
audio, playing (editors) 449
audit log 165

printing 168
auditing user activity 165
AutoFeed (editors) 447
AutoFeed (providers) 256
autoformatting

General tab 365
rules 177, 362

Automatically load PACS studies 146
AutoText 265, 325

creating
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text (editors) 453
deleting 324
importing and exporting 303, 309, 319
inserting in reports (editors) 449
managing in Portal 303
overview 266, 326
printing 324
promoting, upgrading, and deleting 321
properties (editors) 454
reports with (editors) 245
searching for 268, 304
upgrading 323
with merge fields (editors) 456

AutoText Editor (editors) 453
AutoText Manager (editors) 454
AutoText tab

in Admin Portal 303
in client 451

AutoText voice command 150
AutoText, creating 270

and Findings Mode 294
and hyponyms 297
and procedures 306
associating procedure codes 290
default 285
editing fill-in fields in 281
fields with default values 279
impression field 301
merge fields in 292
normal and default 283
omitting field from Findings Mode 300
relevant to procedure 293
relevant, for sites 294
with fill-in fields 272, 279
with merge fields 292
with numeric fill-in fields 275
with pick lists 277

B
Barcode filter 159
Beep on command recognized 149
Beep on dictation start/stop 149
best practice tips 259
BI-RADS

codes 38
Block display of demographics 162
blood types, formatting 383
brackets 276, 398

in AutoText 274
Bridge logging, configuring 29
Bridge logs 572
Bridge service

configuring 29
description 4

Browse (editors) 434

C
calyx, spelling with i 399
Canadian post codes 368
cancelling

orders 484
capitalization 374
Capitalization tab 375
Caps Lock key 374
cc changed to mL 379
Celsius 379, 384
changing

password (editors) 430
preferences (editors) 463
report priority 480

charge masters
importing 193
modifying codes with 198
overview 188, 210
using to maintain database 189, 225

client application
logging in (providers) 231

clinical codes 188
Clinical Data tab 439
codes

clinical 188
modifying with charge masters 198

columns
tips for working with (editors) 437

commands, voice 259
communications logs 571
composite expressions in worklists 405
configuration settings 24, 44
configuring

application server 25
BI-RADS codes 38
Bridge service 29
LDAP settings 24
PowerScribe 360 client 33
practice groups 40
site settings 102
speech utility 32
system 24, 44, 100
Web portal 27

contractions 367
contributors, adding to reports (providers) 254
copying

account preferences 164
AutoText fields with hyponyms 299
user preferences 164

Correct Report option 250
Corrected Today link 433
Correction Queue link 433
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 Index
cover sheet 502
modifying 509

CPT code licensing 188
creating

accounts 112
administrators 15, 113
attending, resident, fellow 113
front desk 122
technologists 123
transcriptionists 118

AutoText 270
default AutoText 285
fax cover sheet 502
normal AutoText 283
physicians 119
print templates 489
relevant AutoText 293
roaming profiles 172
sites 102

currency codes 369
Cursor position on transcribe 149
custom fields

adding to reports (editors) 459
adding to sites 108
changing values in report 480
modifying values of 482

custom words
adding 181
importing 182

D
dash, formatting 398
Dashboard tab 487
database

maintaining with charge masters 189, 225
dates, autoformatting 365
deactivation of unused AM and LM 181
default

AutoText 283
font face 143
font size 143
values 279

deleting
AutoText 324
reports and orders 485
speech profile 174
words from language model 186

Detect accession length in search box 159
device preferences 75
diabetes types, formatting 380
diagnosis codes

adding to reports (editors) 457
changing in reports 480

Dictaphone PowerMic 77
preferences 154

dictating report 244
Dictation 71
dictation

guidelines for 232
preferences 71

changing (editors) 464
for account 149

Dictation tab 149, 152
disc, spelling with k 399
documentation 8
dosage abbreviations 401
draft, resetting report to 479
Drafts link 433
Dragon ACO interval (days) 164
Dragon LMO interval (days) 164

E
editing

fill-in fields in AutoText 281
Ready report 251
reports (editors) 449
reports (providers) 244
with voice 259
worklists 413

editor 112
sending report to 250
training 429
workflow 432

email addresses, formatting 371
Enable background report saving 147
Enable microphone toggle 150
Enable talking fields 146
Enable wet reads 139
Exams group, overview 12
exams, monitoring activity 487
Excel file

for importing non-administrative accounts 
133

for importing patients 124
for importing physicians 129

exception messages 572
excessive items returned by search 435
expanding "dad" and similar words 400
Explorer 85
Explorer Screen 85
explorer screen 85
Explorer Screen preferences

for account 159
Explorer screen preferences

for system and site 85
Explorer tab 468
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exporting
AutoText 303, 309, 319

expressions, simple and composite 405
extended multi-select 309

F
facility-specific features (editors) 457
facility-specific features (providers) 248
Fahrenheit 379, 384
fax

cover sheet 502
modifying cover sheet 509
templates 499

faxing order or report 476
feet and inches, formatting 380
fellow 112
fields

copying in AutoText 299
fill-in fields 272

numeric 275
pick list 277
with default values 279

filters 469
finding reports (editors) 432
finding reports (providers) 245
Findings Mode

and AutoText 294
omitting field from 300

finishing reports (editors) 452
Focus application on PACS launch 146
fonts and colors preferences 464
foot pedal 83

default button settings (editors) 444
preferences

for account 157
preferences, changing (editors) 465
used by editors 444

Force Reset 91
formatting

abbreviations 385
Capitalization tab 375
dates 366
miscellaneous items 396
numbers, units, and dates 378
viewing workstation updates 402

front desk 112
Front Desk account, creating 122

G
General tab for autoformatting 365
general training 235–??
grace period before uploading report 250
group, choosing 11
groups, overview 12

guidelines for dictation 232

H
headset 229
hierarchy of preferences 24, 44
Highlight text on playback 146
holding orders and reports 475
hyphen 399

before "French" 380
hyponyms

adding to AutoText fields 297
copying AutoText fields with 299

I
icons
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in search results (editors) 437

importing
accounts 112
Agfa macros 318
AutoText 303, 309
charge masters 193
custom words 182
non-administrative accounts 133
patients 124
physicians 129

impression field 301
inbound activity 487
initial voice training 232
inserting text in report 449
intermediate provider training 241
intervals for ACO and LMO 93
Invoke FAX at signoff 139
ISO currency codes 369

K
keyboard shortcuts for editors 445

L
language model 176, 177

assigning for system 177
deactivating unused 181
searching for words in 185

language model optimization. See LMO
LDAP settings, configuring 24
LEXIMER

template recommendations 489
licensing for CPT codes 188
LMO 93, 176

scheduling or disabling 97
locations, adding to site 108
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logging in
to Admin Portal 10
to client application (editors) 430
to client application (providers) 231
to Order Entry portal 586

logging off 14
logical operators 406
logs

ACO/LMO 574
Bridge 572
communications 571

Logs group, overview 14

M
macros, importing from Agfa 318
maintaining
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system 563

management reports 511
managing

orders and reports 468
patient records 598
speech profiles 172
vocabulary 181

measurements, autoformatting 365
merge fields 619

in AutoText 292
in AutoText (editors) 456

microphone 228
Microphone off idle time 150
microphone, using (providers) 228
military time 382
millions, autoformatting 371
Miscellaneous tab 396
mL replacing cc 379
mm and Hg, space between 381
modifying

custom field values 482
MRN 483
order priority 480
physicians 120
print and fax templates 507
users 171

monitoring
user activity 487

Move cursor on AutoText insert 144
MRN, changing 483
multi-select in Explorer 309
My Reports (editors) 433
My Reports (providers) 245

N
navigation in Portal 11
non-administrative accounts 133

normal AutoText, creating 283
notes

adding to reports (editors) 460
Notes tab 440
numbers

autoformatting 365, 370
pauses when dictating 371
spelling versus writing as digits 373

Numbers, Units, and Dates tab 378
numeric fill-in fields in AutoText 275

O
o’clock 381
omitting field from Findings Mode 300
one-digit ordinals, formatting 380
"oops" feature. See report transmit grace period
opening

reports (editors) 436
reports (providers) 245

OR and AND 406
Order Data tab 439
order entry 112, 581

logging in to portal 586
Order Entry portal 586
prerequisites 582

order preview 474
orders

assigning (providers) 255
associating with reports 478
cancelling 484
changing priority 480
deleting 485
faxing 476
modifying custom field values 482
previewing (providers) 439
printing 484
searching for across sites 469
unlocking 477
with multiple accession numbers 249

orthopedics, spelling with ae 400
outbound activity 487

P
PACS, adding to site 102
paragraph break 393, 394, 397
password, changing (editors) 430
patients

changing MRN 483
importing 124
managing records 598

pauses in formatting phrases 371
percentage, formatting 382
Perform spell check at signoff 139
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period
removing from dosage abbreviation 401
spaces after 372

permissions preferences
for account 141

Permissions tab 141
personal relevant AutoText 293
Philips SpeechMike 79
phone numbers, autoformatting 369
physician practices 40
physicians

creating 119
importing 129
modifying 120

Physicians grid 120
pick lists in AutoText 277
playing back audio (editors) 449
Portal

groups in 12
navigation in 11

positioning headset 229
PowerMic 77
PowerMic preferences

for account 154
for system 77

PowerScribe 360 | Critical Results 52
PowerScribe 360 client

configuring 33
description 6

PowerScribe 360 Explorer window (editors) 431
PowerScribe 360 Explorer window (providers) 

239, 242
PowerScribe Workstation, importing AutoText 

from 316
practice groups 40
pre-enrollment of providers 227
Preferences 58
preferences 138

changing (editors) 463
copying 164
copying account 164
for system 45, 364
hierarchy 24, 44

preferences by type
ACO/LMO

for account 164
device

for account 152
for system and site 77

dictation
for account 148
for system and site 71

Explorer screen
for account 159

for system and site 85
permissions

for account 141
for system and site 58

report editing
for account 143
for system and site 65

security
for account 161
for system and site 90

workflow
for account 139
for system and site 47

prerequisites
for order entry 582

preview page 474
previewing order or report (providers) 439
prices, autoformatting 369
printing

audit log 168
AutoText 324
reports and orders 484

Priors tab 440
procedure codes

adding and removing from AutoText 306
associating AutoText with 290
database 188

procedures, relevant AutoText 293
promoting AutoText 321
Prompt on GUI sign 139
Prompt to save speech files 150
provider training

basic 227
intermediate and advanced 241

providers
worklists for 424

push-pin 444

Q
query results maximum 435
Quick Search (editors) 462
Quick Search (providers) 243

finding multiple-accession orders with 249

R
RadWhere, importing AutoText from 309
Ready report, editing 251
rejecting reports 251
releasing orders and reports 475
relevant AutoText

for sites 294
personal 293

replacing text in report 449
Report 65
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Report Data tab 441
report editing preferences

for account 143
for system and site 65

Report Editing tab 143
Report Editor navigation panel 443
Report Editor window 442
report preview 474
Report tab 440
report transmission 101
report transmit grace period 250
reports 511

adding
attachments (editors) 461
contributors (providers) 254
custom fields (editors) 459
diagnosis codes (editors) 457
information (editors) 457
notes (editors) 460

associating with orders 478
changing custom field values 480
creating with AutoText 245
deleting 485
dictating 244
editing 449
faxing 476
features 512
finishing (editors) 452
holding, releasing, or resending 475
inserting AutoText in 449
modifying custom field values 482
previewing (editors) 439
printing 484
rejecting 251
replacing or inserting text (editors) 449
resetting to draft 479
searching for across sites 469
selecting (editors) 436
sending to editor 250
types 512
with Ready status, editing 251

reports by type
author productivity 515–527
AutoText 528–532
editor productivity 532–535
report type 536–545
turnaround time (TAT) 546–554

resetting acoustic model 173
resident 112

workstation, attending signature from 255
restoring roaming profiles 172
Restrict diagnosis codes by exam type 146
results area, viewing user accounts in 170
Rh factor, formatting 383

RIS
messages to and from 487

Roaming Profile menu 172
roaming profiles

creating 172
restoring 172

roles 112
rules for autoformatting 177, 362

S
Save audio with report 151
search results area (editors) 436
search results for accounts 170
search results grid 472
searching

for accounts 169
for administrator accounts 15
for AutoText entries (providers) 268, 304
for orders and reports 469
for users 169
for words in language model 185
with filters 469
with worklists 469

sections
adding accounts to 108
adding to site 103
assigning to worklists 424, 427
subscribing to 424

Security 90
security preferences

for account 161
Security tab 161
Select utterances shorter than 149
selecting reports (editors) 436
sending orders and reports 475
servers 3
services 35
Setup group, overview 13
Show brackets on fields 145
Show old resident drafts in My Reports 159
signing out 14
signing reports (providers) 245

by attending at resident workstation 255
simple expressions 405
single digits, formatting 382
site preferences

overview 101
site settings 100, 102
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sites
adding custom fields 108
adding locations 108
adding PACS 102
adding sections 103
creating 102
relevant AutoText for 294

Snapshot 411, 412
Social Security numbers, formatting 371
spaces after period 372
speech options 176, 362
speech profiles

deleting 174
managing 172
restoring entire or acoustic portion 172

Speech recognition mode 149
speech recognition overview 176
speech utility, configuring 32
SpeechMike 79
spreadsheet for procedure codes 190
Start with default AutoText 143
STAT, marking report as (providers) 250
subscribed worklists (providers) 253
subscribing to sections 424
system

maintaining 563
preferences 45, 364

device 77
dictation 71–75
Explorer screen 85–??
permissions 58–60
report editing 65–71
security 90

settings 24, 44, 100
workflow preferences 47–??

system-wide
acoustic model 176
language model 178

T
T N M expressions, formatting 397
technologists 112

creating accounts for 123
telephone numbers, autoformatting 369
temperatures, autoformatting 379
templates

fax 499
modifying fax cover sheet 509
modifying print and fax 507
overview 488
print 489
recommendations for LEXIMER 489

test report 243
times, formatting 367, 381

titles, abbreviating 369
toolbar of reports 512
Touched Today link 433
training

advanced, for providers 258
for speech recognition 232
general, for providers 235

transcriptionists
creating 118
limiting worklist access 427

Turn off dictation when changing modes 150

U
UK post codes 368
units of measure 368
unlocking orders 477
unused acoustic and language models 181
upgrading AutoText 323
Use PC speaker for sound alerts 149
user

accounts
maintaining 169

activity, monitoring 487
preferences 138

copying 164
roles 112

user accounts
searching for 169

V
vertebra range, formatting 402
viewing

accounts 170
vocabulary management 181
voice

commands 259
editing 259
training 232

W
Warn if fields are empty when signing 140
Warn on application exit 162
Warn on sign if new notes exist 140
Web addresses, formatting 371
Web portal, configuring 27
words

deleting 186
searching for 185

Workflow 47
workflow

preferences 47
changing (editors) 465
for account 139
for system and site 47
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Workflow tab 139
working with columns (editors) 437
worklists 403

assigning sections to 424, 427
creating 410, 411

for providers 424
editing 413
elements of 405
executing 469
limiting transcriptionists’ access to 427
overview 404
using in client application 252
viewing subscribed only 253

worklists (editors) 432
worklists (providers) 252
workstation

audio retention on 3
workstation updates for formatting rules 402
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